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1.1 LEARNING OBJECTIVE 
 
Students will get the basic knowledge of computer after learning this chapter.  As 
computer is developed as a multipurpose machine; we will get the information about 
its components, methods, generations and its types in this discussion. Computer is 
working as a model, hence we will also understand about characteristics, working of 
different components and its fundamental knowledge. We will discuss about different 
parts of physical components like Processor; Input devices and Output devices along 
with their usage and limitations. In short, students will be familiar with all types of 
primary information about computer at the end of this chapter.   
 

1.2 INTRODUCTION OF COMPUTER 
 
Human being is an amazing animal.  He does fantastic inventions. He always tries to 
make his life easy. This journey of making life easy started from the ancient era and 
has reached to a digital information era. Digital Information is an electronics 
information system which is based on computer processing.  
Each type of work is dependent on gathering of information, usage of information; 
management of information and providing information to others. Computer is capable 
to do proper processing & storage of information. As decades are passing; 
computers are becoming smaller in size with increase in the data storage. 
Embedded computers without keyboard and mouse are also invented which are 
used in our day to day instruments like VCR, Automobiles, Aeroplane, Train, Power 
Plant, Library, Bank, Cinema, Space Centre , toys etc.  These embedded computers 
are very small in sizes which entertain each & every moments of our life. They are 
affecting so much that they are controlling traffic light; metro train; aeroplane and big 
ships.  
 
The human nature of inventing new things lead to the invention of a machine: 
computer, which performs the calculations easily and is easy to handle.  
 
 

1.3 CLASSIFICATION OF COMPUTER‟S GENERATIONS 
 
Computer‘s generations can be classified in two types:-Hardware based generations 
and Program/ Software based generations. 
 
1.3.1 Classification of Computer‘s generations (Hardware Based) 
 
Hardware and Technology based computers can be divided into five categories 
depending on their characteristics.  
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Generati
on 

Time 
Period 

Technolog
y 

Characteristics Example Figure 

First 1945 
AD to 
1955 
AD 

Vacuum 
Tubes 
 

Less speed, Less 
efficient, Less useful 
or not useful, Big in 
size. 

IBM 
UNIVAC– 1, 
ENIAC 
 

 
 

 

Second 1955 
AD to 
1965 
AD 

Transistor Small in size 
compare to previous 
generation, Use of 
coded (Assembly) 
Language, More fast 

IBM 1620 

 

Third 1965 
AD 
to 1980 
AD 

Integrated 
Circuits 
(ICs) 
 

Small in size, Easy to 
use, Useful in 
business, one type of 
small computers  

IBM 360,PDP 8, 
PDP 11 
 

 
 

 
Fourth 1980 

AD to  
1989 
AD 

VLSI (Very 
Large Scale 
Integration) 
 

Useful in personal 
work,Useful for 
Business,fast in 
action & 
reaction,Computer 
which can give very 
fast output 

IBM PC, Apple 
II, Cray Series 
Computers 
 
 
 

 
Fifth 1989  

AD - till 
date 

Latest 
Software 
Technology 
& Artificial 
Intelligence 
(AI) 

Very Modern,Simple 
network connection, 
Portable,Very fast, 
User Friendly 

IBM Notebook, 
Pentium Series, 
PARAM 10000 
etc. 
 
 

 
 

1.3.2 Classification of Computer‘s generations (Programming/ Software Based) 
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Computer‘s generations can be classified based on programming or software 
technologies. 
Generation Characteristics 
First First generation‘s programming language is called a Machine language or Binary 

language. Only 0‘s and 1‘s are used in this type of language. It is very difficult to 
provide data and information using this language. As computer is an electronics device, 
it can understand this type of two (bi) digit languages. 

Second This generation‘s language is called an Assembly Language. This language was written 
using coded symbols. This was very cumbersome.  

Third These programming languages are called Higher languages. It was very cumbersome 
to exchange information in the previous generations. Hence, considering this fact, 
Higher level languages were developed as a part of English language. Translator 
(Compiler or interpreter) was used to convert this English language into machine 
language. Translator‘s main work is to convert instructions written in English language 
into machine language.  

Fourth In this generation‘s programming language; ―What to do‖ method was adopted instead 
of ―How to do‖ to reduce coding or programming work and process was made faster. 
SQL (Structured Query Language) is an example of this generation. 

Fifth ―Artificial Intelligence‖ was used in this generation‘s programming languages. Hence 
programming languages were developed in such a way that computer started to solve 
the given problems without the help of a programmer. As these programming 
languages are useful to find mistakes, to work, to understand and recognize audio or 
video and for complex calculations, Artificial Intelligence was used in this generation of 
computers. Gradually with the use of artificial intelligence; computer is becoming like a 
human. 

 

1.4 TYPES OF COMPUTER 
 
Famous computers using different technologies are as under. 

 
Figure 1.1 Digital Computer 

Digital Computers: Computers, which are using the binary 
method, i.e. two digits: 0 and 1 are called as digital 
computers. They describe information like words and 
symbols in binary form. These types of computers are useful 
in industrial process and to control machinery work. They 
also do management, analysis or copying of huge business 
data. 

  

 
Figure 1.2 Analog Computer 

Analog Computers: These types of computers use linear 
composition of voltage, current and frequency. Hence this 
machine represents continuously changing physical 
properties in terms of numbers.   
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Figure 1.૩Hybrid Computer 

Hybrid Computers: These types of commuters use 0 and 1 
i.e. binary method as well as linear composition of voltage; 
current and frequency method. Hence computer which uses 
both digital and analog technologies is known as Hybrid 
Computer.  

  

 
Figure 1.4 Mainframe Computers 

Mainframe Computers: These types of computers are large 
in size and can store huge information. Multiple users can do 
multiple jobs simultaneously. Generally many terminals are 
connected with Mainframe Computer. They look like small 
computer but they are devices only. They transmit and 
receive information to main computer through cable. Big 
companies, government agencies and universities use such 
type of computers. 

  

 
Figure 1.5 Mini Computer 

Mini Computers: These computers are small in size and 
less expensive compared to mainframe computers. They can 
store huge amount of information. Medium or small scale 
business units use such computers. 

  

 
Figure 1.6 Personal Computer 

Micro Computers/ Personal Computers/ Desktop 
Computers: These types of computers are very famous. 
They are user friendly and affordable. Normally, they are 
used in routine work, personal work and business work. 
These types of computers are also used in doing routine 
transactions. Keyboard, Monitor and Mouse are used in such 
type of computer systems. 

 
Figure 1.7 Laptop 

Laptops: Such types of computers have thin display. They 
are light in weight and portable enough to move easily. 
Laptop computers are personal computers which can be 
used in a mobile manner. As they are small in size; they are 
also known as Notebook computers. Single unit of laptop 
computer consists of Screen, Keyboard, Touchpad, Pointing 
stick and speakers.   
 
Nowadays, a thin version of laptop computer is very famous 
and is known as Ultrabook computer. Ultrabook is small in 
size and light in weight. Battery life is also very long in this 
computer. Very strong and low voltage processor is used in 
such computers. 
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Figure 1.8 Hand held Computer 

Handheld Computer: Such type of computers can be 
accommodated in our palm, are also known as Personal 
Digital Assistants (PDAs). They are smaller in size compared 
to laptops and are easily portable. In this type of computers, 
the commands can be given directly on the screen through 
hand. Touchscreens are used in Such types of computers. 
They are very useful to store personal information like name, 

address, appointments etc. 
 
 

  

 
Figure 1.9 Tablet 

Tablet Computer: Computers which are wireless and 
portable in nature are called Tablet computers.This is a 
mobile computer having touch screen facility. In such 
computers, keyboard is not required. Instead of an actual 
keyboard, an image of the keyboard is kept. It is used with a 
finger or a digital pen. With the help of such kind of 
computers, users can send or receive messages, use 
internet, can upload or download audio and video files, can 
play or see movie, can do photography or listen music.  
 
Like mobile phones, in some tablets making phone calls is 
also possible. Computers which can work like phone as well 
as tablet are known as Tablets.   

  

 
Figure 1.10Wearable Computer 

Wearable Computer: Computer that can be worn by 
humans is known as a Wearable computer. As they are 
wearable on human body, they are small in size and light in 
weight. These computers are available in the form of Belts, 
Spectacles or Rings etc. Using them, it is possible to interact 
being in touch with the calculating system. They are turned 
on and off less frequently. They can do many works 
simultaneously. One programmed chip is installed on one 
part of human body using which wearablecomputer is 
connected. They are useful for the activities in our daily 
chores, for some specific movements, observations and also 
as a complement to the human brain.  

 

 

1.5 CHARACTERISTICS OF COMPUTER 
 

Characteristics Details 
Speed  Computer calculates very fast. E.g. - A Professor or a Mathematician needs 

minimum one minute to multiply some numbers and in comparison to that, 
being an electronic device, it can do the same calculation within fractions of 
seconds. As electronic signal moves very fast, calculations can be done very 
fast. In fact speed of computers can be measured in second or milliseconds, 
rather in Micro, Nano or Pico seconds.  

Accuracy Generally computers never mistake. There is no chance of mistakes, if it has 
been given the correct information. Computers do not only mathematical 
calculations, but also logical calculations very easily. 

Versatility 
 

Computer is capable of doing different types of work. Nowadays, computers 
are used everywhere- in hospitals, schools, factories, shops, banks, weather 
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Characteristics Details 
department, for various reservations and also at home.   

 
Storage Capacity 

Storage capacity is one of the most important characteristics of a computer 
through which we can store and retrieve important information as and when 
required. It is easy to store any information in computer. Large data 
accommodates in a small space of computer. Thousands of pages can be 
stored in a small disc and computer can find a single word or data from a large 
data base within seconds.  

Reliability 
 

Computers are reliable. Each and every component of computers is made in 
such a way that it fails rarely. .  

Repeatability 
(Can do repetitive 
tasks efficiently) 

We feel bored if we have to do one job repeatedly.  Our efficiency will decrease 
and more mistakes will happen. Whereas computers do the same job 
repeatedly with same accuracy, lightness and concentration. As computer is a 
machine, it is never affected by feelings like sadness or boredom.  

Automation 
 

Computer work on its own. Computer implements all instructions one by one 
which are given to it and keep on working until it is instructed to stop the work.   

 

1.6 THEORATICAL UNDERSTANDING OF COMPUTER 
 

We know that computer is a machine.  Now, it is also necessary to know on which 
principle it works.  We know that a mother uses Mixer or food processor in the 
kitchen for preparing food.  Suppose, if we want to prepare a sauce, we put all 
ingredients in a mixer for crushing and the mixer would crush them and prepare the 
sauce. This theory is required to understand how a computer works. Computer can 
be known as an Information processor as it processes data and provides the 
information. Prior to that, we need to understand what the data are and what the 
information is.   
 
DATA: Numbers, figures, alphabets or other facts are called as Data. For example: 
Marks of students, distance between two places, time and name of a place are not 
useful in their original form. But after processing this data, they become useful. If we 
compare these data with other data, they will be useful. Data will become more 
useful if we compare marks of two students. Such as, 

 
 Akshar scored 450 marks out of 500.  

 
Now after comparison, we can understand that Yogi scored more marks compared 
to Akshar. If we have marks of all students then we could have known about Yogi‘s 
rank in the entire class.  
 
Information: The result which we get after processing data is referred as 
Information. Information is useful in its original form itself. Thus, we get information 

from data.                
Common Examples of Information: 
 
 Akshar got more marks than Yogi.  
 Train is late by 40 minutes. 
 Distance between Bhavnagar and Ahmedabad if 180 kms.  
 



9 
 

Processing: Work done on data is Process. Ex: Summation: subtraction or 
comparison.  Data is converted into information by processing. So let us now define 
computer.           
A machine which processes data and provides information is known as a Computer.  

 
Computers provide information as follows: 
 Instruction and data are fed into the computer.  
 Computer processes the data as per the given instructions.  
 Thus gives us the information after processing data. 
 InputProcessingOutput 
 DataProcessingInformation 
The difference between data and information can be represented in a tabular form as 
follows: 
DATA INFORMATION 

A set of statistics and facts Organized Data 

Less Useful More Useful 

Can be converted into information Can be used to take decisions 

 
Considering all the above factors, computer is a simple model which functions with 
its basic components input, memory, processor and output.   
 
Input Unit: To perform any kind of task, computer has to be given commands. 
Arrangement has been made such that computer can accept commands and 
instructions given by the user for processing, and is known as the input or import 
unit. For example: Mouse, Key-board, Scanner etc.  
 
Memory: Information entered through input devices is stored in computer memory.  
 
Processor: Processing unit or Processor does various types of processing on 
information stored in computer memory.  
 
Output Unit: Results generated by the processing unit is presented to the users by 
the Output unit. Examples of Output Devices: Monitor, Printer, Plotter etc.  
 
After looking at four main components, let us concentrate on where these 
components are connected in computer.  
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Figure 1.11 Different parts of Computer 

 
Figure 1.11 shows different parts of a computer. Thus computer is a collection of 
different parts. 
Let‘s study them in detail. 
 
System Unit: System unit is an internal part of a computer system. Normally, you 
will find one rectangle box below your desk is the CPU, with many useful electronic 
sections. They are useful in data processing. CPU is the main component among all 
components which works as the brain of a computer.  There is a second component 
which is the memory unit, which stores the information for short time until the CPU is 
ON. When the computer is turned off; all the stored information will be erased. 
Besides this, there are some disc devices which store the data permanently, retain it 
even when the computer is turned off. 
 
Now let us see the functioning of computer‘s brain which is the Central Processing 
unit.  
 
Function of CPU: CPU is the main part of a computer system, is divided into three 
parts.  
 
Control Unit: Control unit is a part of CPU. Function of CU is to bring out the 
information stored in memory and to monitor the execution of commands after 
decoding. It also takes the help of ALU (Arithmetic and Logical Unit) for doing 
calculations. 
 
Functions of Control Unit: Control unit controls and does proper management of 
data flow sent by the processor through electrical paths. It manages different 
activities done by the unit: 

 To get the command from memory, to decide the type of it, to implement it 
and to store the result in memory at the end. 

 Directs the information flow of different parts.  
 Interprets the commands.  
 Controls the processor time.   
 To transmit control signals to variety of devices and to receive the same.  
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1. Arithmetic Logic Unit (ALU): ALU is a part of computer which does different 
logical works and mathematical calculations like addition, subtraction, 
multiplication and division. It is a high speed digital circuit which solves puzzles 
and does comparison too.  

 
Functions of Arithmetic Logical Unit: It executes almost all mathematical and 
logical functions done by the computer. For this, it takes required information 
from a fixed computer memory which is known as the Processor Register. After 
getting the information; the ALU processes it and the result is stored in the ALU 
Output register. It does addition and subtraction kinds of activities too. Complex 
calculations are also carried out in this unit only.  

 
2. Register: These are high speed storage components. Each datum is recorded in 

registers before it is processed. For Example: While multiplying two numbers, 
both the numbers will be recorded in register as well as their results will also be 
recorded in register. (Apart from actual information, information about the location 
where information is stored is also recorded in the register) 
 

1.7 STORAGE DEVICES 
 
Human beings are capable of storing data in brain and can recollect it when 
required. Likewise computer can store both data and information in the storage 
devices.   
 

There are two types of computer memory: Primary Memory and Secondary Memory. 
Let us see both these memories in detail. 

1.7.1 Primary Storage 

Primary storage is also called as the Main storage or Memory.  
Primary memory is a memory that remains in touch with CPU constantly. It stores 
information, gives proper commands and takes care of them as per requirement. All 
types of information, data and applications are stored here systematically. Primary 
storage is of three types as shown below.  
 
 
Primary Storage 
 
 
 
RAM      ROM    Cache Memory 
(Random Access Memory)                       (Read-Only Memory) 
 
RAM (Random Access Memory) 
 
RAM is a storage place where information is stored and can be accessed fast. RAM 
is one kind of volatile memory. Volatile memory is a memory in which electricity 
power is required to access a memory. If electricity is not available during that time, 
then stored data cannot be retrieved.  
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There are two main types of RAM:  
1. Dynamic RAM: Dynamic RAM  stores information for  fraction of a second. It has 

to be refreshed thousands of time per second. It is slower and cheaper than static 
RAM. 
 

2. Static RAM:Static RAM uses a completely different technology. Static RAM 
stores information till the power is on. It is expensive and consumes more power 
and is faster than Dynamic RAM.  

 
1.7.1.2 ROM (Read Only Memory) 
 
It gives a facility to read only from a computer. Data and commands are stored in it 
when it is being manufactured. It is a kind of static memory. Data can be stored here 
permanently. The information is retained in it even if the computer is turned off.  Data 
in ROM is not modifiable. ROM is suitable to store the data which are not required to 
be modified. Even during power cut, it is capable to store them, thus it is permanent 
and Non-volatile in nature.   
 
Non-Volatile Memory: There are various types of ROM available as: 
 

 Programmable Read Only Memory (PROM) 
 Erasable Programmable Read Only Memory (EPROM) 
 Electrically Erasable Programmable Read Only Memory (EEPROM or Flash 

ROM) 
 Electric Alterable Read Only Memory (EAROM) 

 
Some ROM are Non-Volatile but can be reprogrammed.  
 

 Programmable Read Only Memory (PROM): In this ROM, data program is 
written on empty chip using a special unit named PROM writer. 

 
 Erasable Programmable Read Only Memory (EPROM): It is the kind of 

ROM, where data written on it can be erased by exposing it to Ultraviolet light.  
 Electrically Erasable Programmable Read Only Memory (EEPROM): In 

this PROM, electrical signals are used to erase information instead of 
ultraviolet light.  

 Ultraviolet Erasable Programmable Read Only Memory (UVEPROM): This 
memory can be erased and reprogrammed using ultraviolet light.   

 
1.7.1.3 Cache Memory 
 
Cache: Cache is a high speed memory which is between the CPU and the Main 
memory. In this, data which are in use at present and data which have been used 
recently used can be stored. It is effective because it is faster than the main memory 
but its storage capacity is less as it is more expensive than the main memory.  
 
1.7.2 Secondary Storage 
 
Secondary storage technology is related to storage devices and storage media that 
are not directly accessible through computer. Hard disk, CD, DVD is examples of 
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secondary storage media. It is generally used for storage and backup purposes. 
When computer stops working, secondary storage devices are used to restore the 
backup in the new system. Hard disk and magnetic tape works on magnet principle 
whereas CD, DVD and Blue Ray Disk work on the principle of light. Let us see some 
of the examples of secondary storage of computer.  
 

1) Secondary Storage 2) Description 

 
Figure1.12Magnetic 
Tape 

3) Magnetic Tape: Magnetic tape is a very thin plastic strip on which Iron 
Oxide has been coated. In this storage, information can be written and 
read sequentially. Storage capacity of tape is from Kilobytes to 
Megabytes.  

4)  
5) Figure 1.13 Floppy Disk 

Floppy Disk: Floppy disk is also used to store information permanently. 
Floppy disks are available in various sizes such as in 2‖, 5.25‖ and 3.5‖. 
Storage capacity of floppy disk is 1.44 MB.  

6)  
Figure 1.14 Compact 
Disk 

Compact Disc: Compact discs (CD) are used to store Audio, Video, text 
or any other information in digital format. 120mm CD has a storage 
capacity of 700 MB.   

 

Types of Compact Disks: 

Disk Type Description 
CD-ROM CD-ROM data can only be read. Data is recorded on this disk from the 

beginning and stored information cannot be changed. It is mostly used for audio 
CD recording.  
 

WORM/CD-R WORM (Write Once Read Many) is meant to be written once and read many 
times. Using CD-R drive connected to computer, computer gives permission to 
make their own CD-ROM disk to WORM users.  
 

CD-RW CD-RW Compact disk is used to re-write the data in the CD. Here the data can 
be written on a CD through a CD Burner. Unlike CD-R (CD-Record), data on the 
CD-RW can be re-written.  

 
Figure 1.15DVD 

DVD is called as Digital Versatile Disk or Digital Video Disk. It is useful for 
storing information permanently. DVD has minimum storage capacity of 4.7 GB. 
DVDs are one sided or two sided and every side can have two layers. Two layer 
DVDs are capable to accommodate video, audio and other information up to 17 
Gigabytes.  
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Let‘s give a look on different types of DVDs. 

DVD Type Description 

DVD-R Information‘s can be recorded for one time only on DVD-R and data is retained 
permanently on the disk. This disk cannot be recorded for second time. DVD-R 
has a storage capacity of 4.71 GB generally.  
 

DVD-RW DVD-RW is suitable to re-write the data. Information‘s written on DVD-RWcan be 
removed without any problem and can be recorded for number of times.  
 

DVD-ROM DVD-ROM Digital disk is useful mainly for storing huge software programs only. It 
is just like a compact disc (CD-ROM) but has more capacity. Storage capacity of 
DVD- ROM is approximately 4.38 GB.  
 

Blu-Ray Disk:  
 

Blu-Ray disk is known as BD. It is a new Optical disk format, jointly created by Blu-
Ray Disk Association and world leader consumer electronics group. Blu-Ray disk 
has been developed for mass storage of high quality videos (HD video playback) 
and recording. Its storage capacity is five times more than a DVD.  Storage 
capacity of one BD is 25 to 50 GB. Blu-Ray disk having storage capacity of 500 
GB is under development.  
 

 
Figure 1.16 
Hard Drive 

1) Hard Drive: Hard Disk is a magnetic disk, is set in a sturdy box which is known as 
a Hard Drive. The hard drive is configured in CPU box. According to the 
instructions, computer can read and write the content from the Hard Disk. Hard 
disk stores all the information in its magnetic area. So even if there is power failure 
or computer is turned off by mistake, stored information will not be erased. Hence 
it is known as Local Storage device.Hard disks are faster than the floppy disks. To 
transfer large amount of data, external hard drives are available in the market 
which can be connected externally to the CPU through USB port. 

 
Figure 1.17 Pen 
Drive 

2)  

 
Pen Drive:Pen drvie is able to store the data for long time. It is solid and is a highly 
durable storage device. It does not need any extra software and is compatible to 
connect with most computers..  
 
A pen drive can be used easily by  students, professionals and academicians 
being small and handy device.Currenlty it is available with storage capacities of 
8GB, 32GB  and even more. Graphics, heavy documents, photographs, music, 
videos and movies can be stored in a pen drive. A pen drive is plugged into 
computer‘s USB port and is a plug-and-play device. It comes with a USB port. 
Using pen drive data can be transferred easily from one machine to another 
machine. Moreover being small in size, it can be handled easily, and can be kept 
in pockets or purse. 
 

 

1.8 INPUT DEVICES 
 
The unit that puts or feeds data into the computer is known as the input device, 
through which the data or informations are  entered into the computer. Computer 
input devices are used to provide data as well as control signals. Here we will get 
information about some importanct input devices of computer. 
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Figure 1.18  keyboard  

Keyboard: The most common and 
popular inpur device is the keyboard. 
The keyboard is used  the input of 
data into the computer. keyboard has 
82 or 102 keys. Keyboard with 104 
keys are available for internet and 
windows. 

 
The utilities of various keys on the keyboard is shown in the following table: 
 

Key Description 
Alphanumeric 
Key 

These keys include characters (A-Z,a-z) and numbers(0-9) 

Numeric 
Keypad 

It is used for inputting the statistical data or for cursor movement. In general, it 
has a 17 key set 

Function Key These keys are used to control cursor and screen. Keys F1 to F12 are the 
function keys.  

Special Key These include ―Enter, Shift, Caps Lock, Num Lock, Space bar, Tab, and Print 
Screen" keys. Each key is used for a particular purpose. 
It also includes Home, End, Insert, Delete, Page Up, Page Down, Control(Ctrl), 
Alternate(Alt), Escape(Esc) and four directional arrow key.  

 

Mouse: The mouse is the most popular pointing device. It is very 
famous cursor control device. In general, a mouse contains two 
buttons – left button and a right button and a scroll bar in the 
center. Mouse can be used to control the position of the cursor on 
the screen. 

 
Figure 1.19 Mouse 

  
Joystick: Joystick is used to move the cursor on the screen of the 
monitor. It is a directive device. Joystick can be moved in all the 
four directions. The function of the joystick is similar to the mouse. 
It is primarily used for Computer Aided Design (CAD) and playing 
computer games. 

 
Figure 1.20 Joysick 

  
Light Pen: Light pen is a pen like pointing device.It is useful to 
display the selected menu item. It is an optical system that is 
placed in a small tube, which sends corresponding signals to the 
CPU.  
  

Figure 1.21 Light Pen 
  
Track Ball: Track ball is mostly used in  laptops or notebooks. It is 
a semi-rounded ball where in the indications are given by the 
movement of the fingers on the ball. The track ball takes up less 
space than the mouse. The track ball is available in different 
shapes like  ball, button or square. 

 
  Figure 1.22 Track Ball 
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Scanner : Scanner is a device which is used to copy the 
information from paper to hard disk. The copied data can be edited 
using the softwares. 

 
Figue 1.2૩ Scanner 

Digitalizer:The Digitalizer converts the analog data into  digital 
form.It can be used by computers to create pictures. It converts the 
graphical and pictorial informations into binary form. It is also 
known as digital tablet or a graphics tablet. 
  

           Figure 1.24 Digitalizer 
  
Touch Screen: The users of the touch screen interact with the 
computer by touching the pictures or words on the screen. The 
Touch screen is sensitive to human touch. Touch screen kit 
includes a touch screen panel, controller and hardware driver. 
Touch screen can be used by moving the hand or fingers on the 
screen. Touch screens are  the most popular device for tablets and 
smart phones.  

Figure 1.25: Touch Screen 
  
Microphone: The use of microphone is to store the input voice 
into digital format. Microphone is used to add sound and mix music 
for  multimedia presentations. 

 
Figure 1.26: Microphone 

  
Magnetic Ink Character Reader (MICR) :MICR is useful in a 
large number of banks to process check. Bank code numbers and 
cheque numbers can be read into this machine. This process of 
reading is referred as Magnetic Ink Character Recognition (MICR). 
The main advantage of MICR is that it is fast. 
 

 
Figure 1.27 MICR 

Optical Character Reader (OCR): OCR is useful for reading 
printed text. OCR optically scans the characters and stores the text 
in memory. 
 

 

Bar code Reader: Bar code reader is a useful tool for reading bar-
coded information (the information in the form of light and dark 
lines). Bar-coded data usually found on books and some other 
products also, is being scanned by the Bar code reader and is 
converted into alphanumeric value. 

 
Figure 1.29Bar code reader 

Optical Mark Reader (OMR): OMR pen or pencil is useful to 
identify the type of account. OMR is used to check marked 
answers of MCQ exams by verifying against the correct options for 
answers.  

 
Figure 1.30  OMR 
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1.9 OUTPUT DEVICES 
 
Output devices are those parts of the computer, that provide information processed 
by the compouter as output. Lets take a look on some of the output devices listed 
below. 
 
1. Monitor 2. Printer 3. Plotter 4. Projector 5. Speakers  
Monitor: Monitor is the most popular and commonly used output device. 
The output by Monitors is similar to telvesion screnes and is intanigable in 
nature. However the output can be printed on paper. Various types of 
monitors like Cathod Ray Tube (CRT), Light Emiting Diode (LED)/ Liquid 
Crystal Display (LCD) are available. These types of monitors are thin in 
size, light-weighted and occupy less space. 

 
 

Figure 1.31 Monitor 
 

 
Printer: Printer is a very useful output device. Prinnter is used to print the 
infomration on a paper.Printers are of various types.  Followng is the classification of 
printers:  
 
Types of Printers: 
 
1. Impact Printer  

a. Character printer  
 Dot Matrix printer  
 Daisy Wheel printer  

b. Line printer 
 Drum printer  
 Chain printer 

2. Non-Impact Printer 
 Laser printer 
 Inkjet printer  

 
1. Impact Printer: In this type of printer, ribbon is used to print the characters. The 

characters hammered on the ribbons are printed on the paper.The paper and the 
head (head like part of hammer) containing the characters are in physical contact 
with each other.     
 
 

Characteristics: 
 Very low consumption cost 
 Produces too much noise 
 Useful for low cost bulk printing 
 To print, it gets in physical contact with the paper 

 
1.1 Character Printer: This printer prints one character at a time. 
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1.1.1 Dot-matrix Printer: In dot-matrix printer, for character 
formation, a specific pattern of matrix of pins is used where-in the 
size is pre-decided (5*7, 7*9, 9*7 or 9*9). 
 
Advantages:  

 Reasonable in price 
 Used very widely 
 Characters of other languages can also be printed. 

 
Disadvantages:  

 Only  text can be printed. 
 Speed is slow. 
 Poor printing quality 

 
Figure 1.32Dot Matrix 

Printer 

 
2. Non-Impact Printer: This printer prints one line at a time. In this type of printer, 

there is no physical contact between the printer and the paper. 
Characteristics: 
 Faster than other printers. 
 Does not produce noise. 
 High quality printing 
 Printing facility with various sizes and font. 

2.1 Laser Printer: In this printer, printing is done by the laser beam.   

 
Figure 1.33 Laser Printer 

Advantages:  
 Faster. 
 Text and graphics output with excellent quality. 
 Characters with different size and font.   

 
Disadvantages:  
 Expensive. 
 Cannot be used to produce multiple copies of a single page. 

 
2.2 Inkjet Printer                   : 
 

 
Figure 1.34 Inkjet Printer 

Inkjet printer is a non impact printer based on relatively new 
technology. This printer prints the characters by spraying tiny 
drops of ink on the paper. Inkjet printer offers high quality output 
with better facilities. 
Advantages:  

 High quality printing. 
Disadvantages :  

 Costlier. 
 Slow in compared to laser printing. 

 
3. 3. Plotter 

 
Figure 1.35 Plotter 

 

4. Is a graphics printer, that makes the graphs, diagrams, line 

drawings and images with one or more automated pen. Plotters 

are used to print very high resolution point-to-point lines. 
 
Engineers use plotters because they are larger in size and are 
very precise. It is mainly used to print maps. 
 
 
 

5. 4. Projector 
6.  

Projector is an output device that can display the computer 
screen and can project the bigger version of the same on a flat 
surface. Projectors are used in meetings so that the presentations 
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Figure 1.36 Projector  

could be seen by all, present in the room. 
 
Types of Projector: 
 

 Cathod Ray Tube (CRT)   
 Liquid Crystal Display (LCD)   
 Digital Light Processing (DLP)  

7.   
5. Speakers 

 
Figure: 1.37 Speaker 

 
The speaker is used to listen the audio file and the files recorded 
in a computer. It is convenient to reduce and increase the volume 
of sound. It produces the sound by converting the digital data of 
the computer into  analog data. 
 

 

1.10 TYPES OF SOFTWARE 
 
Software means set of instructions. Physical devices which can be seen and 
touched, e.g. Keyboard, monitor, CPU, etc. are known as hardware whereas that 
part which can only be seen but can‘t be touched, is known as the software, for e.g. 
Operating system. Software can be divided as: 

Computer Software 
 

 
  
System Software                      Application Software
  
System Software: 
 System software is a collection of one or more programs. 

It controls the computer hardware and provides a platform to run the application 
software. 

 The programs that are the part of System software are assembler, compiler, file 
management programs, system utility and debugger etc.. 

 When you install the operating system on your computer, the system software 
gets installed 

 Examples of system software are Operating systems like windows, Macintosh, 
Linux, Compiler, Scan disk, backup utility. 

 
Application Software: 
 It is a collection of one or more programs. 
 It helps the user to solve real problems and to perform specific functions. 
 The programs containing the actual work of the user are the application software 
 Examples of application software:  word processor, spreadsheet, database, 

entertainment softwares. 
Relationship between system software and application software: (Figure 1.38) 
 System software provides an interface by which application software can run. 
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 System software provides an interface between the hardware and application 
programs. 

 Application software can be executed only if the system software is present. 
 

USER

APPLICATION SOFTWARE
(Computer Games, Spreadsheet, Word Processor, 

Database,Internet Browsers)

SYSTEM SOFTWARE
(Operating System, Utility)

HARDWARE
(CPU, Disks, 

Mouse,Printer, etc.)

 
Figure 1.38 The relation between application software and system software 

Open Source Software: 
 The software whose source code (Basic program code) is available,is an Open 

source software 
 The source code could be modified by the user. 
 With the open source software, the source code is readily available to the user. 
 Open source software, provides all the controls to the user. 
 Example of Open source: MySQL, LAMP, VLC Media Player, PostgreSQL  
 Open source software could be shared and integerated. 
 

1.11 USES OF COMPUTER IN VARIOUS DOMAIN 
 
Because of the human‘s quatlity of inventing new things, he invented computer, a 
device which can perform calculationsfast and easily and is ease to use.  List of 
some of the domains or areas where it is playing its major role are : 
Areas where computer have stepped in :  
 Monthly light bill and telephone bill that we receive are prepared by computer. 
 Reservations of airways or railway tickets to travel to different places can be done 

from any place through computer.  
 Payment of various bills also could be done through computer. 
 Complaints regarding any part of the computer are also fed in computers only. 

This will help to have a better control on the  complaint. The status of the 
complaint like whether the complaint is resolved or not can also be tracked easily. 

 The markseheet of the university that we obtain, is also prepared by computers. 
 Computer is also widely used to exchange and share the information. 
 Accounts, large bills and ledgers are  maintained through computer.  

http://www.mysql.org/
http://www.postgresql.org/
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 The information about the products that are available and sold by the large 
departmental stores is  stored in computers.  

 News readers keep terminals on their desk. This helps them to deliver the news 
quickly and  with diversity. 

 Computer are used for providing security in shopping malls, banks, schools, 
colleges, public or private hospitals, railway stations, airports etc. These days 
computers are also used for reservations on the roads with heavy traffic. 

 Now a days computers are also required for gaming, applications and using 
softwares. 

 Commercial organizations, public agencies etc use computers to enhance their 
business. 

 

1.12 LIMITATIONS OF COMPUTER  
 

 Lack of thinking ability: Computer is not capable to think on its own. It only 
follows the instructions being given to it irrespective of whether the information is 
right or wrong. 

 Inability to learns from the mistakes: Human mind learns from his past 
mistakes, but computer repeats the same mistake again and again due to lack of 
thinking ability. 

 Dependent on electricity: Computer is an electronic machine. So it is not able 
to work without the source of electricity. On the other hand it is possible that file 
may get corrupted or damaged due to sudden power cut while working. However 
the work can be saved by using Uninterrupted Power Supply (UPS). 
 

1.13 CHECK YOUR PROGRESS – POSSIBLE ANSWERS 
 
Q1. Choose the correct option .  
 
1 Which of the following is an example of input device? 
 A) Keyboard, mouse B) Scanner, joystick C) Electronic card reader, MICR D) All 

of the above 
2 Which type of data could be fed by a keyboard? 
 A) Alphabets         B) Numbers          C) Special characters            D) All of the 

above 
3 When was ENIAC invented? 
 A) 1945  B) 1946      C) 1947              D) 1948 
4 What is the full form of AI? 
 A) Arithmetic Intelligence  B) American Intelligence  C) Artificial Intelligence  D) 

None of these 
5 Computer  memory which can only be read is called what? 
 A)  RAM           B) ROM               C) Static memory                 D) Dynamic 

memory 
 A.  
 
Q2. Fill in the blanks with appropriate words. 
 
1. The computer that uses the binary methods i.e  0 and 1is  known as 
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___________. (Digital Computer, Analog Computer, Mobile phone) 

2. Numbers, group of digits, alphabets or other facts are  known as ________. 
(Information, Data, Facts) 

૩. The machine that process the data and converts into information is called 
________. (Calculator, Computer, Mobile) 

4. __________, works as the brain of the computer. (Monitor, keyboard, CPU) 
5. _______ is a storage that stores the information and can be accessed fast. 

(Control unit, RAM,Monitor)    
 
Q3. State whether the following statements are true or false. 
 
1. A special software is required to use a pen drive. 
2. In a keyboard the keys from F1 to F12 are called the function keys.  

૩. Joystick is mostly used for Computer Aided Designs (CAD) and playing 
computer games.  

4.  The users of the touch screen communicates to the computer by touching the 
pictures and words on the screen. 

5. Mike converts the waves of sound into electromagnetic waves.  
 
Q4. Match the following : 
 

 
 
Answer: 
 
Q1. 1. D        
2. D        3.A       
4.C       5. B  
Q2. 1. Digital 
Computer   2. 
Data   3. 

Computer 4. CPU5.RAM 
Q3. 1. False 2. True   3. True   4.True  5. False 
Q4.  
      First Generation   -  vaccum tube 

 Second Generation  -  Transistor  
 Third Generation  - Integrated circuit 
 Forth Generation  -  Very Large Scale Integration 
 Fifth Generation  -  Artificial Intelligence  

  

       Column A    Column B 

1. First Generation a.  Transistor 

2. Second Generation b. Vacuum tube 

3. Third Generation c. Artificial Intelligence  

4. Fourth Generation d. Very Large Scale Integration  

5. Fifth Generation e. Integrated Circuit  
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Unit 2:  Introduction to Windows 
Operating System  

  
 
Unit Structure 
 
2.1. Learning Objectives 
2.2. Introduction to Windows 7 operating system 
2.3. History of Windows 
2.4. Windows 7 Desktop 
2.5. Gadgets 
2.6. Taskbar 
2.7. Aero pick 
2.8. Start menu 
2.9. Toolbar 
2.10. Pinning an application in taskbar 
2.11. Notification area 
2.12. Dialog Box 
2.13. Windows Accessories 
2.14. Security settings 
2.15. Check your Progress: Possible Answers 

 
  

2 
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2.1 LEARNING OBJECTIVE 
 
After studying this unit, the following topics will be familiar.  
 

 Basic understanding of how Windows came into existence and how many 
versions it has. 

 Various components of Windows operating system like: Taskbar, Start menu, 
Toolbar, Notification area, dialog box etc. 

 Changing background of Windows 7 Desktop, creating shortcut, how to 
display toolbar. 

 New features like aero pick and gadgets in Windows 7. 
 Utility programs like paint and WordPad available in Windows 7. 
 Security system. 

 

2.2 INTRODUCTION TO WINDOWS 7 OPERATING SYSTEM 
 
Windows 7 is developed by Microsoft for personal computers and it is in use since 
2009. It provides many new facilities as compared to previous versions of Windows. 
There are mainly three editions of Windows 7. 
 

i. Ultimate 
ii. Professional 
iii. Home 

 
Windows 7 does not have some features like data security, management and 
networking. These features are available in Windows Professional and Ultimate 
editions. Home edition contains games like chess, which is not available in 
Professional edition. Ultimate edition have all features. 
 
To install Windows 7, it is necessary to have the following hardware‘s. 
 

 32-bit or 64-bit processor with 1 GHz or more speed. 
 Minimum 1 GB RAM for 32-bit and 2 GB RAM for 64-bit processor. 
 Minimum 16 GB hard disk for 32-bit and 20 GB hard disk for 64-bit processor. 
 DirectX 9 graphics device and WDDM 1.0 or later. 

 

2.3 HISTORY OF WINDOWS 
 
Bill Gates and Paul Allen jointly started Microsoft Company in 1975. Thereafter 
following versions of Windows 7 were released in different years. 
 

Logo Year Version Main Features 
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Logo Year Version Main Features 

 

1985 1.0 To do any work in MS-DOS, it require to type the command. 
Whereas Microsoft WIndows 1.0 has the facility to do tasks 
easily by just cliking icons or options and moving the mouse 
on the screen  . Additionaly, it was simpler to learn and use 
Windows through drop-down menus, scroll bars and dialog 
boxes.  It was easier to switch between two windows. 
Moreover, It included facilities like file management, paint, 
window writer, notepad, calculator, calander, clock and games.    

 

1992 3.1 This version was significantly better than the previous version. 
It contains advanced graphics with 16-bit colour and improved 
icons. It included programs like program manager, file 
manager, print manager and was having more games. It also 
provided network support.  

 

1995 95 WIndows-95 was a 32-bit operating system with facilities like 
internet, dial-up networking, plug-and-play fetaure to install 
hardware and software, multimedia, mobile computing and 
networking. Fot the first time, facility was provided for menu, 
taskbar, start button and minimize-maximize-close buttons for 
windows. 

 

1998 98 Using Windows-98, it was easier to get information using 
computer and internet. It facilitates the use of DVD disk and 
Universal Serail Bus (USB). It included quick launch bar to 
open the programs quickly. 

 

2001 XP Windows 2001-XP was a speedy and better operating system 
having simple visual design containing start menu, taskbar, 
control panel, network wizard, media player, movie maker and 
digital photo, remote desktop, file encryption system, 
advanced and wireless network, windows messanger, remote 
assistance facilities.    

 

2006 Vista Windows-Vista provided powerful security, user account 
control, bit locker drive encryption, new start botton. Moreover, 
it sopported 35 languages.    

 

2009 7 Windows-7 includes more themes, desktop slide show, 
gadgets and slide bar, federated serach, jump list, touch 
screen, shake and snap features. One can pin the application 
in taskbar, have better thumbnail view of open application. It 
provides notification area and aero pick button.  

 

2012 8 Windows-8 is totally in a new look. One can work using mouse 
and touch-screen. It includes window store, cloud storage, 
new task manager, anti-virus defender etc..   

 
 

2.4 WINDOWS 7 DESKTOP 
 
After Windows 7 start up, the first screen seen is called the Desktop. It is shown in 
figure 2.1. It contains taskbar, background image or colour, icons or shortcuts, 
various gadgets selected by the user etc. Now let us understand these various 
components.  
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Figure  2.1 Desktop 

2.4.1 Icon 

When right button of mouse is clicked anywhere on the desktop, short cut menu is 
opened as shown in the figure 2.2. On selection of the ―Personalize‖ option, a 
window is opened as seen in figure 2.3. When ―Change Desktop Icons‖ is selected 
from this window, a dialog box is opened as seen in figure 2.4. Required icons can 
be selected by checking the boxes and unwanted icons can be removed by non-
selection of check boxes. On pressing OK button, icons are added or removed as 
per user‘s choice. 
 

 
Figure  2.૩ Change Desktop icons 
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                       Figure  2.4 Setting desktop icon  

 
To create other icons, the following method can be used. For example, if you want to 
create a shortcut for Microsoft Excel, then select Microsoft Excel 2010 program form 
start menu, right click the mouse and select ―Send To‖―Desktop (create shortcut)‖. 
Shortcut icon of Microsoft Excel 2010 program will be created on the desktop. In this 
way, shortcut can be created for other programs. 

 

 
                                                Figure  2.5 Create a shortcut 

2.4.2 Background Image 

To change the background image on the desktop, right click anywhere on the 
desktop to get shortcut menu as seen in figure 2.2. Select ―Personalize‖ option to get 
the screen as shown in the figure 2.3. On the selection of ―Desktop Background‖, a 
window is opened as shown in the figure 2.6. It has the following options. 
Picture Location :When ―Browse‖ button is pressed, it opens folders. You can 
select the folder where pictures are stored and see the list of pictures in this folder. 
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Select All :To select all pictures in the folder. 
Clear All :To unselect all pictures in the folder. 
Picture Position : To select the view of the picture. 
Change Picture Every : To select the time (seconds, minutes or hours) for changing 
a picture in case of multiple picture selection. 
Shuffle:To specify repeated display of multiple selected pictures 
 
After selecting above options, press ―Save‖ button. It will change the background and 
images as per the selected options. 

 

 
    Figure  2.6 Change Desktop background  

 

2.5  GADGET 
 
In Windows 7, gadget is a small application which provides the facility to know 
frequently changing information like time, usage of computer, news, whether etc. 
Manytimes, it is also called the Applet. Figure 2.7 shows ―Clock‖ gadget. 
 

 
Figure  2.7  Clock gadget 
 

To move gadget 

To close gadget 

For gadget settings 
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Figure  2.8 Gadgets  

 
To have gadget on the desktop, right click anywhere on it and select ―Gadgets‖ to 
get the dialog box as shown in figure 2.8. Double click the required gadget and it will 
be added on the desktop.  
 

2.6  TASKBAR 
 
Usually taskbar is located at the bottom (Refer Figure 2.1). Taskbar always remains 
present on the screen. Taskbar is divided as follows:  
 
(1) Start button: On clicking the start button, we can choose the application from 

menu as per our choice and can execute it. 
(2) Quick Launch or Middle Toolbar: Here it shows small icons for all open 

applications. Applications can be quickly closed from here. Usually, when 
WIndows is installed, applications like browser and media player are launched in 
the taskbar. 

(3) At the right end, it shows system time and date. Nearer to this, it shows various 
tools for computer settings which enables to perform certain tasks very easily. 
For example, increase or decrease the volume. 

(4) Minimize or maximize applications using taskbar:The icon of the application 
which we are using currently is seen on the taskbar. On single clicking of the 
icon, the application can be minimized.. clicking it  again will maximize the 
application. 

Gadget Description 

To hide gadget details 

To see more gadgets 

Type gadget to 

besearched 
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There is another way to minimize or maximize an application. In the title bar of the 
application, three buttons are available on the right side at the top. On clicking 
minimize or maximize button, application will get minimized or maximized. 
 

2.7 AERO PEEK 
 
With the help of Aero Peek feature, you can see the desktop whenever you want. To 
do so, press ―Show Desktop‖ button (refer figure 2.9) available at the rightmost end 
of the taskbar. It will minimize all the application windows and will show the desktop. 
When pressed ―Show Desktop‖ button again, all application windows will be seen as 
before.  
 

 
Figure  2.9 “Show Desktop” button 

 
Preview open window: when more than one windows are open, you can see the 
thumbnail (refer figure 2.10) of the window by clicking the application window icon in 
taskbar. Thumbnail view will help to know what is going on in an application window 
and can select it by clicking. 
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Figure  2.10 Thumbnail preview of an Application  
 

For example, as per figure 2.10, task bar contains icons of many open applications 
like word, excel, PowerPoint. We are working in word. Now it will preview excel when 
a mouse is moved on excel application icon and it will open when clicked.  
 
Check your progress 
 

1. Add icon of Control Panel on desktop. 
2. Set the background picture using any picture from your folder such that it is 

changed after 1 minute. 
3. Add CPU Meter gadget on desktop and then remove it. 
4. Add shortcut of Microsoft Word application on desktop. 
5. Change system date and time. 
6. Set volume to 80%. 

2.8 START MENU 
 
With the use of start button, one canopen computer programs, files, directories 
(folders), settings, installation etc. Using start menu, we can easily open the 
application of our choice, shut down the computer, search any file or directory, install 
new fonts etc. Start menu can be activated or opened in three ways. 

1. By clicking the start button available on the desktop. 
2. By pressing the start key from the keyboard. 
3. By pressing ESC key (on the left-top of the keyboard) and CTRL key together. 
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Figure  2.11 Start menu 

 
As soon as the start menu is activated, we can see various components as shown in 
the figure 2.11. 
 

1. ―Search Programs and Files‖ option is seen just above the start button. 
Whatever files or directories are to be searched, we can enter here and 
system will display the corresponding list of files or directories. 

2. When ―All Programs‖ option in start menu is clicked, it will show the list of all 
applications being installed. To open the application, we should either move 
the mouse on it and click or select the application using arrow key and then 
press ENTER key. Thus we can open required application from ―All 
Programs‖ and start working. 

3. In the start menu, various utilities are shown on the right side in blue colored 
portion. It includes options like Documents, Pictures, Music, Games, 
Computer, Control Panel, Devices and Printing, Default Programs, Help and 
Support, Shut down etc. These options are explained below. 

 
Documents: By default, the saved files are stored in the folder named ―Documents‖. 
If we have specified a fixed path, then only it is stored at different place. Required file 
can be directly opened from the list of files shown in the Documents folder. 
 
Music: By default, downloaded audio files are stored in a folder named ―Music‖. 
 
Games: When we install Windows 7 operating system, specific games are stored in 
the folder named ―Games‖ by default. 
 
Computer: “Computer‖ is very important utility. In previous versions of Windows, 
this utility was known as ―My Computer‖. On clicking ―Computer‖ from start menu, a 
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window is opened as shown in figure 2.12. ―Computer‖ icon is available on the 
desktop also. 
 

 
Figure 2.12 Computer 

 
 ―Computer‖ is used to quickly see what is available in the computer. 
 On double-clicking it, will open window showing files and folders. 
 In status bar, it shows number of objects (files and folders) and the amount of 

consumed memory space. 
 By double-clicking the folder, its content is shown. 
 When file is double-clicked, it will open the file and will show its contents. 
 One can see the number of divisions made in the hard disk. 
 One can see total number of files and folders on each disk. 
 One can see free space and used space on each disk. 
 File or directory from one disk can be easily copied to another disk or folder. 
 One can change the name of file or folder. 
 One can easily delete file or folder.  

Control Panel: As seen in figure 2.13, changes can be made in computer system 
using ―Control Panel‖ utility. We can install new fonts, install printer, install or 
uninstall programs, change the background of desktop etc. To get the window given 
in figure 2.13, press right arrow in ―Control Panel‖ window and then select ―All 
Control Panel Items‖. 
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Figure  2.13 Control Panel 

 
(a) Fonts: ―Fonts‖ icon is available in control panel. Select ―Fonts‖ to install new 

fonts. Some fonts automatically get installed at the time of installing the operating 
system. When we click on ―Fonts‖, it asks for the path from where new fonts are 
to be installed. When the path is entered, new fonts get installed. 

(b) Display: We can change the background of the desktop very easily with this 
utility. Moreover, we can also set some message or picture to appear on the 
desktop screen when the computer is on and it is idle for some time. 

(c) Backup and Restore: With the use of ―Backup and Restore‖ option available in 
the control panel,  a backup of all the data stored in  the  computer can be taken 
to  some other place and necessary data can be restored back from this place to 
the computer again. 

(d) Date and Time: ―Date and Time‖ option is used to set the system date and time. 
(e) Devices and Printers: Using this option, we can install devices like printer, fax, 

scanner etc. which are connected to the computer. See figure 2.14. 
(f) Default Programs: We need different applications to perform different tasks. For 

example, web browser, photo editor, music-video player, email etc. For this, we 
can specify certain settings so that each such task can be performed using the 
application as per our settings. 

(g) Help and Support: This option is used to get all information related to Windows 
7 operating system. 

(h) Shut down: When mouse is moved or clicked on the arrow appearing near the 
―Shut down‖ button, a box appears as seen in figure 2.15. It displays options as: 
Switch user, Log off, Lock, Restart, Sleep, and Hibernate. 
 
When more  users are working on a single computer, then the user should select 
―Log off‖ option after completing their  work. Once a user completes log off, 
another user can login using his/her user identification and password. 
 
―Restart‖ option enables to restart the computer. Computer can also be restarted 
by pressing ALT+CTRL+DEL keys altogether twice. 
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Figure  2.14 Devices and Printers 

 

 
 

Figure  2.15 shutdown button 
 

2.9 TOOLBAR 
 

By right clicking  on the windows taskbar, a shortcut menu is opened as seen on the 
lefthand side of the figure 2.16. Selecting ―Toolbars‖ option from this menu, will  
show various toolbars available on the taskbar. . You can create new toolbar by 
clicking New toolbar option. 
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Figure  2.16 Toolbars 
Toolbar Use 
Address 

 
This toolbar is used to open any website. When address of some website is enterd here, website is 

opened in your browser. 
Links This toolbar gives the list of your favorite websites. A website can be opened in the 

browser by just clicking it. 

Tablet PC 

Input 

Panel 

 
This toolbar displays a panel as shown in above figure. Without using keyboard, one can do free-
hand writing by dragging a mouse. Free-hand writing gets converted to text. 
 

Desktop This toolbar displays the list of shortcuts available 

on desktop. A progem can be opened  by clicking on 

the shortcut from the list. 

New 

Toolbar 
This option can be used to quickly open the file in your folder. Here it displays the list of files in 

the selected folder. You can click on any file to open it. 
 

 

2.10 PRINTING AN APPLICATION 
 

When windows is opened for the first time, icons of programs like Internet Explorer, 
Windows Media Player, Windows Explorer are available on the taskbar. When 
clicked on this icon, the program gets opened. You can pin the frequently used 
programs on the right side of start button in the taskbar area. Programs can be 
pinned in taskbar in any of the following ways. 
 

1. Select the program from start menu or desktop. Right click the mouse to have 
shortcut menu as shown in figure 2.17a. Select option ―Pin to Taskbar‖ from 
shortcut menu. 
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Figure  2.17- A To pin an application  

 
2. Drag program shortcut on taskbar as shown in figure 2.17b.‘ 
 

 
Figure  2.17-b   To pin an application 
 

2.11 NOTIFICATION AREA 
 

The collection of icons in the area on the right end of the taskbar is known as the 
―Notification Area‖. These icons display details about the status of the computer or 
enable to do certain settings. When mouse is moved on these icons, will  display 
their  names and related information. For example, when mouse is moved on 
―Volume‖ icon, it displays ―Speakers: 10%‖ as shown in the figure 2.18. It shows that 
the speaker‘s volume is 10%. 

 
Figure 2.18 Volume 

 
When a tool in notification area is double-clicked, a program and its associated 
settings are opened. For example, double clicking   ―volume‖ icon will open volume 
control. When there is an increase in number of programs or applications in the 
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notification area, ‗<‘ symbol is observed. It shows that notification area is small to 
accomodate all these applications, so some applications are hidden. To see hidden 
applications, click on ‗<‘ symbol. 
 
About Taskbar: We can move the taskbar anywhere on the desktop i.e. towards  
left, right, top or bottom. Using mouse, we can even widen the taskbar. 
 
Default arrangement of windows: We know that windows can be moved and its 
size can be changed. For automatic arrangement of windows, there are three types 
of arrangement. (i) Cascading (ii) Vertically stacked (iii) Side by side 
 

2.12 DIALOG BOX 
Dialog box is a feature of Windows. When we try to delete any file or folder, it asks 
for confirmation. When we install any application, then it gives message with the 
options Next, OK, and Finish buttons. Thus computer proceeds ahead only after 
getting the confirmation from the user through the dialog boxes... Dialog box cannot 
be minimized or maximized, but it can be positioned elsewhere by dragging. 
 
Check your progress 

1. Prepare a list of names and size of hard drives available on your computer. 
2. Add ―Address‖ toolbar in the taskbar. 
3. Create a folder with your name in ―Documents‖ folder. Copy it in C:\ drive and 

name it temp. Now delete this temp folder. Remove it from recycle bin also. 
4. Using ―Search Program and Files‖, search Microsoft PowerPoint and open it. 

2.13 WINDOWS ACCESSORIES 
 
There were four important Directories 
when Windows was first introduced in the 
market. This includes ―Accessories‖ and 
―Main‖ apart from two other directories.  
Since then the applications like Paint, 
Notepad, WordPad, Calculator and 
Systems Tools which are used in 
everyday work, were included in the 
group named ―Accessories‖.  As the 
operating system gets advanced with 
time, it updates the existing applications 
as well as includes new applications in 
the Accessories group. Accessories 
group in Windows 7 is shown in figure 
2.19.  
 
Here we will study about four 
applications: (1) Paint (2) WordPad (3) 
Calculator (4) Sticky Notes. 
 

 

 Figure  2.19 Windows Accessories 



39 
 

 

2.13.1 MS PAINT 
 
MS Paint application is used usually to draw any kind of picture or to write text as per 
the requirement and to edit or make small corrections in any photograph / picture... 
This application is known as Paint.  

 
To start the Paint application, we have to first click on the Start button, then ―All 
Programs‖ using mouse or with the help of navigation keys. By right-clicking on ―All 
Programs", many folders can be seen. Accessories group is one of them, clicking on 
which will show all the applications included in this group. ―Paint‖ is one of these 
applications... Thus to open paint the flow is Start  All Programs  Accessories 
paint. 
 
Shown below is the layout of paint. 

 

 
Figure  2.20 Screen lay-out of Paint  

 
The first line where Untitled-Paint is written is called The Title bar. 
 
The second line where we see different options like Home, View etc. is called the 
Menu bar. 

 
In Windows 7, the appearance of the application is different. The group of different 
tools in it is known as the Tab. This includes Clipboard, Image, Tools, Shapes, Size, 
and Colors etc. Below this is the Working area and at the bottom of the screen is the 
Task bar.  
 
Let us study about different tabs and menus. Here, File menu is not seen on the 
screen, but it can be seen with the options as shown in the figure 2.21 by pressing 
ALT+F.  
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Figure  2.21 Paint menu  

 
Following are the uses of the options shown in the Figure 2.21 
 
New: We use this option to create a new file in Paint.  

 
Open: This option is used to open an existing file that is created in Paint application. 
A dialogue box appears on the screen as shown in figure 2.22. Select the required 
file and it will be opened when OPEN button is clicked. 
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Figure  2.22 Open dialog box  

 
Save: We use this option to store our work done in Paint application. Selecting this 
opens a dialogue box as seen in figure 2.23. The file created here has an extension 
―.bmp‖ (Bitmap image). 

 

 
Figure  2.2૩ Save Dialogue box  

Save as: If we want to store the file opened in Paint application in a different format 
or want to store it with a different name, then this option is used. Here, we can save 
the file in formats like png, jpeg, gif etc. 
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Figure  2.24 Save As option  

 
Print:  This option is used to take print out of a file created in Paint application. 

 
From Scanner or Camera: This option is used to bring a photograph in a Paint 
application from a scanner or digital camera attached to the computer. 

 
Send in Email: This option is used to send any file opened in Paint application to a 
person through email. 

 
Set as Desktop Background: If we have created a picture and want to keep it as a 
desktop background, this option is used. 
 
Properties: This option is used to change the length or width of a screen in Paint 
application. 

 
Exit: This option is used to exit from the Paint application. 

 
TITLE BAR 

 
We see following different tools in the Title bar. 

 
Save: The file created in Paint application is saved by clicking on this tool. 

 
Redo: By clicking this tool, we can redo an undone change. 
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Undo: On clicking this tool, will show all the operations performed that can be 
undone. 

 
Customize Quick Access Toolbar: This option can be used to insert or remove the 
menus to be shown in the Title bar. Avialble tools are to create new file, open 
existing file, save file, print file, see the print preview of file before printing. Refer 
figure 2.25. 
In addition to this, it contains tools to send an open file in email, undo as well as redo 
last operation, to show quick access tools below the ribbon and to hide the ribbon. 
The line of group of tabs below menu bar is known as ribbon. 
 

 
Figure  2.25 Quick access toolbar 

 
Now let us study about tabs. 
 
Tabs: 
Here, one can see two options: Home and View. Let us first study about Home tab. It 
contains groups like Clipboard, Image, Brushes, Shapes, and Size etc. 

 
 

 
Figure  2.26 Paint tab 

Home Tab: 
 
Clipboard: When we cut or copy a selected object in Paint application, generally it is 
first stored in the Clipboard. Then only, it is moved elsewhere. If we want to delete 
any information, we can use cut option available in the clipboard group.  If we want 
to have a second copy of the same object, we can use the copy option. After copy, 
place the cursor to the place where the copied information is to be inserted. Then 
clicking on the ―paste‖ option will bring that information to the cursor position. 
 
Image: We can see Select, Resize, Rotate, and Crop options in this tab. In general, 
Image tab is used to copy the object, to remove the object, to change the size of the 
object, to rotate the object to a specific degree or to remove some portion of an 
object. To perform any of these actions, first it requires an object to be selected. 
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Select: Using the Select option, we can select the required section of any object. 
Various Rotation options are available as seen in the Figure 2.27 which can be 
applied to the selected object. The available Rotation options have been shown. 
However the effects can be observed only when the data/object is selected. 

 
 

Figure  2.27 Options to rotate 
 

Resize and skew: This option is used to increase or decrease the size of an object 
or to skew an object at some degree. As seen in figure 2.28, object can be stretched 
horizontally or vertically. In the same manner, an object can be skewed at certain 
degree horizontally or vertically.  

 

 
Figure  2.28 Resize and Skew dialog box 

 
Crop: This option is used to select specific potion of an image and to create a new 
image. 
 
Tools: This group includes options that can be considered to be the core part of 
Paint application. 
 
Pencil: We can draw a picture of any shape using Pencil tool. We can use different 
colors to draw lines from Colors group available in the Home tab. 
 
Fill with Color: We can use this option to fill color in the created shape. 

 
Text: This option is used to write some text content in Paint application. A new tool 
(text tool) appears when we start typing text. This tool provides the options to change 
the style and size of font, , ‗B‘ option to make  the text  to  bold, ‗I‘ option for italics, 



45 
 

‗U‘ option to underline  and strike-through option to  draw a horizontal line in the 
middle of the  text. 
As soon as we click outside text object, the text tool disappear Different color options 
can be used change the color of the text. The text tab has been shown in the Figure 
2.29.  
 

 
Figure  2.29 Text Option 

 
Brushes: Brushes option is useful in Paint to create pictures using brush of various 
sizes or to shade around the object. Brushes tool has been shown in the Figure 2.30. 

 
Figure  2.૩0 Brushes option 

 
In the Paint application, different shapes are available in the Home tab. Thus 
different shapes can be drawn as shown in the Figure 2.31.We can type anything in 
these shapes.  
 
Some other features are also available as seen in the Figure 2.31 to color the border 
and to change the thickness of these shapes. Further they can be filled with selected 
colors using the ‗Fill‘ option. 
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Figure  2.૩1 Shape option 

 
Sizes: Using the ‗Size‘ option, we can change the thickness of the border or line of 
the object being created as seen in figure 2.32. 

 
Figure  2.32 Size option 

 
Colors  Edit Colors: When this 
option is clicked, it opens a dialog 
box as seen in figure 2.33. Using 
this, we can select any color of our 
choice, Further any new color can 
be created and added to the 
Custom color. 

 
Figure  2.33Color option 

 
View Tab: As shown in figure 2.34, Zoom, Show or Hide and Display groups are 
available in this tab. 

 

 
Figure  2.૩4 View Tab 
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Zoom: The Zoom in and Zoom out options can be used to view the objects in the 
increased or decreased size. To see the real appearance of any object, we can use 
100%. 

 
Show or Hide: This group is used to show or hide the rulers and grid lines on the 
screen as shown in figure 2.35. Thus objects can be created with specific 
measurements as per our need for better quality. 

 

 
 

Figure  2.35 Grid Line 
 
Display: To see only the object on the screen, we can use Full Screen option. It will 
not display any of the tabs, menus or taskbar. . On pressing ESC key, we can return 
back to the normal view. 

 
Check your progress 

 
1. Start Paint and create a picture as shown below. Save this file with the name 

‗smile.jpeg‘. 

 
2. Change the background of the picture. Create black border around the 

picture. 
3. Set your picture as the desktop background. 

 
2.13.2 Wordpad 

WordPad application is generally used to write  draft letters  or to create documents. 
The name ‗WordPad‘ itself implies a word processing application.. WordPad is the 
first application where use of Toolbar was started. The layout of WordPad screen 
has been shown in the Figure 2.36. 
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Figure  2.36 WordPad Screen layout 
 

Let us see different tabs and menus available in wordPad. The  File menu is not 
visible , but can  appearwhen ALT+F is presssed. The options  avialble in it have 
been  shown in the Figure 2.37. 

 

 
 

Figure  2.37 WordMenu 
 

New: We use this option to create new file in WordPad. 
 
Open: This option is used to open a file created in WordPad. A dialog box is shown 
when Open option is selected. When the required file is selected, it opens the file.  
 
Save: This option is used to store the work done using WordPad application. The file 
created in WordPad has an extension .rtf (Rich Text Format), but we can also 
specify the extension to be .doc also. 
 
Save as: This option is used to save a file opened in WordPad in different format or 
with different name. A file can be saved in different formats like txt, rtf, doc etc. 
 



49 
 

Print: Once the file is created in WordPad, It can be printed using this option.Page 
setup: On selecting Print option, it opens a dialog box as shown in figure 2.38 for set 
up. It provides facilities for setting paper, margins, orientation etc. which have been 
explained below : 
 

 
 

Figure  2.38 Page Setup Dialog Box 
 

Paper:  
 Size: As shown in figure 2.39, different sizes of page are available here. Page 

size can be Letter, A4, legal, Postcard etc. By default, page size is set to be of 
letter type. 

 
 

Figure  2.39 Paper Size 
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 Source: It has two options, ‗Manual feed‘ and ‗Automatic Select‘.We should 
keep ‗Automatic Select‘ as the default option so that we need not to feed 
pages one by one at the time of printing.  

 Orientation: Here, the options are avialble for landscape or portrait printing. 
Default option is ‗Portrait‘. If the content is not fitting in the portrait option, 
‗Landscape‘ option can  be used. 

 Margins: Using Marigin option, we can set the margins for left, right, top and 
bottom.  Finally, on pressing the OK button, page will be opened with the 
applied settings. 

 
Send in Email: A file opend in WordPad can be sent to any email address using this 
option. 
 
Exit: This option is sued to exit from WordPad application. 
 
TITLE BAR 
 
We can see various tools in the title bar.  
 
Save: It is used to save the file created in WordPad.  
 
Redo: On clicking Redo, all the editing effects can be reapplied back. 
 
Undo: On clicking this tool, all the operations performed t can be undone. 
 
Customize Quick Access Toolbar: As shown in figure 2.40, this option can be 
used to insert or remove the menus to be shown in toolbar.  Tools are to create new 
file, open existing file, save file, print file, see the printview of file before printing etc. 
 

 
 

Figure  2.40 Quick-Access Toolbar 
 

Tools can be selected or unselected so as to appear or not in the Title bar.. Ribbon 
is a row that shows the collection of tabs. The ‗Show below the Ribbon‘ option  can 
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be selected to show the Title bar  below the ribbon and the ‗Minimize the ribbon‘ 
option  to minimize the ribbon. 
 
About Tabs: In WordPad, two types of tabs are available in WordPad as shown in 
figure 2.41.These tab types are Home and View. Let us first see the Home tab. 
 

 
 

Figure  2.41 Home Tab 
 

Home Tab contains groups like Clipboard, Font, Paragraph, Insert, Editing etc. 
 
Clipboard: In general, when we cut or copy some object from a file in WordPad, the 
object is first stored in the clipboard. Thereafter only, it is copied or moved 
elsewhere.   To remove the selected content from any file,  the Cut option is used. 
To copy the selected content, Copy option is used. Thereafter, to insert such cut or 
copied content  to other place, take the cursor to that  appropriate position and 
choose the Paste option.  
 
Font: This group gives the options: Font Style, Font Size, Font Color, Bold, Italic, 
Underline, Strikethrough etc. 

 Font Style: Whatever we write or draft, the font style can be selected using 
this option. Font styles can be like Calibri, Times New Roman etc. 

 Font Size: Using this option, we can incraese or decrease the font size of the 
selected content. 

 Grow Font: Font size of the selected content can be increased using this 
option. 

 Shrink Font: Font size of the selected content can be decreased using this 
option.  

 B, I, U, abc: Using these tools, the fonts of selected contents can be given the 
effects like Bold, Italics, Underline and strike-through. 

 X2: Using this subscript tool, selected content can be displayed as subscipt. 
 X2

: Using this superscrip tool, selected content can be displayed as 
superscipt. 

 Text Highlight Color: This option is used to highlight the content. After 
selceting the content, and clicking on  the highlight tool, the content is shown 
with the selected background colour to differentiate it from the other contents. 

 Text Color: Using this tool, the colour of the text can be changed. 
 
Paragraph: Using this tab, we can easily format paragraphs with bullets, numbering, 
line spacing, alignment etc. as explained below: 

 Decrease Indent and Increase Indent : We can increase or decrease 
the indention of any paragraph using these tools. (Tools with right arrow and 
left arrow).  



52 
 

 Start a list : If the content contains points, usually some symbol is used 
before the beginning of the point so as to differentiate it from the other points. 
We use symbols like * or + etc.  The List tool   can be used to fulfill this 
purpose.  . To do so, first the content is to be selected and then clicking on the 
List tool, will open a box with list options as shown in figure 2.42. This tool 
contains numbers, symbols and alphabets which can be used to list the 
points. 

 
Figure  2.42 List Options 

 Line Spacing: Line Spacing tool  is used to set the distance between 
two lines in a paragraph. If the paragraph is already written, it needs to be 
selected first and then clicking this tool, opens a box as shown in figure 2.43. 
Here, one can specify the value for distance between two lines. Generally, 
distance between two lines is 1.15. We can also specify the distance to be 
kept before and after the paragraph. We can set line spacing from the 
beginning. 

 
 

Figure  2.43 Line Spacing 
 

 Alignment: Four types of alignments  are available in WordPad. 
They are Left, Centre, Right and Justify will do the following when selected 

o Left: Content is aligned towards left. 
o Right: Content is aligned towards right. 
o Centre: Content is center aligned. 
o Justify: Content is aligned along both left and right side by inserting 

extra spaces as needed. 
If the content is already written, it first needs to be selected and then 
alignment is applied. 
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 Paragraph: This tool can be used to specify all above settings from a single 
dialog box as seen in the Figure 2.44. One can specify the space to be left on 
the left side (left indentation) and right side (right indentation), distance on the 
left for the first line, distance between two lines and alignment using 
Paragraph tool. 
 

 
Figure  2.44 Paragraph Dialog Box 

 
These settings can be specified before  writing the content. If the content is 
already written, it is to be selected first and then the settings can be applied. 
we can specify the values for all these settings.  The Alignment option given 
at the end,  has  the options  left, right, and justify. 

Insert Tab: This group is used to insert picture, change picture or change the size of 
the picture in a file. It also enables to insert date, time and other objects.as explained 
below: 

 Picture: Picture tool is used to insert an image stored anywhere in the 
computer, floppy, CD, pen drive etc. in WordPad. As shown in the Figure 
2.45, clicking on Picture tool shows three options: Picture, Change picture and 
Resize picture. On selection of Picture option, it asks to specify the path 
where an image or picture is stored. After selecting the required file and 
pressing OK button, the image will be inserted in the document at the 
specified location.  

 
Figure  2.45 Picture Tool 

 
 The inserted image can be changed by using Change Picture option. 
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We can change the size of the image using Resize Picture option. To do so, 
select image first and then choose Resize Picture option. It will open dialog 
box to specify the size. Also, one can resize the image by stretching the 
mouse from the corners or sides of the selected image. 
 

 Paint Drawing: While working in the WordPad application, if we want to insert 
some object created in the Paint application, then this tool can be used. On 
clicking it, opens the Paint application in the WordPad file, with the provision 
to draw an object, when the mouse is clicked in the working area of the 
WordPad, the object created in the Paint application will be inserted in the 
WordPad file. 

 
Date and Time: This tool is used to insert date and time at the position of the cursor 
in the WordPad file. 
 

 
Figure  2.46 Date and Time dialog box 

 
On clicking  it, opens a dialog box with various available formats as shown in the 
Figure 2.46.  It inserts the date and time, at the cursor positionusing the selected 
format. 
 
Insert Object: This tool is used to work with Word, Excel, PowerPoint and some 
other applications while working with WordPad. On clicking this, it shows most of the 
applications available in the computer. . After completion of the work in the selected 
application, the created object can be inserted in the WordPad file when clicked on 
the WordPad application. 
 
Editing Group: With the help of this group, it is possible to select any word or 
phrase, find any specified phrase and to replace it with another phrase. 
 
Find:Without using any tool, if we want  to find any word in a file, delete any word, or 
to substitute all the occurrences of specific word with another word, we need to read 
the file content one line at a time very carefully. and it is a time taking task also .  . 
But using the tool ‗Find‘ it is very easy  to do such tasks  irrespective of the number 
of pages in the file. 
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On selecting the ‗Find‘ option,  a dialog box is opened as shown in the Figure 2.47. 
Specify the word to be searched in the box appearing near ‗Find What:‘. On clicking 
the ‗Find Next‘ button, first occurrence of this word is highlighted. To search another 
occurrence, click the ‗Find Next‘ button again and so on. In this manner, we can find 
all the occurrences of any specified word one after the other. At the end  , a 
message will appear saying that wordpad has finished searching the document. 
 

 
Figure  2.47 Find dialog box 

 
Replace: This option is used to replace any word with another. For example, if we 
want to replace the word ‗UNIVERSITY‘ with  ‗DRBAOU‘ in the WordPad file, first 
click on the Replace option from Editing group. A dialog box will appear as shown in 
the Figure 2.48. Write UNIVERSITY in the ‗from what:‘ box and DRBAOU in the 
‗Replace with:‘ box. Now click on the ‗Replace All‘ button, to replace all the 
occurrences of the word ‗UNIVERSITY‘ with ‗DRBAOU‘. To replace only specific 
occurrence, we need to use ‗Find Next‘ and ‗Replace‘ button. 
 

 
Figure  2.48 Find and Replace dialog box 

 
Select All: This tool is used to select the entire content of the file. On clicking the 
‗Select All‘ option, the entire content is highlighted showing the selection. To come to 
the normal view from selected view, the arrow keys or the mouse can be clicked. 
 
VIEW TAB: View Tab contains three groups: Zoom, Show or Hide and Settings as 
shown below. 

 
Figure  2.49 View Tab 
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Zoom Group:  Using the ‗Zoom In‘ and ‗Zoom Out‘ options, we can have the 
increased or decreased view of any object. Option ‗100 %‘ can be used to see the 
real view of an object. 
 
Show or Hide: This group is used to enable or disable the ‗Ruler‘ and the ‗Status 
bar‘ in the WordPad application. (Refer Figure 2.49). Using Ruler, we can create 
objects with specific measurement to have better quality objects. Status bar is shown 
at the bottom of the window. 
 
Settings: Using this group, we can set our content inside or outside the ruler. When 
‗Word wrap‘ is clicked, it gives three options as seen in the Figure 2.50. If ‗No wrap‘ 
option is selected, the content is not wrapped in the window. If window size is 
changed, the look of the content does not change. Activating ‗Wrap to window‘ 
shows the content wrapped as per the window size. Enabling ‗Wrap to ruler‘ ensures 
the content to be wrapped within the rule. 
 

 
Figure  2.50 Word Wrap 

 
Measurement Units: This is the second option in ‗Settings‘ group. It provides the 
options for unit of measurement to be used in the Ruler. Available units are Inches, 
Centimeters, Points and Picas as shown in the Figure 2.51. The scale on ruler is 
changed according to the selected option. Figure 2.52 shows the ruler line in various 
units. 
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Figure  2.51 Measurement Units 

 

 

 

 

 
Figure  2.52 Ruler in different units 

 
Check your progress 

 
1. Open WordPad and type your bio data. Save the file with the name 

‗mybiodata.rtf‘. 
2. Set the line spacing to 1.5 and show your hobbies using bullets. 
3. Insert today‘s date and time at the end of the file. 
4. Insert some picture in the file. 
5. Replace specific word with another word. 

 
2.13.3 Calculator 

Nowadays, calculator is the most needful device everywhere. With the use of 
calculator, mathematical and scientific calculations can be performed very quickly 
and easily. Calculator in Windows 7 provides more functionality. 

 
To open Calculator, first of all we should go to Start button. On activating Start 
button, Accessories group is seen when All Programs option is selected. In this 
group, Calculator is available. [Thus the sequence of applications for opening 
calculator is Start  All Programs  Accessories  Calculator] 

 
On clicking Calculator option, it gets opened as in the Figure 2.53a. Here, we can 
easily perform addition, multiplication, division and multiplication. If we require 
performing some specific type of calculations, we can see different types of views in 
Calculator and can do such calculations easily. 

 
Here, select View (ALT+V) option to see different types of calculators available as 
shown in the Figure 2.53b.we can quickly get the correct result by selecting the 
option as per need. We can select any of these calculators as per our need and can 
do the calculations. 
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Figure  2.53-a 

 
Figure  2.53-b 

 
When we click on scientific option, the scientific calculator is opened which has been 
shown in the Figure 2.53c. Using scientific calculator, we can easily perform 
scientific calculations like Sine, Cosine, Tan, Int, Degree, Logarithm etc. very fast. 
 
The third option is Programmer in the View menu, for the programmer calculator. In 
this calculator various functions like Mod, RoR, And, Not, Byte etc. are available to 
be used by the programmers as shown in the Figure 2.53d. 

 
Statistics option available in View menu opens Statistical calculator for performing 
statistical calculations as in the Figure 2.53e.  

 

 
Figure  2.53-c 

 
Figure  2.53-d 
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Figure  2.53-e 

 

 
Figure  2.53-f 

 
On selection of Unit Conversion option from View menu, a window is seen as in the 
Figure 2.53f. On the right side pan, the first drop-down menu is for the type of unit 
we want to convert. . Now suppose we want to convert area from acre to square 
meter. Then select Area from the unit option. Now enter value in acres and select the 
option Acres from the second drop-down list ―From‖.  Select ‗Square meter’ in the 
last line of ―To‖ drop-down menu. It will show the converted value immediately in the 
text box above the ―To‖ drop-down menu as in shown the Figure 2.53g.  

 
When the Date Calculation option is selected from the View menu, a screen appears 
as seen in the Figure 2.53h. On the right hand side, the first option is to select the 
type of calculation to be performed on date. To find the difference between two 
dates, select the respective option from it. As shown in figure 2.53h, the two dates 
entered are 1/05/2014 in from date and 15/05/2014 in to date. On clicking on the 
Calculate button, it   shows the difference in weeks and days.  

 

 
Figure  2.53-g 

 

 
Figure  2.53-h 
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Figure  2.53-i 

 
Figure  2.53-j 

 
On selection of the option Worksheets from View menu, a screen appears as shown 
in figure 2.53j. Financial calculations related to mortgage, vehicle lease etc. can be 
easily performed using this option. 

 
At the end, Help menu is given in the Calculator. If we have any difficulty in 
understanding the available options, we can easily take the help and can complete 
our work. 
 

2.13.4 Sticky Notes 

      
Figure  2.54-a   Figure  2.54-b 
 

 
       Figure  2.54-cFigure  2.54-d 
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Figure  2.54-e 

 
In general, Sticky Notes becomes useful when we want to rememebr something at 
the time of working with computer or when we need to follow certain instructions 
while working with specific application. 

 
To open Sticky Notes, first click on Start button and go to All Programs. Now click on 
Accessories group and the Sticky Notes option is available here. Thus the sequence 
to open it is: Start  All Programs  Accessories  Sticky Notes. 

 
On clicking Sticky Notes, a yellow slip (note) is seen as shown in the Figure 2.54a. In 
figure 2.54a, three items can be seen in the sticky note. On the top, two buttons ‗+‘ 
and ‗X‘ are seen. Symbol ‗+‘ informs that a new sticky note (as seen in the Figure 
2.54c) can be inserted by clicking it.  Symbol ‗X‘ is used to delete or remove 
unwanted sticky notes. When we click on button X, it asks for confirmation to remove 
the sticky note. If ‗Yes‘ is selected, then the sticky note is immediately removed from 
the computer. 

 
Third item is a blank area where we can write any information in sticky notes as 
shown in the Figure 2.54d. There can be as many sticky notes as we want. Thus, 
‗sticky notes‘ is helpful to remind certain things in our day-to-day work. 
 

2.14 SECURITY SETTINGS AND SOFTWARE 
 

Action Center: Action centers are used to run Windows operating system without 
any problem. To run Windows smoothly, action center is a place which takes 
necessary action as soon as a security related problem occurs. 
Windows Defender: When Windows is installed, an anti-spyware software named 
‗Windows Defender‘ gets automatically installed. Windows Defender is used to 
protect our computer from spyware. Spyware enters our computer through internet, 
Cd or DVD with our knowledge. At this time, anti-spyware software ‗Windows 
Defender‘ is proved to be very useful in protecting the computer.  
 
Windows Defender protects the computer in two ways:  
 
(1) By providing real time protection. 
(2) Scanning through Windows defender. 
 
User Account Control: Whenever a need is raised for changes in the program, the 
User Account Control (UAC) informs or instructs at the administrator level. Changes 
are made only after the permission granted by the user. We can use only those 
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rights which are granted to us. For example, check email, listen music, create new 
documents etc. If access rights are not granted on these applications, neither the 
application can be opened nor can it be executed. 
 
Windows Update: In Windows operating system, everyday new features are being 
added or utilities are getting modified to add or improve some features. In licensed 
operating system, ―Windows Update‖ option should be kept ON so as to 
automatically update the system. When this option is ON, updates are automatically 
accepted and installed so that the computer remains updated with the new system. 
 
Windows Firewall: Windows Firewall is helpful in protecting our computer when it is 
connected to any network. It protects the data and information stored in our 
computer from other computers or other programs. 
 
Parental Controls: Nowadays, children are wasting lot of time in playing computer 
games. Thus Parental Controls can be  used to control  such activities. 
 
To activate Parental controls, click on the start menu, type ―Parental Search‖ in the 
search box as shown in the Figure 2.54. On pressing ENTER key, it will open dialog 
box as shown in the Figure 2.55. 
 

 
Figure 2.54 

 

 
Figure 2.55 
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Figure  2.56 

 
The option ―Parental Controls‖ is available in Control Panel also as in the Figure 
2.56. On selecting  this option, a new window is opened as seen in the Figure 2.57. 

 
Figure  2.57 

 
When a computer is used by more than one users, normally users are assigned 
separate user ids and passwords. If we do not want to allow some user to access 
particular application, we need to have admin password. Admin password should be 
kept secured or should be changed at times. If the system is not secured with 
password, any user can change Parental Controls. To secure ‗Parental Controls‘, 
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password can be set for ―Ensure Administrator Passwords‖. A window will be seen 
where we can set the time, games and other programs. 
 
Here we can set the time such that computer will shut down after a specific time. We 
can decide the rating of games. We can block some applications such that it can be 
seen but cannot be executed. 
 
Check your progress 

 
1. Prepare a list of your important work using sticky Note. 
2. Decide the time of playing video game for children using parental control. 
3. Convert a value given in one unit to another unit using calculator. 

 
 

2.15 CHECK YOUR PROGRSS: POSSIBLE ANSWERS 
 

Q1. Select the appropriate option. 
 
1. In how many ways can a Start button be activated? 
 A. A) 3 B. B) 4 
 C. C) 1 D. D) 2 
2. Which option is used to uninstall or remove a program installed in computer? 

 A. A) Control Panel  B. B) System Panel  
 C. C) File panel  D. D) None of these  

૩. In which group a calculator is included? 

 A. A) Accessories B. B) Control Panel  
 C. C) System panel  D. D) None of these  
4.  What is the full form of UAC? 
 A. A) User Account Control B. B) Uses Account Circle 
 C. C) Utility Account Control D. D) User Account Concern 
5. Which of the following is required to secure computer when it is connected to 

network? 
 B. A) Firewall  C. B) Internet  
 D. C) Word application  E. D) None of these 
 
Q2. Fill in the blanks with appropriate word/words. 
 
1. Sticky notes is included in ___ group.   
2. An image seen in the background of desktop is also known as ______.   

૩. Taskbar is divided in main ___ components. Taskbar is divided into _______ 
main components. 

 

4. Tabs ___ and ____ are available in the paint application.   
5. The collection of icons on the right side of taskbar is known as _____.   
 
Q3. State whether following statements are true or false. 
 
1. Windows is an operating system developed by Sun Java company. 
2. Printer or scanner can be installed in the computer with the help of control panel. 
3. The file created in Paint application has file extension ―.bmp‖. 
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4. WordPad application does not provide a facility to search word. 
5. Action center provides help to run Windows operating system smoothly without 

any hindrance. 
 
 
Q4. Match the following. 

 
 
 
 
 
 
 
 
 

 
 
Answers 
Q-1. 1-A (૩),   2-A (Control Panel),  ૩-A (Accessories), 4-A (User Account Control), 

5-A (Firewall) 

Q-2. 1-Accessories, 2-Wallpaper, 3-૩,  4-Home ,view, 5-Notification area 

Q-3. 1-False, 2-True,  ૩-False,  4-False,  5-True 

Q-4. 1-e,  2-d,  ૩-b,  4-c, 5-a.   

 

  

1 Paint a Find  

2 Fonts b Save 

3 Ctrl+S c Start button 

4 Esc+Ctrl key d Control panel 

5 Ctrl+F e Accessories 
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Block-2 
Word Processing 
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Unit 1:  Introduction to Word 
Processing  

  
 
Unit Structure  
 
1.1. Learning Objectives 
1.2. Introduction to Word Processing 
1.3. Introduction to Microsoft Word 

1.3.1 Microsoft Word Window 
1.3.2 Tabs of Microsoft Word 

1.4 Document Creation 
1.4.1 Open and Save a Microsoft Word File 

1.5 Check Your Progress: Possible Answers 
  

1 
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1.1 LEARNING OBJECTIVES 
 
After studying this chapter student will be able to: 

 Create a file in Word 2010 and format it. 
 Understand the functions of different Word 2010 Tabs. 

 

1.2 INTRODUCTION TO WORD PROCESSING 
 
Paper and pen have been used to create documents from ages. It is undisputable 
that our life style has changed in today‘s electronic era due to the arrival of 
technology in every aspect of our lives. The process of storing, editing and printing 
letters, report or book with the help of computers is known as Word Processing. 
Word processing program primarily uses text. The current Word Processors though 
besides the text, make efficient use of pictures, images, figures, diagrams, graphs, 
etc. A computer program that uses all these mediums for the purpose of 
documentation is known as a Word Processor. We can create high quality document 
by using the work capabilities of today‘s Word Processor. 
Some benefits of the document created using Word Processing instead of 
handwritten or typewritten documents are as under: 
 Simplicity: Word Processor facilitates WYSIWYG, which means, ―What You See 

Is What You Get.‖ The word processor provides a user with simple GUI 
(Graphical User Interface) to create a document. After adding the details, the 
user can easily create very attractive and informative documents by giving just a 
few clicks and commands. Furthermore, today‘s computer is equipped with 
modern keyboard, using which textual and numerical data can be added quickly 
and easily. In addition, many word processors provide templates of different type 
of documents. By replacing the sample details given in the templates with the 
appropriate information, it is easy to create a document in a short span of time. 

 Editing: Once a handwritten or typewritten document is prepared, it is difficult to 
change it. If there is a need to change such a document then updating such a 
document makes it look unattractive or efforts have to be put in to create the 
document once again which is boring as well as time consuming. 

Before storing and printing a document created using word processor, it can be 
checked and corrected one or more times. Editing the text and other details is as 
simple as adding the details. The errors occurring during typing or changes 
occurring real time can be accommodated in the document very easily. It is 
possible to add details in-between the existing details. Also if the added details 
seem unnecessary, they can be removed from the document. It is also easy to 
update the details by using various keys available on the keyboard. 
 

 Replication: Sometimes we need to create a new document by changing a small 
portion of an existing document. For example, the birthday invitation card created 
for your younger brother or sister needs to be sent to more than one friend or 
relative. Majority of the text in the invitation card being sent to these people will 
remain the same, only the name of the person and address need to be changed. 
In such cases, more than one copy of the same letter with name and address of 
different persons is required. Word processor can be very useful in such 
situations. 
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A word processor is equipped with features using which we can produce multiple 
copies of the same document. It is possible to incorporate the required changes 
in copies so created. Once the document is ready, it is possible to make required 
copies, do the necessary changes, store and print each copy. 
 

 Storage of document: Word Processor stores document in digital form. 
Normally the information is stored on magnetic disk medium like hard disk or 
optical medium like CD/DVD. These mediums guarantee long storage duration of 
the information. After a period of time the information stored on physical medium 
like paper is affected by environment. Also there is a possibility of the information 
being lost as the paper becomes worn-out after a long period of time.  

Moreover, storing information in form of a paper or book occupies much physical 
space, while the plenty of information saved in digital form requires much less 
space. Data card used in a mobile phone is an example of such digital storage. It 
is possible to store many GBs of data in an extremely small-sized data card. 
Thousands or millions of pages of documents can be stored on few DVDs; this 
also resolves the storage problem. 

 Rearranging Sections: Once the documents have been prepared, a word 
processor provides the facility to rearrange sections within it. It often happens 
that the order of the details being entered is not determined or due to some real 
time requirement the order of the sections needs to be changed. Word Processor 
provides features of ‗Cut‘ and ‗Copy‘, using which a section can be removed (cut) 
from its original place and put (paste) into another place very easily. Also 
sometimes it is required to put a section as it is or with minimal changes in a new 
place, and in such cases the ‗Copy‘ and ‗Paste‘ feature of the word processor can 
be used. Using this feature, a user may replicate a sentence, a paragraph or a 
section many times, and thus can be spared out from the task of repeated typing. 

 Formation: After adding details in the word document it is possible to set Font 
type, Style, Color, Alignment, Border, Background or other such formation quickly 
and easily. Such formation increases the attractiveness and legibility of the 
document considerably.  

 Spelling and Grammar Check: Word processor provides a feature to find and 
correct the spellings and grammar of the text keyed into the documents. With the 
help of this feature, a document can be made error-free very easily. 

 Currently, word processors created by a number of different organizations are 
available, often the features provided by every Word Processors and its working 
mechanism is almost same. A list of some popular word processors is given 
below: 
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Figure 1.1 Different Word Processors 

 
 Word available in Office package developed by Microsoft Corporation. 
 Writer available in Open Office developed by Oracle Corporation. 
 Quick office available on Android and iOS. 
 Word Pad one of the accessories in Microsoft Windows. 
 Word Perfect developed by Coral. 
 Apple Pages developed for Mac system. 
 Online Google Docs provided by Google. 

 

1.3 INTRODUCTION TO MICROSOFT WORD  
 
Microsoft Word is the most popular word processor developed by Microsoft 
Corporation.  Microsoft Word was first launched by Microsoft in 1983 for the Xenix 
system by the name of Multi-Tool Word. Over a period of time, several versions of 
Word were released, which were available not only for the Windows operating 
system but also for other operating systems like Mac. 
Currently, Microsoft Word is available as a part of the Microsoft Office 2010 software 
package. In addition to Microsoft Office Word, the package also contains other 
software such as Excel, PowerPoint and Outlook; we will study them in later 
chapters. Microsoft Office is proprietary software; hence it is essential to take a 
license before using it. 
 
1.3.1 Microsoft Word Window 
 
If Microsoft Office program is installed on a computer, any of the following methods 
can be used to open the Microsoft Word application: 
 Select the option Start  All Programs  Microsoft Office Microsoft World 

2010. 
 Open a Run dialog box by selecting the option Start  Run, type WinWord 

command in the dialog box and click on OK button. 
 If icon for Microsoft Word 2010 is available on the desktop then double-click on it. 

 
Figure 1.2 Icon of Microsoft Word 

When Microsoft Word application is started using any of the methods mentioned 
above, the window shown in Figure 1.3 is provided to the user. 
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Figure 1.3 Initial window of Microsoft Word 2010 

When Microsoft Word 2010 is started, the components as shown in the figure are 
presented on the screen. Let us get the introduction of different components used to 
create a document. 
 Title Bar: 

 
Figure 1.4 Title Bar 

The vertical bar on the top of the Microsoft Word 2010 window is known as Title Bar. 
The name of the program Microsoft Word along with the name of currently open 
document is shown in the middle of the title bar. In case the document is yet to be 
saved then Document1, Document… appears on the title bar. In addition to this, the 
title bar also provides few simple buttons that can be used to create a document. 
The tool bar appearing to the left of the title bar is called Quick Access Toolbar. The 
functions of the buttons present on this toolbar are mentioned below: 
 Control Menu: The Control Menu appearing on the left side of the title bar has 

options that allow us to show the window in a particular portion (Restore), move 
the window from one place to another (Move), change the size of the window 
(Size), minimize the window and make it appear as a task button on the task bar 
(Minimize) and close the window (Close). 

 Save Button: As learnt in the previous chapter, when information is added to the 
computer, it is stored temporarily in the primary memory. To store the information 
permanently, it needs to be put on permanent storage place like a hard disk. This 
activity is known as ‗To Save‘. When this button is clicked the information added 
to the document is saved in form of a file. Alternatively, a shortcut key ‗Ctrl + S‘ 
on the keyboard can also be used. If the user is saving the document for the first 
time,a ‗Save As‘ dialog box is displayed. The information can now be stored as a 
file by entering the name of the document in this dialog box.  We will learn about 
the other options of this dialog box later.   
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 Undo Button: We know that word processing software provides a feature to 
correct the information added within the document. The Undo button is used to 
cancel the effect of last change done in the document. If the Undo button is used 
more than once, all the actions performed by us to add or edit the document are 
cancelled in the reverse chronological order. Alternatively, a shortcut key ‗Ctrl + 
Z‘ on the keyboard can also be used. 

 Repeat Button: This button is used to repeat the last action. For example, if a 
user needs to add similar text or perform similar adjustments, he can perform the 
desired action by using this feature, but unlike the undo feature, this feature can 
be used only once at a time. Alternatively, a shortcut key ‗Ctrl + Y‘ on the 
keyboard can also be used. 

 Customize Quick Access Toolbar Menu: Thismenu is used to add or remove 
buttons from theQuick Access Toolbar. A tick sign is visible in front of the tool 
buttons that are already selected. By clicking on the desired option, it can be 
made visible or invisible from the toolbar. Just like the other open Windows in the 
Windows operating system, the Microsoft Word 2010 window‘s title bar also has 
three buttons on the right side a shown below: 

 
 
 
 
 

Figure 1.5: Control Buttons 
 

 Minimize Button: When this button is clicked, the active windows of Microsoft 
Word get minimized and are visible in form of a task button on the task bar. 
These windows can be brought back to their original size by clicking the task 
button present on the task bar. While working with a word document, if we 
need to work with some other software program or need some details, this 
button is very useful. By using this button, a document can be temporarily 
removed from the screen which saves time taken for closing and reopening a 
file. 

 Restore/Maximize Button:  Microsoft Word window is usually presented as a 
full screen (maximized). But sometimes, a need arises to open different 
software programs and work in them along with Word. During such times, 
clicking on the restore button arranges the Word window in some specific part 
of the screen. The restore button changes to Maximize button during this 
period. Clicking again on the same button shows the window in full screen. 

 
 Close Button: This button is used to close the active window of Microsoft 

Word. An alternative to this button is ‗Alt + F4‘shortcut key. If only one window 
of Microsoft Word has been opened and close button is clicked, Microsoft 
Word program also gets closed along with the open document. 

Minimize Close 

Restore / 
Maximize 
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 Ribbon:  

 
Figure 1.6 Ribbon 

 
The menu and toolbars used in previous versions of Microsoft Word have been 
replaced as Ribbon in Windows 2010. The Ribbon has many tabs used to perform 
different tasks. The ribbon has eight tabs as shown below: File, Home, Insert, Page 
Layout, References, Mailings, Review and View. 
Let us now learn about different facilities provided by each tab of the ribbon in brief. 
We will look into the details of the important options later. 
 
1.3.2 Tabs of Microsoft Word 
 
1. File tab: Clicking on the File tab, opens the screen as shown in Figure 1.7.  

 
Figure 1.7 File Tab on the Ribbon 

 
This Tab is used to perform some basic functions associated with the document 
such as creating a new document (New), opening existing documents (Open), 
storing document (Save), storing a  document with another name or at another 
location in the hard disk (Save As), closing a document (Close), obtaining 
information about a document (Info), listing of documents recently opened by the 
user and opening a document (Recent), printing a document (Print), storing a 
document and sending it via e-mail or web (Save and Send), getting help with 
document preparation (Help), etc., Figure 1.7 shows the Info section of this Tab. 

2. Home Tab:  
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Figure 1.8 Home Tab on the Ribbon 

Several options to adjust the text inserted in document (Formatting) such as 
changing font style (Font), changing size of the fonts (Font size), changing the 
character style (Bold / Italic / Underline), applying different effects to the text (Text 
effect), highlighting text (Highlight), changing position of the text (Cut / Copy / 
Paste), aligning the text (Left / Center / Right / Justify), applying border to the text 
(Border), searching text and replacing it with another text (Find / Replace) are 
included in this Tab. 

3. Insert Tab: 

 
Figure 1.9 Insert Tab on the Ribbon 

This tab is used to add some supporting features to the contents of the 
document. Using this tab an initial page (Cover page), an empty page (Blank 
page), a table (Table), an illustration /clip art (Image / ClipArt), various shapes 
(Shapes), a graph (Chart), screen appearance (Screenshot), hyperlinks 
(Hyperlink), header and footer (Header and Footer), text boxes (Text box), text 
decoration (WordArt), equation (Equation), signs (Symbol) and many other 
features can be added. 

4. Page Layout: 

 
Figure 1.10 Page Layout Tab on the Ribbon 

This Tab is useful for adjusting the pages within a document. This Tab is required 
to make changes in a predetermined arrangement of the pages. The Page 
Layout tab is used to change many properties like the theme of the page 
(Themes), margins (Margins), orientation (Orientation), page size (Size), page 
numbering (Page numbers), watermark (Watermark), page color (Page color), 
page border (Page Borders), indent and space (Indent and Spacing), etc.   

5. References Tab:  
 

 
Figure 1.11 References Tab on the Ribbon 

Once the document is prepared, this tab is used to perform various activities like 
inserting a table of contents, updating the index as per changes done in the 
document (Update table), adding Footnote / Endnote, showing Bibliography, 
adding Caption, etc. 

6. Mailings Tab: 
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Figure 1.12 Mailings tab on the Ribbon 

This tab is used to create envelopes, create labels that have addresses, as well 
as prepare a table that contains list of recipient. Sometimes a letter needs to be 
sent to more than one person with few changes. The feature of adding names 
and addresses of individuals in the original contents of a letter is known as Mail 
Merge. The Mail Merge feature is also provided in this Tab. 

7. Review Tab: 

 
Figure 1.13 Review Tab on the Ribbon 

To make a document free from spelling and grammatical errors, this tab provides 
an option of Spelling & Grammar. In addition this, it also provides the feature of 
Thesaurus which is used to replace a given word with its synonym or antonym. 
Word count feature gives us the count of total number of pages, paragraphs, 
lines, words, and characters within a document.  Translate feature allows us to 
translate the document to another language. Language feature allows us to 
change the language of data entry. New Comment feature allows us to add 
notes. Compare feature allows us to compare two or more documents. 
Accept/Reject features allow acceptance or rejections made to the document. 

8. View Tab: 

 
Figure 1.14 View Tab on the Ribbon 

This Tab facilitates viewing of document in various ways (Views). It provides the 
option to view the document layout before printing (Print Layout), view the 
document in full screen (Full Screen Reading), view the document as web page 
(Web Layout), display the text within the document as title and subtitle (Outline), 
enlarge or shrink the document (Zoom), view one or more pages on one screen 
(One page / Two Pages), organize multiple open documents on the screen in 
different ways in a window (New Window / Arrange All), go to another window 
(switch Windows) and perform any action by issuing series of instructions once 
(Macros). 
 Ruler: At times need arises to work as per fixed measurements within a 

document. The feature of vertical and horizontal ruler is provided for the 
same. The default unit of the ruler is Inch. It can be changed as per the 
requirement of the user. The Tab stops are provided at a distance of half inch 
in the ruler. It is possible to move half inch every time a Tab key on the 
keyboard is pressed. The default setting of half inch Tab stop can be modified 
by applying mouse click at the desired interval on the ruler. The default Tab 
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stop is shown as L. When a Tab key is pressed the cursor directly jumps to 
this place. The figure below shows a horizontal ruler along with different Tab 
stops. 

 
Figure 1.15 Horizontal Ruler with Tab stop 

 Work Area: The white area (initially blank) shown after the Word window is 
opened is known as Word‘s word area. All the information to be added in the 
document is shown here. The work area can be divided into one or more 
pages. The Print Layout view allows us to see the space between these 
pages. 

 Scroll Bar: It is not possible to display all the information within a document 
on a single screen. If the information in a document is more than the screen 
size, some information becomes invisible. To see this information the 
document needs to be scrolled up/down or left/right. To perform this 
operation, a feature of vertical and horizontal scroll bar is provided in Word. 
The document can be moved on the screen by clicking the arrow-shaped 
button at both ends of the scroll bar. To perform this operation faster, the 
scroll button on the scroll bar can be dragged using the mouse pointer. The 
figure below shows the horizontal scroll bar. 

 
Figure 1.16 Horizontal Scroll Bar 

 Status Bar: The horizontal bar shown at the bottom of the Word window is 
known as a Status bar. Brief details of the active document are shown on 
this bar. The figure 1.17 shows the status bar and some of its components. 

 
Figure 1.17 Status Bar 

The Status bar displays following details in the Microsoft Word 2010: 
 Current page number and total number of pages. 
 Total number of words in the document. 
 Proofing Icon to check Spelling and Grammar. 
 Current Language. 
 Button to change the layout of the document (Print Layout, Full Screen 

reading, Web Layout, Outline, Draft). 
 Zoom control button of the document. 

 
It is possible to change all this information by clicking the options available on the 
status bar. After getting introduced to the main screen of Microsoft Word 2010, let us 
obtain some basic knowledge about how to create a word document. 
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1.4 DOCUMENT CREATION 
 
1.4.1 Open and Save a Microsoft Word File 
 
To open a new file: As seen previously, when a user opens Microsoft Word 2010, he 
is presented with a blank file. A user can start adding information into this blank file 
without using any other options. Following methods can be used to create a new file 
in Word. 
 
 Click on the File Tab on the Ribbon. This will open a back stage view as shown in 

Figure 1.7.  
 Click on the ‗New‘ option on the left side. This will provide options to create a new 

file as shown in Figure 1.18. 
 As shown in Figure 1.18, there are many templates available to create 

documents with predefined structure. From all these templates, the default blank 
template is the most popularly used.  

 Select the desired template icon and click on the Create button visible on the 
right side. 

 A document as per the selected template will be visible on the screen. 
 Alternatively, a shortcut key CTRL+N can also be used to perform this operation. 

Using CTRL+N key option will open a blank document on the screen. 
 

 
Figure 1.18 Options to create a new file 

 
Add some text to the new document opened using the keyboard. To perform this 
action we simply need to start typing the text. For example, Figure 1.19 shows a 
document that contains information about different parts of computer. 
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Figure 1.19 Data Entry done in New Word Document 

 
Adding information within a Word document is a very simple task. While adding text 
within a document, Microsoft Word 2010 verifies the spelling and grammar of the 
added text. As shown in Figure 1.19, wrong spellings are displayed using a red 
underline and grammatical mistakes are displayed using a green underline. To get 
instructions and options to correct the erroneous text, you can put the mouse pointer 
on the erroneous text and right click. Many alternatives will be displayed on the 
screen. An option which suits your requirement can be selected to correct the 
mistake or this option can also be ignored. 
To Save a File: We know that when any information is added to a word document, it 
is stored in temporary memory called Random Access Memory (RAM). Before 
closing the program or turning off the computer, it is necessary to store this 
information on permanent storage places like hard disk drive. Save command is 
used to perform this operation. 
Let us use the steps shown below to save a file: 

 Click on the File Tab and select ‗Save‘ option. Performing this operation will 
present a ‗Save As‘ dialog box as shown in Figure 1.20. As an alternate, 
‗CTRL + S‘ shortcut key on the keyboard can also be used. 

 As shown in figure 1.20, using the features shown in the ‗Save As‘ dialog box, 
a file can be saved easily. 
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Figure 1.20 Save As dialog box 

 
 Decide the place to store the file from the section visible on the left side of 

dialog box. By default a word file will be stored in the folder called Documents.  

 Desired file name can be selected from the ‗File name:‘ drop down menu or a 
new name can be assigned to the file. 

 By default a file is stored as a Word document. With the help of ‗Save As 
type:‘ drop down menu, the file can be saved in different formats (for example, 
old format of Microsoft Word). 

 Using the options given in the Tools menu, the images in the file can be 
compressed or security can be added to a document. 

 After adding all the required details, click on the Save button to save the 
document in the form of a file. The dialog box can be closed without saving 
the file by using the Cancel button. 

To Open Existing Document: We saw how Microsoft Word saves a document in 
form of a file. Now perform the steps mentioned below to open and view the file on 
the screen. 

 Click on the File tab and select ‗Open‘ option. Performing this operation will 
present ‗Open‘ dialog box as shown in Figure 1.21. Alternatively, ‗CTRL + O‘ 
shortcut key on the keyboard can also be used. 
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Figure 1.21 Open Dialog Box 

 
 This dialog box lists the files that have been saved. Select the desired file and 

click on Open button, the information in the file will be displayed on the 
screen.  

 Using the left section of the Open dialog box, the file stored in the different 
folders can be opened. 

 Clicking on the arrow button visible near the Open button, a file can be 
opened with some more options. For example, a file can be opened as Read 
Only. To repair a damaged file choose Open and Repair. 

Shortcut Key: Microsoft Word provides many different features. To use these 
features, the option given on Ribbon or commands within the menu can be used. 
The Word program provides shortcut keys for many of these features. The time 
taken to search a button or option for performing a required action can be reduced 
by using shortcut keys. Word provides shortcut keys for most of the features used 
regularly. Table 1.1 lists the shortcut keys used in Microsoft Word 2010 along with its 
command and use. 
 
Shortcut Key Command Use 
Ctrl+F1 Show/Hide Ribbon To make the Ribbon invisible or visible. 
Shift+F10 Show shortcut 

menu 
To display a shortcut menu for the active component. 

F12 Save As To store the file with another name or at another location. 
F7 Spelling and 

Grammar 
To find and correct spelling and grammatical errors. 

Shift+F7 Thesaurus To find the synonyms and antonyms of a word and to 
change the original word. 

Ctrl+A Select All To select all the information in the document. 
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Shortcut Key Command Use 
Ctrl+B Bold To make the selected text bold. 
Ctrl+C Copy To copy the selected data to the clipboard (memory). 
Ctrl+D Font To open the Font dialog box having several options for 

letters. 
Ctrl+E Align Center To align a paragraph in the center of the page. 
Ctrl+F Find To find specific text in a document. 
Ctrl+G Go to To reach directly to a specific location (page) in the 

document. 
Ctrl+H Replace To replace a text with another text. 
Ctrl+I Italic To skew (italics) the selected text. 
Ctrl+J Align Justify To align a paragraph on both sides of the page. 
Ctrl+K Insert Hyperlink To add hyperlink. 
Ctrl+L Align Left To align a paragraph on the left side of the page. 
Ctrl+M Increase Indent To increase the indent of the paragraph. 
Ctrl+N New File To create a new file. 
Ctrl+O Open File To open a saved file. 
Ctrl+P Print File To print a file. 
Ctrl+Q Remove Indent To remove the indent of a paragraph. 
Ctrl+R Align Right To align a paragraph on the right side of the page. 
Ctrl+S Save File To save a file. 
Ctrl+T Hanging Indent To increase the hanging indent of the paragraph. 
Ctrl+U Underline To underline a selected text. 
Ctrl+V Paste To add data stored in clipboard (memory) at the current 

cursor position. 
Ctrl+W Close Window To close the window. 
Ctrl+X Cut To remove the selected text from the document and place 

it in the clipboard (memory). 
Ctrl+Y Redo To re implement the last given command. 
Ctrl+Z Undo To remove the effect of the last given command. 
Ctrl+→ One word right To move the cursor one word towards its right. 
Ctrl+← One word left To move the cursor one word towards its left. 
PgUp Page Up To move document up by one screen. 
PgDn Page Down To move document down by one screen. 
Home Beginning of line To move the cursor to the beginning of the current line.sa 
End End of line To move the cursor to the end of the current line. 
Ctrl+Home Top of document To move the cursor to the beginning of the document. 
Ctrl+End End of document To move the cursor to the end of the document. 
Ctrl+Shift+D Double Underline To create double lines at the bottom of the selected text. 
Ctrl+Shift+W Word Underline To underline a word. 
Ctrl+Shift+A All Caps To convert the selected text to uppercase (capital). 
Ctrl+Shift+K Small Caps To convert the selected text to small caps. (example: 

HELLO WORLD) 
Ctrl+Shift  Superscript To convert the selected text to superscript (example: X2). 
Ctrl+= Subscript To convert the selected text to subscript (example: H2O). 
Ctrl+ 
Spacebar 

Erase formatting To remove the formatting of the selected text. 

Ctrl+Shift+> Increase font size To increase the font size of selected text. 
Ctrl+Shift+< Decrease font size To decrease the font size of selected text. 
Ctrl+1 Single line spacing To keep one line spacing between the lines of a selected 

paragraph. 
Ctrl+5 One and half line 

spacing 
To keep one and half line spacing between the lines of a 
selected paragraph. 

Ctrl+2 Double line spacing To keep double line spacing between the lines of a 
selected paragraph. 

Ctrl+Enter Page Break To start a new page at the cursor position. 
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Shortcut Key Command Use 
Ctrl+Shift+8 Show/Hide To make the formatting of characters visible or invisible. 
Ctrl+Alt+I Print Preview To see the view of the document before taking a print. 
Ctrl+Shift+G Word Count To count the number of characters, words, lines and 

paragraphs inserted in the document. 
Alt+Shift+D Today‘s Date To add today‘s date to the document. 
Alt+Shift+T Current Time To add current time to the document. 
Alt+Ctrl+V Paste Special To use the paste command with additional options. 
Alt+Ctrl+F Footnote To add a footnote to the document. 
Alt+Ctrl+D Endnote To add an endnote to the document. 
Alt+Ctrl+M Comment To add comment to the selected text. 
 

Table 1.1 Shortcut keys available in Microsoft Word 2010 
 

After discussing the basic functions and shortcut-keys used while creating a 
document, let us now learn about some special features provided by Microsoft Word. 
 

1.5 CHECK YOUR PROGRSS: POSSIBLE ANSWERS 
 

1. Create a word document that gives information about your village/city and 
save it with the name of your village/city. 
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Unit 2:  Formatting in Microsoft 
Word File 

  
 
Unit Structure 
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2.1 LEARNING OBJECTIVES 
 
After studying this unit student should be able to understand: 

 Add a cover page in Word 2010 file and change Page Layout. 
 Customize Word 2010 Ribbon. 
 Arrange Word 2010 file as per column. 
 Add a watermark to Word 2010 file. 
 Print Word 2010 file. 
 Add images and chart to Word 2010 file. 

 

2.2 INTRODUCTION 
 
In this part we are going to discuss how Formatting can be applied on a word file. 
Microsoft Word provides many options to do so. The document  can be made 
attractive using different available options. Let us discuss it in detail. 

 

2.3 FORMATTING IN MICROSOFT WORD FILE 

Word Wrap: Microsoft Word provides the facility to add an image along with the text. 
Word wrap command can be used to arrange the image in different ways. Let us 
learn Word Wrap facility using an example. 

 Open a new file and add two three paragraphs of text to it. Now, click the 
Insert option on the Ribbon and select Picture option from it. Performing this 
operation will present ‗Insert Picture‘ dialog box as shown in Figure 2.1. 

 
Figure 2.1 Adding Image using Insert Picture Dialog box 

 
 Select the desired image file and click on the Insert button. The image will be 

added to the document. Figure 2.2 shows a screen in which an image has 
been added to a document. 
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Figure 2.2 Adding Image within a Text in a document 

 
 The process of arranging the text around the image is known as Word Wrap. 

The default word wrap setting of an image is ‗In Line with Text‘. 

 By selecting the image, the Picture Tab on the Ribbon will be enabled, and 
Wrap Text button will now be visible. Using this button, other options of Word 
Wrap feature can be used. Alternatively, the Word Wrap submenu of the 
context menu that is obtained by right clicking on the image can also be used. 

 Table 2.1 below shows how to arrange an image around the text along with its 
different options, usage and example. 

Option Use Example 
In Line with 
Text 

To align the 
image in the line 
of text 

See Figure 2.2 

Square To align text 
around an image 
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Option Use Example 
Tight To align text 

tightly around an 
image 

 
Through To leave small 

amount of white 
space between 
the text around 
the image 

 
Top and 
Bottom 

To align the text 
above and below 
the image 

 
Behind Text To align image 

behind the  text  

 
In front of 
Text 

To align image in 
front of the  text 
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Option Use Example 
Edit Wrap 
Points 

To change the 
wrap points by 
using mouse 
clicks and 
aligning the 
image as per this 
wrap points 

 
 

Table 2.1 Options of Wrap Text 
 

 To use more settings of word wrap, the ‗Layout‘ dialog box provides ‗More 
Layout Options‘ which can also be used. It contains additional options of 
wrap text. 

Toggle Switches: Microsoft Word provides several other options for formatting 
which provide two states for the tool button-On and off. A button that can have ‗On‘ 
or ‗Off‘ state is known as a toggle switch. The ‗On‘ state shows the indication of the 
effect that has been applied, while the ‗Off‘ state displays the lack of the said effect. 
Table 2.2 below shows some of the important toggle switches available in Microsoft 
Word 2010 and their usage. 

Icon Name Use 

 
Format 
Painter 

To copy the formatting of a selected text and apply it to 
another text. 

 
Bold To make the selected text bold. 

 
Italic To make the selected text italic. 

 
Underline To underline the selected text. 

 
Strikethrough To strike the selected text. 

 
Subscript To write the selected text slightly below the line. 

 
Superscript To write the selected text slightly above the line. 

 
Highlight text To highlight the selected text. 

 
Bullets To apply bullets to the selected text. 

 

Numbering To apply numbering to the selected text. 

 

Show/Hide To make formatting characters visible or invisible. 

 

Border To apply borders to selected paragraph. 

Table 2.2 Toggle Switch 
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2.4 PAGE BREAK & COVER PAGE IN MICROSOFT WORD 
FILE 
 
Page Break: Microsoft Word 2010 allows us to add information in more than one 
page. When a new Word document is opened, we get a page of predetermined size 
(usually A4) on the screen. Sometimes it so happens that instead of using the whole 
page, we may leave some portion of the page blank and intend to add a new page at 
this pointer we may want to move the text added to the next page. The Page Break 
command can be very useful in such cases. To use this command following steps 
are required: 

 Set the cursor to the location where Page break (i.e., all the text is to be 
moved to the next page) in the document is to be added. 

 
Figure 2.3 Page Break Command 

 
 Select the Insert Tab on the Ribbon. Click on the Page Break option in it. A 

new page will be found added to the document. The text (if any) after the 
cursor will be seen positioned on the next page. 

Cover Page: Usually, the first page of any document is typically decorated. This 
page usually includes title of the document and author information. Microsoft Word 
2010 provides special facility to create a Cover Page. To add a cover page to a 
document you can perform the steps mentioned below: 

 Open the document in which the cover page is to be added. 

 Click on the Insert tab on the Ribbon and select the Cover Page option. This 
will open a menu as shown in Figure 2.4.  
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Figure 2.4 Cover Page 

 
 Select an appropriate template from the different templates displayed in the 

menu. By performing this operation, a new page with sample information can 
be found added in the beginning of the document. Figure 2.5 shows one such 
cover page. 

 
Figure 2.5 Cover Page Template 

 
 Sample data can be seen on the cover page as shown in Figure 2.5. This 

sample data is replaced with the actual data to prepare a cover page. A cover 
page designed with actual data is shown in Figure 2.6. 
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Figure 2.6 Cover Page after adding actual data 

 

2.5 CUSTOMIZING THE WORD 
 
The users can change or arrange most of the Microsoft Word 2010 options 
according to their needs. The look of the Word window that is favorable to us 
provides easy and quick access to our work. The next section discusses how to 
configure some options of Word program. 

 Customizing Quick Access Toolbar: As we already know, the toolbar on 
the left side of the topmost title bar in Microsoft Word 2010 window is known 
as the Quick Access Toolbar. By default it contains Save, Undo and Redo 
buttons. Perform the following steps to add or remove a button from the Quick 
Access toolbar. 

 Click on the Customize Quick Access Toolbar button visible on the right 
side of the Quick Access toolbar. By performing this, the menu as shown 
in Figure 2.7 will be presented. 

 
Figure 2.7 Customize Quick Access Toolbar 
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 The options that can be shown on the Quick Access toolbar can be 
seen in the menu shown in Figure 2.7. The options that have a tick 
mark in front are the currently available options on the Quick Access 
Toolbar. 

 By clicking on any of the options, they can be added or removed from 
the Quick Access Toolbar. 

 Customizing Ribbon: During the introduction of Word window, we saw that for 
creation of documents various options are available as buttons on different 
tabs, and the ribbon has been created with a group of such tabs. We can now 
add desired tab on the ribbon according to our convenience and can also add 
tool buttons for different options on this tab. The customized tab created by the 
user can make document creation easier and faster. The steps to add a new 
tab on the ribbon are mentioned below:  

 Click on the File tab and select ‗option‘. Word Options dialog box shown in 
Figure 2.8 will appear on the screen. 

 Several options for organizing the Microsoft Word program are given in the 
Word Options dialog box. Click on the Customize Ribbon option seen in 
the left panel. All options available to change the ribbon are displayed on 
the right side section of the dialog box as shown in figure 2.9. 

 To add a new tab to the ribbon click on the New Tab button at the bottom 
of the dialog box. By doing so, two new elements named New Tab 
(Custom) and New Group (Custom) will be added to the list on the button. 

 The name of the newly added tab can be changed using the Rename 
button. Here we have assigned My Tab as a new tab name. 

 
Figure 2.8 Word options dialog box 
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Figure 2.9 Customize Ribbon 

 
 Any option shown on the left side section of the dialog box can be 

added to the new tab. For this, choose the option that is to be added on 
the new tab and click on the Add button between the two lists. Here we 
have added New, Open, Save, and Cut Copy, Paste, Print Preview and 
Print options to a new tab named MyTab. 

 After adding a new tab, the Word Options dialog box will appear as 
shown in Figure 2.10. 

 
Figure 2.10 Word Option Dialog Box after Adding Desired Options 

 
 Click on the OK button to close the dialog box. A new tab with name 

MyTab will now appear on the Ribbon of the Word window. By clicking on 
it, we will see the tool buttons for the selected options, which can be used 
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when working with the document. The tab-MyTab and the tool buttons 
added by us are shown in Figure 2.11. 

 
Figure 2.11 The tab-Mytab with Tool Buttons 

 
 Page Options: Sometimes while creating a document, a need arises to 

change the options such as size, margins, orientation, etc., of the page. To 
perform any such action, Microsoft Word 2010 has been given the facility 
of Page Layout Tab. Various options to change document available in the 
Page Layout tab are mentioned below: 

 Themes: This option can be used to select different themes for the 
document. ―Theme‖ is a kind of template for the document that has 
arrangement for different colors and style. Figure 2.12 shows various 
themes available in Word 2010. By clicking on a theme, the document can 
be displayed according to the selected theme. To change the color, font 
and effect of the selected theme the Colors, Fonts and Effects menu 
adjacent to the theme can be used.  

 
Figure 2.12 Themes 

 Margins: This menu is used to change the size of the margins of the page in 
a document. The Margins menu contains several predefined margin names 
like Normal, Narrow, Moderate, Wide, etc. These are shown in Figure 2.13. 
By clicking on these names, required margins can be selected. 



94 
 

 
Figure 2.13 Margin Menu 

If a user wants to give margins as per his/her requirement then he/she can 
choose Custom Margins option given at the end of this menu. By doing this, a 
Page Setup dialog box is presented to the user. User can change the size of 
the margins as per the need. The Page Setup dialog box is shown in Figure 
2.14. 

 Orientation: By default the pages are arranged in a vertical manner. But if the 
width of the contents being added to the document is more, the page can also 
be arranged in a horizontal manner. To perform this operation, Orientation 
menu is used. Orientation menu as shown in Figure 2.15 provides two 
options: Portrait and Landscape which arrange the page in vertical or 
horizontal manner respectively. 

 

 

Figure 2.14 Page Setup Dialog Box Figure 2.15 Orientation 
 

 Size: This menu is used to determine the size of pages in the documents. By 
default the size of the page is defined as A4. This menu as shown in Figure 2.16 
provides other options to change the page size. 
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Figure 2.16 Size 

 
 Columns: Sometimes the user needs to arrange the information added to the 

document into more than one vertical row. You must have seen more than 
one vertical rows in the newspapers. This vertical row is called Column. The 
Columns menu option available in the Page Layout tab can be used to 
arraange the data in more than one column. The options available in Column 
menu are shown in Figure 2.17. Figure 2.18 shows a document view in which 
the information is divided in three columns. 

  
Figure 2.17 
Columns 

Figure 2.18 Information divided in three columns 

 

 Breaks: The options like Page Break, Column Break, etc., used to take 
information on one page or column to another page or column are given in 
this menu. 

 Line Numbers: Using this option the pages in the document can be given 
numbers. 

 Hyphenation: This option is used to decide whether the word at the end of 
the line is to be broken or moved to a new line. 
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 Page Color: This option is used to change the color of the page. 

 Page Border: This option is used to add borders to all the pages in a 
document. By clicking this option, a Border dialog box as shown in Figure 
2.19 will be seen. A page can be given different types of borders by using the 
options in this dialog box. 

 

Figure 2.19 Page Border dialog box 
 
 

 Watermark: The watermark effect is used to add distinct text or image as a 
background in the information added to all the pages of a document. At times, 
this effect is also known as Hologram. Generally, the watermark is used to 
show the ownership of the information in the document. Use of watermark 
stops unauthorized user from copying the document.  

Microsoft Word 2010 not only provides the feature of page with predefined 
watermark but also allows a user to create a watermark and add it to a 
document. The steps to use the watermark are mentioned below: 
 
 Open the document in which the watermark is to be added. The document 

may be blank or it is possible that it has text in it. 
 Click on the Watermark menu available in Page Layout tab. The options 

shown in Figure 2.20 will be visible after performing this operation. 
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Figure 2.20 Watermark Menu 

 Selecting any of the options given in the watermark menu will add the 
effect of that watermark in the current document. 

 It is possible to change the watermark as per our requirements. To 
perform this operation click on the Custom Watermark... option in the 
Watermark menu. This option presents a Printed Watermark dialog box. 

 Two options namely Picture Watermark and Text Watermark are available 
in this dialog box. For example, to add a text Dr. Babasaheb Ambedkar as 
a Watermark in our new document, the options as shown in Figure 2.21 
can be selected. 
 

 

 

Figure 2.21 Printed Watermark Dialog Box 
 Once all the information is added, click on the OK button. The watermark 

added in the new document is as shown in Figure 2.22. 
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Figure 2.22 New documents with watermark 

 
Spelling and Grammar: It is always desired that the contents of a document should 
be free from spelling and grammatical mistakes. Microsoft Word 2010 provides the 
feature to identify and correct the spelling and grammatical mistakes in a document. 
This feature is enabled as soon as the document creation starts, and every word that 
is typed as well as every sentence that is formed is checked for spelling and 
grammar mistakes. For performing this operation, Word uses its predefined 
Dictionary. The spelling mistakes are shown using a red underline and the 
grammatical mistakes are shown using a green underline.  
The mistake found by Word can be easily corrected. Word gives suggestions for the 
mistakes that it has found. To see the suggestions, right click on the text. Performing 
this action opens a context menu as shown in Figure 2.23.  

 
Figure 2.23 Spelling Correction 

 
As can be seen in the figure, there is a red underline under the word ‗organizing‘. 
This indicates a spelling mistake. The context menu opened by right clicking on the 
text suggests the correct spelling 'organizing' available in Word dictionary. The 
following tasks can be performed by using this menu: 



99 
 

 The correct suggestion is accepted by clicking on it. Thus the text in the 
document is replaced with this text. 

 By selecting the Ignore option, the mistake identified by Word can be ignored.  

 By selecting Ignore All option, mistakes due to a particular word in the entire 
word document are ignored and the red underline under each occurrence of 
that word disappears. 

 By selecting Add to Dictionary option, the text can be added into the dictionary 
of Word. Then on, Word considers this text as correct. 

Once the document is ready the Spelling & Grammar option on the Review tab can 
be selected to check and correct all the spelling and grammar mistakes. 
Alternatively, a shortcut key F7 can also be used to perform this action. This 
command finds the spelling and grammar mistakes in the document one by one and 
opens the Spelling & Grammar dialog box as shown in Figure 2.24 to correct it. 

 
Figure 2.24 Spelling & Grammar dialog box 

 
Using the options shown in the dialog box, the mistake can be corrected or ignored 
and new words can be added into the dictionary. 
Document Views: Microsoft Word 2010 provides facility to view a document with 
different viewing options. This feature is known as Document Views. The document 
views along with its features provided by the Word are mentioned below: 

 Print Layout: This view shows the look of the document when it is going to 
be printed. This view shows the real-time appearance of the document. In this 
view the margins, page break and other components of the document are 
displayed on the screen. 

 Full Screen Reading: This view becomes important when only details of 
document are to be read. In this view, whole document is displayed on the 
screen and title bar, ribbon, margins, ruler and other such components are 
made invisible from the screen. Esc key can be used to close this view. 
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 Web Layout: Word also provides a feature of saving a document as a web 
page. This file is stored in form of HTML. But while creating the document if a 
need arises to see how this page is going to look on a web browser then this 
view is used.  

 Outline: This view is used to display only text that has been added to the 
document. In this the titles of the document (Headings) and its subtitle 
(Subheadings) are displayed as a list, and pictures within the document are 
not displayed. This view is best used to change the order of details added to 
the document. To perform this operation, the bullet point before the detail to 
be rearranged is clicked and dragged to a new location. 

 Draft: This view is used to show the document after removing images, 
column, header, page break and other such components. 

All these views can be used in two ways: 
1. By using View tab available on the Ribbon. (See Figure 1.14) 

2. By using the icon at the bottom right side of the Word window. (See Figure 
1.17) 

Zoom: The zoom command is used to see the information within a document with 
different resolutions. The effect of this command is applicable only on that particular 
screen and the same effect cannot be obtained on the printed version of that 
document. To use the zoom command, the Zoom button on the View tab needs to be 
clicked. By performing this action, a Zoom dialog box as shown in Figure 2.25 will be 
displayed.  

 
Figure 2.25 Zoom dialog box 

 
The Zoom dialog box shows the current zoom level of the document. If needed, this 
can be changed as per our requirement. The zoom level is shown in percentage. As 
shown in the figure, zoom level of 200%, 100% or 75% can be chosen. For all other 
levels a number needs to be entered in the Percentage text box. It is also possible to 
increase or decrease the percentage level. 

 Page width option when selected sets the zoom level of the document as per 
the width of the page.  

 Text width option when selected sets the zoom level of the document as per 
the text width within the document.  
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 Whole page option displays the entire document along with all its information 
on a screen. 

 When more than one page is to be displayed on a screen, the Many Pages 
button is clicked. From the menu that opens up the number of pages are 
selected.  For example, if three pages are selected then the view of the 
document is as shown in Figure 2.26. 

 

 
Figure 2.26 Zoom level that shows three pages 

 
Compatibility Mode: The files created in the older version of Microsoft Word can be 
opened in Microsoft Word 2010. When a file saved in the older version of Word is 
opened in the latest version of Word, some special features available in this version 
are not applicable to the information stored in that file. Microsoft Word 2010 displays 
[Compatibility Mode] on the title bar of such documents, which enables the user to 
realize that the currently opened file was saved in the older version of Word. 
 
Backup options: When the information is stored in a digital format, its security 
becomes a very important aspect. If the saved file cannot be opened due to some 
reasons, there is a major loss of data. At times, there is a possibility that the saved 
file is harmed either accidently or deliberately. If the file stored on the computer 
cannot be retrieved, one might have to face many difficulties. 
 
This type of problem can be solved by using the backup feature available in 
Microsoft Word 2010. The process of storing the information in the traditional storage 
medium as well as some another safe place is known as ‗backup‘. The backup 
feature available in Microsoft Word stores the file created by the user at some 
predefined place without the knowledge of the user. Accidentally if the original 
document gets damaged, the copy of the document stored in this place can help 
getting the original information back. The location of the backup can be changed by 
using the steps mentioned below: 

 Click on the Option button of File tab. 
 Click on the ‗Advanced‘ option available in the left panel of the Word Options 

dialog box. Scroll down the options visible in the right panel till ‗Save‘ section 
is visible on the screen. See Figure 2.27. 

 Select the check box in front of the option ‗Always create a backup copy‘ in 
this dialog box. By performing this action, whenever a file is saved its backup 
copy is automatically created. 

 If the file has been opened from network, its backup can also be created by 
selecting the check box in front of the option ‗Copy the remotely stored file 
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onto your computer, and update the remote file when saving‘. 
 

 
Figure 2.27 Advanced Save Options 

 
Document Inspector: By using the Document Inspector feature provided by 
Microsoft Word 2010, the hidden contents and personal information in a document 
can be checked. As a document can be used by more than one author, generally it is 
better to perform this check before sending it to another place electronically. The 
steps mentioned below need to be followed to get the document checked by the 
Document Inspector. It is advisable to take a backup of the original document before 
using this command.  

 Open the document that is to be inspected. 
 Click on the ‗Check for Issues‘ button of Info menu available on File tab. 
 Click on the Inspect Document option from the menu opened using 

previous action. A dialog box as shown in Figure 2.28 will be displayed on 
the screen. 

 
Figure 2.28 Document Inspector dialog box 

 
 As shown in the figure Document Inspector allows checking of six different 
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aspects. 
 To start the inspection click on the Inspect button. 
 Word inspects the document and shows the result which can be similar to the 

one shown in Figure 2.29. 

 
Figure 2.29 Result shown by Document Inspector 

 
 The result shows that the document contains hidden text. By clicking on the 

Remove All button this text can be removed from the document. 
 

2.6 PRINTING OF DOCUMENT IN MICROSOFT WORD 
 
Printing of Document: When the document is saved, it is stored on hard disk or 
some electronic storage similar to it. Most of the documents after being stored need 
to be printed on paper. The document printed on paper is known as a hardcopy. To 
print a document an output device named printer is used. Once the document is 
ready, the steps mentioned below will enable you to take a printout of the document.  

 After the document is created, click on the Print option in the File tab 
alternatively, the shortcut key CTRL + P on the keyboard can also be used. 
The Print dialog box as shown in Figure 2.30 will be displayed on the screen. 
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Figure 2.30 Print dialog box 

 
 By clicking on the Print button available in the Print dialog box, printing of the 

document will get started as per the predefined settings of the document and 
the printer.  

 A list of the printers installed on the computer system is shown in the Printer 
section visible below the Print button. Desired printer can be selected from 
this list. 

 To change the properties of the installed printer, the Printer Properties link 
can be used. Figure 2.31 shows the dialog box with Printer Properties. Note 
that this dialog box may vary as per the printers installed in the computer 
system. 

 

 
Figure 2.31 Printer Properties dialog box 

 
 This dialog box is used to set the page size, source, printing quality, and other 

effects of printing. 
 Page numbers are entered in the Pages textbox of the Settings section within 
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the Print dialog box to instruct which pages of the documents are to be 
printed. The Print All Pages button can be used to print all the pages of the 
given document. 

Document Properties: „Document properties‘ option is used to get details of 
properties of the document prepared in Microsoft Word 2010. The details of the 
current document are given on the right side of the screen opened by clicking on the 
File tab. Figure 2.32 shows one such sample. 

 
Figure 2.23 Document Properties 

 
As shown in the figure the following document information is shown in the Document 
Properties: 

 Size of the document. 
 Total pages and words in the document. 
 Total editing time of the document. 
 Title and Tag of the document. 
 Comment. 
 Document creation date. 
 Last modified date of the document. 
 Last printed date of the document. 
 Author of the document. 
 To get more information you can click on the All Properties link. 
 

2.7 TYPOGRAPHY IN MICROSOFT WORD FILE 
 

Typography: When a word processor such as Microsoft Word is used, the text 
inserted in the documents can be displayed with different types of characters. 
Characters can be represented by different typeface, font and size. 
A set of characters such as Times, Arial, Courier, etc., with same appearance is 
known as typeface. This typeface is called ‗font‘ and has styles and sizes. Italics, 
Bold and Underlined characters may be included in the font style. The size of 
character is represented by the unit called Point. 
Font typefaces can be divided into two categories: Serif and Sans Serif. The 
characters in Serif type font have little decoration at the ends. Times, Bookman, 
Century, etc., are Serif type fonts. If document is to be printed, such fonts are easier 
to read. In French language Sans means ‗without‘. Sans Serif fonts are without 
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decoration. Arial, Verdana, Helvetica, etc., are the examples of  Sans Serif font 
types. Usually these type of fonts are used in the title of the documents. Figure 2.33 
shows an example of Serif and Sans Serif font types. 

 
Figure 2.33 Serif and Sans Serif fonts 

 
Font Attributes: It is possible to make the document attractive by changing different 
characteristics of the fonts. Many features of font are provided on the Home tab of 
the ribbon. To obtain all the features of fonts at once the Font dialog box is used.  
The steps mentioned below can be used to open the Font dialog box. 

 
Figure 2.34 Font dialog box 

 
 Click on the buttons besides the Font group on the Home tab. 
 Press Ctrl+Shift+F on the keyboard. 
 The Font dialog box as shown in Figure 2.34 will be displayed on the screen.  

 
The facilities provided in this dialog box are listed below. Before applying any of the 
effects from this dialog box, one should remember that the text in the document 
needs to be selected first.   

 Font: The names of all the fonts available in the Windows Operating System 
are shown in this drop style down menu. When any font is selected, a sample 
text is shown using characters of this font within the Preview section.  Times 
New Roman, Arial, Calibri, Verdana, etc., are few commonly used fonts that 
can be selected from this section. 
 

Microsoft Word  Microsoft Word  
Serif Font    Sans Serif Font 
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 Font Style: This selection box is used to change the style of fonts in the 
selected text. In this if bold style is selected, the characters become dark, and 
if Italic style is selected the characters get slightly skewed. The characters 
become more eyes catching when font style is used. Hence, generally its 
effect is applied to text added as title. 
 

 Size: This option is used to decide the size of the characters. Generally to 
differentiate the title and the normal text from each other different text sizes 
are used. 
 

 Font Color: The font color option is used to change the colors of the selected 
characters. Different font colors can be selected by clicking on the Font Color 
drop down menu. To get the shades other than the ones given in the palette, 
click on the More Colors link. It should be noted that a printout taken with the 
help of a color printer will only show the effect of different colors used. So, a 
color printer is required to take out such a printout.   
 

 Underline Style: This option is used to create different types of underlines 
under the selected text. Different underline styles like Words only, single, 
double, dash, etc., can be selected from this drop down menu. 
 

 Underline Color: This palette provides a variety of colors which can be used 
to underline the text. 
 

 Effects: The selected text can be given the effects as mentioned below: 
 Strikethrough: To draw a horizontal line on the characters. 
 Example: Microsoft Word 
 Double strikethrough: To draw two horizontal lines on the characters. 
 Example: Microsoft Word 
 Superscript: To write the characters slightly above the line. 
 Example: 1st, 2nd, 3rd, X2 
 Subscript: To write the characters slightly below the line. 
 Example: H2O, X2 
 Small caps: To write all characters in capital letters, with the first 

character of the word being slightly bigger than others. 
 Example: MICROSOFT WORD 
 All caps: To write all characters in capital letter. 
 Example: MICROSOFT WORD 
 Hidden: To make the selected characters invisible. 
 

The above options are available under Font tab in the Font Dialog Box. By clicking 
on the nearby advanced tab, the look of the dialog box will appear as shown in 
Figure 2.35. 
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Figure 2.35: Advanced tab of Font dialog box 

 
 Scale: This option is used to change the width of the selected 

characters. By default the scale value is set to 100%. The value greater 
than default increases the width of the characters while value less than 
the default narrows down the width of the characters. 

 
Figure 2.36 Scales applied to characters 

 
 Character Spacing: This option is used to control the space between 

the characters of selected text. Three sub options are available in this 
drop down menu: 

 Normal: Indicates default space between characters. 
 Expanded: Indicates slightly more space than default between 

characters. 
 Condensed: Indicates slightly less space than default between 

characters. 
Figure 2.37 shows an example of all the three different types of spacing. 

 
Figure 2.37 Spacing applied to characters 
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Change Text Case: At times there is a need to change the case (capital/small) of 
the text after it has been inserted in the document. Microsoft Word 2010 provides a 
feature called Change Case to perform such action; it saves the effort of removing 
and rewriting the entire text again. The Change Case menu is available in Home tab. 
Figure 2.38 below shows five options available to change the case of the text 
inserted in a document. 

 
Figure 2.38 Options of Change Case menu 

 
 Sentence case: To make the first character of the selected text capital. 
 Lowercase: To make all the characters of the selected text small. 
 UPPERCASE: To make all the characters of the selected text capital. 
 Capitalize Each Word: To make the first character of all the words in the 

selected text capital. (It is also known as Title Case.) 
 TOOGLE CASE: To invert the case of all the characters in a selected text, 

that is used to change capital letters to small and small letters to capital. 
  

Figure 2.39 shows example of the five cases. 

 
Figure 2.39 Change Case 

 
Text Highlighting: At times certain text being important needs to be highlighted 
within a document. The highlighted text becomes more eye-catching within a 
document. Microsoft Word 2010 provides a feature of highlighting text with different 
colors. Perform the steps mentioned below to highlight the desired text: 

 Select the text within the document. 
 Click on the Text Highlight Tool available on the Home tab. This opens a 

menu with different colors. See Figure 2.40. 
 Select a color in the menu and click on tithe selected text will now be 

highlighted with this color. 
 To remove the effect of the highlight, select the No Color option from the 

menu. 
 If Highlight Color is selected without selecting the text, all the text that is 

selected later is highlighted with the said color. To stop this process, Esc key 
can be pressed or Stop Highlighting option can be selected from the highlight 
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menu. 

 
Figure 2.40 Text Highlight Color 

 

2.8 PARAGRAPH FORMATTING IN MS WORD 
 

 
Figure 2.41 Paragraph Formatting 

 
The names and usage of all the tools available in the Paragraph Group are shown in 
Table 2.3.  
 

Icon Name Use 

 
 

Bullets This option is used add an unordered list. It is possible to select the 
bullet sign that is to be displayed in front of the list by clicking on the 
arrow sign besides this tool button. See Figure 2.42 

 
Figure 2.42 Bullets 

 

Numbering This option is used add an ordered list. It is possible to select the 
number style that is to be displayed in front of the list by clicking on 
the arrow sign besides this tool button. See Figure 2.43 
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Icon Name Use 

 
Figure 2.43 Numbering 

 

Multilevel 
list 

This option is used to add a multilevel list to a document. This 
tool plays an important role when adding Hierarchical lists that 
contain points and sub points.  To select the number style that 
is to be displayed in front of the points and sub points in the 
list, click on the arrow sign besides this tool button. See Figure 
2.44 

 
Figure 2.44 Multilevel List 

 

 
Decrease 
Indent 

This option is used to move all the contents of the paragraph to a 
predefined distance on the left side.   

 

Increase 
Indent 

This option is used to move all the contents of the paragraph to a 
predefined distance on the right side.   

 
Sort This option is used to arrange the tabular information in a 

sequential order. When this tool button is clicked a Sort dialog 
box as shown in Figure 2.45 gets displayed on the screen. 
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Icon Name Use 

 
Figure 2.45 Sort Dialog Box 

 
Using the Sort by drop down menu of this dialog box, the field 
name of the information that is to be arranged sequentially is 
selected. Selecting the Ascending option arranges the 
information in an increasing order whereas Descending option 
arranges the information in a decreasing order. A multilevel 
sorting can be obtained by selecting the Then by option. It 
means that for the similar first fields the sorting is done based 
on the information in field that follows it. 

 

Show/Hide While formatting the document as per our requirement, Microsoft 
Word program inserts some white spaces in between the text. Using 
this button, it becomes possible to view different white spaces 
inserted between the texts. For example, normal space is 
represented by a dot and a tab space is represented by an arrow 
sign. It is necessary to note that while printing the document they are 
not displayed on the paper. 

 

Align Text 
Left 

This button is used to arrange all text toward the left side with 
respect to the ruler.  

 
Centre This button is used to arrange all text in the centre with respect 

to the ruler.  

 
Align Text 
Right 

This button is used to arrange all text towards the right side 
with respect to the ruler.  

 
Justify This button is used to arrange all text with equal spacing 

towards left and right side with respect to the ruler.  

 

Line and 
Paragraph 
Spacing 

This option is used to control the spacing of lines in-between 
the lines of the paragraph. By default the line spacing value is 
set to 1.15. This is known as single line spacing. To increase 
the spacing between the lines, values such as 1.5, 2.0 or 
greater are chosen. To get more paragraph arrangement 
options click on the Line Spacing Options... given in the menu. 
The Paragraph dialog box as shown in Figure 2.46 will 
displayed on the screen.    
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Icon Name Use 

 
Figure 2.46 Paragraph dialog box 

 
With the help of Indentation section provided in this dialog box 
following paragraph arrangements can be selected: 
 
Left Indent:  To move all the lines in the paragraph towards 
right side from the left side ruler. 
 
Right Indent:  To move all the lines in the paragraph towards 
left side from the right side ruler. 
 
Special: 
First line: To move only the first line of the paragraph towards 
right side from the left side ruler. 
 
Hanging: To move all the lines of the paragraph accept the 
first towards the right side from the left side ruler. 

 

Shading This option is used to fill the background Colour in the 
paragraph. Many colours are shown in the menu that can be 
selected by clicking on the arrow sign besides this button.  See 
Figure 2.47 

 
Figure 2.47 Shading Menu 

 
When any colour is selected from the menu, it becomes 
applicable as a background to the current paragraph. By 
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Icon Name Use 
selecting More Colours... option additional colour shades can 
be obtained, and by selecting No Colour option, it is possible to 
remove the background colour applied to the paragraph. 

 
Border This option is used to apply borders around the selected paragraph. 

The menu displayed by using this tool button is shown in Figure 2.48.  
 
As shown in the figure, it is possible to apply different types of 
borders to a selected paragraph or table. The No Border option 
removes the border applied to the paragraph. To apply border around 
all the four sides of the paragraph, the All Borders options is used. 

 
Figure 2.48 Border Menu 

Table 2.3 Paragraph Formatting 
 

2.9 TAB FORMATTING IN WORD 
 

Set Tabs: The word „tab‘ has been derived from the word ‗table‘. The tab facility is 
used when the information in the document needs to be arranged in a columnar form 
similar to tables. We have already seen that when a tab is arranged on ruler, it is 
possible to make the cursor directly jump on it by pressing the tab key on the 
keyboard. (See Figure 1.15) 
Microsoft Word 2010 provides five types of tab facilities. To change the type of tab, a 
mouse click needs to be pressed on the left hand side of the Horizontal ruler 
available in the Word window. The names, usage and examples of tabs available in 
the Microsoft Word are as shown below: 
1. Left Tab: By using this tab, the text is arranged towards the right side of the tab 
stop. 
For example, 
 Hello Friends 
 This is a demonstration of  
 Left tab stop. 
 
2. Right Tab: By using this tab, the text is arranged towards the left side of the tab 
stop. 
For example, 
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 Hello Friends 
 This is a demonstration of 
 Right tab stop. 
 
3. Center Tab: By using this tab, the text is arranged in a manner that it remains in 
the center of the tab stop. For example, 
 Hello Friends 
 This is a demonstration of 
 Center tab stop. 
 
4. Decimal Tab: This tab is used especially to add decimal numbers. By using this 
tab, all the decimal numbers that are added are arranged as per the decimal point. 
For example, 
 12.34 
 12345.67 
 0.1234 
 -5.234 
 
5. Bar Tab: By using this tab, a vertical line is inserted between two columns in a 
document. This tab is used to separate text using a vertical line. For example, 
   This is   this is 
   First column.  Second column. 
 
To remove any kind of Tab, the Tab sign on the ruler line is dragged using the ruler. 
 

2.10 BORDERS AND SHADING IN WORD 

 
Figure 2.49 Border and Shading dialog box 

 
Borders and Shading: In the previous discussion we have already seen how to 
apply border and background color to the selected paragraph. To perform this action, 
the Border and Shading menus on Home tab are used. To get more options about 
border as well as shading, click on the Border and Shading... option available in the 



116 
 

Border menu on Home tab.  On performing this action, a Border and Shading dialog 
box will be displayed on the screen as shown in Figure 2.49. 
The Border and Shading dialog box is divided into three sections: 

 Borders: Using this section Box, Shadow and 3D type of borders can be 
applied to a paragraph. To select different styles of borders the Style box is 
used. To select color and width of the border the Color and Width menu is 
used respectively. The look of the selected border can be seen in the Preview 
section. 

 Page Border: The Page border section is used to apply borders to the entire 
page. The Page Border tab has been shown in Figure 2.50. 
 

 
Figure 2.50 Page Border Tab 

 
As seen from the figure, the options given in Page Border tab are similar to 
the options given in the Border tab, but the effect of the options given in this 
tab are applicable to the entire page. Over and above, an Art border option is 
also given in this section, using which some attractive borders can be given to 
a page. 

 Shading: The third section of the Border and Shading dialog box is shading, 
using which background color can be applied to a page. Figure 2.51 shows 
the Shading tab. 
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Figure 2.51 Shading Tab 

 

2.11 BULLETS AND STYLES IN WORD 
 

Bullets and Numbering: Creation of a list is a normal process while creating a 
document. Microsoft Word 2010 provides features to create two types of lists: 
Unordered (Bulleted) and Ordered (Numbered).The information about both the lists 
are given in Table 2.3. 
The unordered list can be created using the Bullet menu available in the Home tab 
as shown in Figure 2.42. To get additional bullets, other than those available in the 
menu, click on the Define New Bullets... link. This action will open a Define New 
Bullet dialog box as shown in Figure 2.52.  

 
Figure 2.52 Define New Bullet dialog box 

 
Click on the Symbol button of this dialog box to get additional signs as bullet options. 
A Symbol dialog box as shown in Figure 2.53 will be displayed, wherein different 
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fonts can be selected and an appropriate symbol from the available symbols can be 
chosen as a bullet symbol.   

 
Figure 2.53 Symbol dialog box 

The ordered list can be created using the Numbering menu available in the Home 
tab. Generally, the order of all the components given in the ordered list is of utmost 
importance. The method to add an ordered list is shown in Table 2.3. (See Figure 
2.43) 
In Microsoft Word, it is possible to change the default numbers of an ordered list in a 
document. To do this a Define New Number Format dialog box as shown in Figure 
2.54 can be opened by clicking on the Define New Number Format... link in the 
Numbering menu. This dialog box can be used to prepare an ordered list with 
different number styles. 

 
Figure 2.54 Define New Number dialog box 

Another list can also be added within an ordered list which is known as a multilevel 
list. The method to create a multilevel list is shown in Figure 2.54. 
Style: We have already learnt about the different ways used to apply formatting to 
the text in Microsoft Word 2010. For faster creation of professional documents, Word 
provides some predefined formatting known as ‗Styles‘.  Using styles the text in a 
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document can be uniformly formatted using lesser efforts. The different styles that 
can be applied to text are available in Home tab. This is shown in Figure 2.55. 

 
Figure 2.55 Style 

Users can also create a new style as per their requirement. The Change Style menu 
available in the Home tab can be used to change the selected style. Table 2.4 shows 
examples of some predefined styles. 
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 Table 2.4 Different Styles 

 

2.12 GRAPHICAL OBJECTS AND CHARTS IN MAS WORD 
 
Graphical Objects: The adage ‗A picture is worth thousand words‘ refers to the 
notion that a complex idea can be easily conveyed by a single image. People always 
prefer to view images instead of reading long text. The document‘s informative 
capability and attractiveness can be increased by adding information in form of an 
image. It is possible to add many different types of graphical objects in Microsoft 
Word 2010.The section below introduce them. 

 Picture: Using this option the images that have been stored in a form of a file 
can be added to a document. By clicking on the Picture button, available in 
Insert tab, an image that has been stored as a file can be added. As shown in 
Figure 2.1, by clicking on the Insert button the selected image can be inserted 
in a document. 

 Clip Art: Microsoft Word 2010 contains a library of some predefined images 
known as ClipArt Gallery. The ClipArt Gallery can be opened by clicking on 
the Clip Art button available on Insert tab. performing this action a ClipArt 

Style Example 
Normal The quick brown fox jumps over the lazy dog. 
Heading 1 The quick brown fox jumps over the lazy dog. 
Heading 2 

The quick brown fox jumps over the lazy dog. 
Heading 3 

The quick brown fox jumps over the lazy dog. 
Heading 4 

The quick brown fox jumps over the lazy dog. 

Heading 5 
The quick brown fox jumps over the lazy dog. 

Title 

The quick brown fox jumps over 
the lazy dog.  

Subtitle The quick brown fox jumps over the lazy dog.  
Subtitle 
emphasis 

The quick brown fox jumps over the lazy dog. 

Emphasis  The quick brown fox jumps over the lazy dog. 
Intense 
emphasis 

The quick brown fox jumps over the lazy dog. 

Strong The quick brown fox jumps over the lazy dog. 
Quote The quick brown fox jumps over the lazy dog. 
Intense quote 

The quick brown fox jumps over the lazy dog. 

Subtle 
reference 

THE QUICK BROWN FOX JUMPS OVER THE LAZY DOG. 

Intense 
reference 

THE QUICK BROWN FOX JUMPS OVER THE LAZY DOG. 

Book title THE QUICK BROWN FOX JUMPS OVER THE LAZY DOG. 
List paragraph The quick brown fox jumps over the lazy dog. 
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Gallery as shown in Figure 2.56 will be displayed on the right side of Word 
window.  

 
Figure 2.56 ClipArt Gallery 

 
To search an image of a particular subject, type the keyword in the Search for 
text box of the ClipArt Gallery. For example, here we have used Animals as 
keyword and pressed Enter key. The images related to animals can be seen 
in the ClipArt Gallery. Any image can be inserted in a document by clicking on 
it. 

 Shapes: Microsoft Word 2010 has a facility to add different type of shapes in 
a document. Place the cursor at the position where the shape is to be inserted 
in the document and click on the Shapes button available in the Insert tab. 
Many shape options in form of different menus will be visible as shown in 
Figure 2.57.  

 
The steps to add different shapes in the document are as mentioned below: 

 From the menu shown in Figure 2.57 click on the desired shape. 
 Drag the mouse pointer on the position where the shape is to be 

inserted in the document. 
 Release the click to stop the process of inserting the shape. The shape 

will be inserted in the document as shown in Figure 2.58. 
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Figure 2.57 Different Shapes 

 
  To change the size of the inserted shape, the white edit points on the 

boundary can be dragged using the mouse pointer, and with the help of 
yellow-colored edit points, the style of the shape can be changed. The 
green-colored edit point is used to rotate the shape. 

 
Figure 2.58 Edit Points 

 
 SmartArt: To add non sequential components in a document, Microsoft Word 

2010 provides shapes known as Smart Art. It is possible to add text within this 
shape. The dialog box that shows different types of Smart Art can be opened 
with the help of SmartArt button available in the Insert tab. As shown in Figure 
2.59, the desired SmartArt can be selected and inserted in a document. 
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Figure 2.59 Smart Art 
4. Chart: Sometimes a graph is used to compare the information stored as text. 

To add a chart in the document, the Chart button available in the Insert tab 
needs to be clicked. On performing this action, Insert Chart dialog box will be 
displayed on the screen, which contains different graphs as shown in Figure 
2.60. 
 

 
Figure 2.60 Insert Chart dialog box with different graphs 

 
By selecting the desired graph and clicking the OK button, Microsoft Excel 
2010 program is opened  for a temporary period, and it is possible to see 
sample information needed to create a graph. This information can be 
replaced with our original information. For example, here we have created a 
graph that shows the sales of hardware items for a period of three months as 
can be seen in Figure 2.61. 
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Figure 2.61 Graph showing sales of hardware items in three months 

 

2.13 CHECK YOUR PROGRESS: POSSIBLE ANSWERS 
 

1. Add an image of your village or city in the previously created file. 
2. Arrange the image using different Wrap Text options. 
3. Add a cover page to your file. 
4. Change the look of your previously created file by applying different themes to 

it. 
5. Add page border to your file. 
6. Add your name as watermark in the previously created file. 
7. Correct the spelling mistakes in the file. 
8. Set your file in a manner such that its backup copy is created. 
9. Take the printout of the file created by you. 
10. Convert the fonts of the file created by you to ‗Tahoma‘. 
11. Change the Color of one of the paragraphs to red. 
12. In the file created by you, add a list of sightseeing places of your village using 

Bullets. 
13. Align the text in your file as Justify. 
14. Use a symbol as a bullet and create the list of sightseeing places of your 

village. 
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Unit 3:  Advance Formatting in 
Microsoft Word File 
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3.11. Convert Table to Text in Word 
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3.1 LEARNING OBJECTIVES 
 
After studying this unit student should be able to understand: 

 How to use a table, 
 How to add or update a table, 
 How to arrange the table data in a specific order and  
 How to use mail merge. 

 

3.2 INTRODUCTION TO TABLE IN WORD 
 
Table is a 2-dimensional structure. Width and height are the two dimensions of the 
table. The data can be arranged in a tabular format within the table. This tabular 
format can be details of employees in an organization, credit and debit details of an 
event, mobile numbers and email ids of friends, etc. The data present in the tables is 
easily readable. Hence it also improves the look of the document.  
The horizontal lines in the tables are known as Rows whereas the vertical lines are 
known as Columns. Blocks formed by intersection of row and column are known as 
Cells. To enter data in a table, it is to be written in the Cell. The figure below shows a 
table. 
 

 
Figure 3.1 Table 
 

In Table 3.1, First Name is the first column, Last Name is the second column, DOB 
(short form of Date of Birth) is the third column, City is the fourth column and Mobile 
No. is the fifth column. 
Akhil Dave 12/1/1990 Rajkot 1234567890 is the first row. Similarly, 
Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 is the second row. 
The student name Akhil is written in the intersection of first column (First Name) and 
first row.  
Hence, it can be said that Akhil is written in the first cell. Generally, the cell is 
recognized by its cell address. The column name is generally written using alphabets 
while a row name is written using numbers.  
Hence, column names can be A, B, C, etc., and row names can be 1, 2, 3, etc. In 
Table 3.1, Akhil can thus be considered as written in cell A1. Only one type of 
information should be entered in the cell so that the table can be used effectively for 
counting and analysis.  
 

3.3 CREATING A NEW TABLE IN WORD 
 
To add a table in the word document, the Insert tab available on the Ribbon is used. 
By clicking on the Insert tab, options shown below are obtained. 
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Figure 3.2 Insert tab 

 
The Table icon arrow is clicked to insert a table. Word gives us the following options 
to create a table: 

 
Figure 3.3 Table options of Insert tab 

 
To create a table, the Insert Table... option can be clicked or rows and columns 
under the Insert Table option can be selected. 
If the table is selected using the mouse movement then it will be visible as shown in 
Figure 3.4. 

 
Figure 3.4 3×3 Table 

When the Insert Table... option of Insert tab is used, it opens an Insert Table dialog 
box. This dialog box is used to decide the number of columns and rows that will be a 
part of the table. It is also possible to increase or decrease the number of rows or 
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columns once the table is created. To decide the table size, it is possible to enter the 
number of columns required in the Number of Columns text box. The spinner control 
can also be used to decide number of rows and columns in a table. 
 

 
Figure 3.5 Adding Table 

Insert Table dialog box has two main sections. The two main sections are: 
1. Table size  
2. AutoFit behavior 
With the help of Table size, it is possible to create a table with number of rows and 
columns depending on our needs. Once the table is created, the rows and columns 
can be increased or decreased as per our needs. 
AutoFit behavior provides the feature of arranging the text within the cells. Fixed 
column width means that the column width is predefined. With the help of spinner 
control given besides the Fixed Column Width text box, it is possible to set a fixed 
column width, or we can also enter the value of the width in the spinner control. If the 
Fixed Column Width is set to auto, the width of the column can increase or decrease 
as per the contents of the text. Auto usually means that the width of all the columns 
will not be the same. It is possible that the width of all the columns may be the same 
or different. The column width does not change until we change the values in the 
Fixed Column Width.  
AutoFit to contents option changes the cell width automatically as per the contents 
of the text. 
AutoFit to window option increases or decreases the column width and fits the 
table in the Window. The AutoFit to window option is a good choice when multiple 
users are going to view the table, as the screen size of the users may vary. 
Additionally, there is one check box. If this checkbox is checked and OK button is 
clicked, Word will remember the size (in form of row and column) and when a new 
table is created, it will be created with number of rows and columns. 
Once a table is created, the text can be added to a cell. Any object like number, text, 
picture, etc., can be inserted in a cell. It is possible to the apply formatting to the 
contents of a cell. The formatting to the text in the cell can be done in the manner 
similar to the formatting applied on Font and Paragraph without tables. For this, the 
text in the cell is selected and desired formatting option is clicked; this applies the 
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selected formatting to the contents of the cell. Formatting can be applied to a single 
cell or more than one cells together. To apply formatting to more than one cell at a 
time, all the cells should be selected. To select more than one cell at the same time, 
press the left mouse button and move it across the cells to be selected. Once all the 
cells are selected release the mouse button. This technique is known as drag and 
drop.  To select more than one cell using keyboard keep Shift key pressed and move 
the arrow keys, the cells will be selected as per the arrow key movement.  
The Tab key can be used to move from one cell to another within a table. Whenever 
a Tab key is pressed the cursor moves towards right by one cell position. If the 
cursor is in the last column of some row and the Tab key is pressed, the cursor will 
move to the first column of the next row. If the cursor is in the last column of last row 
and Tab key is pressed, a new row is added to the table.  To move from the right cell 
to the left cell within the table press Shift and Tab key together. When a cell is 
selected, it gets highlighted as shown in figure 3.6. 

 
Figure 3.6 Moving from one cell to another 

3.4 FORMATTING A TABLE IN WORD 
 
Once a table has been created, the entire table can be selected. Generally, entire 
table is selected when it needs to be formatted in a specific way or it needs to be 
moved from one place in a document to another.  
It is necessary to select the entire table to apply predefined style on the table. To 
select the entire table, click on the symbol with four arrows. The four-headed arrow is 
visible near the left top corner of the first column whenever the mouse is moved over 
the table.  

 
Figure 3.7 Table selection 

As soon as you click on the four-headed arrow, entire table will be selected. The 
selected table will be highlighted. 

 
Figure 3.8 Selected table 

As soon as the table is selected, Table tools will be added to the title bar and a 
Design and Layout tab will also be added to the Ribbon. 
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Figure 3.9 Design and Layout Tab 

 
Table style and other options will be visible on the Ribbon as soon as you click on 
the Design tab of Table tools. As the mouse will move on different style options, the 
selected table will be previewed with the effect of that style. 
 

 
Figure 3.10 Table design 

 
We can also decide the border width of the table as well as its design. To see this 
effect, select the table and choose different options of border. 
 

3.5 INSERT AND DELETE ROW/COLUMN IN TABLE IN 
WORD 
 
The Layout tab of the table allows us to select different layout options such as add 
new row or column, merge two or more cells of table (convert two or more cells into 
a single cell), AutoFit behavior, change the cell size, align the text within the cell and 
options for performing operation on the data stored in the table.  
 

 
Figure 3.11-a Table Layout 

To add a row or column in a table, select a row or column and from the Layout tab 
given in the Table tools on Ribbon select appropriate option. For example, assume 
that we want to add a column between the City and Mobile No. columns. To perform 
this operation select the column Mobile No. as shown in Figure 3.11-b. To select the 
Mobile No. column go to the top of this column and click on the mouse. When the 
mouse is moved to the top of the column, the cursor gets converted to a solid 
shaped arrow, and now when the left mouse button is clicked, the entire column gets 
selected. 

 
Figure 3.11-b Selection of single column 
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Now as shown in Figure 3.12 by clicking on the Insert Left button given in the Layout 
tab, a new column will be inserted to the left of Mobile No. column as shown in 
Figure 3.13. 

 
Figure 3.12 Adding new column to the left of selected column 

 
Figure 3.13 New columns inserted to the left of selected column 

 
Data can now be added into this newly inserted column. For example, we will give 
the title of this new column as E-mail. As shown in Figure 3.96, student‘s E-Mail ID 
can be stored in this column. 
 
First 

Name 
Last 
name 

DOB City E-mail Mobile No. 

Akhil Dave 12/1/199
0 

Rajkot adave12@yahoo.com 123456789
0 

Bhavi
n 

Pandy
a 

24/5/199
1 

Ahmedaba
d 

Bhavinp1991@gmail.co
m 

123459876
0 

Mitul Bhatt 10/3/199
0 

Surat Mbb10@yahoo.co.in 987654321
0 

Figure 3.14 New columns E-mail inserted to the left of column Mobile No. 

 
Similarly, we can add a new row between two rows. We can also add more than one 
row or column at a time. For this, we need to select more than one row or column. 
For example, assume that we want to add three rows after the last row. We need to 
select all rows and then click on the Insert Below option in the Layout tab as shown 
in Figure 3.15. 

mailto:adave12@yahoo.com
mailto:Bhavinp1991@gmail.com
mailto:Bhavinp1991@gmail.com
mailto:Mbb10@yahoo.co.in
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Figure 3.15 Adding three rows below the last row 

 
First 

Name 
Last 
Name 

DOB City E-mail Mobile No. 

Akhil Dave 12/1/199
0 

Rajkot adave12@yahoo.com 1234567890 

Bhavin Pandya 24/5/199
1 

Ahmedabad Bhavinp1991@gmail.
com 

1234598760 

Mitul Bhatt 10/3/199
0 

Surat Mbb10@yahoo.co.in 9876543210 

      
      
      

 
Figure 3.16 Three rows added below the last row 

 
Similarly, it is possible to delete one or more than one rows or columns. To delete a 
row, select the row to be deleted. As shown in Figure 3.17 from the Delete tab of the 
Table layout, click on the Delete Rows option. 

 
Figure 3.17 Deleting last three rows 

 
First 

Name 
Last 
name 

DOB City E-mail Mobile No. 

Akhil Dave 12/1/199
0 

Rajkot Adave12@yahoo.com 123456789
0 

Bhavi
n 

Pandy
a 

24/5/199
1 

Ahmedaba
d 

Bhavinp1991@gmail.co
m 

123459876
0 

Mitul Bhatt 10/3/199
0 

Surat Mbb10@yahoo.co.in 987654321
0 

Figure 3.18 Table after deleting the last three rows 

mailto:adave12@yahoo.com
mailto:Bhavinp1991@gmail.com
mailto:Bhavinp1991@gmail.com
mailto:Mbb10@yahoo.co.in
mailto:Adave12@yahoo.com
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Similarly, one or more columns can also be deleted. For example, to delete the E-
mail column, select the E-mail column, and then as shown in Figure 3.19 from the 
Delete tab of the Table layout, click on the Delete Columns option. Figure 3.20 
shows the table with E-mail column deleted. 

 
Figure 3.19 Deleting E-mail column 

 
First Name Last name DOB City Mobile No. 
Akhil Dave 12/1/1990 Rajkot 1234567890 
Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 
Mitul Bhatt 10/3/1990 Surat 9876543210 

Figure 3.20 Table after deleting E-mail column 
 

3.6 MERGE AND SPLIT CELL IN TABLE IN WORD 
 

We can merge (convert two or more cells into a single cell) or split (convert a single 
cell into two or more cells) the cells in the table as per our needs. Assume that a row 
has been added before the first row of the table as shown in Figure 3.21. The text in 
the first column is ABC and in the second column is School. 

ABC School    
First Name Last name DOB City Mobile No. 
Akhil Dave 12/1/1990 Rajkot 1234567890 
Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 
Mitul Bhatt 10/3/1990 Surat 9876543210 

 
Figure 3.21 Before cell merge operation 

As ABC School is a title, we want to align it in the center of all the columns in the 
table. It means that we want to merge the text ABC School and put it in center of the 
table. As shown in Figure 3.22, select the first row. 

 
Figure 3.22 the cells selected before being merged 

After this as shown in Figure 3.23, by clicking on the Merge Cells option from the 
Layout tab, all the selected cells will get merged and become one cell as shown in 
Figure 3.24. 
Now if you wish the text in this cell can also be aligned in the center, and as shown 
in Figure 3.25, the additional spaces can be removed using delete or backspace 
keys. 
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Figure 3.23 Selecting Merge Cells option from layout for merging the selected cells 

 
 

ABC  
School 
First Name Last name DOB City Mobile No. 
Akhil Dave 12/1/1990 Rajkot 1234567890 
Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 
Mitul Bhatt 10/3/1990 Surat 9876543210 

 
Figure 3.24 Display of table after merging the cells 

ABC School 
First Name Last name DOB City Mobile No. 
Akhil Dave 12/1/1990 Rajkot 1234567890 
Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 
Mitul Bhatt 10/3/1990 Surat 9876543210 

Figure 3.25 Display of table after merging the cells and removal of extra spaces 
Similarly, a cell can also be split. For example, to split the text ABC School as shown 
in Figure 3.26 again in two cells, select the text ABC School and click on the Split 
Cells option on the Layout tab. This will open a Split Cell dialog box as shown in 
Figure 3.26. In this dialog box, you are supposed to enter the details of number of 
rows and columns in which we want to split the cell and click the OK button. The cell 
will now be split. 

 
Figure 3.26 Clicking the Split Cell button to split the cell 
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If we want to split the cell in 5 columns and 1 row, as shown in Figure 3.27, enter 5 in 
the Number of columns field and 1 in the Number of rows field and then click on the 
OK button. 

 
Figure 3.27 Details of number of rows and columns for splitting the cell 

Clicking on OK button will split the cell in 5 columns and 1 row. This is shown in 
Figure 3.28 below. 

ABC School     
First Name Last name DOB City Mobile No. 
Akhil Dave 12/1/1990 Rajkot 1234567890 
Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 
Mitul Bhatt 10/3/1990 Surat 9876543210 

Figure 3.28 Cells after splitting 
By using the Split Table option it is possible to split the tables. For example, for 
splitting our existing table into two tables, select the last two rows of the table and as 
shown in Figure 3.29.As soon as the Split Table option of the Layout tab is clicked, 
the table will be split from one table to two tables as shown in Figure 3.30. 
 

 
Figure 3.29 Split Table option for dividing the tables 

 
ABC School 

First Name Last name DOB City Mobile No. 
Akhil Dave 12/1/1990 Rajkot 1234567890 

 
Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 
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Mitul Bhatt 10/3/1990 Surat 9876543210 
 

Figure 3.30 Tables after splitting 

 

3.7 MODIFY HEIGHT AND WIDTH OF ROW AND COLUMN 
IN TABLE  
 
It is possible to change the row height and column width after the table is created. 
The row height and column width of the table can be changed by selecting the Cell 
Size option of the Layout tab. For changing the row height, select the row and in the 
Height: text box of the Cell Size option, enter the value for row height. The height of 
the selected row will now change. For example, by setting the height of the second 
row shown in Figure 3.31 to 0.5‖, its height will be changed to 0.5‖ from 0.2‖.This has 
been shown in Figure 3.32. Similarly, it is possible to change the width of the 
column. 

 
Figure 3.31 Changing the row height of table 

ABC School 
First Name Last name DOB City Mobile No. 

Akhil Dave 12/1/1990 Rajkot 1234567890 
Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 
Mitul Bhatt 10/3/1990 Surat 9876543210 

 
Figure 3.32 View after change in table‟s row height 

 
Other option is also available to change the row height and column width after 
creation of the table. For using this option, select the table and right click on the 
mouse, from the context menu, click on Table Properties. This will display a Table 
Properties dialog box. Many options like Table, Row, Column, Cell, etc., will be 
visible in the Table Properties dialog box. For example, we will change the width of 
the City column. For performing this operation, select the table and right click on the 
mouse button. Click on Table Properties from the context menu. This will open a 
Table Properties dialog box as shown in Figure 3.33. Click on the Column tab in the 
Table Properties dialog box. This will give the option for changing the column width 
as shown in Figure 3.34. 
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Figure 3.33 Table Properties dialog box 

 
Figure 3.34 Column tab of Table Properties dialog box  

Now to select the column whose width is to be changed, click on Previous Column or 
Next Column button. This will select the left or right column as per the click. If we 
want to change the width of City column then by clicking the Next Column four times, 
the City column will get selected. Now as shown in Figure 3.35, in the Preferred 
Width text box, enter the value of the desired width. Using the Measures in combo 
box, decide whether the unit is to be kept in Inches or in Percentage. Now by clicking 
on OK button, the width of the selected column will be changed as shown in Figure 
3.36. 
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Figure 3.35 Options to change the column width in the Table Properties dialog box 

 
ABC School 

First 
Name 

Last name DOB City Mobile No. 

Akhil Dave 12/1/1990 Rajkot 1234567890 

Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 
Mitul Bhatt 10/3/1990 Surat 9876543210 

 
Figure 3.36 Table after changing the column width using Table Properties dialog box 

 

3.8 POSITION AND ALIGNMENT OF A TABLE IN MS WORD 
The position of the text in the table and the space (Margin) between the two cells of 
table can be changed as per our needs. To change the position of the text, select the 
cells whose text position is to be changed and then from the Layout tab select the 
desired position alignment and click on it. By doing this, the position of all the 
selected text will change. For example, we want to align the column headings in the 
center of the columns. To perform this action, select the row with column heading. 
As shown in Figure 3.37, click on the Align Center option of the Layout tab. The 
selected column headings will now be aligned in the center as shown in Figure 3.38.  

 
Figure 3.37 Aligning the text in table 



139 
 

 
ABC School 

First Name Last name DOB City Mobile No. 

Akhil Dave 12/1/1990 Rajkot 1234567890 

Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 

Mitul Bhatt 10/3/1990 Surat 9876543210 

 
Figure 3.38 Table text after alignment 

 
Additionally, the Alignment tab can also be used to change the direction of the text 
written in the cell. For example, to change the text direction of the column headings 
in our table, select the column heading row. As shown in Figure 3.39, click on the 
Text Direction option of the Layout tab. The direction of the selected column 
headings will now be changed as shown in Figure 3.40. 

 
Figure 3.39 To change the direction of the text 

ABC School 
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Akhil Dave 12/1/1990 Rajkot 1234567890 

Bhavin Pandya 24/5/1991 Ahmedabad 1234598760 

Mitul Bhatt 10/3/1990 Surat 9876543210 

 
Figure 3.40 Table text after change in text direction 

Margin: The space between two cells of the table can be changed using the Cell 
Margin option available in the Layout tab. For example, to increase or decrease the 
spacing between the cells of second row in the table, select the row as shown in 
Figure 3.41. A Table Option dialog box will be displayed by clicking on the Cell 
Margin option of the Layout tab. By using this dialog box the Top, Bottom, Left and 
Right spacing of cell can be decided. 
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Figure 3.41 Options to change the cell spacing between cells 

Now enter the value of the cell spacing, and by clicking on the OK button, the new 
spacing will be applicable on the selected cells. For example, select the second row 
and set the values of Top, Bottom, Left and Right. Figure 3.42 shows the application 
of new spacing after clicking on the OK button. 

 
Figure 3.42 Look of table after changing the cell spacing 

 

3.9 SORTING OF A TABLE DATA IN MS WORD 
The data stored in the table can be sorted in Ascending or Descending order. To do 
this, select the column and click on the Sort option available in the Layout tab. This 
will open a dialog box as shown in Figure 3.43. Using the Sort dialog box, the 
column on which the data is to be sorted and the order (ascending or descending) of 
sort can be decided. For example, by selecting the Last Name column and clicking 
on the Sort option, a Sort dialog box is displayed. In the Sort dialog box, the Sort by 
text has Column 2 selected and as Last Name is a field that contains textual data, in 
Type: text box ‗Text‘ is selected. We have selected the Sort order to be Ascending. 
Now by clicking the OK button, the data stored in the Last name column will be 
arranged in ascending order. It can be observed here that although the sorting was 
applied on the Last name column, the entire table gets sorted. This does not change 
the details of any student. 
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Figure 3.43 To arrange the Last name column in ascending order 

 

ABC School 

First Name Last name DOB City Mobile No. 

Mitul Bhatt 10/3/1990 Surat 9876543210 

Akhil Dave 12/1/1990 Rajkot 1234567890 

Bhavin  Pandya 24/5/1991 Ahmedabad 1234598760 

 
Figure 3.44 after arranging the Last name column in ascending order 

 
In Microsoft Word 2010, the data can be sorted on maximum three columns. 
 
Check Your Progress 

1. Crate cricket score board in word using table 
2. Display name of the cricket team on the top of the score board after inserting 

the raw and merging the cells. 
 

3.10 FORMULA FOR TABLE DATA IN WORD 
It is possible to perform calculations on table data by applying formulas. Let us 
create a new table to learn the concept of calculations in table. 
 

Sr.No. Item Name Unit Price Quantity Net Price 
1 Ball Pen 25 4  
2 Pencil 10 5  
3 Eraser 4 3  
4 Sharpener 3 5  
 Total    

 
To calculate the Net Price in this table, multiply the Unit Price and Quantity fields of 
the table. To perform this operation, keep the cursor on the Net Price field.  Click on 
the ‗Formula‘ option on the ‗Layout‘ tab. This will open a Formula dialog box as 
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shown in Figure 3.45. Using this dialog box, formula to be used, number format and 
the function to be used can be decided. 

 
Figure 3.45 Formula dialog box 

 
Sr.No. Item Name Unit Price Quantity Net Price 
1 Ball Pen 25 4  
2 Pencil 10 5  
3 Eraser 4 3  
4 Sharpener 3 5  
 Total    

 
In the above table to calculate Net Price, keep the cursor in the first row under the 
Net Price column. Now click on the Formula option in Layout tab. This will open the 
Formula dialog box. In the Formula dialog box we need to multiply the Unit Price and 
Quantity. Hence from the Paste Function combo box choose Product as can be seen 
in Figure 3.46. 

 
Figure 3.46 Formula in Table 

 
As both the left side columns are to be multiplied, write Left in parenthesis besides 
PRODUCT and delete SUM (LEFT). The = sign is compulsory. Thus, now the 
formula will look like the one shown in Figure 3.47. 
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Figure 3.47 Product 

 
This formula is not case sensitive. Hence product and left if written in small letters 
will not have any effect on the formula. The Net Price will be calculated as the OK 
button in clicked as can be seen in Figure 3.48. 
 

 
 
 
 
 
 
 

Figure 3.48 Calculation of Net Price 
Similarly, the Net Price for all rows can be calculated. Now to add all these Net Price 
values, again the Formula option will be used and in that Sum function is used. Here 
as the Total row will store addition of all the rows, the function written should be SUM 
(Above) as shown in Figure 3.49.  

 
Figure 3.49 Sum Function 

 
As can be seen in Figure 3.50, when OK button is clicked the values of all the above 
rows is added and we get the value of Total. 

Sr.No. Item Name Unit Price Quantity Net Price 
1 Ball Pen 25 4 100 
2 Pencil 10 5 50 
3 Eraser 4 3 12 
4 Sharpener 3 5 15 
 Total   177 

 
Figure 3.50 Output of Sum Function 

Sr.No. Item Name Unit Price Quantity Net Price 
1 Ball Pen 25 4 100 
2 Pencil 10 5  
3 Eraser 4 3  
4 Sharpener 3 5  
 Total    
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It is possible to calculate the product even if there is one column between Unit Price 
and Quantity. For example, assume that there is a column Description between 
columns Unit Price and Quantity. Now to calculate Net Price, Unit Price and Quantity 
are to be multiplied. When calculation is done in such a manner, it is desirable to 
give a name to each row and column. Consider Sr. No. column as A, Item Name 
column as B, Unit Price column as C, Description column as D, Quantity column as 
E and Net Price column as F. Similarly consider first row as 1, second row as 2, etc. 
Keep the cursor in F2 row, and by clicking on Formula, a Formula dialog box will be 
displayed. Here write the formula C2*E2 and the Net Price will be calculated when 
OK button is clicked. As the Net Price here is multiplication of Unit Price and 
Quantity, in Figure 3.51, we have written C2*E2. To calculate Net Price of Pencil 
C3*E3 has to be written. The Net Price of all the records can be calculated similarly. 

 
Figure 3.51 Calculation of Net Price 

 
 
 
 
 
 
 
 

      Figure 3.52 Final Calculation of Net Price 
 

3.11 CONVERT TABLE TO TEXT IN WORD 
 

We can convert a text to table and a table can also be converted to text. For 
example to convert the table shown in Figure 3.53 to text, select the table and from 
Layout tab select the Convert to Text option. This will open a Convert Table to Text 
dialog box.  

 
Figure 3.53 Convert Table to Text dialog box 

Sr.No. Item Name Unit Price Description Quantity Net Price 
1 Ball Pen 25 Cello 4 100 
2 Pencil 10 Natraj HB 5 5 
3 Eraser 4 Camlin 3 3 
4 Sharpener 3 Apsara 5 5 
 Total    113 



145 
 

By selecting desired option in this dialog box and clicking on OK button the table will 
be converted to text as shown in Figure 3.54.  
 

 
Figure 3.54 Convert Table to Text dialog box using comma option 

 
Check Your Progress 

1. Display total score of the team using formula in the table created for score 
board. 

2. Display average run scored by the player of the team using formula in the 
table created for the score board. 

3. Convert the table created for the score board into text with the help of the tab 
separator. 

 

3.12 MAIL MERGE IN MS WORD 
 

Mail merge can be used when we have a document that contain similar text and 
needs to be sent to multiple people. For example, if we need to write a letter for 
meeting, the text of this letter will be the same but the name and address of the 
officers receiving this letter will be different. If this letter is to be sent to all the 
officers, first a letter needs to be created with the name of one officer, then the letter 
needs to be copied and new letters need to be created by changing the name and 
address of the officers. If mail merge is used, the need of doing such copy-paste 
does not arise. Additionally if we have name, address, phone numbers, etc., details 
in the database then by using mail merge we can filter on name, address or phone 
number and send the letter to the specific officers. Assume that we want to mail 
merge a document that contains the following message: 
―There is a meeting for annual academic planning on 1/4/2014. You are informed to 
remain present in the meeting.‖ 
Now on clicking the Mailings tab, options for mailing will be available. Click on the 
Start Mail Merge option. This will open mail merge options as shown in Figure 3.55. 
From the available options, click on Step by Step Mail Merge Wizard. This will open 
a wizard to perform mail merge. There are six steps in the mail merge wizard. 
By clicking the Step by Step Mail Merge Wizard, we will get the first step of the 
wizard as shown in Figure 3.56.It will open a mail merge pane on the right side of the 
document. In this pane, we need to select the type of document that we are working 
on. We will click on Letters option as we are writing a letter here. 
 

Sr.No. Item Name, Unit Price, Description, Quantity, Net Price 
1, Ball Pen, 25, Cello, 4, 0 
2, Pencil, 10, Natraj HB, 5  
3, Eraser, 4, Camlin, 3  
4, Sharpener, 3, Apsara, 5  
, Total, 177  
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Figure 3.55 Step-by-Step Mail Merge Wizard 

 

 
Figure 3.56 First step of Mail Merge 

 
Now when the Next button is clicked, it provides an option to select a document for 
mail merge as shown in Figure 3.57-a. As we are going to use the same document, 
select the first option 'Use the current document' and click on the Next button. 
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Figure 3.57-a Second step of Mail Merge 

 

 
Figure 3.57-b Third step of Mail Merge 

 
As can be seen in Figure 3.57-b, in the third step mail merge provides an option to 
create a list of people to whom this letter is to be sent. The list can be selected from 
Outlook also. Here we will select the option to create a new list. The Create option is 
available under the section Type a new list. By clicking on the Create option, a New 
Address List dialog box as shown in Figure 3.58 will be displayed. In this dialog box, 
we will enter the details of the person to whom the letter is to be sent. 
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Figure 3.58 New Address List of Mail Merge 

 
In this dialog box with the help of Customize Columns, a column can be deleted, 
column name can be changed and order of columns can also be changed. By using 
the New Entry button a new record can be added and by using the Delete Entry 
button a record can be deleted. Here we will use the Customize Columns... button 
and use the fields Title, First Name, Last Name, Address Line 1, Address Line 2, City 
and Pin Code. The Zip Code field has been renamed to Pin Code. Now we will add 
records in it and save the list. 

 
Figure 3.59 New address list of mail merge 

 
We will now be able to see Recipients list in the Mail Merge Recipients dialog box as 
shown in Figure 3.60.  Using this dialog box, the records can be sorted or filtered. 
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Figure 3.60 Mail Merge Recipients 

 
In Figure 3.57-b when Next option is clicked, step four is displayed. It has an option 
‗Write your letter‘. In Figure 3.61 from Mailings tab, click on the Field option of the 
Insert Merge Field. Thus the selected fields will be inserted in the document. Now we 
can insert the merge field by giving desired space and center alignment. 
 

 
Figure 3.61 After the fields are inserted in Mail Merge 

 
We can now preview the mail merged document by clicking on the Next button. The 
Preview of the Mail Merge can be seen as shown in Figure 3.62 by clicking on the 
button besides the Recipient: option under the Preview your letters section. 
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Figure 3.62 Preview letter in Mail Merge 

 
Now by clicking on Next button, our letter can be printed or it is possible to edit each 
of them as shown in Figure 3.63. 
 

 
Figure 3.63 Print letter in Mail Merge 

 
Check Your Progress 
 
1. Create an invitation letter using mail merge inviting your five  friends on your 

child‘s birthday party. 

 
 

3.13 CHECK YOUR PROGRESS: POSSIBLE ANSWERS 
 
Q1. Choose the correct option. 
1. Using which of the following a Word application cannot be closed? 
A) Exit option in File tab       B) By pressing Alt + F4 
C) By clicking on X button on Title bar      D) By clicking on Close Sub Menu option 
on File tab 
2. What are the fonts without decoration known as? 
A) Serif type fonts B) Sans Serif type fonts C) Scientific type fonts D) All of these 
3. Portrait and Landscape is ______. 
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A) Page Orientation  B) Paper Size  C) Page Layout  D) All of 
these 
4. Which of the following option is a type of page margin? 
A) Left  B) Right C) Center D) Top 
5. Which of the following option is not available in the table‘s AutoFit behavior? 
A) Fixed Column Width   B) AutoFit to Contents   C) AutoFit to Window  D) 
AutoFit to Column 
 
Q2. Fill in the blanks using correct option. 
1. _________ is not a font style. ( Bold, Regular, Superscript) 
2. A character that is little below and smaller than other characters is known as 

_________. (Raised, Superscript,  Subscript) 
3. The extension of Word 2010 file is _______. ( .doc, .docx, .txt ) 
4. Shimmer, Sparkle text, Blinking Background, etc., are known as _________. 

(Font styles, Font effects, Text effects) 
5. The intersection of row and column in table is known as _______. (cell, border, 

tab)  
 

Q3. Say whether following statements are true or false. 
1. You can set different header and footer for odd and even pages in Word 2010. 
2. The Left Indent Marker controls the indent of all the lines except for the first line. 
3. The ClipArt cannot be added through the Insert tab. 
4. A new column cannot be added once a table is created in Word 2010. 
5. The table data can be arranged in ascending or descending order of some 

column. 
 
Q4. Match the following 
A B 

1. Saving a Word file a. Ctrl + S 

2. To save the file with another name or in a new location b. Ctrl + V 

3. To darken the selected text c. F12 

4. To paste the copied text  d. Ctrl + F 

5. To find a desired text in the document e. Ctrl + B 
 
Answers 
Q1 

1. D [By clicking on Close Sub Menu option on File tab] 
2. B [Sans Serif type fonts] 
3. A [Page Orientation] 
4. C [Center] 
5. D [AutoFit to Column] 

 
Q2      1.  Superscript 2. Subscript 3. .docx  4. Text effects  5. Cell 
Q3      1. True     2. True      3. False     4. False     5. True 
Q4 

1. Saving a Word file - Ctrl + S 
2. To save the file with another name or in a new location - F12 
3. To darken the selected text - Ctrl + B 
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4. To paste the copied text - Ctrl + V 
5. To find a desired text in the document - Ctrl + F 
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   Block-3 
Spreadsheet and Presentation 
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Unit 1:  Introduction to Microsoft 
Excel 2010 

  
 
Unit Structure 
 
1.1. Learning Objectives 

 
1.2. Introduction  to Excel 2010 

 
1.3. Entering Data and formatting  

 
1.4. Saving File in MS Excel 

 
1.5. Printing File in MS Excel 

 
1.6. Check your Progress: Possible Answers 

 
  

1 
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1.1 LEARNING OBJECTIVES 
 
After studying this unit student should be able to: 
 

 Enter data in Excel-2010 . 
 Arrange data . 
 Format data .  
 Can use the Workbook and Worksheet efficiently. 
 Save  an Excel-2010 Workbook in different Formats. 
 Print an Excel-2010 Workbook 

 

1.2 INTRODUCTION TO EXCEL 2010 
 

Generally we use Microsoft Word to create project reports, letters and   other 
documents. Microsoft Word can also be used  to put information in the form of rows 
and columns which is known as the  table., But in order to deal with  high volume of 
data involving  huge amount of calculations, where lots of changes and 
rearrangements are required , charts are plotted for better analysis of data, Microsoft 
Excel works better  under such circumstances. This section we will give a detailed 
overview about Excel-2010. Excel is a spreadsheet program which helps in storing 
big collection of data in the form of large tables, and to arrange and analyze them for 
better decision making. 
Excel-2010 is a useful spreadsheet program that is part of Microsoft Office Suite. 
Excel-2010 is used to perform the operations as mentioned below: 

 Perform different types of calculations easily. 
 Create Charts. 
 Create Lists. 
 Use previously created information. 
 Create Graphics and Diagrams. 
 Perform complex tasks with the help of Macro etc. 

 
Additional facilities have been added in Excel-2010 as compared to its previous 
versions. Some of them are as follows: 

 Sparkline. 
 Slicer. 
 Formatting option in Pivot Table. 

 Back stage view  instead of Office button . 
 Changes can be done in better ways in Conditional Formatting, Functions and 

Image. 
 Screen Capture Tool to convert a part of a screen to image or picture. 
 Paste Preview  option which shows   how the data will look like before being  

pasted 
 Ribbon Customization  option which allows to customize the Ribbon 
 Equation Editor  so as  to write and edit equations 
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Starting Excel-2010 
 
Method 1: To start Excel-2010 click on the Start button of Windows-7, Microsoft 
Office Program Group will be opened. Clicking Excel-2010 will start it (Figure 1.1). 
Method 2: First select the Start Button followed by Run, and then type Excel, press 
the Enter key. Under Programs, clicking Microsoft Excel 2010 will open Excel-2010 
(Figure 1.2). 
The simplest way to start Excel is to double-click on the Excel shortcut available on 
the desktop, but to perform this action the shortcut must be available on the desktop. 
 

 
 

  

 

Figure 1.1 Starting Excel   Figure 1.2 Starting Excel 

Introduction to important parts of Excel-2010 
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Figure 1.3 Important parts of Excel-2010 screen 
 
Once Excel-2010 is started the screen, we can see different parts as in the Figure 
1.3. Table 1.1 gives us the introduction to the important parts of this screen. 
 

Name of the Part Description 
Title bar Shows the name of the software and the file, also has minimize, 

maximize and the restore button that helps in handling the 
window. 

Quick Access Toolbar This toolbar shows the commonly used commands. It can be 
customized to make visible the selected tabs. . 

Ribbon Collection of tabs is the Ribbon, is a place for Excel commands. 
Clicking a tab, changes the look of the ribbon. 

Tab List Various tabs show different type of commands. 
File Button Clicking on this button opens a back stage view, providing 

options to print, open, close, save or to perform some other 
operation on a file. 

Name box It shows the address of the active cell, range or name of the 
selected cells. 

Formula bar The information or equations entered in a cell are visible here. 
Sheet Tab Scroll Buttons These buttons are used to navigate between different sheets in 

a workbook. 
Status bar Shows different messages along with the status of the Num 

Lock, Caps Lock, Scroll Lock keys etc. 
Scrollbars Used to move the sheets in the horizontal or vertical directions. 
Page View Buttons Used to view the worksheets in different forms. 
Zoom Control Zoom Control is used to shrink or grow the worksheets. 
Insert Sheet Button This button is used to insert a new worksheet. 
Ribbon Show/Hide 
Button 

This button is used to show or hide the ribbon. 

Column Character The worksheet has 16384 columns, having column index A to 
XFD. 

Row Number Each row in a worksheet has number starting from 1 to 
1,048,576. 

Active Cell Shows the active cell in which data is being entered, usually 
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Name of the Part Description 
shown with dark borders. 

Table 1.1 Different parts of Excel 

Back Stage View / File Tab 

File Tab Microsoft Office button  is provided in Microsoft Office 2010 instead of 
the File menu used in the previous versions of Microsoft Office, clicking on this 
button opens a back stage view (Figure 1.4) 
File Tab is the only colored button present on the top left corner of Microsoft Office 
2010 and is shown as a green colored tab. With the help of the Back Stage View we 
can create, save, open, close  or print a file, can see the properties of  a file, can see 
the list of the last opened files, , and also can send a file as an Email too.  

 
Figure 1.4 Back Stage View 

Ribbon  

The traditional menu has been replaced by the Ribbon in Office 2010, grouping the 
related commands separately. The brief idea about different tabs available in Excel 
has been described below. 

 
Tab Usage 
Home This tab includes the commands for Clipboard, Formatting, Style, Deleting 

rows or columns and changes in worksheet. 
Insert This tab is used when we need to insert table, picture, clip art, diagram, chart, 

symbol, equation etc. in a worksheet. 
Page 
Layout 

This tab has the commands that affect the entire look of a worksheet; it 
includes commands like print settings. 

Formula This tab is used to enter equation, assign name to a cell or range of cells and 
to enter functions. 

Data This tab allows to get data from outside the Excel file, to arrange them in 
ascending or descending order, to separate the important data, to group and 
ungroup them etc.  

Review This tab provides commands that allow checking the spellings, find synonyms, 
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Tab Usage 
add comments, and protect the worksheet or workbook with password. 

View The view tab provides commands that allow us to control different views of the 
worksheet. Some of the commands of this tab are also available in the Status 
bar. 

Table 1.2 Tabs available in ribbon 

Contextual Tab 

In addition to the Standard Tab, Excel-2010 also includes a Contextual Tab. 
Whenever a Chart, Table or a Smart chart is selected, a desired set of operations 
can be performed on it using a specific set of tools available in the ribbon, known as 
the Contextual Tab. 

 

 
Figure 1.5 Contextual Tab for Chart 

 
The red box in figure 1.5 shows the Contextual Tab when Chart is selected. Design, 
Layout and Format are the three contextual tabs in it. The details of this Contextual 
Tab are shown in Chart Tools title bar. We can also use other tabs when Contextual 
Tab is visible. 
 
Types of Commands present on the ribbon 
 
Command Type Example Usage 
Simple Button  Clicking on it an action is taken immediately. 
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Command Type Example Usage 
Toggle Button  This works as On/Off.  

Drop Downs  Clicking on it shows additional options. 

Split Button 

 

Split button is a combination of Simple button 
and Drop Down button. 

Check Box 

 

Works as ‗‗On‘‘ when checked and ‗‘Off‘‘ when 
unchecked. 

Spinner 

 

Used to increase or decrease a value. 

Table 1.3 Different types of commands present on the ribbon 
Many command groups in the ribbon contain a small symbol on its right hand side 
known as the ―dialog box launcher‖. For example see the symbol in the Home → 
Font Group (Figure 1.6). On clicking this symbol, shows an Excel Font dialog box, t 
listing the font options generally not present on the ribbon.  
 

 
Figure 1.6 Dialog box launcher button 

Shortcut Menu 

Along with the ribbon Excel provides us many Shortcut menus that can be seen by 
clicking the right mouse button. Shortcut menu shows the commands that are 
normally used for a selected object. For example, figure 1.7-a, shows a shortcut 
menu that is available when we right click in a cell. This shortcut menu is visible at 
the position of the mouse cursor thus allowing us to select the command quickly and 
easily. . 
The displayed shortcut menu depends on what work is being done at the moment of 
clicking. For example, if you are working with charts then the shortcut menu will look 
like  the one being shown in the figure 1.7-b. 
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Figure 1.7-a Shortcut menu for cell 

 
Figure 1.7-b Shortcut menu for Chart 

 
Quick Access Toolbar 

Normally the Quick Access Toolbar is visible above the ribbon on the left side of the 
title bar.  However it   can also be displayed below the ribbon also. To perform this 
action right click on the Quick Access Toolbar, this will open a shortcut menu as 
shown in the Figure 1.8 below. Here selecting the highlighted option will show the 
Quick Access Toolbar below the ribbon. 

 
Figure 1.8 To show Quick Access Toolbar below ribbon 

 
The ribbon is very much useful for keeping and using preferable commands to be 
visible always instead of selecting them from various tabs. Initially the Quick Access 

Toolbar shows three commands: Save, Undo and Redo.  
Additionally you can add frequently used commands to Quick Access toolbar. To add 
a new command, right click on the desired command and select the option Add to 
Quick Access Toolbar, this will add the command to the Quick Access toolbar. Thus 
you can show commands from different tabs at one place and can avoid moving 
between tabs. (See figure 1.9: Adding Column Chart to Quick Access Toolbar). 
 

 
Figure 1.9 Adding Command to the Quick Access Toolbar 

 
Alternatively clicking the down arrow key on the right hand side of the Quick Access 
Toolbar, you will be able to see a drop down menu with additional commands. By 
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putting a check in front of the desired command, it can be added to the Quick Access 
toolbar. (Figure 1.10) 
 

 
Figure 1.10 Adding commands to the Quick Access Toolbar 

 
Workbook and Worksheet 

The file that you work with in Excel is known as the Workbook. The extension of a 
file in Excel-2010 is .lax. Each workbook consists of one or more Worksheets. The 
worksheet is made up of group of cells. In each cell a number, text or equation can 
be entered. A picture, diagram or chart can also be inserted in a worksheet. A 
worksheet helps us in arranging information properly and allows us to use it easily. 
Every worksheet is a collection of rows and columns. The rows range from 1 to 
1,048,576, while the columns are named as A, B. Z, AA, and AB…, AZ, BA, BB …. 
And so on and is continued up to XFD. Thus it has 16384 columns in total. The 
intersection of the row and column is known as the cell. At any given moment of 
time, one cell is active and is highlighted by dark borders as shown in the Figure 
1.11. A single worksheet contains more than 17 billion cells. In a single cell, 
maximum of 32,767 characters can be entered. 
 
Note 

You cannot undo all type of activities. Normally the activities done using the File 
button cannot be undone. For example, if you save a new file, then the old file 
cannot be brought back using the undo command.  
 

1.3 ENTERING DATA AND FORMATTING 
 
The Excel workbook consists of worksheets which inturn consists of cells. In every 
cell we can enter three types of data. 1) Number 2) Text and 3) Formula.  
 
Entering Data 

To enter data: 
 Select the desired cell by using the mouse or arrow keys. 
 Type the data in the selected cell. 
 Press the Enter or arrow key. 
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Excel interprets Date and Time as a number. Thus, 1-January-1900 is considered as 
1, 2-January-1900 as 2, and so on. . By this, calculations can be done more easily 
on dates, for example: to know the number of days between two dates it can be 
subtracted. 
 
Changing the data 

Once data has been entered in a cell, it can be changed in many ways: 
 By deleting the data. 
 Replacing the data with another data. 
 Changing the data in the desired way. 

 
To delete data from the desired cell or cells, select one or more cells and then press 
the Delete key. More than one cell (Range) can be selected by pressing the Shift + 
Arrow keys or using the mouse (Keep the left mouse button clicked and drag it on 
the desired cells). 
You will get five options as shown in figure 1.11 to delete data by selecting Home → 
Editing → Clear. With the help of this we can delete data and formatting, only format, 
only data, comment or hyperlink. 
 

 
Figure 1.11 Clear command available on Home tab 

 
To change the data within in a cell with new data, select the cell and type the new 
data, the old data will be replaced with the new one. 
The edit mode of Excel gives us following options to change any specific data in a 
cell: 

 Double click on the cell 
 Select the cell and press F2 key or 
 When the cell is selected its contents are visible in formula bar, change the 

contents in the formula bar and the change will be reflected in the cell. (See 
figure 1.12) 
 

 
Figure 1.12 Changing the data in the cell with the help of formula bar 

 
Filling data series using Autofill 



164 
 

When the data comes in the form of series like 1, 2, 3… 10 or Sunday, Monday… 
Saturday or January, February…, December or 01- Mar – 2014 to 31- Mar – 2014 
etc. then we can use the Autofill option of Excel. Other than this we can also fill data 
as per any desired order. To use the Autofill fill option, enter the initial value and 
select the number of cells that are to be filled as shown in figure 1.13, then choose 
Home → Editing → FillSeries, which will open a dialog box as shown in figure 
3.14. 

 
Figure 1.13 Filling data 

 

 
Figure 1.14 Fill Series dialog box 

 
Series In: If you want to fill in horizontal direction then select Rows, or if a vertical fill 
is to be done as shown in figure 1.13 then select Columns. 
Type: To fill in series select Linear, to fill date select date, to multiply select Growth. 
Date Unit: If Date is selected only then this last option will be visible. 
Step Value: It shows the incremental value from initial value, while Stop Value 
displays the last value. 
Alternatively enter first two values in the first and second cell, select both these cells, 
a small plus  sign (+) will be  visible near the bottom right corner, this is known as fill 
handle. Drag the mouse by keeping it on the handle, Excel will automatically fill 
values based on the initial values. 
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Figure 1.15 An Example of Fill Series 

 
Number Format 

Excel provides us facility to store data in different formats. List of formats provided by 
Excel is as follows: 
Format Usage 
General This is a default format. It is used to show an integer, fraction or a large value using 

scientific form.   
Number  It gives options to display number of digits after decimal place, whether a coma is 

to be used to separate thousand values and to show negative values. 
Currency Used to show currency. It give options to display number of digits after decimal 

place, whether a coma is to be used to separate thousand values, which currency 
symbol is to be used and to show negative values. 

Date Used to show date in different formats. 
Time Used to show time in different formats. 
Percentage Used to Show % symbol as wells as how many digits to be displayed after decimal 

place. 
Fraction A fraction can be displayed in 9 different ways. 
Scientific Shows a number in Scientific form. For example, 205,000 is shown as 2.05E+05. 
Text A number is also considered as text in this format by Excel. 
Special Displays additional number formats. 
Custom Used to define your own format that is not available in any other format. 

Table 1.4 Number Format 

Formatting a number with the help of ribbon 

As shown in figure 1.16, the Home → Number group provides you the facility to 
format a number. When a mouse pointer is kept on the desired option it shows a 
brief description about it. 

 
Figure 1.16 Number group available in Home Tab 
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Formatting Number with the help of Format Dialog Box 

We can also do formatting with the help of Format Dialog box. To open the Format 
Dialog box, click on the button in the bottom right corner of the Number Group in the 
Home Tab, as shown in the Figure 1.17. You can see different formatting options 
here. 

 
Figure 1.17 Format Dialog box 

Formatting Text 

As shown in the Figure 1.18, the Home → Font group give options to apply 
formatting to the selected text in a cell such as changing the font and style, to make 
it bold, italics, or to underline, to apply border, to increase or decrease the font size, 
to change the font color of the cell as well as to fill the cell with different color. 

 
Figure 1.18 Font group in the Home tab 

 
To get more options of formatting, click on the button at the bottom right corner of the 
Font group, as shown in the Figure 1.19. 
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Figure 1.19 Font Tab of Format Dialog Box 

 
As shown in the Figure 1.20, the Home → Alignment group has options that allows 
the selected text to be aligned horizontally (Alignment) and vertically, to move the 
text within a cell (Indent), to show the text at a specific angle (Orientation), to merge 
or separate more than one cell in different ways (Merge & Center), and to move the 
text to a new line so that it does not move out of the cell (Wrap Text). 

 
Figure 1.20 Alignment Group and its options available in Home Tab 

 
Clicking on the button at the bottom of right hand corner of the Alignment group, will 
open a Format dialog box as shown in the Figure 1.21.It gives additional options for 
cell formatting. 
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Figure 1.21 Alignment tab of Format Dialog Box 

 
 

1.4 SAVING FILE IN MS EXCEL 
 
Once an Excel worksheet is ready, it can be saved permanently and is stored in the 
hard disk in the form of a file. Further it can be opened again to see the contents and 
required changes can be done when needed. . When Excel file is saved, by default it 
is assigned with the extension name .xlsx. However it can be but stored in other 
formats also. List of some of the commonly used file format is shown in the table 1.5. 
To save a file the Save or Save As command available in the Back Stage View as 
shown in the Figure 1.22 is used, when this command is clicked the Save dialog box 
as shown in the Figure 1.23 is opened, where the filename , file  format, and the path 
of the  file  is to be entered . 

 
Figure 1.22 Save Options on the Back Stage View 
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Figure 1.23 Save dialog box 

 
File Format Extension 

Name 
Usage 

Excel Workbook .xlsx  A default file format for Excel-2010 and Excel-2007 based on 
XML.  

Macro Enabled Excel 
Workbook 

.xlsm A file format for Excel-2010 and Excel-2007 based on XML 
that also stores Macro code. 

Excel-97 and Excel-
2003 Workbook 

.xls A binary file format that opens in Excel-97 and Excel-2003. 

Template  .xltx A file format to store Excel-2010 and Excel-2007 file as 
template.  

XML Data .xml Data is stored in XML format. 
Text .txt In this format Excel stores data as tab or comma separated 

simple text file, it can be opened in DOS, Macintosh, and 
Linux operating system. 

DBF 3, DBF 4 .dbf You can open this file in Excel but cannot save with this 
format in Excel. 

Open Document 
Spreadsheet 

.ods The file saved in this format can be opened in Google 
Document or Open Office CALC program as well as in any 
other program that supports this format. 

Portable Document 
Format  

.pdf This format is popular for web. 

Hyper Text Markup 
Language  

.html This format is used to save file as web page. 

Table 1.5 Excel File Formats 
 
 

1.5 PRINTING FILE IN MS EXCEL 

As shown in the Figure 1.24, to print an Excel workbook the Print command available 
on the Back Stage view is used, giving different print options. Page Setup link is the 
last entry available in the Print option, clicking on this option opens a Page Setup 
dialog box as shown in Figure 1.26, proving additional options to set page, margin, 
header and footer. By clicking on the Print button, the default printer prints the 
document as per the desired settings.   
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The document can be viewed before printing it in the right side of Back Stage view 
but the view cannot be changed.  To make changes in the view, View → Workbook 
Views → Page Layout View is to be selected as shown in the Figure 1.25. 

 
Figure 1.24 Options for the Print Command 

 
If you want to see from where the pages will be separated during printing, then the 
View → Workbook Views → Page Break Preview as shown in Figure 1.25 can be 
used. 

 
Figure 1.25 The Page Layout View 
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Figure 1.26 The Page Setup Dialog Box 

 
 

1.6 CHECK YOUR PROGRESS: POSSIBLE ANSWERS 
 
1. Different type of data is filed in the data given below that you try to enter in excel 

using fill series. 
2. Apply different text colour and fill colour to the column of the series you filled 

before. 
3. Give two decimal points to the data of column A. 
4. Give accounting symbol to the data of column B. 
5. Apply     rotation to the column heading text. 
6. Save the file you created and create it‘s pdf file. 
7. Take printout of the file you created. 
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Unit 2:  Formulas and Functions 
in MS Excel 2010 

  
 
Unit Structure 
 
2.1. Learning Objectives 
2.2. Introduction 
2.3. Calculating with the help of Formulas and Functions 
2.4. Working with Worksheet, Rows, Columns and Cells 
2.5. Table Format 
2.6. Sorting 
2.7. Filter 
2.8. Data Tools 
2.9. Outlines 
2.10. Check your Progress: Possible Answers 

 

  

2 
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2.1 LEARNING OBJECTIVES 
 
After studying this unit student should be able to: 
 

 Understand how to perform different calculations.  
 How  to use various functions for performing fast and specific calculations. 
 Arrange information in Ascending, Descending or in a specific order. 
 Filter important information, sort information based on groups and to bring 

data in different formats to Excel. 
 

2.2 INTRODUCTION 
 
As we have seen the introduction of Microsoft Excel 2010 in previous chapter that 
gives us idea of how to enter data and how to format it, how the file is saved and 
how to get print of excel file. In this chapter we are going to see the use of functions 
and formulas as well as we will also understand how calculations are performed 
using it. This chapter explains the concept of sorting in Excel as well as how filtering 
of data is done using different filter options available. Use of different Data Tools and 
Outlines is also explained in this chapter. 

2.3 CALCULATING WITH THE HELP OF FORMULAS AND 
FUNCTIONS 
 
As mentioned earlier Excel is used extensively for calculations. Formula is used to 
perform calculations on the data entered within the cells in the Excel worksheet. The 
advantage of the formula is that, Excel automatically calculates the new value of the 
cell in which formula is written, when value of the cell used in this formula changes. 
Formula mainly consists of the following components: 

1. Arithmetic operators like + , -, *, /, %, ^ 
2. Cell address, for example A1 
3. Value, for example 10 and 
4. Function, for example sum(A1:A10) 

A formula always starts with an = operator. Example of some formulas is given in 
Table 2.1. 
 

Formula Meaning 
=5*6  Multiplication of 5 and 6 
=A1+B1 Addition of the values in cells A1 and B1 
=A1^3 The value in cell A1 raised to the power of 3 

Table 2.1 Example of Formula 

Operator 

Table 2.2 below shows the operators used in a formula based on their precedence. 
If a formula contains more than one operator, then the operators are evaluated 
based on their precedence. If you need to change the precedence of an operator 
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then it needs to be written in brackets. The formula written in the brackets will be 
evaluated first. 
Operator Example  Meaning Precedence 

^ A1 ^ B1 Power of 1 
* A1 * B1 Multiplication 2 
/ A1 / B1 Division 2 
+ A1 + B1 Addition 3 
- A1 – B1 Subtraction 3 
& A1 & A2 To concatenate two text values 4 
= A1 = B1 True if values in A1 and B1 are same, else false 5 
< A1 < B1 True if value of A1 is less than B1, else false 5 
> A1 > B1 True if value of A1 is greater than B1, else false 5 
<= A1 <= B1 True if value of A1 is less than or equal to B1, else 

false 
5 

>= A1 >= B1 True if value of A1 is greater than or equal to B1, 
else false 

5 

<> A1 <> B1 True if value of A1 is not equal to B1, else false 5 

Table 2.2 Precedence of operators used in formula 

 
For example the formula (3 + 5) / 4 * 5 ^ 3 – 2 will be evaluated as shown below: 
 
(3+5) / 4 * 5 ^ 3 – 2 Given Formula 
8 / 4 * 5 ^ 3 – 2 As brackets will be evaluated first, 5 + 3 = 8 will be calculated 

first. 
8 / 4 * 125 – 2 The power sign will be evaluated hence 5 ^ 3 = 125 will be 

calculated 
2 * 125 – 2 Now as precedence of / and * are  same, as division comes first 

8/4=2 is calculated, then * will be evaluated and 2*125=250 is 
obtained 

250 – 2 Finally subtraction will be done and the final result 248 is 
obtained 

248 Answer 
 
Cell reference and Cell range 

Cell is the basic unit in which data can be entered. A cell is identified by its address. 
A cell address is the combination of column character and row number. When a 
formula is to be applied on a consecutive set of cells (more than one cells), all these 
cells need to be selected. These set of cells is known as the range. 
More than one cell can be selected with the help of Shift + Arrow keys or by clicking 
on the first cell and then dragging the mouse. For example, the range of the cells 
selected in the Figure 2.1–a: is B2:E4 (Address of the first cell: Address of the last 
cell). 

 
Figure 2.1-a The Cell range B2:E4 
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Looking at the data of the workbook shown in the Figure 2.1-b, to find the total 
marks of Ajay, formula needs to be written in the cell F4, and the formula will be =C4 
+ D4 + E4 as C4, D4 and E4 contains Marks-1, Marks-2 and Marks-3 respectively. 
You can type the cell address in the formula or it can be automatically added in the 
formula by clicking the desired cell whose value need to be used in the formula. 
Perform the actions mentioned below to write any formula: 
1. Select the cell in which answer is desired 
2. Type ―=‖ sign 
3. Type the desired formula 
4. Press the Enter key 

You can copy a formula, which helps to avoid writing it again and again. To calculate 
total marks of other students, select cell F4, drag the fill handle using mouse. 

 
Figure 2.1-b Example of Formula 

 
Cell references are of two types, 1) Relative and 2) Absolute. By default the cell 
references are defined as relative. The position of the rows and the columns 
changes as per the situation when you copy a cell. For example, if you copy the 
formula (=C4+D4+E4) in the fourth row, and paste it in the fifth row, then the formula 
will be changed to =C5+D5+E5. 
When an absolute reference is used and a cell is copied or filled then the formula 
does not change, it is used when the value need not to be changed. To make an 
address absolute ―$‖ sign is used. Table 2.3 explains how a value of row and/or 
column can be fixed. 
 

Formula Meaning 
$A$2 Row and column both will not change when the formula is copied 
A$2 Row will not change when the formula is copied 
$A2 Column will not change when the formula is copied 

Table 2.3 Absolute reference 

 
Figure 2.1-c shows a formula to calculate Mass, using the formula mass = density * 
volume. Here the value of the density(Value in the cell E2 ) does not change while 
the value of the volume changes, hence the formula to calculate mass in second row 
within cell C2 is =B2*$E$2, when this formula is copied to cell C3 using fill handle the 
new formula will be = B3*$E$2. Thus if the value of any cell is not to be changed 
within a formula then absolute reference is used. 
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Figure 2.1-c Example of Absolute reference 
Function 

Excel has a library of predefined formulas (functions) that can be used to do things 
faster or to do calculations. It can be used for adding, multiplying, finding average, or 
to find the maximum or minimum of a range of cells. Excel gives hundreds of 
functions for text formatting, cell references, financial calculations, and to analyze 
numbers.  
It is necessary to follow a predefined syntax for each function, to-do the intended 
work properly. To use a function in a formula, an ―= ―sign, name of the function 
followed by the list of arguments/parameters need to be provided. Arguments are to 
be written in brackets. A value or cell reference range can be given as an argument, 
and is separated by ',' or ':' sign. Figure 2.2 shows how to calculate the total marks 
using the SUM function. 

 
Figure 2.2 Example of function 

 
Auto Sum Command 

To enter a function in a cell we can use Home → editing → AutoSum command as 
shown in the Figure 2.3. AutoSum automatically selects the cell range to add, to 
calculate the average or to perform other operations. In the above example by 
selecting cell F4 and clicking on AutoSum, Excel automatically shows the function, 
we only need to check whether it is correct or not. 

 
Figure 2.3 AutoSum command 

 
Function Library 

As shown in the Figure 2.4, Function Library group available on the Formulas tab 
can be used to enter financial, logical, text, date, time and other functions. 
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Figure 2.4 Function Library 

 
Some very useful functions and their uses are listed in the Table 2.4. 
Function Usage  
ABS Gives Absolute/positive value if the given number is negative. 
AND Gives true if all the arguments are true, else false. 
AVERAGE Used to find the average from the argument list. 
CHAR Gives a character value for the given integer code.   
CODE Gives integer code value for the given character.  
COUNT Counts total values in the argument list.  
COUNTIF Counts total values in the argument list if some given condition is true. 
DATE Shows the numeric value (order) of a given argument starting from 1 January 

1900.  
EXACT Checks whether two texts are same or not. 
EXP Used to find exponent e (2.71828182845904) of a given number till the 

specified value. 
FACT Used to find the factorial of given number. 
IF Used to perform a logical operation. 
LEFT Used to separate number of characters from the left side of the given text in 

the argument. 
LEN Used to find out the number of characters in a given argument. 
MAX Used to find out the maximum number from a given argument list. 
MID Used to separate number of characters from the middle of the given text in the 

argument. 
MIN Used to find out the minimum number from a given argument list. 
MOD Used to find the remainder when a number is divided by another number. 
NOW Used to display the current date and time. 
PI Shows the value of pi π (3.14159).  
PROPER Capitalizes the first character of each word in the argument. 
RAND Generates a random number between 0 and 1. 
RIGHT Used to separate number of characters from the right side of the given text in 

the argument. 
ROUND Used to round off a number after a specific decimal digit. 
SQRT Used to find the square root of a given number. 
SUM Used to add numeric values of an argument list. 
SUMIF Used to add numeric values of an argument list if some given condition is true. 
TODAY Used to show today‘s date.  
UPPER Used to convert text to upper case/ capital. 
LOWER Used to convert text to lower case. 

Table 2.4 List of some useful functions 

Insert Function Command 

You can find out any function as well as select the arguments for a function using the 
Insert Function command. The steps to use the Insert Function command are as 
shown below: 
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Figure 2.5 The Insert Function Dialog Box 

 
1. Select the cell in which function is to be entered. 

2. An Insert Function dialog box as shown in the Figure 2.6 will be opened. 
When a function name is typed followed by the pressing of the Go button, the 
function or a list of similar functions will appear. 

3. Select the desired function from the list and press the OK button, an 
Argument dialog box as shown in the Figure 2.6 is opened so as to pass the 
required arguments for the function. The arguments shown here will change 
based on the function being selected. 

4. The function will be written in the active cell when an argument is selected 
from the worksheet or manually typed and the OK button is pressed. 

 
Figure 2.6 The Argument Dialog Box 
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2.4 WORKING WITH WORKSHEET, ROWS, COLUMNS AND 
CELLS 

When you start Microsoft Excel 2010 you will be presented with an empty Workbook 
that has three Worksheets by default. You may add or delete desired number of 
worksheets in a workbook. Also it is possible to hide as well as change the order of 
the worksheets, copy or move a worksheet. Additionally a worksheet can be grouped 
and un-grouped, the rows and columns can be freeze such that they are visible even 
when scroll button is used. 
You can add or delete rows and columns, can hide or un-hide it, as well as change 
the height and width of the cells. 
 
A new worksheet can be inserted in three ways (Insert) 
 
1. As shown in the Figure 2.7, by clicking on an Insert Worksheet button a new 

worksheet is added. 
2. By right clicking the mouse button on the sheet tab, an Insert option in the 

shortcut menu is visible; selecting this option opens an Insert Dialog box. Now 
from the General tab select worksheet and press OK button, a new worksheet is 
inserted.  

3. By pressing Shift + F11 a new worksheet is inserted before an active worksheet. 
 
A  worksheet can be deleted in two ways (Delete) 

1. Right click the mouse button on the worksheet to be deleted on the sheet tab, a 
shortcut menu as in the Figure 2.7 will be visible. Selecting the Delete option 
from it will delete the worksheet. 

2. The active sheet can be deleted by selecting Home → Cell → Delete → Delete 
Sheet. 

In both cases if the worksheet contains data, Excel seeks your permission before 
deleting the data. 
 
A worksheet can be renamed in two ways (Rename) 
 
1. Right click the mouse button on the worksheet to be renamed on the sheet tab. A 

shortcut menu, as shown in the Figure 2.7 will appear. Selecting the Rename 
option will highlight the worksheet name. By typing the new name and pressing 
the Enter key the new name will be assigned to the worksheet. 

2. Double click on the worksheet whose name is to be changed on the sheet tab, 
which will highlight the worksheet name. By typing the new name and pressing 
the Enter key, will assign the new name to the worksheet. 

Change the colour of the worksheet tab 

To differentiate a worksheet from other sheets, the   tab color can be changed. 
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Right click the mouse button on the 
worksheet tab; a shortcut menu as shown in 
the Figure 2.7 will be displayed. Selecting 
the Tab Color option provides a choice to 
select any color. 

 

 
Figure 2.7 The Shortcut menu in sheet tab 

Move or Copy a worksheet 

You can move a worksheet in a specific order or copy a worksheet as desired. Right 
clicking on the worksheet on the sheet tab which we wish to move or copy, will open 
a shortcut menu as shown in the Figure 2.7.Select the Move or Copy option from it. 
This will open a dialog box as in the Figure 2.8, with the help of which it can be 
decided whether the selected worksheet is to be moved to a new workbook, to put it 
before a desired worksheet or to be moved or copied. By clicking the OK button the 
desired task can be done. 

 
Figure 2.8 The Move or Copy Dialog box 

 
Hide or UnHide the worksheet 

If you do not want to show the worksheet to someone else, then you can hide the 
worksheet and can be made visible again, when needed. Right clicking the mouse 
button on the worksheet on the sheet tab that is to be hidden, a shortcut menu will 
appear as shown in the Figure 2.7. Selecting the Hide option the worksheet will be 
invisible.  

To make the hidden worksheet visible again, right click the mouse button on the 
worksheet, a shortcut menu will be appeared as before. Now selecting the Unhide 
option will display a list of the hidden worksheets in a dialog box. Select the sheet 
that is to be unhidden and click on the OK button, it will be visible again. 

Viewing more than one worksheet of a workbook in multiple windows 
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To view more than one worksheet you can create a new Window for the workbook. 
To do this select View → Window → New Window option, which opens a workbook 
in a new Window. As shown in the Figure 2.9 the windows then can be viewed as 
tile, horizontal, vertical, cascaded or other way with the help of View → Window → 
Arrange All option. In the Figure 2.10, a workbook is viewed with vertical option and 
is seen as two different worksheets. 

 
Figure 2.9 Arrange Windows Dialog box 

 

 
Figure 2.10 Two worksheets of a single workbook shown in two different Windows 

 
Viewing two different parts of a worksheet in different panes at the same time 

The option View → Window → Freeze Panes when selected divides the workbook 
into four parts as shown in the Figure 2.11.When one of the parts is scrolled the 
others parts are still visible. Then we need a single worksheet, it can be seen again 
by selecting View → Window → Unfreeze Panes. 
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Figure 2.11 Freeze Panes option 

 
Working with rows and columns 

In Excel you can add or delete data in a single cell, entire row or column, hide and 
unhide rows or columns, can change the height of the rows and width of the 
columns. 

Adding rows and columns 

As mentioned earlier the number of rows and columns in Excel are fixed, hence 
when you add a row, the last row is removed while all the rows after the new row are 
shifted down. Similarly when a column is added all the columns move towards the 
right side. If the last row or column contains data then you cannot add an additional 
row or column. 
New row can be added in two ways. 

1. Right click on the row number above which the new row is to be inserted. This 
opens a shortcut menu, from which select the Insert option. 

2. A row is inserted above the active cell by selecting Home → Cells → Insert → 
Insert Sheet Rows. 
 

New column can be added in two ways. 
1. Right click on the column name before which the new column is to be 

inserted. A shortcut menu will be displayed. Select the Insert option from it so 
as to insert columns in the left side. 

2. A column is inserted in the left side of the active cell by selecting Home → 
Cells → Insert → Insert Sheet Columns. 

Deleting rows and columns 

If a row or column is not needed, it can be deleted. If a row or column gets deleted 
by mistake then it can be brought back using Ctrl + Z or the undo command. 
 
Row can be deleted in two ways. 

1. Right click on the row number that is to be deleted, this opens a shortcut 
menu. Select the Delete option from it, the row will be deleted. 
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2. A row of an active cell can be deleted by selecting Home → Cells → Delete → 
Delete Sheet Rows. 

Column can be deleted in two ways. 
1. Right click on the column name that is to be deleted so as to open the 

shortcut menu. Now select the Delete option from it, the column will be 
deleted. 

2. A column of an active cell is deleted by selecting Home → Cells → Delete → 
Delete Sheet Columns. 

Hide or Unhide a row or column 

To hide a row/column select it, click the right mouse button. Select the Hide option 
from the displayed menu, the row/column will be hidden. 
 
To show the row/column again, click the right mouse button on the nearby 
row/column. Select the Unhide option from the displayed menu, the corresponding 
row/column will be visible again. 
 
Changing the column width and row height 
 
The width of the column is measured in points. By default the width of each column 
is 64 pixels (PX) or 8.43 points. 
 
The column width can be changed by using any one of the following methods: 

1. Bring the mouse pointer towards the right side border of the column. Now 

drag the handle ( ). 
2. Enter the value of the width in the dialog box by selecting Home → Cell → 

Format → Column Width. 
3. The column width can be adjusted according to the longest text contents by 

selecting Home → Cell → Format → AutoFit Column Width. 
4. The column width can also be adjusted as per the longest text contents by 

just double-clicking on the right border of the column. 
 
The row height can be changed by using any one of the methods shown below: 

1) Bring the mouse pointer towards the top border of row. Now drag the handle (

). 
2) Enter the value of height in the dialog box by selecting Home → Cell → 

Format → Row Height. 
3) The row height will be automatically set to the largest text content by selecting 

Home → Cell → Format → AutoFit Row Height. 
4) 4)  The row height will be automatically set to the largest text contents by double-

clicking on the top border of the row. 
Copy and Paste a Cell 
 
Select the cell that is to be copied with the help of a mouse or arrow keys (see cell 
reference and cell range). Copy the cell by using any of the methods shown below: 
 

 Press Ctrl + C 



 
184 

 Right click the mouse button on the selected cell, select Copy option from the 
shortcut menu. 

 Click on Home → Clipboard → Copy 
 
Paste the cell where ever desired by using any of the methods shown below: 
 

 Press Ctrl + V 
 Right click the mouse button on the selected cell, select Paste option from the 

shortcut menu. 
 Click on Home → Clipboard → Paste, Excel will show you how the contents 

are going to look before pasting. 
 Click on Home → Clipboard → Paste, Excel will give you different paste 

options as shown in the following table :  
 

Option Usage 
Paste To paste data, format and validation of the cell. 
Formulas Only formula is pasted but not the formatting. 

Formula & Number 
Formatting 

Only formula and number formatting is pasted. 

Keep Source 
Formatting 

Formula as well as all formatting is pasted. 

No Borders Everything except border is pasted.  
Keep Source Column 
Width 

Formula and the column width from where the data is copied are 
pasted.  

Transpose Interchanges row and column data. 
Values Only the value of the data is pasted.  
Values & Number 
Formatting 

Value of the data and number formatting is pasted. 

Values & Source 
Formatting 

Value of the data and all formatting is pasted. 

Formatting Only formatting is pasted. 
Paste Link Exact formula (not relative) as in the copied cell is pasted. 
Picture Pastes data as picture. 
Linked Picture Pastes data as picture but when the data in the cell from where 

copy was done changes the picture also changes. 

Table 2.5 Paste Options 

Moving the Cell 
 
A cell can be moved by first selecting the cell, cutting it and then pasting it. 
Alternatively a selected cell can also be moved by dragging the mouse. Remember 
that when a cell is moved if it contains data then that data is removed and new data 
comes in its place. 
 
Cell Comment 
 
Cell comment is used to give additional information about the cell contents. To 
assign comment first of all select the cell and can apply any of the following ways: 

 Select Review → Comments –> New Comment 
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 Right click the mouse button on the selected cell, select Insert Comment 
option from the shortcut menu. 

 Press Shift + F2 
 
Then type the comment. Figure 2.12 shows a comment (already assign) that is 
visible when a mouse pointer is moved to that cell. 
 

 
 

Figure 2.12 The Cell Comment 
 
In Excel to remove the comment, Review → Comments → Delete option is used. 
Also to hide or show the comment, Review → Comments → Show/Hide Comment 
option is used. 
 

2.5 TABLE FORMAT 
 
To work easily on data ranges, you can convert it to a table format, which provides 
the following benefits: 
 

 To apply predefined formatting. 
 Allows filtering and sorting the data. 
 Calculations can be done easily on rows and columns. 
 Duplicate rows can be automatically removed. 
 The size of the data can be easily changed. 

 
To create a table, first select all the cells that need to be converted to table, and then 
select Insert → Tables → Table, which will open the CreateTable dialog box. 
Clicking on the OK button will create a table as shown in the Figure 2.13(ribbon: in 
Design tabTools). 
 

 
 

Figure 2.13 Table Design Tab 
 

The Style group in the Table Design tab provides facilities to change the look of the 
table as shown in Figure 2.14. The Table Styles option in Table Design tab provides 
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options to show/change Header Row, Total Row, First Column, Last Column, 
Banded Row and Banded Column as shown below. 
 

 
Figure 2.14 Table Format 

 
If a table has duplicate rows as shown in the Figure 2.14, the Remove Duplicates 
option can be selected to remove them as in the Figure 2.15. It is required to identify 
the duplicate entries to be removed and then clicking the OK button will make the 
necessary changes to the table. 
 
The row header gives option to sort and filter, we will understand about sort and filter 
in detail later. To remove the table format and convert the data to a normal cell 
range, Convert to Range option can be selected as shown in the Figure 2.13. 
 

 
 

Figure 2.15 Remove Duplicates Dialog Box 
  

2.6 SORTING 
 
Sorting allows you to arrange the data in ascending or descending order or to 
separate the data as per the requirement. By sorting, data (text, number or Date and 
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Time) can be arranged as per the required order of choice.  data can be sorted on 
more than one level in the custom sort, for example you can arrange employee data 
first based on the Department, then by Name and then  by Age.  
 
To sort data based on single column, select any cell of the column on which data is 
to be sorted, then use any of the following method: 
 
1. Home → Editing → Sort & Filter → Sort Smallest to Largest/Sort Largest to 

Smallest 

2. Data → Sort & Filter →  or  
 
To sort data based on more than one column, select any cell then use any of the 
methods mentioned below: 
 
1. Home → Editing → Sort & Filter → Custom Sorting 

2. Data → Sort & Filter → Sort  
 
By selecting any of these methods a sort dialog box as shown in the Figure 2.16 will 
opened and Excel will automatically select all the data. Then  the required   column 
and sort order can be chosen and then by pressing Add Level button the next 
column on which sorting to be done can be added. 
 

 
 Figure 2.16 The Sort Dialog Box 

2.7 FILTER 
 

Filter shows only those rows that satisfy a predefined condition. The use of the filter 
thus provides facility to reduce data, and shows only the important data and hides 
the unnecessary data. You can apply more than one filter and if not needed the filter 
can be removed and the entire data can be displayed back. You can filter the data 
based on number, date, text or color. Select any cell of the data that is to be filtered, 
then use any of the below mentioned methods to apply the filter.  
1. Home → Editing → Sort & Filter → Filter 



 
188 

2. Data → Sort & Filter → Filter 
 
The Figure 2.17 shows the data before being filtered and the Figure 2.18 is after the 
filter has been applied. As shown in the Figure 2.19 clicking any of the check boxes 
including the Select All the corresponding filter can be applied 
 
 

  
Figure 2.17 Before Applying Filter Figure 2.18 After selecting filter 

 

 
Figure 2.19 The Number Filter 
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Figure 2.20 Data to be given for filter 

 
Figure 2.21 Filtered Data 

 

Excel filters data based on its type (number, date or text).The Figure 2.19 shows a 
number filter for Roll No., selecting an option from the available list, will open a 
dialog box as shown in the Figure 2.20.Now entering the desired conditions and 
clicking on the OK button will filter the data as shown in the Figure 2.21. 
 

2.8 DATA TOOLS 

The following options are available in Data Tools. 

 
Figure 2.22 Data Tools 

 
Data Data Tools Text To Columns 

Depending on the data, the cell content can be splinted based on a delimiter, such 
as a space or a comma, or based on a specific column break location within the 
data. To implement this option first select the data that has been entered. As shown 
in the Figure 2.23.Selecting Data Tools and clicking on Text to Columns, will open a 
dialog box as shown in the Figure 2.24. Converting text to columns uses three 
steps. 

 
Figure 2.23 The Data 
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Let us understand by taking an example. Enter the data as shown in the Figure 
2.23. It displays column headings NAME, AREA, SELLING. Both the column 
headings and the data entered thereafter are separated by comma (,). Here there is 
one record in one row and 10 such records are there. Now select this data (to select 
the data we can use mouse or use the Shift and the arrow keys from the keyboard). 
After selecting the data we have to separate it in three different columns, by clicking 
on the Text to Columns options shown in the Figure 2.24.  
In this dialog box we can see the range of the selected data. Then we are asked two 
options, 
Delimited: If the data selected is separated by comma or tab key then click on this 
option. 
Fixed width: If there is space in the data that is being selected then this option is 
used or if we want the data to be separated automatically based on the width of the 
column then click on this option. Here we have clicked on the Delimited option. Then 
click on the Next button to open a new dialog box as seen in the Figure 2.25. 

 
Figure 2.24 Step 1 

After clicking on next button a dialog box as shown in the Figure 2.25 will be 
opened. Here in the left hand side we are asked for the Delimiters. Click on the 
comma option, because the data has been separated using comma. Here as soon 
as we click on the comma option, the data is displayed in the form of columns 
immediately in the bottom part of the dialog box. Now clicking on Next button will 
show another dialog box, as seen in the t. 
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Figure 2.25 Step 2 

 
Figure 2.26 Step 3 

 
Here we are asked the format of the data like General, Text, and Date. Clicking on 
the General option, followed by clicking   the Finish button, the result will be 
displayed as shown in the Figure 2.27. 
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Figure 2.27 The Final Result 

 
Data Data Tools Remove Duplicates 
At times when we enter data, there can some records being entered multiple times 
accidentally, leading to the duplicity of data. Such records are known as the duplicate 
records.  The Remove Duplicates option can used to remove such duplicate records. 
Let us understand by taking an example, enter some records as shown in the Figure 
2.28. Then select the data and click on the Remove Duplicates option available in 
Data Tools. This will open a dialog box as shown in the Figure 2.29. 

 
Figure 2.28 The Data 

 

 
Figure 2.29 The Remove Duplicates Dialog Box 
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This will give the option either to remove the duplicate from the current selection or 
to expand the selection. If the selection needs to be increased then Expand the 
selection option is to be chosen.  
Since we want to remove the duplicates only for the selected area, here we click on 
the Continue with the current selection option. Then clicking on the Remove 
Duplicates, it will show another new dialog box as in the Figure 2.30 
. 

 
Figure 2.30 The Remove Duplicates Dialog box 

 
If we had selected more than one column then their names would have been also 
visible here. Additionally if needed a column from the selected set of columns can be 
unlisted (unselected). Finally clicking on the OK button a final result as shown in the 
Figure 2.31 is visible. Here we can see that there is a difference in the number of 
records shown in the Figure 2.28 and 2.31.i.e.the number of records are less in the 
Figure 2.31. Finally Figure 2.32 shows the number of duplicate records that have 
been removed. 

 
 

Figure 2.31 Final List 
 

 

Figure  2.32 Number of records removed 

Data Data Tools  Data Validation 
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Data Validation is used when we need to enter the data in a specific manner, thus 
restricting the entry of the invalid entries. For example, the selling price should be 
between 15000 and 35000. Let us understand by taking an example. 
As shown in the Figure 2.32 Name, Area, Selling Amount, etc. data is already 
entered. Let us now see how to make a circle around values that are greater than 
15000 and less than 35000 so that they can be differentiated.  
 

 
Figure 2.32 Data Validation 

 
First select selling amount. After the amount is selected click on the Data Validation 
option in Data Tools. A dialog box as shown in the Figure 2.33 and 2.34 will appear. 
Three tabs can be seen in this Data Validation dialog box, Settings, Input Message 
and Error Alert. 
Settings: In this tab we are asked about validation. In the Allow: option the 
acceptable data format is chosen. Here we are talking about selling amount, hence 
select Whole Number. If in case a value has not been entered in a cell, then to 
ignore entries in such cells check on the Ignore Blank option. 
Based on the option selected under the Data, list the options below and it will 
change. Here we need the values greater than 15000 and less than 35000, hence 
select Between option, thus we are asked the Maximum and Minimum value. Here 
we need to enter the decided values. After entering these pre-decided values, move 
to the Input Message tab. 
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Figure 2.33 Input Message tab 

 
Input Message: This option is used so that the user does not enter wrong 
information. The input message written by us will be visible in a box near the 
selected cell in which validation is applied. 
Error Alert: Normally the user enters correct data after giving an Input Message. But 
if any mistake happens, then to show such mistakes in a dialog box this option is 
used. Three styles Stop, Warning and Information can be used to show the mistakes. 
We can select any of these styles as per our choice. We will see different symbols 
based on the style being selected. The steps of data validation will be finished, after 
entering the Title as well as the Error Message and finally clicking on the OK button. 
Now if the output of the data validation is to be seen then in Data Tools a Data 
Validation option is available named Circle Invalid Data. As soon as this option is 
clicked an output as shown in Figure 2.35 comes on the screen. It shows a red 
colored circle on the data with wrong selling amount. 
We can clear the red colored circles on the wrong dataset, by clicking on the Clear 
Circle Validation option in the Data Tab of the Data Validation group. 

 
Figure 2.34 Data Validation Dialog box 
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Figure 2.35 Result of Data Validation 

 
Data Data ToolsConsolidate 

This option is used to summarize and consolidate the results of the data available in 
different worksheets into a single master worksheet. The worksheet in which you 
consolidate the data can be stored in the same workbook as master worksheet or in 
another workbook. With the help of Consolidate option you can store information in a 
single worksheet and update it easily. Different status of data, type of data can be 
consolidated in some another format in a single worksheet. Let us take an example 
to understand this. 

  

Figure 2.36 Data 

 
As shown in the Figure 2.36, the sales details are stored in two different worksheets. 
Then go to the worksheet in which data is to be consolidated and click on the 
Consolidate option in Data Tools group.  A dialog box will be opened as shown in the 
Figure 2.37. Here we need to specify the function that is to be applied on the data to 
be consolidated, then go to both the worksheets one by one, and select the data and 
add its cell references to All References by clicking on the Add button. Clicking on 
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the OK button will show the consolidated data of both the worksheets in the third 
worksheet as shown in the Figure 2.37-a, 2.37-b. 
 

 
Figure 2.37 Consolidate Dialog Box 

 

 
Figure 2.37-a Output of Consolidate 

 
Figure 2.37-b Detailed output of Consolidate 

 
Figure 2.37-b shows the addition of the rate, quantity and amount of all the items 
from both the worksheets. Lecture-2 is the name of the file. 
 

Data Data ToolsWhat-If Analysis Scenario Manager 
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Figure 2.38 Scenario Manager 

 
Scenario Manager: This option provides you the facility to see different values 
(scenarios) of a formula result. Let us try to understand this with an example. 
Enter data as shown in the Figure 2.39, containing values for the Principal Amount, 
Rate of Interest, No of Years, and Interest Amount. Under the Interest Amount, the 
value in first row is calculated using the formula of simple interest, while in the 
second row formula of the compound interest is used. 

 
Figure 2.39 Data 

 

  

Figure 2.40 Scenario Manager 

 
Let us now think of the scenarios in which simple interest and compound interest 
need to be calculated on the Principal amounts of 20000, 30000, 40000 and 50000. 
To create these scenarios, select the data and click on What-If-Analysis in the Data 
Tools. Clicking on the sub option of Scenario Manager a dialog box as shown in the 
Figure 2.40 will appear. On clicking the Add button in it, will open the Edit Scenario 
dialog box as shown in the above figure. 
In this dialog box, Scenario Name is to be given.  The scenario name can be any 
name of our choice. Here we want to see what an Interest amount will be,  when the 
Principal Amount is 20000.Hence in the Changing Cell type A2:A3 and on clicking 
the OK button, will  open a dialog box as shown in the Figure 2.41. In this dialog box 
enter the values of A2 and A3 as 20000 and click on the Add button, thus adding a 
new scenario. Similarly other scenarios can be added for 30000, 40000 and 50000as 
shown in the Figure 2.42. 
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Figure 2.41 Scenario Values 

Name of all the scenarios created will be shown as below. To remove a scenario, 
select its name and click on Delete button, similarly the scenario can be changed 
using the Edit button. To see the output of the scenario, select it and click on the 
Show button, this will display the scenario sheet with the new values. 

 
Figure 2.42 Multiple Scenarios 

 
Clicking on the Summary button a dialog box as shown in the Figure 2.43 is visible. 
Select the Scenario summary option in it, followed by entering the interested formula 
range in the Result Cells and click on the OK button. This will show the summary of 
different values and its result in different worksheets. (Figure 2.44) 

 
Figure 2.43 Scenario Summary 

We can change the data using this option, enter new record as well as view all the 
data in a summarized form.  
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Figure 2.44 Scenario Summary Output 

The Scenario summary sheet shows the current values of the cells, values of cells 
as per the scenario, the value of current Result cell and value of Result cell after 
scenario is applied. 
 
Data Data ToolsWhat-If Analysis Goal Seek   

Goal Seek: This option is used to get an exact desired output of a mathematical 
calculation. Three sub options Set Cell, To Value and By Changing Cells are 
available in the dialog box for this option. In Set Cell, only the address of cell that 
contains a formula can be entered, the value of the target is to be entered in To 
Value. In By Changing Cell enter an address of any one of the cells (by changing 
whose value the result is to be obtained) that has been used in the resultant formula. 
Let us take an example, 
In this example the principal amount, rate of interest, number of years for which the 
principal amount is invested, and how much interest will be obtained is given. Here 
the principal amount is Rs. 250000, rate of interest is 10 percentage, number of 
years for which the principal amount is invested is 3. The interest is calculated with 
the help of simple interest formula (I = P * R * N /100), the interest calculated here is 
Rs. 75000. 

 
Figure 2.45 Goal Seek 

 
But now we want to see what needs to be done if only Rs. 50000 is to be obtained 
as interest instead of Rs. 75000? We need to change either the principal amount or 
rate of interest, or keep the amount for less number of years. To perform this 
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operation Goal Seek option is needed. A dialog box appears as soon as we click on 
the Goal Seek option. 
When this option is to be used, initially the cursor has to be placed in the cell that 
needs to be changed (the cell containing the formula). The dialog box which opens 
when this option is clicked automatically contains the address of the Set Cell. As 
mentioned earlier in the two value box we need to type the value of the result that we 
want. Assume that we enter 50000 in it and then in By changing cell box select 
address of any one of the cells  (cells containing principal amount, rate of interest or 
number of years) that we want to change, the address of the selected cell will be  
visible. By clicking on the OK button, the desired output will be obtained. Normally 
this option is used when large calculations are to be done.  
 

2.9 OUTLINES 

 
Figure 2.46 Outline 

 
When there is huge amount of data in a worksheet, this option facilitates to arrange 
and view the data in groups. Also is it possible to show or hide the data based on this 
group. The data can be un-grouped using the ungroup option when not required. The 
Subtotal option allows to perform analysis and to total it for faster calculations.  
 
Data Outlines  Group 

Group: As shown in the Figure 2.47 different persons sell products belonging to 
different vendors. If we need to arrange this data in such a manner that the details of 
a person is shown together then with the help of Data → Sort option the data can be 
sorted on name, then select all the data and from the Outline group select Group 
option.  
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Figure 2.47 Data 

 
As shown in the Figure 2.48, we can decide whether the group is to be created 
based on row or column.  

 
Figure 2.48 Group 

As soon as we click on Rows we get the desired output. The output can be seen in 
the Figure 2.49. If the grouping was done based on Columns then it was possible to 
show or hide columns. 
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Figure 2.49 Output of Grouping 

 
As seen in the Figure 2.49 a line is visible on the left hand side. A ‗+‘ (plus) sign 
comes on the top and a ‗–‗(minus) sign comes on the bottom of this line. Here when 
the ‗–‗sign is clicked, the data is hidden and when a ‗+‘ sign is clicked the hidden 
data becomes visible on the screen again. Due to this option on the right side of the 
Outline tool, options like Hide Details and Show Details are given. 
Once the group are created we can see options like 1 2 on the left side. This 
indicates that if we have created more than one group then the output of each of 
these groups can be seen by clicking on these numbers one by one. 
 
Data Outlines  Ungroup 

When we want to convert back the data that has been grouped into a normal 
dataset, then if the ungroup option of the Outline tool is clicked we get two sub 
options as shown in the Figure 2.50. Here if we directly click on the Clear Outline 
then we need to use the ungroup option. 

 

 
Figure 2.50 Ungroup 
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Figure 2.51 Data after Ungroup 

 
When the Ungroup option is selected, it will ask whether the group was based on 
row or column. Select the correct option, as soon as we click on either row or column 
the data will again become normal as shown in the Figure 2.51. 
It is important to note that if the Subtotal has been done then that data will not be 
removed. To remove it, first we need to open the Subtotal dialog box by clicking on 
the Subtotal command, and then click on the Remove All, only then the groups and 
the subtotal can be removed. 
 
Data Outlines  Subtotal 

Subtotal option provides a facility to outline the data in different ways. The Subtotal 
option uses function like Sum, Count, and Average to summarize the data and keeps 
them in a group.  
The subtotal option is used only when the data available is already sorted. If we have 
not sorted (ascending and descending) the data, then select the data and sort it 
using the Data Tools. Once the data is sorted select the entire data set as shown in 
the Figure 2.51. Now click on the Subtotal option which will open a new dialog box 
as shown in the Figure 2.52. 
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Figure 2.52 Subtotal Dialog box 

In the ‗at each change in:‘ box select the column name that has been sorted, and in 
the ‗Add subtotal to:‘ box select the column in which subtotal is to be added. Here 
we need to find sales of an individual person, hence in the each change in: box 
person name and in the Add subtotal to: box Total Sales has been chosen. If a 
subtotal has been calculated previously then check Replace current subtotals option, 
which replaces the old subtotal with the new subtotal. If Summary below data is also 
checked then we will get the Grand total at the end. The output similar to the one 
shown in the Figure 2.53 will be visible when the OK button is clicked. 
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Figure 2.53 Output of Subtotal 

 
As can be seen in the Figure 2.53, on the left hand side three group options 1, 2, 3 
can be seen. When the number 1 is clicked we will be able to see data as shown in 
the Figure 2.54. Here only the Title and the Grand Total have been displayed. 
 

 
Figure 2.54 Output when 1 is clicked 

When the number 2 is clicked, we will be able to see data as shown in the Figure 
2.55. It displays the name of the person, total sale done by him along with the Grand 
Total. When the number 3 is clicked we will be able to see data similar to the one 
shown in the Figure 2.53.  

 
Figure 2.55 Output when 2 is clicked 
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To remove the effect of subtotal, we first need to choose the Subtotal option.  A 
dialog box as shown in the Figure 2.52 will be opened, on the left bottom of which, 
there is Remove All option. Clicking on this option the effect of the subtotal will be 
removed and the data will come back to its normal form. 
 

2.10 CHECK YOUR PROGRESS: POSSIBLE ANSWERS 
 
1. According to figure 2.2 create excel sheet and find total marks and percentage 

with the help of formula and function. 
2. Find maximum and minimum marks in each subject. 
3. Make a file in excel and sane it with name Myworksheet. 
4. Add a new sheet in excel  and name it mysheet and  make it‘s tab colour  brown. 
5. Move mysheet to first sheet and copu it by the name Mysheet-1. 
6. Hide mysheet and then unhide it. 
7. Create excel sheet as figure 2.14 and remove all duplicate data that repeats in 

every columns. 
8. Sort the data by the country name if data name and name are equal. 
9. Display vinay‘s data of selling above 5000 with the help of data text and number 

filter. 
10. According to figure 2.23 convert  excel sheet data into three columns from one 

column . 
11. After converting into three columns .circle the record with red colour which has 

selling less than 15000. 
12. Insert a duplicate record of any record in the table and remove it using  option 

‗remove duplicates‘. 
13. Collect quarterly exam data from one sheet and semester exam data from other 

sheet 
14. Add name of the student and marks of three subjects and find total marks and 

percentage. And to find different values of percentage ,find marks needed in 
particular subject with the help of goal-seek. 

15. Create different scenarios of marks of the student and make it‘s summary sheet. 
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Unit 3:  Pivot Table, Charts and 
Review Tools in Excel 2010 

  
 
Unit Structure 
 
3.1. Learning Objectives 
3.2. Introduction 
3.3. Pivot Table 
3.4. Chart, Spark lines and Graphics 
3.5. Review Tools 
3.6. Keyboard Shortcuts 
3.7. Check your Progress: Possible Answers 
3.8. Further Reading 
3.9. Activities 
  

3 
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3.1 LEARNING OBJECTIVES 
 
After studying this unit student should be able to: 
 

 Create different types of Charts . 
 Use Sparkline and Graphics in Excel. 
 Consolidate and separate important data as per the requirement from a huge 

data set using Pivot Table   
 Create chart for this using the Pivot Chart. 

 

3.2 INTRODUCTION 
 
In the previous chapter we have seen how to use different functions and formulas in 
Excel sheet. As well as Table formatting, Sorting of data. How different filters are 
used that is also discussed and how different Data Tools and Outlines are used that 
we have seen. This chapter provides detailing of Pivot Table. How it is used for 
different purposes. How different data can be represented in graphical form with the 
help of Charts that is discussed. This chapter also discusses about Spark lines and 
Graphics. Use of Review Tools is also covered in this chapter. With it, it also 
discusses Keyboard shortcuts.  

 

3.3 PIVOT TABLE 
 

 
Figure 3.1 The Pivot Table 

 
Pivot table is very fast and is a useful tool, used to summarize, analyze and present 
huge amount of data. With the help of pivot chart you can compare data, view type 
and variation of data easily. Pivot Table and Pivot Chart help you in taking efficient 
decisions for important dataset. Also it is feasible to answer some difficult questions 
very easily. 
Let us take an example where sales of different products (vegetables and fruits) of 
different countries are listed. Now select all the data and go to the Insert tab, click on 
the Pivot Table option. This will open a dialog box as shown in the Figure 3.2. It 
shows an option that asks us whether the pivot table is to be placed in the same 
worksheet or another. Here as soon as OK button is clicked a dialog box will be 
opened as in the Figure 3.3. 
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Figure 3.2 Pivot Table Example 

 
In the right side here we are able to see the Field List as shown in the Figure 3.4. 
We can see Report Filter, Column Labels, Row Labels, and Values in it. We need to 
select the field names in the field list first. To select the field list go to the field and 
click on it, a Blank Pivot Table on the left side as shown in Figure 3.3 will be  filled 
with data.  
To get the desired output when the Pivot Table is used, we need the fields like 
Report Filter, Column Labels, Row Labels and Values. 
Row Labels: The value of the column names selected from the main table will be 
shown in the pivot table rows. 
Column Labels: The value of the column names selected from the main table will 
be shown in the pivot table columns. 
Values: Shows the sum, average, maximum, minimum or other function being 
selected at the intersection of the rows and columns.  
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Figure 3.3: Blank Pivot Table 

 

 

 

 

Figure 3.4 Pivot Table Field List 
 

 
As shown in the Figure 3.4 in the Pivot Table Field List, Product is selected as Row 
Labels, Country is selected as Column Labels and under the Values, and Sum of 
price is selected, hence in Pivot Table as shown in the Figure 3.5: 

 The row will contain name of the products from the main table. 
 The column will contain name of the countries from the main table. 
 The intersection of the rows and columns will contain the sum of the price 

for a product sold in the corresponding country. 
 The row will contain total of all products sold. 
 The column will contain total of all products sold in each country. 

 
Pivot table also provides you the facility to filter the data stored in the rows and 
columns. Thus we can hide unnecessary data. 
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Figure 3.5 Output of Pivot Table 

 

 
Figure 3.6 Value Field Setting 

 
On the right hand side of the Pivot table a Field List option is given, within which 
when we click on the Values part a popup menu as shown in the Figure 3.6 is 
visible. Using different options of this menu we can move a field, remove a field, or 
change a function. 
 
Check Your Progress 
 

1. Make pivot table entering data as figure 4.28 that shows total selling of 
vegetables and fruits in all countries. 

 

3.4  CHART, SPARKLINES AND GRAPHICS 
 

 
Figure 3.7 Charts 
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Chart is also recognized as the graph. In Excel charts are used to display specific 
data set graphically or to segregate information. As shown in the Figure 3.8 we have 
data of students, their marks in different subjects, total marks and the corresponding 
percentages. 

 
Figure 3.8 Data 

To create a chart the Insert tab is used. As soon as this tab is clicked a Chart tool is 
displayed. We can see different types of charts here. Almost 11 different types of 
charts like column, pie, line, bar, area, scatter chart are available here. Thus we have 
an opportunity to show the data in different ways. 
Here we will create a graph based on the student names and their marks in four 
different subjects. For this, we will have to first select the name of the student and all 
the four subjects. (The data can be selected using shift + arrow keys or using a 
mouse drag). 
 
Once the data is selected we need to select the type of the chart (graph) that we 
want to create. Here we are selecting Column chart. As soon as the Column chart is 
clicked, it asks the sub option of what type of column chart is to be created. See 
Figure 3.9. 
 
Here we select the first option, as soon as we click on it a chart as shown in the 
Figure 3.10 is visible to us. 
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Figure 3.9 Column Chart Types 

 

 
Figure 3.10 The Column Chart 

A Chart tool as shown in the Figure 3.11 will be visible on the screen as soon as the 
chart is created. 

 
Figure 3.11 The Chart Tool 

It is possible to change the design of the graphs with the available designs. 
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A Move Chart tool is available in the Chart Tool. We can easily move the chart to 
another sheet with the help of it. When we click on the Move Chart option a dialog 
box is opened. It displays the list of the sheets where the chart can be moved, 
selecting the desired sheet the chart is immediately moved to that sheet. (Figure 
3.12) 

 
Figure 3.12 The Move Chart Dialog Box 

 
Figure 3.13 Chart Tools 

The first tool available in the Chart Tools is ‗Change Chart Type‘. With the help of it 
we can easily convert the column chart to pie, line or any other chart type. We simply 
need to select the chart type and the current chart will be converted to the new type. 
(Figure 3.14). 

 
Figure 3.14 Changing Chart Type 

The second tool of Chart Tools is ‗Save As Template‘. With the help of it we can 
save the chart. Here the chart will be saved with the desired name , with the 
extension  .crtx.(Figure 3.15). 
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Figure 3.15 Saving Graph 

The third tool of the Chart Tools is ‗Switch Row/Column‘. In this example we have 
created the graph based on row (based on the name of the student). Now if we want 
to create a chart based on the column, then when this tool is clicked a new graph is 
created. (Figure 3.16). 

 
Figure 3.16 Select Data Source 

‗Select Data store‘ is the fourth tool in the Chart Tools.. With the help of it we can 
see  the range (rows and columns) that we has been selected for the chart. We can  
change the range of cells using the Edit Series option.as shown in the Figure 3.17. 

 
Figure 3.17 Edit Series 
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There is  an option of Legend Entries (Series), as in the Figure 3.14 which have 
been displayed on the right hand side as Series 1, Series 2, and Series 3 and so on. 
Instead of it if we want to write the names of the individual subjects, then it can be 
done by clicking on the Edit button. (See Figure 3.18) 

 
Figure 3.18 Changing Series 

‗Chart Layout‘ is the next tool in the Chart Tools. With the help of it we can add a 
Chart Title. We can also show numeric data, for example marks or average of the 
subject as shown below. Charts can be displayed in different ways like with the chart 
title, with the data table, with Axis title  as shown in the follwing figures (Figure 3.20, 
Figure 3.21 and Figure 3.22) respectively.  

 
Figure 3.19 Chart Layout 
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Figure 3.20 Chart Title 
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Figure 3.21 Chart with data table 
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Figure 3.22 Axis Title 

 
Sparkline 

Normally the charts that can be embedded in a single cell is called sparkline. As 
sparkline is small we can work by keeping them along with the worksheet. In the 
previous example we have used name of the students, their marks in  different 
subjects, total marks and their percentages. Let us now create a sparkline for the 
subject of Computers. To perform this operation we first need to select the marks in 
the subject of computer. Then select a line chart. Click on the first option (Line), you 
will be able to see a sparkline as shown in the Figure 3.23. Intialy the sparkline will  
come with a horizontal line. we can deselect the option of the horizontal line from the 
Line chart.. We can also change the size of this sparkline if required. 
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Figure 3.23 Sparkline 

We can get coloured sparklines by selecting different designs.  

 
Figure 3.24 Different Designs 

Check Your Progress 
1. Create a column chart entering data as figure 2.1-b that shows name and total 

marks. 
2. Enter data as figure 2.27 and create a pie chart that shows what percentage 

of selling is done of the total selling by a person. 
3. Enter data as figure 2.1 –b and for each marks create a sparkline at the end 

of the column. 

 

3.5 REVIEW TOOLS 
 

 

Figure 3.25 Review Tools 

Review Proofing  Spelling 

Normally whenever we enter data, there is the possibility of some spelling mistakes 
always. .  The Spell Check option can be used to check the spellings. 

This option is available to us under the Review Tools, Proofing option. The shortcut 
key to activate the spell check is F7. This option when activated will check each and 
every spelling, and for the wrong spellings it will provide suggestive list of other 
relevant spellings that can be used. But the computer will display all the available 
spellings in its dictionary to us. If the suggestion is to be accepted then we need to 
click on the Change. If we don‘t want to use the suggestion then Ignore has to be 
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clicked. The Spell Checker in this case will move on to the next word. Once all the 
data is checked a message Spell Check Complete will appear on the screen, 

 
Figure 3.26 Spell Check 

 
Review Proofing  Research 

This option is used usually when we need to find out a reference or a gist (how or 
where can the word be used) of a word from the available reference books. Let us try 
to understand with an example: Assume that we have written a word above, a 
research box will be opened as soon as we press Alt key and click the left mouse 
button on this word. We will be able to see the reference and the gist of this word in 
this box.  

Review Proofing  Thesaurus 

This option helps us to find the synonyms of any word. For example for the word 
Above, Thesaurus will give the list of synonyms words as shown in the Figure 3.28 
 
Review Proofing  Translate 

This option is used to translate the text written in English language into any other 
language. For example if we want to convert the word this into French language, 
then select the word and click on Translate, This will open a dialog box as shown in 
the Figure 3.29. Selecting French from this list in the dialog box, followed by 
pressing the Enter key, will translate the word into the French language. (Figure 
3.29) 
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Figure 3.27 Research            Figure 3.28 Thesaurus            Figure 3.29 Translate 

 
Review Comment 

When we want to provide additional information for data then this option is used. We 
can write the meaning, reference or any other detail about the data in the comment.  

Review Comment  New Comment 

We can write comment on any word. As shown in the Figure 3.30, a box appears as 
soon as we keep the cursor on the word above, and click on the Comments option in 
the Review Tools. We can write the desired comment in this box. Once the comment 
is written, a red colored dot is visible in the cell where comment has been written. 
When the cursor is brought on to this red dot, the comment that is written for this cell 
will be visible. 

 

Figure 3.30 The Comment 

Review Comment  Delete 
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This option is used to delete any comment that has entered for any word. To do so, 
go to the cell whose comment is to be deleted, and select this option. .  

Review Comment  Previous 

If we have written more than one comments in our sheet, then using this option we 
can see the previous comment. 

Review Comment  Next 

If more than one comments are there in a sheet, then this option allows us to see all 
the comments one by one. 

Review Comment  Show/Hide Comment 

This option is used to show or hide a comment that has been written within a cell. 
For performing this action, t we need to go to the cell where the comment is written. 
Clicking on this option, the comment can be made visible and invisible alternatively. 

Review Comment  Show All Comments 

This option is used to see all the comments in worksheet. It is possible to see all the 
comments given by the user at once. 

Review Changes  Protect Sheet 

This option is used if we need to protect our worksheet, a cell or a specific column. It 
is necessary to protect our sheet so that no one can copy the data or change the 
data. . Suppose we have some data as in the Figure 3.31. 

 
Figure 3.31 Data 

We can see the Protect Sheet in the ‗Changes‘ option of the ‗Review Tools‘. 
Clicking on this option will open a dialog box as shown above. It asks us whether we 
want to protect the whole sheet, some specific cell, column or row. This effect will be 
applicable to only that option being selected from the list. 

We need to enter a password to protect the data. The password can contain 
alphabets as well as numbers. Once the password is entered and the OK button is 
clicked, a Confirm Password dialog box will appear. Entering the same password 
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again and clicking on the OK button, the data can be protected. . If anybody tries to 
delete the data being protected, then a message as shown in the Figure 3.32 will be 
displayed. 

 

Figure 3.32 Message (displayed when data is accessed or deleted by anybody) 

If we need to unprotect the sheet, then the option ‗Unprotect Sheet‘ available in the 
Changes option of Review Tools can be used. Clicking on this option will show a 
dialog box as shown in the Figure 3.33. By entering the correct password the sheet 
will get unprotected. 

 

Figure 3.33 Unprotecting Sheet 

Review Changes  Protect Workbook 

This option is used to protect an entire workbook, thus protecting all the worksheets 
within the workbook. 

. Clicking on this option will show some sub options as in the figure below. 

 

Figure 3.34 Protect Workbook 
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. In case we want that no one should be able to make changes, then we need to 
select Unrestricted Access. In order to provide some limited editing options 
Restricted Access has to be selected. 

Review Changes  Share Workbook 

This option is used when we need 
to share a workbook. 

Selecting this option will open a 
dialog box as shown in the Figure 
3.35. We can see the workbook 
name here. Selecting the workbook, 
followed by clicking the Enter key, 
the workbook can be activated for 
sharing. 

 

Figure 3.35 Protect Workbook 
 

Check Your Progress 
1.correct spelling mistakes in your worksheet, find synonyms and use translate 
option. 
2. make your worksheet password protected. 
  

3.6 KEYBOARD SHORTCUTS 

A list of useful Excel keyboard shortcuts is given in table below: 

 
Key Meaning  

Arrow Keys To move up, down, left or right by one cell 

Page Down/Page Up To move up or down by one screen size 

Alt + Page Down /Alt + Page Up To move left or right by one screen size 

Tab/Shift + Tab To move right or left  by one cell 

Ctrl + Arrow Keys To move to the next cell containing data from the active cell 

Home To move to the starting of a row 

Ctrl + Home To move to the first cell of the worksheet 

Ctrl + End To move to the last cell that contains data from active cell 

Ctrl + f Selects find option in Find and Replace dialog box 
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Key Meaning  

Ctrl + h Selects replace option in Find and Replace dialog box 

Shift + F4 To find the last find option again 

Ctrl + g (or f5) Goto dialog box 

Alt + Arrow Down Auto complete option 

Shift + Space To select an entire row 

Ctrl + Space To select an entire column 

Ctrl + a To select an entire worksheet   

Ctrl + Shift + Page Up To select the last worksheet 

Shift + Arrow Keys To increase the selection by one cell 

Ctrl + Shift + Arrow Key To take the selection to the last cell containing data in a row 
or a column 

Shift + Page Down/Shift + Page Up To move up or down the selection by one screen size 

Shift + Home To move selection to the first cell of the desired row 
Ctrl + Shift + Home To  select the cells up to the first cell containing the data 

Ctrl + Shift + End To  select the cells up to the last cell containing the data 

F2 To edit an active cell 

Alt + Enter To enter a new line in the active cell 

Enter To complete an entry 

Shift + Enter To complete cell entry and to move up 

Tab/Shift + Tab To complete cell entry and to move towards the left or right 
side 

Esc To cancel an entry 

Backspace To remove the character on the left side of the cursor 

Delete To remove the character on the right side of the cursor 

Ctrl + ; (semicolon) To add the current date 

Ctrl + Shift + : (colon) To add the current time 
Ctrl + c, Ctrl + x, Ctrl + v To copy, cut and paste data 
Ctrl + Alt + v If clipboard has data then it shows the Paste Special dialog 

box 
Ctrl + z To undo the last change 
Ctrl + y To redo the last change again  
Ctrl + 9 To hide a row 
Ctrl + Shift + 9  To unhide the previously hidden row 
Ctrl + 0 (zero) To hide a column 
Ctrl + Shift + 0 (zero) To unhide the previously hidden column 
Alt + Shift + Arrow Right To group rows or columns 
Alt + Shift + Arrow Left To ungroup rows or columns 

Ctrl + Space To select an entire column 
Alt + o, ca To make the width of a column equal to the length of the 

data 
Alt + o, cw To make the width of a column as per the requirement  
Alt + o, ra To make the height of column equivalent the height of the 

data 
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Key Meaning  

Alt + o, re To make the height of a column as per the requirement  
 

 

3.13 CHECK YOUR PROGRESS: POSSIBLE ANSWERS 

Q1. Choose the correct option 
1. What is the cell that contains the data in Excel-2010 known as? 

A) Active cell B) Select cell C) Current cell D) None of these  
2. Which of the following type of data can be entered in a cell within Excel-2010? 

A) Numbers       B) Text       C) Formula   D) All of these   
3. Which of the options given below are not available in the fill series dialog box of 

Excel-2010?  
A) Max value B) Type         C) Step Value   D) Series In 

4. Which of the following operator has first precedence in Excel-2010?  
A) *            B) /       C)    ^      D)    + 

5. What can be used in Excel-2010 for calculations?  
A) Formula     B) Function    C) a and b    D) only a  

 
Q2. Choose the correct option and fill in the blanks. 
1. In Excel-2010 _________ reference does not change the value of the cell when 

copied. (absolute, relative) 
2. In Excel-2010 _________ refers to a chart that can be embedded in a single cell. 

(Sparkline, Slicer) 
3. The ___________ is a shortcut key to select an entire row in Excel-2010. 

(Ctrl+Space, Shift+Space) 
4. In Excel-2010, ________ chart is used for only one series. (Pie, Column) 
5. The _________ function is used to find an average of numbers in Excel-2010 

(Average, Sum) 
 
Q3. State whether the following statements are true or false. 
1. In Excel-2010 comment is used to give additional detail for the entry within a cell.  
2. In Excel-2010 the continuous information separated by comma (,) can be 

converted to columns using Data → Data Tools → Remove Duplicates option. 
3. In Excel-2010 the Goal Seek option is used to get a specific output for a numeric 

calculation. 
4. In Excel-2010 to use the Subtotal option the information needs to be in a sorted 

order. 
5. In Excel-2010 once a chart is created it can be moved to another sheet. 
 
Q4. Match the Following. 

A B 
1. A$2 a. Predefined formula 
2. $A2 b. Written with the help of variable, constant and 

operators. 
3. Function c. When formula is copied, column will not change. 
4. Formula d. Shows selected rows only, when some given 

conditions are true. 
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5. Filter e. When formula is copied, row will not change. 
 
Answers 
Q1 1-A (Active Cell), 2-D (All of these), 3-A (Max value), 4-C (^), 5-C (a and b)  
Q2 1-Absolute, 2- Sparkline, 3- Shift+Space, 4-Pie, 5-Average 
Q3 1- True, 2-False, 3- True, 4-False, 5- True 
Q4 1-c (When formula is copied, column will not change) 

2-e (When formula is copied, row will not change) 
3-a (Predefined formula) 
4-b (Written with the help of variable, constant and operators) 

 5-d (Shows selected rows only, when some given conditions are true) 
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Unit 4:  Basics of Microsoft 
Power Point 2010 

  
 
Unit Structure 
 
4.1. Learning Objectives 
4.2. Introduction 
4.3. Introduction of PowerPoint 2010 
4.4. How Does PowerPoint 2010 work? 
4.5. Saving Presentation 
4.6. Printing Presentation 
4.7. Slide Transition 
4.8. Check Your Progress : Possible Answers 

 
  

4 
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4.1 LEARNING OBJECTIVE 
 
After studing this unit student will be able to do the follwing:  
 
 Create 'Efficient Presentation' using Power Point 2010 by creating different types 

of slides. 
 Add Text, Theme, Picture, differet Shapes and Audio and Video to make the 

slides attaractive. 
 Save a presentation in various formats and print a Presentation. 
 Give different effects using Slide Transition option when the slide changes. 

 

4.2 INTRODUCTION 
 
Nowadays, many skills are required to stand out in this competitive world.  A skillful 
person becomes more successful in his work.  Presentation skills (Art of Presenting 
Information) have gained a great deal of importance these days.  Presentation 
means to convey our ideas and information effectively, so as to make them 
acceptable by the audience.  A professional presentation can provide more 
information to the audience in less time, and the audience can easily comprehend it.  
It enables a person to inform, persuade and entertain the audience, and thus forms 
an integral part of our academic or professional career.  At times it becomes difficult 
to understand a piece of information or an event narrated verbally; the same task 
can be performed more effective and within no time if aided by a picture.  Picture 
makes your presentation more attractive and colorful and its impact can be 
increased by adding sound.  Animation can also be added to a presentation which 
can ultimately work wonder.  All these features enable us to make pace with the 
today‘s world where it is necessary to present more information, most effectively and 
in less time. 
 

4.3 INTRODUCTION OF POWER POINT 2010 
 
Power Point is well-known presentation software.  The basic version of Microsoft 
Power Point has undergone many changes through the years, and the new versions 
are available in the market. Currently, Power Point 2010 is more in use.  Power Point 
2010 is a Program item of MS Office 2010. Previously, Office 2007 and Office 2003 
were most commonly used.  
 
With the help of Power Point, we can address a large audience with fewer efforts.  
We can also present our ideas or information more clearly and exquisitely because 
the presentation can be accompanied with pictures, audios and videos, thus making 
the presentation more meaningful. The information becomes more interesting 
because of this.  Move rover with the help of various tools available in Power Point, 
we can select different fonts, font size and colors for textual information.  With the 
use of multimedia technology, we can convey information to audience more 
effectively.  This presentation can be presented by overhead projector or by 35-mm 
slides.  Generally, the presentation is used in following scenarios: 
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 To render information about a new product 
 To narrate an event in order 
 For Company Meetings  
 For Training and aids in Education Field 

 
Let us discuss different parts of Power Point 2010 and the facilities it provides. 
 

4.4 HOW DOES POWER POINT 2010 WORK? 
 

Slide 

A slide is used to prepare a Power Point presentation.  A Presentation can consist of 
a group of slides put together to render information.  We can use more than one 
slide to cover a lengthy topic and can also include more than one topic on a single 
slide.  Once the slides are ready, we can arrange them sequentially and run the 
presentation.  Text, Graphics, Audio and Video can also be included in a slide.  As 
per requirement, we can add a new slide as well as delete or change a slide.  One or 
more slides can also be printed whenever required.  We can also decide the number 
of slides in a presentation.  The slide show command can be used anytime to start a 
presentation. Collection of presentation slides can be saved as a file with .pptx 
extension. 
It is very important to understand Ribbon and its Tabs along with their working to 
navigate and to get familiarised to the usage of various tools of Power Point.  Ribbon 
is located at the top left hand side of the screen.  It consists of various Tabs like File, 
Home, Insert, Design, Transition, Animations, Slide Show, Review and View.  To 
work smoothly in Power Point, groups are created gathering various commands—
Font Group, Paragraph Group, Drawing Group, etc.  For example, different functions 
related to formatting text like Font Type, Font Color, Font Size, Text to be Bolded or 
Italicised can be grouped under the Font Group.  
 

 
 

Figure 4.1 Power Point Screen 
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Figure 4.1 shows a toolbar on the left side of the Ribbon. It includes commands like 
Open, Save, Quick Print, Undo, Redo, etc., which are frequently used while creating 
a presentation. We can also create a Quick Access Toolbar as per our choice.  This 
toolbar enables a user to include commands of his/her choice.  By doing so, though 
we may be working anywhere on the Ribbon, we can directly use any commands on 
the Quick Access Toolbar. 
 
Ribbon and various tabs 
 

 
Figure 4.2  Tabs on Ribbon 

 
As shown in figure 4.3, Power Point provides us a Zoom control which helps in 
enlarging or reducing the size of a slide.  The Zoom-in and Zoom-out buttons can be 
seen on the lower right side of the screen.  They have + and - signs respectively.  
Using these buttons, slide on the screen can be enlarged or reduced as per our 
wish.  The size is also shown in percentage (%) on the left side of the button.  There 
is a slider—'Zoom' between these two buttons.  Size of the slide can be enlarged or 
reduced by dragging the slider.  The 'Fit Slide to Current Window' button, on the right 
side of Zoom Control, enables the user to resize the slide as per the size of the 
window on the screen by zooming-in or zooming-out automatically.  A slide can be 
zoomed in to the maximum of 400% and zoomed out to the minimum of 10%.  
 
 

 
Figure 4.3 Zoom Control and View Buttons 

 
With reference to figure 4.3, the first four buttons to the left hand side of the bar 
enable the user to view their presentation in different ways—Slide Sorter, Reading 
View, Slide Show and Normal.  
 
Slides tab on the left hand side 'Pane' is very useful to work in different slides at a 
time and to navigate from one slide to other (figure 4.1).  Here we can also change 
the order of slides, rearrange the slides, duplicate the slides and delete the slides.  
On clicking the Outline tab, near the Slide tab, we can see only the textual 
information in all the slides on the left side. 
 
By dragging the scroll button on the right side bar, a user can smoothly navigate 
through slides.  There are two buttons below this scroll bar through which a user can 
navigate a slide forward or backward.  By using Ctrl + Home key combination, one 
can straight away reach the first slide, and to reach the last slide, one can use Ctrl + 
End key combination.  Thus, Power Point 2010 provides various types of options to 
navigate through the slides of a presentation. 
 
Steps to create new Power Point (Presentation) file 
To create a new Power Point presentation, click the start button; a pop-up menu will 
be displayed on the screen.  If not, findthe Microsoft PowerPoint 2010 from the menu 
displayed while clicking all the programs. You can also begin this program if it is 
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available on your desktop.  By doing so, a new Power Point Presentation will open 
up which has a slide pane.  We work and create slides in this area.  We can see 
different slides in form of thumbnails on the left side of the screen (see figure 4.1 for 
reference).  The slide in which we are working is highlighted in this left side area.  
There is a Notes Pane at the bottom of the screen.  Here, a speaker can write 
additional necessary notes at the time of presentation.  Speaker‘s notes can also be 
printed.  After selecting the desired layout for each slide, details are entered in the 
slides.  Different layouts can be selected for different slides of a single presentation. 
Add a new slide 

 
Figure 4.4 Slide's Layout 

 
When we create a new Power Point presentation, it has only one slide.  On clicking 
the Home Tab, New Slide icon will be displayed on the screen.  On clicking the 
upper portion of this icon, a new slide will be added automatically after the slide 
displayed on the screen.  Whereas, if we click the lower portion of this icon, a gallery 
consisting different types of layouts of slides will be displayed on the screen from 
which we can select the desired layout (see figure 4.4 for reference).  The selected 
slide will be added to our presentation.  Now, we can enter the desired text on the 
slide.  Various layout displayed on the screen are Title Slide, Title and Content, 
Section Header, Two Content, Comparison, Title Only, Blank, Content with Caption 
and Picture with Caption.  We can also add a new slide to the presentation by using 
the Ctrl + M key combination. 
Text Formatting 
 
Font and Paragraph groups are in the Home tab, which include various commands 
to enter the information in the slide. When we enter text in the place holder box of 
the slide, it gets automatically converted into a bulleted list.  Information in the sub 
points is arranged below the main point.  If the information in the place holder box is 
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excess, the size and space in between the lines of the Power Point text gets 
automatically reduced. 
 
We can change Type, Size and Color of fonts with the help of different commands in 
the Font group.  We can also make the text Bold, Italics and/or underline the lines of 
text.  See figure 4.5a for reference.  With the help of various commands in 
Paragraph group, we can set the type of bullet, indentation and space between two 
lines as per our wish.  Example of the same is shown in figure 4.5b. 
 

 
 

Figure 4.5-a Font and Paragraph Group 
 

 
 Figure 4.5-b Text Effects  

Add Design Theme 
Very often, we wish to have the same background in each slide of our presentation. 
The Design tab provides different themes with attractive background colors, fonts, 
filling effects which can be used to make the presentation unique, thus enhancing 
the presentation (Figure 4.6).  Every new presentation starts with a predefined 
theme, which is called Office theme, which has a white background and black text.  
Many themes are provided by Power Point.  If we wish to use a theme in our 
presentation, by clicking Design tab, we can get a group namely themes which 
provides us a series of designs for our selection.  When we hover the cursor on the 
thumbnail, we can see (preview) its effects on the slide. When a theme is selected, 
the corresponding effects will be applied to the entire presentation.  
 

 
Figure 4.6 Design Theme 
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Include Picture, Audio, Video on the Slide 
 
As shown in figure 4.7, by clicking the Insert tab on the Ribbon, Images and Media 
group can be obtained.  We can add pictures from a file on a slide as well as pictures 
and audio-video files from the library of Power Point by using the commands of 
Image group. Any photograph or picture can be added to the presentation.  .  We 
can select various types of media files (e.g. pictures, photographs, video and audio) 
available in Power Point library and can add them to the slides using Clip Art 
command.  As shown in figure 4.8, Search command is available in Clip Art to find 
the required image.  For example—to add a picture of a computer, it is needed to 
search for the keyword ‗Computer‘ in the search for: option (Figure 4.8).  Now we 
can select any one of the available images for computers to be inserted in the slide.  
On clicking the 'Image' it gets automatically aligned on the slide.  We can change the 
place of the image by dragging it. 
 

 
Figure 4.7 Image and Media Group in Insert Tab 

 

 
 

Figure 4.8 Pictures from Clip Art 
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Figure 4.9 Options of Media Group and Video Command 

 
In figure 4.9, video and audio commands of the Media group can be seen.  By using 
the video command, a video can be added to the slide from any file from the website 
or from the Clip Art.  In the same way, audio from any file, audio from Clip Art and 
recorded audio can also be added to the slide by audio command. 
 
Include different types of Shapes 
 
Shape command on Insert tab can be used to enhance the appearance of a slide 
and also to add graphics.  Various shapes are displayed on the screen by clicking 
the Shapes command.  Various types of lines, rectangle, circle, arrows, symbol of 
flow chart and call outs are available in this feature.  We can select from these 
shapes as per our requirement, and by double clicking over that shape, it gets 
automatically displayed on screen.  We can drag the shape to different places by 
clicking its border.  We can also reduce or enlarge this shape and can rotate it in all 
the directions. 
 
Note:  Text Box available in the Insert tab can  be added to the slide as is in the 
Figure 4.9. Whenever it is added, the cursor is seen in the text box so that we can 
write within it. 
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Figure 4.10 Diffrent types of shapes available under Shapes command 
 
With reference to the Figure 4.11, we can add different shapes available in the 
Drawing group. The similar shapes are available in different groups as shown in the 
Figure 4.12. Also different textures and filling options can be applied to the objects 
being inserted. (Figure 4.13) 
 

 
Figure 4.11 Drawing Group 
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Figure 4.12-a Options of Drawing Group 

 
Figure 4.12-b shows the slide with added shape.  
 

 
Figure 4.12-b Shapes on a Slide  
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Figure 4.1૩ Texture available in Shape Fill Command 

4.5 SAVING PRESENTATION 
 
The presentation that we prepare is used by us very often; therefore, its storage is 
very necessary.  A presentation is saved as a file in Power Point with .pptx 
extension. The saved file can be re-edited and can be used whenever required... 
'Save' or 'Save As' command in the File tab on the Ribbon is used to save the 
presentation prepared by us.  
 
 Save As – This command is used to save the presentation for the first time.  As 

soon as we click the Save As option, it asks us the name of the presentation and 
as to where should it be saved.  If corrections are made in the presentation and if 
they are temporary, the earlier version of the file without corrections can also be 
saved by using this command but by giving a different file name.  We can save 
the presentation with a new name so that this new presentation can also be 
detected if not required after its use.  This option also gives us a facility to save a 
file in different formats.  A list of some traditional file formats and the extensions 
used by Power Point are as follows: 
 

o PowerPoint Presentation (.pptx) 
o PowerPoint 97-2003 Presentation (.ppt) 
o PDF Document Format (.pdf) 
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o PowerPoint Design Templates (.potx) 
o PowerPoint Show (.pps, .ppsx) 
o PowerPoint 97-2003 Show (.ppt) 
o Windows Media Video (.wmv) 
o GIF (Graphics Interchange Format) (.gif) 
o JPEG (Joint Photographic Experts Group) File Format (.jpeg) 
o PNG (Portable Network Graphics) Format (.png) 
o TIFF (Tag Image File Format) (.tif) 
o Device Independent Bitmap (.bmp) 
o PowerPoint Picture Presentation (.pptx) 
o Open Document Presentation (.opd) 

 
 Save:  By giving this command, the presentation is saved again with the same 

name and in the same directory. Save command can be run from the File tab.  
This command can also be given from the Quick Excess Toolbar.  
 

 

 
Figure 4.14 Commands available on File tab 

 

4.6  PRINTING PRESENTATION 
 

Print command from File tab is given to print some or all the slides which we have 
prepared for our presentation. Therefore when print command is given, a preview of 
document is displayed on the screen with the option of print command.  By looking at 
the preview, we can come to know how the presentation will look after being printed.  
Figure 4.15 shows the window which is displayed on giving the print command, 
along with the preview window. 
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Figure 4.15 Parameters of print command with preview window. 
 
Now, let us go through the parameters required while giving the print command: 
 
 We are supposed to enter the numbers of copies to be printed in the box near 

Copies. 
 We need to mention in the Settings section whether we want to print all the 

slides, selected slides or the slide displayed on the screen. Under custom range 
we can only provide slide numbers or range.  For example, 5-12 means all the 
slides from number 5 to 12.  If we write 1,4,7,10-13,18, slide number 
1,4,7,10,11,12,13 and 18 will be printed. 

 On clicking Full Page Slides in the check box, an option as shown in figure 4.16 
will be displayed on the screen.  This option gives us the facility to select number 
of notes from Notes Pane along with the slide to be printed or only the text from 
the slide (outline) to be printed.  We can print one, two, three, four, six or nine 
slides in a page.  

 If more than one copy of presentation is to be printed, Collated option will print 
1,2,3,.....,n and once again will start printing 1,2,3,...,n.  But if uncollected option 
is selected and if 3 copy option is given, it will print the slides in 
1,1,1,2,2,2,3,3,3,..........,n,n,n manner. 

 We get two options in Orientation to print slides. If Portrait Orientation is selected, 
slide will be printed vertically; whereas, on selecting the Landscape Orientation, 
the slide will be printed horizontally.  This effect of orientation can be seen in the 
preview window. 



 
 243 

 
 

Figure 4.16 Options of Print Layout 
 

 
 

Figure 4.17 Portrait Orientation in Print 
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Figure 4.18 Landscape Orientation in Print 
 

 For color, we can select any one option out of the three available color options: 
Color, Gray scale, and Pure Black and White.  If we have the color printer, then this 
option can be used.  

 
Figure 4.19 Presentation printing color 
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4.7 SLIDE TRANSITION 

 
 

Figure 4.20 Commands of Transition tab 
 

As shown in the Figure 4.21, on clicking the Transition tab on the Ribbon, various 
effects can be seen while displaying the slides on the screen—Cut, Fade, Push, 
wipe, Split, Reveal, Random Bars, etc. On clicking the tringle (More) on the bar near 
this option, all the transitions available in Power Point can be seen on the screen.  If 
any option is clicked, we can see the preview on the screen and how it has effected 
the slide.  We can also select an option from the Effects options for all these 
commands. Options of Effect options are different from each other as per the 
command.  For example, if we select 'Zoom' command in transition, we get two 
options Zoom In and Zoom Out in the Effect option as shown in figure 4.21.  But if 
we select ‗Box‘ command, we get From Right, From Bottom, From Left and Top 
options in the Effect option as shown in figure 4.22. 
 

 
 

Figure 4.21 Options of Zoom command 
 

 
 

Figure 4.22 Options of Box command 
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Figure 4.23 All options of Transition to this slide group 

 
We can select different types of audio—Bomb, Breeze, Click, Coin, Explosion, Wind, 
etc., or any other audio that we have saved, and by mentioning the time in Duration 
can play it during the slide transition. See figure 4.24. 

 
Figure 4.24 Sound options with Timing group 

 
This sound can be applicable to all the slides of presentation by giving Apply to All 
command.  
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We have two options to display the next slide of the presentation on the screen.  
First option is by using a mouse click while second is automatic slide change after a 
prescribed time mentioned in the check box as shown in Figure 4.24. 
 

 

4.8 CHECK YOUR PROGRSS: POSSIBLE ANSWERS 
 

1. Prepare a presentation which gives information of your school/college/city and 
add text into to the slide with different slide layouts.  Use various text 
formatting effects. 

2. Apply design theme to your slide. 
3. Add relevant pictures, clip art, shapes, audio and video to the presentation 

prepared earlier and make it more attractive.  
4. Save the presentation prepared earlier in any other format. 
5. Take a printout of your presentation. 
6. Give various slide transition effects to the slides you have prepared.  
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Unit 5:  Advance Features of 
Microsoft Power Point 2010 

  
 
Unit Structure 
 
5.1 Learning Objectives 
5.2 Introduction 
5.3 Usage of Table in a Slide 
5.4 Usage of Smart Art in a Slide 
5.5 Usage of Chart in a Slide 
5.6 Inserting Hyperlink in a Slide 
5.7 Inserting Symbol in a Slide 
5.8 Inserting Equation in a Slide 
5.9 Add an Animation to Slide 
5.10 Start a Slide Show (Run Your Show) 
5.11 Slide Master 
5.12 Review Tool 
5.13 Dictionary of Power Point 
5.14 Keyboard Shortcut 
5.15 Check Your Progress: Possible Answers 
  

5 
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5.1 LEARNING OBJECTIVE 
After learning this chapter students will be able to : 

 Use Table, Smart Art, Chart, Link, Symbol and Equation to present information 
effectively in a slide. 

 Use Animation to make your slide more live and how to run your Slide Show? 
 Give overall common lock to slide using 'Slide Master' and also use 'Review 

Tools' to varify information. 
 Become conversant with important words and some shortcut keys used in Power 

Point. 
 

5.2 INTRODUCTION 
 
In previous chapter we have discussed How Power Point works and how you can 
save it. Printing options are also discussed. We have also seen Slide Transition in 
previous chapter. This chapter introduces some advance features like use of Table, 
Smart Art and Charts in a Slide. How you can insert Hyperlink, symbols as well as 
equations for calculation in a slide that is also discussed. How you show will run and 
how to use Slide Master that is explained in this chapter. The chapter gives immense 
knowledge of Review Tools , Dictionary of Power Point and Key board Shortcuts. 
Now let us start our Discussion. 

5.3 USE OF TABLE IN SLIDE 
 
Add Table 
 
Table is used to generally show numeric information so that it becomes easy to 
compare and contrast the values.  Tables can be added to the slides by using one of 
the following methods. 
 
1) Select InsertTableInsert table option. A dialog box as shown in the Figure 

5.1-a will be opened.  
2)  Now enter the number of columns and rows as required for the table to be 

inserted followed by pressing the OK button, the table with desired number of 
rows and columns will be inserted. 
 
 

 
 

Figure 5.1-a Insert table dialog box 
 

Table can also be added by clicking the Table icon as shown in figure 5.2. If you 
have prepared a table in Excel earlier or if you want to prepare a table in excel 
format, click the Excel Spreadsheet as shown in figure 5.1-b.  As shown in figure 5.3, 
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Excel sheet can be seen in the slide.  Here you can type or you can open spread 
sheets prepared earlier.  Once the data is typed, it looks like only a table as in the 
Figure 5.4. 

 

 
Figure 5.1-b Add table through 
Selection 
 

 
Figure 5.2 Add table by clicking on table icon 

 

 
Figure 5.3 Insert data in Excel sheet 

 

To add table  
click here 
 

To add table from Excel click here  
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Figure 5.4 After inserting data into Excel sheet only table is seen 

 
 
Table Formatting 
On selecting a table, Design tab and Layout tab are displayed in the Table Tool 
Group where options are available to format a table. 
 
As shown in figure 5.5, Design tab has the following options: 
1) To give Table Style (predefined shading, border and effect) 
2) Various options for Table Style  
3) To change the color of Text, Style and to change Border (WordArt Styles) 
4) Border Style (Draw Borders) 
 

 
Figure 5.5 Design tab 

 
As shown in figure 5.6, Layout tab has the following options: 
 
1) Table select and  view gridlines (Tables) 
2) Addition or deletion of rows and columns (Row and Column) 
3) Merging or separation of more than one cell (Merge) 
4) Changing of heights and widths of rows and columns (Cell Size) 
5) Alignment of cells (Alignment) 
6) Changing of height and width of table (Table Size) 
7) Arrangement of table (Arrange) 
 

 
 

Figure 5.6 Layout tab 
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5.4 USE OF SMART ART IN A SLIDE 
 
Figures are created with SmartArt Graphics in Power Point.  You can shift, change or 
write in these figures which are very useful.  In other words, you can use it to create 
figures and can change these figures easily as per your choice. 
 
You can use anyone of these methods to add a SmartArt: 
 
1) Click the Insert tab and select the SmartArt option (InsertSmartArt).  A dialogue 

box is displayed on the screen as shown in figure 5.7 from which you can select 
the diagram of your choice. 
 

 
Figure 5.7 SmartArt Dialog box 

 
2. Click the 'SmartArt' icon in the slide as shown in figure 5.8. 
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Figure 5.8 SmartArt icon 

 
Following diagrams are available in SmartArt: 
 
Diagram Usage  
List Related information, to show steps and to show the order of work and process.  
Process To narrate the changes with time in form of an idea or process. 
Cycle Shows cyclic progress without beginning or end, to show balanced parts. 
Hierarchy To narrate the hierarchical relationship between people, divisions or other 

things and to narrate such relations that leads to decision making or process. 
Matrix To show relationship between four different divisions. 
Pyramid Shows balanced or hierarchical relations. 
Picture To create figure that includes photographs and pictures. 
Office.com To download different figures from Office.com. 
 
Figure 5.9-a shows SmartArt with hierarchy type of Diagram.  
 

To add Smart Art click here 
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Figure 5.9-a Slide with SmartArt 

 
Figure 5.9-b Shows slide after inserting SmartArt 
 

 
Figure 5.9-b Slide after inserting text 

 
When clicked once, Power Point shows Design tab in SmartArt tab as shown in 
figure 5.10 and in the same way shows Format tab as shown in figure 5.11, which 
helps to change the SmartArt. 
 
Design tab provides the following options: 
 
1) Add any shape of SmartArt to the front, back, above or below another shape, 

remove and/or change its position.  (Create Graphics) 

  

           

              
To write text  
click here 



 
 255 

2) Change the look of SmartArt.  (Layouts) 
3) Change the color of SmartArt.  (Change Colors) 
4) Remove format or its conversion into text and shape.(Reset) 
 

 
Figure 5.10 Design tab 

 
Format tab provides the following options: 
 
1) Change the shape of SmartArt—reduce or enlarge as compared to others.  

(Shapes) 
2) Change the style of a shape—fill color, border color or change effect.  (Shape 

Styles) 
3) Change Text color, outline color or to change its appearance.  (WordArt Styles) 
4) Shift a shape in front or back of another shape, to group or to rotate it from centre 

or around its axis, etc.  (Arrange) 
5) Change the size of shape. 
 

 
Figure 5.11 Format Tab 

Check your progress 
 

1. Add a table with information related to School/College/City to your presentation and 

format it with the help of Design tab.  
2. Shows the proper information of School/ College/City in presentation with the help of 

SmartArt. 

5.5 USE OF CHART IN A SLIDE 
 
Power Point provides us with the facility to add different types of charts to our 
presentation, as shown in figure 5.12.  With the help of charts, audience, 
students/trainees or members can easily understand the meaning of figures, their 
importance and comparisons.   
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Figure 5.12 Types of Charts 
 
Charts can be added to a slide by following one of the following methods:  
 
1) Click on the Insert tab and select the chart option (InsertChart).  A dialog box 

as shown in figure 5.12 is displayed on the screen.  By selecting the desired 
type of chart and by pressing the OK button, it gets added to the slide.  Excel 
opens up in a new window as shown in figure 5.13, and after entering the data in 
it and on closing it, the chart in the slide also shows the relevant changes.  (See 
figure 5.14) 

2) Click the Chart Icon on the slide.  (See figure 5.15) 
 

 
 

Figure 5.13 At the time of Inserting Chart 
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Figure 5.14 After the data Inseration 
 

Figure 5.15 Insertion of Chart through Chart icon 
 
Understanding of the various parts of a chart is given in figure 5.16. 
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Figure 5.16 Parts of Chart 

 
On clicking the chart, Power Point displays a Chart Tool Tab group.  Design, Layout 
and Format tabs are available under the Chart Tool tab.  These tabs enable us to 
make changes to the chart even after the chart has been created.  
 
Options provided by the Design Tab are as follows: 
 

 
 

Figure 5.17 Design Tab 
 

1) To change the type of chart (Type) 
2) To change the data in the chart (Data) 
3) To change the layout of the chart (Charts Layouts) 
4) To change the style of the chart (Chart Style) 
 
Options provided by the Layout Tab are as follows:  
 

 
 

Figure 5.18 Layout Tab 
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1) To change the format of the selected area of a chart (Current Selection) 
2) To insert picture, shape or text in the chart (Insert) 
3) To show  the title of a  chart, axis titles, value of data used in the chart and to 

show the table along with the chart. (Labels 
4) To show the  Axes differently and to show or not to show the gridlines. (Axes) 
5) To change the background of the chart (Background) 
6) Options for analysis of the chart (Analysis) 

 
Options provided by the Format Tab are as follows: 
 

 
 

Figure 5.19 Format Tab 
 

1) To change the format of selected area of the chart (Current Selection) 
2) To change the color of selected area of the chart/give border color and effect 

(Shape Styles) 
3) Format the text of the chart in terms of text color, text border, text effect (WordArt 

Style) 
4) Arrangement of selected area of the chart (Arrange) 
5) To change the size of the chart (Size) 
 
When and where to use which type of chart in general is given in Table 5.1 
 
Chart Usage 
Area Observation of how the values change with time and see the ups and downs 

of values. 
Bar Useful in comparing the values of different category with one another as the 

time passes by.  The information is displayed in form of horizontal lines in 
this chart. 

Bubble This chart is useful in observing the information by the study of the size and 
place of a bubble in the chart. 

Column Generally, useful in comparing the values of different categories with one 
another as the time passes by.  The data is shown in form of vertical lines in 
this chart. 

Doughnut  Useful in showing values as a part of overall percentage. 
Line To see the ups and downs of values with the passage of time.  Data is 

displayed in a single line. 
Pie Useful in showing values as a part of overall percentage. 
Radar Useful in examining information and plotting values of different category 

along a separate axis starting from the  center point with the minimum value 
and the edge with the maximum value. Thus for each category the value of 
the point is the distance from the center of the chart. 

XY 
(XY- Scatter) 

Useful in knowing the relationship between  numerical datas  along the 
horizontal and vertical axes 

Stock Useful in knowing the daily, weekly or annual variations in value of a item. 
Surface Display relation betwen information and values on 3D surface or layer with 

different colors. 
Table 5.1 Types of Chart 
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5.6 INSERTING HYPERLINK IN A SLIDE 
 
Information can be easily accessed by adding a hyperlink to a slide.  Hyperlink is 
useful in performing the action of going forward or backward or to a predefine slide in 
a slide show.  Link group in Insert Tab is used to add a Hyperlink. 
 
On clicking Insert  Links  Hyperlink, a dialog box is displayed on the screen as 
shown in figure 5.20.  Here on entering the text of the hyperlink, providing the 
address of the link and clicking the OK button, a hyperlink gets added as shown in 
figure 5.21.  When the slide show is running and meanwhile if the link is clicked, 
website of Dr. Baba Saheb Ambedkar opens up. 
 

 
 

Figure 5.20 Insert Hyperlink dialog box 
 

 
 

Figure 5.21 Slide including Hyperlink 
 

To add Action Button 
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Action Button is used to go forward or backward in a slide and also to open a 
Programme. By clicking InsertShapeAction Buttons, any desired action button 
can be inserted in a slide. (Figure 5.22)  
 
 

 
 

Figure 5.22 Action Button 
 

 
 

Figure 5.23 Action Settings dialog box 
 

Use the Mouse Clicktab if you want to open a link by a click of themouse.  , and if 
you want to open a link by moving the mouse over it, then use ―Mouse Over‖ tab and 
can select the options as described below  
 
1) None: No action is to be taken.  
2) Hyperlink to:  On selecting this option and clicking on one of the options from the 

drop down menu, you can select forward, backward, first or last slide or can even 
select the option to close the slide show. 

3) Reprogram:  This option is useful for opening a program.  You can also give a 
path of the program you want to open by using the 'Browse' button. 

4) Play Sound:  By clicking this checkbox, when a new slide is opened, any 
audio/sound—hand clapping, applause, hammer, breeze, etc., can be played from 
the gallery saved in the computer. 
 

Finally on clicking the OK button, Action Button setting gets completed.  
 

5.7 INSERTING SYMBOL IN A SLIDE 
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To add any 'sign' which is not seen on the keyboard, we can use the Symbol 
command available in the Insert tab.  On clicking Insert  Symbol, a dialog box as 
shown in figure 5.24 is displayed on the screen.  Now by selecting the desired 
symbol and clicking the Insert button, it gets automatically added to the slide. 
Different fonts can be selected from the Font drop down list. The added symbol is 
added in Recently Used Symbols and can be promptly used once again.  
 

 
 

Figure 5.24 Symbol dialog box 
 

5.8 INSERTING EQUATION IN A SLIDE 
 
Equation command of Symbols group in the Insert tab is used to add an equation to 
the slide.  With the help of Equation editor, you can add mathematical equations and 
you can also create your own equations. 
 
Various types of predefined equations are seen on clicking Insert  Symbols  
Equation button as shown in figure 5.25.  We can add any of these to our slide by 
clicking over it.  
 
If you want to add a new equation, you are supposed to click on the ―Insert New 
Equation‖ button.  As shown in figure 5.26, a Equation Tools tab is added to the 
Ribbon. You can select the type of the equation you want to add. Also built in 
symbols and equation elements can be added to create custom equations. 
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Figure 5.25 Predefined Equations 

 

 
 

Figure 5.26 To create Equation 
 

5.9 ADD AN ANIMATION TO A SLIDE 
 

You can make your text, clipart, shape or picture alive by using Animation.  It is used 
to draw attention of the audience on a particular point or to make the slide easier to 
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read.  Animation tab is used to add Animation to a slide.  First of all, we have to 
select the text or object which requires animation. 
 
Animation is divided in four categories as shown in figure 5.27: 
 
Entrance:  Controls the entry of any item in a slide. 
Emphasis:  This animation takes place when an item is on the slide. 
Exit:  Controls the exit of any item from a slide. 
Motion Paths:  This is useful in moving an object on a predefined path in the slide. 
 

 
 

Figure 5.27 Types of Animations 
 
Animation Tab is used to select animation options in Power Point as seen in figure 
5.28.  
 
 

 
 

Figure 5.28 Animation tab 
 

Table 5.2 discusses various options available in the Animation tab. 
 
Option Usage 
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Option Usage 

 

See how the animation will look before starting a slide show 
byclicking this button. 

Animation Add animation as discussed earlier. 

 

Provides options for some animation effects. You can change them. 
Options for effects change as per the type of animation—Direction 
of an object in the slide can be controlled. 

 

Add animation and see how it will look. 

 

Displays Animation pane as shown on the right side of figure 5.53 
will be displayed on the screen.  It will enable you to control when 
to begin the animation and in which order. 

 enables to choose the embedded object for triggering the animation 
effect 

 
You can copy the animation effects  of one object to another object 
with the help of animation painter. 

 

Can be set to decide , how to start the  animation , the length of an 
animation effect,  and the gape between the end of one animation 
and the start of the new animation. 

 

Helps to change the order of the animation selected in the 
animation pane. 

 
Table 5.2 Options of Animation tab 

 
You can give more than one animation at a time, record animation, preserve how it 
will start, and decide how much time it will run. 
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Figure 5.29 Slide including animation 
Check your progress 
 

1. Prepare a chart to show statistical information of school/college/city in the 
presentation. 

2. Add hyperlink to website and email address of school/college/city in the 
presentation. 

3. Use 'Action button' to move forward/backward in the slide. 
4. Add a mathematical equation to your presentation. 
5. Give different animation effects to various objects your presentation. 

 

5.10 START SLIDE SHOW (RUN YOUR SHOW) 
 

 
 

Figure 5.30 Commands available on Slide Show tab 
 

Once the slides are ready, you can run the slide show and see the actual 
presentation.  The Slide Show tab can be clicked from the Ribbon.  If the 
presentation is supposed to be started from the first slide, select the 'From 
Beginning' command; whereas, if it is to be started from the slide displayed on the 
screen, select 'From Current Slide' command.  On giving the Slide Show command, 
active screen will disappear and a slide show will start on the entire screen.  We can 
display the next slide on the screen by clicking on the separator, pressing the Enter 
key or mouse key.  Presentation can be terminated by pressing the Esc key. We can 
also start a presentation by pressing F5 Key on the keyboard. 
 
Note:  We can also begin a slide show by clicking the right hand side button from the 
four view buttons, at the bottom right corner of the screen as shown in figure 4.3. 
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Apart from the above-mentioned commands, there are other commands on the Slide 
Show Tab, which enable us to run the presentation as per our requirement.  For this 
settings of slide are necessary. 
 
 Broadcast Slide Show: This option is used to broadcast the show for the 

audience who are far away and wish to see the slide show on web browser. 
 Custom Slide Show: This option is used to display presentation by selecting 

different slides for different audiences from a single presentation.  Some slides 
are not displayed for certain presentation, using the Hide command. This Custom 
show is saved separately with a different name.  We select different slides as per 
our requirement for different audiences by giving their names in the Custom 
Show and apply that presentation. 

 Set up Slide Show: We can set the timing of each slide displayed on the screen 
during a presentation.  Hence, the slide gets automatically changed once the time 
limit is over.  If we do not want to set the time for a slide, we can click the radio 
button of manually option.  In addition to this, if a Presentation is to be continued 
while you are preparing the next part of your presentation so as to keep the 
audience entertained, then select the check mark in front or the loop continuously 
until Esc option.  

 Hide Slide: This command is used to prohibit the display of a slide in the 
presentation though it has been created along with other slides.  The slide does 
not get deleted with this command, but it is not displayed in the presentation. 

 Rehearse Timings: We can rehearse before the presentation, and can set up to 
play it at a certain speed without having to click through the slides throat 
Rehearse Timings.  If the time seems right, you can also set the time for each 
slide, and also come to know how much time the entire presentation will take.  
We can also change the time of each slide if required. 

 
In addition to this, Slide Show Tab also provides us certain distinctive facilities like 
different displays on different monitors. For example, if our system has two monitors, 
one monitor displays the slide show while the speaker‘s view is displayed on the 
other monitor. 
 
Thus, the Slide Show Tab provides us many commands to display the preseentation 
prepared by us along with numerous facilities and options. 
 

5.11 SLIDE MASTER 
 
Slide Master saves the information of Theme of presentation and Slide Layout, which 
includes background, color, font, size of place holder and its placement.  Each 
presentation has minimum one slide master, and you can also create more number 
of slide master for a lengthy presentation.  Having many types of slides is always 
considered worthwhile.  As shown in figure 5.31, Slide Master Command is available 
on the View tab of the Ribbon.  As shown in figure 5.32, by opening the view of Slide 
Master using this command, enables you to change the design and layout of the 
master slide. 
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Figure 5.31 Slide Master command on View Tab 

 

 
 

Figure 5.32 Slide Master View 
 

The customization made in the Slide Master can be seen in the entire presentation.  
Therefore, we can modify the backgrounds, can change the place holders, can 
customize the text formatting‘s too.  ) If we want to have two or more different 
themes (e.g. background, color scheme or font) in a presentation, a slide master for 
each theme has to be added. (Figure5.32) 
 
There are options of Handout Master and Notes Master in Master View group.  
Options of working in all these three master slides are the same.  There is a 
checkbox to select options for Ruler, Gridlines and Guides, for the easy editing of 
Master Slide.  Zoom command can be used to zoom the slide; it allows maximum 
400% zooming.  Fit to Window command when used enlarges or reduces the size of 
the slide and makes it equal to the size of the screen.  We can also select Color, 
Gray scale or Black and White option to view the presentation. 
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Figure 5.33 Master Slide view along with Ruler, Gridlines and Guides 
 

5.12 REVIEW TOOLS 
 

There are four groups namely Proofing, Language, Comments and Compare on the 
Review Tab of the Ribbon.  By using the New Comment option under the Comments 
group, we can add new comments to the slides.  Existing comment can be edited or 
can be deleted by using the Edit Comment or Delete options.  Previous and Next 
commands help us to go to the previous or next comment.  
 

 
Figure 5.34 Groups available on Review Tab 

 
Power Point provides an excellent facility of spelling command to check the spellings 
of the text entered in the slides.  It also provides us the option to select another word 
if the spelling is not available in the dictionary or to ignore it.  We also get an option 
to add a word in the dictionary.  Figure 5.35 shows various options to correct the 
spelling of the word—learners. 
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Figure 5.35 Options available when spelling mistake occurs 
 

Alternately, Spelling commandcan also be run by pressing F7 function key on 
keyboard.  
 
With the research task pane under ReviewProofing can search through reference 
materials, Dictionaries and from Encyclopedias, thus giving an advantage of a 
number of research and reference services. (Figure 5.36) 
 

 
 

Figure 5.36 Use of Research command 
 

Further in Research pan we can go for Thesaurus for synonyms and antonyms for 
the word under search. 
Selected text can be translated with the help of Translate command.  There are 
many options of languages available for translation; Hindi being one of them. 
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Thus, commands on Review Tab enable us to prepare a presentation without 
mistakes and are useful in finding and adding necessary information to our 
presentation. 
 
Check your progress 
 

1. Set up a slide show for your presentation and rehearse your presentation. 
2. Prepare a Slide Master of your requirement and apply it. 
3. Correct the spelling mistakes in your presentation. 

5.13 DICTIONARY OF POWER POINT 
 

Word Meaning 
Animation Movement of any type 
Bold Thicken a word/text.  It is generally used to emphasisea keyword. 
Border Border around a picture. 
Chart Presentation with graphics which makes the  data  more meaningful.  
ClipArt Graphic images that can be inserted from a file into a power point slide. They 

can also be online pictures. 
Clip Board Memory field to save information temporarily or a place where we can save 

one or more items and then paste it back in the office documents. 
Copy Paste To copy an item on the clipboard and paste it to another place. 
Drag It is the process pressing the left button of the mouse and relesing it , can be 

used for moving an object. 
Drag Drop An object ( word text or image)  can be placed in a desired location being 

dragged from another place.  
Gallery Library where various options are avilable. 
Handout To print information on slide for the audience.  One, two, three, four, six and 

nine slides can be printed on a page for handout. 
Navigate To go to different parts of presentation. 
Normal 
view 

Power Point window is divided into three parts—Slide/outline pane, Slide pane 
and Note pane. 

Help To be used to learn  and  use powerpoint  
Print 
Preview 

A facility to see the document on the screen before printing as to how it will 
work after it is printed. 

Ribbon Arragement of various commands on Tab and to prepare a group of related 
commands to do certain type of work. 

Slide A page of presentation. 
Slide pane Big image of active slide is shown in slide pane. 
Slide show Presentation—slides are displayed one by one on the computer screen.  
Slide sorter To make global changes in the presentation and reviewing the entire 

presentatiion with small slide thumbnails. 
File All the slides of presentation are saved in a file.  Extension of Power Point file 

is .pptx. 
Transition During the slide show, display of a new slide on the screen.  New slide can be 

displayed in various ways. 
 

Table 5.3 Some Keywords in PowerPoint 
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5.14 KEYBOARD SHORTCUT 
 

Generally, a command is clicked to perform a task in Power Point, but we can also 
use certain key combinations from the keyboard to perform the same task.  These 
combinations are known as shortcut key.  The key is separated with + sign, when 
two key are to be pressed together.  A list of Shortcut Keys used frequently has been 
given in the following table.  Working in Power Point becomes easier and faster if we 
navigate with the Shortcut Keys. 

Shortcut-Key Work 
Alt+F1 Help—to open window 
Alt+F4 Help—to close window 
Ctrl+F1 Display Ribbon or to close the display of Ribbon 
Ctrl+M To add new slide 
Ctrl+C To copy informationor an object to the clipboard. (Copy) 
Ctrl+V To paste from clipboard. (Paste) 
Ctrl+X Tocut the selected information and keep it in the clipboard. (Cut) 
Ctrl+B To bold the selected text. (Bold) 
Ctrl+I To italicize the selected text. (Italic) 
Ctrl+U To underline the selected text. (Underline) 
Ctrl+Shift+> To increase the size of fonts. 
Ctrl+Shift+< To decrease the size of fonts. 
Ctrl+L To align text to the left side. 
Ctrl+E To align text in the center. 
Ctrl+R To align text to the right side. 
Ctrl+F To find text in a document (Find) 
Ctrl+H To find text in document replace it with another text (Replace) 
Ctrl+K To add a hyperlink 
F5 To start a slide show beginning from the first slide of the presentation. 
Shift+F5 To start a slide show from the current slide. 
F7 To check spellings. 
Shift+F7 Thesaurus—provides a list of words having the same meaning as the selected word. 
 

 

5.15 CHECK YOUR PROGRSS: POSSIBLE ANSWERS 
 
 
 
 

 
Q1. Select appropriateoptions. 
 
1. Power Point 2010 is a program item of which of the following software? 

A) Microsoft Office 2010  B) Microsoft Visual Studio 2010 
C) Oracle 10g    D) Microsoft Word 2010 

2. Which key combination can be used as a shortcut to add a new slide to the 
presentation? 
A) Ctrl + C  B) Ctrl + V          
C) Ctrl + M  D) Ctrl + B 

3. Presentation document prepared in Power Point is saved as a file.  What is the 
extension of that file? 

A) .docx    B) .jpg   
C) .pptx    D) .pdf 

4. Which key cannot be used to go to the next slide during a slide show? 
A) Esc Key   B) Space bar  
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C)  Enter key   D) Mouse button 
5. When you open a new presentation, which of the following is not available on 

the left side Pane? 
A) Outline    B) Slides  
C)  Notes    D) All of the above 

6. How to start a slide show? 
 A) F5 Key   B) F1 Key  
 C)  Giving Rehearse Timings command to the slide show  D) A and B both 
7. Which key combination will take us to the first slide of presentation ? 

A) Page up    B) Ctrl + F   
C)  Ctrl + Home   D) Ctrl + End 

8. Which key combination will take us to the last slide of presentation ? 
A) Page down    B) Ctrl + E   
C)  Ctrl + Home   D) Ctrl + End 

9. What is the maximum limit of zooming of a slide in Microsoft Power Point 2010? 
 A) 100%    B) 200%   

C) 400%    D) 500% 
10. Which key combination is used to get help in Power Point 2010 ? 

A) F1    B) F2   
C)  F5    D) F10 

 
Q2. Fill in the blsnk eith proer option. 
 
1. To get help in Power Point ____________ function key is used. 
2. First slide of the presentation can be reached by giving Ctrl + ____________ on 

keyboard. 
3. Maximum ____________ slides can be printed on a page. 
4. We can print a slide in Portrait orientation as well as  ____________ orientation. 
5. By giving ____________command, we can see the words of common meaning in 

Research Pane, related to the word of our choice. 
 

Q3. State whether the statements are True or False. 
 
1. Microsoft Project software is required to prepare a presentation. 
2. On clicking any slide displayed in the Slide Sorter View and then clicking the 

delete key, automatically deletes the slide from the presentation. 
3. Power Point 2010 is a hardware of one kind through which a presentation can be 

prepared. 
4. Slide in presentation can be seen on screen and can also be printed on a paper. 
5. If Hide slide is activated on a slide, it is not displayed in the presentation. 
6. Extension of file in presentation is .docx. 
 
Q4. Add proper link 
 

A  B 
1. Animation  a. Selecting an item and moving it to a new place 
2. Drag and Drop  b. Memory field to save information temporarily 
3. Clipboard  c. Slide show 
4. Slide  d. Movement of any type 
5. F5 key  e. A page of presentation 
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Answers: 
 
Q1. 1. A (Microsoft Office 2010) 

3. C (.pptx) 
5. C (Notes)  
7. C (Ctrl + Home) 
9. C (400%) 

2. C (Ctrl + M) 
4. A (Esc Key)  
6. A (Pressing F5 key) 
8. D (Ctrl + End) 
10. A (F1) 

Q2. 1. F12. Home     3. 9 (nine)4. Landscape 5. Thesaurus  
Q3. 1. False2. True3. False4. True 5. True  6. False  

Q4. 1. d (Movement of any type) 
2. a (Selecting an item and moving it to a new place) 

૩. b (Memory field to save information temporarily) 

4. e (A page of presentation) 
5. c (Slide show) 
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   Block-4 
Internet and Networking 
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Unit 1:  Computer Networks 
  

 
Unit Structure 
 
1.1. Learning Objectives 
1.2. Introduction 
1.3. Elements of Commnication 
1.4. Benefits from Computer Networks 
1.5. Types of Computer Networks 
1.6. Transmission Media 

1.6.1     Wired/Cable Medium 
1.6.1.1   Unshielded Twisted Pair 
1.6.1.2   Co-axial Cable 
1.6.1.3   Fiber Optic Cable 
1.6.2     Wireless 
1.6.3     Satellite 

1.7 Devices used in Computer Network 
1.7.1   Network Card 
1.7.2    Modem 
1.7.3    Hub 
1.7.4    Switch 
1.7.5   Access Point 
1.7.6   Bridge 
1.7.7   Router 
1.7.8   Gateway 
1.7.9   Amplifier and Repeater 

1.7.10 Crimping Tool 

1.8 Network Topology 
 1.8.1    Bus Topology 

1.8.2    Ring Topology 
1.8.3    Mesh Topology 
1.8.4    Star Topology 
1.8.5    Tree Topology 
1.8.6    Hybrid Topology 

1.9  Computer Network Model 
1.9.1 Client-Server Model 
1.9.2   Peer to Peer Model 

1.10 Check Your Progress: Possible Answers 
 

  

1 
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1.1 LEARNING OBJECTIVES 
 
After studying this unit student should be able to: 
 
 To get an overview of computer networks and its types. 
 To understand various transmission media used for computer networks. 
 To understand various devices used in computer networks. 

 

1.2 INTRODUCTION 
 
We are all familiar with the term ‗network‘.  In our day to day life, we use terms like 
road network, canal network, railway network, bus network, telephone network, etc.  
Recently in the 21st century, few more terms have been added like mobile networks, 
social network, etc.  Broadly speaking, network means group of 
components/elements connected together.  These groups can be of people or 
devices.  When we use the term ‗computer network‘, these components can be 
computers, laptops, lets, etc.  Let us now study computer networks in detail. 

1.3 ELEMENTS OF COMMUNICATION 
 
In this section, we will familiarize ourselves with few terms used in computer 
networking.  The following terms are used when two or more computers exchange 
information.  These terms are known as elements of communication.  
 
 Message:  The data or information that is being transmitted is usually known 

as message.  After a network is established, computers can exchange 
information with one another.  When we transfer a file from one computer to 
other, it takes the form of a message and gets transmitted. Such messages 
can be made up of single packet or multiple packets.  These packets are 
converted into electrical signals or waves, and they are delivered to other 
computer. 

 Sender:  The computer that sends the message is usually known as a sender 
or source. 

 Receiver:  The computer that receives the message is usually known as a 
receiver or destination. 

 Transmission Media:  To exchange data or information across different 
computers, wire/cables or space (air) is required.  With the help of wires, the 
data travels in the form of electrical signals; whereas in space, the data 
travels in the form of electromagnetic waves.  Optical fibers allow the data to 
travel in form of light rays.  Such communication media are known as 
transmission media.  We will discuss different types of media in subsequent 
sections. 

 Protocol:  Well defined set of rules are required whenever messages get 
transferred between computers. For example, when two persons talk with 
each other, there are few rules like in which language will they communicate, 
how long will they wait for each others reply, etc.  Similarly in computer 
networks, sender and receiver communicate with each other using certain 
well-defined rules.  Each computer over the network has to follow certain rules 
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while communicating with other systems. These well defined set of rules are 
known as protocols. 

 
Note:In computer networks, terms like computer/workstation, host or node can be 
used interchangeably. A host or node can be either a sender or a receiver. 
 
Following are a few protocols that are widely used: 
 

HTTP -Hyper Text Transfer Protocol 
FTP -File Transfer Protocol 
SMTP -Simple Mail Transfer Protocol 
IMAP -Internet Message Access Protocol 
TCP -Transmission Control Protocol 
IP -Internet Protocol 

 

 
 

Figure 1.1 Elements of Communication 
 

In computer networks, the speed of transmission of data is known as bandwidth.  As 
we use terms like Km/h while driving a vehicle, the following is a list of few units used 
to identify the amount of data transferred with respect to the time: 
 

Kbps = Kilobits per second 
Mbps = Megabits per second 
Gbps = Giga bits per second 
KBps = Kilobytes per second 
MBps = Megabytes per second 

 
1 Giga = 1024 Mega 
1 Mega = 1024 Kilo 
1 Kilo = 1024 bits Or bytes 
    (1 byte     = 8 bits) 

 
 In layman terms, the transmission speed of 256 kbps is known as broadband 

connection. 
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1.4 BENEFITS FROM COMPUTER NETWORK 
 
Computer can store a lot of information.  When we want to transfer the information 
from one computer to another computer, we need storage media like CD, DVD or 
Pen-Drive.  This process consumes a lot of time and money; however, in the 
presence of computer networks, the transfer of data and information can be done 
very easily. 
 
If we attach a microphone, speaker and webcam to a computer and connect the 
computer with a network, we can perform face-to-face meeting and can chat with 
many people at the same time. Computer networks can be extremely helpful in Tele-
Conferencing and Video-Conferencing.  Using these techniques, people can 
communicate at a very low cost. 
 
In most of the corporate offices, each and every employee may not be provided with 
the facility of printers, scanners, etc.  With the help of computer networks, a single 
printer or scanner can be shared by many people.  By this way, an employee can 
take prints remotely from his computer even though the printer is not on his desk.  
This is how a computer networks can help in saving costs. 
 
We have discussed few benefits that can be achieved through computer networks; 
however, there are few precautions which need to be taken while working with 
computer networks.  Malicious programs like viruses, worms, Trojans can easily 
spread over computer networks.  Moreover, the data and information stored in a 
computer can be easily accessed from other computers. Proper security measures 
are required to ensure the safety of data while using computer networks. 
 

1.5 TYPES OF COMPUTER NETWORK 
 
Computer networks can be classified into 5 major categories depending on the type 
of work it performs and its geographical span. 
 
a. Local Area Network (LAN):  Whenever a computer network is established in a 

room, a building or a small campus of single organization, we identify it is a Local 
Area Network (LAN).  Computers placed in LAN are very near to each other. For 
example, computer network created in computer laboratory of schools or 
colleges. 

 
b. Metropolitan Area Network (MAN): Whenever a computer network is created for a 

city, we identify that network as Metropolitan Area Network (MAN). For example, 
networks used by municipalities or local bus transportation (BRTS). 

 
c. Wide Area Network (WAN): Whenever a computer network covers a wide 

geographical area, it is known as Wide Area Network (WAN).  A network spread 
across the state, country or continent is a WAN. These networks usually range 
from 50-100 Km to several Km in geographical coverage. For example, Gujarat 
State Wide Area Network (GSWAN) connects the collector/ mamlatdar offices of 
Gujarat state.  Few other networks like NIC, ERNET are the examples of WAN.  
Internet is also considered WAN which we will discuss in the next chapter. 
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d. Personal Area Network (PAN): We are familiar with many families where more 

than one computer is used at their home.  Such types of networks found in 
homes are known as Personal Area Network (PAN). These networks are 
restricted to a single house. 

 
e. Body Area Network (BAN): With the increased use of smart phones, many people 

nowadays connect wireless headphones, laptops with their smart phones. Most 
of the time they use Bluetooth technology to establish the connection. Such kinds 
of networks establish within a person's peripheries are known as Body Area 
Networks (BAN). 

  
Network 
Type 

Geographical 
span(approximate(  

Need of 
Security 

Persons involved 

BAN 1-2 metre Less Single 
PAN 1-20 metre Less House/Family 
LAN 1-100 metre Medium Small 

Organization 
MAN 1-100 Km More City/Metropolitan 
WAN 100 Km or more More State/Country 

 
Figure 6.2 Summary of Classification of Computer Networks 

1.6 TRANSMISSION MEDIA 
 

A computer network is created whenever various computers are interconnected.  
There are two different ways to interconnect different computers: 
 
a) Using Wire/Cables for connection 
b) Wireless connection 
 
Whenever the computer network is fixed, that is the computers are not required to 
move now and then, wires or cables are used to interconnect the computers.  But for 
a businessman who has to travel a lot with his computer or laptop, a wireless 
network is preferable.  Let us explore both the types of transmission media in detail. 
 
1.6.1 Wired/Cable Medium 
 
Usually metals like copper or aluminum are used in electrical wires. Such types of 
metals are good conductors of electricity. When two computers are connected 
through wires made up of conducting material, the data gets converted into electrical 
signals with the use of hardware and software.  These signals can be transmitted 
from one computer to other with the help of wires.  The amount of current flowing 
through the wires is negligible, and therefore there is no threat of accidents. 
 
Different types of wires are available for networking.  For instance, the wires used for 
landline telephones are thin and are known as twisted pair cable whereas the wires 
used in televisions (that the connect dish antenna to the set-top-box) are thick and 
are known as co-axial cables. Nowadays, small fiber-like cables are also being used, 
which are known as optical fiber cables. Depending on the need and circumstances, 
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different types of cables can be used to establish a computer network. 
 
1.6.1.1 Unshielded Twisted Pair – UTP 
 
Unshielded Twisted Pair (UTP) is a type of cable used for data transmission.  This 
type of cable has eight thin wires twisted in pairs and so it is known as a twisted pair 
cable.  These cables are widely used in LANs.  The quality of twisted pair cable is 
considered to be superior with the increase in number of twists per 
centimeter?(Please check for the meaning of this sentence, hope it is not distorted)  
There are different categories of UTP cables, for instance CAT3 cables are used for 
telephone lines whereas CAT5, CAT6 or CAT7 cables are used for computer 
networks.  The transmission capability of CAT5, CAT6 and CAT7 cables is more as 
compared to CAT3 cables. Nowadays, CAT5 and CAT6 cables are widely used to 
enhance computer networks.  These cables can connect two different computers 
which can be nearly 100 meters apart and can transfer the data at a speed of 100-
250 Mbps. 
 
The cable shown in figure 1.3 is a UTP cable.  These cables are covered with a 
protective material.  The connectors used to connect such cables with a computer 
are known as RJ-45 connectors.  A special type of protective material can provide 
more security to the data.  When such special covering is used with UTP cables, the 
cables are known as Shielded Twisted Pair Cables (STP).  The cables available for 
computer networks have more number of twists per centimeter. 
 

 
Figure 1.3 UTP Cable 

 

 
Figure 1.4 UTP Cable with RJ-45 Connector 

 
 
1.6.1.2 Co-axial Cable 
In earlier years, co-axial cables were used in computer networks.  However, recently 
they are hardly being used.  These cables can be used for LANs.  They are widely 
used in televisions.  As shown in figure 6.4, these cables are covered with a plastic 
sleeve.  At the center of the cable, a thick metal wire is present for the transmission 
of data.  Co-axial cables can be used even if two computers are up to 5 Km apart 
from each other.  The data transmission speeds varies from 10-100 Mbps in the 
presence of co-axial cables.  The connector used with co-axial cables is known as a 
BNC connector.  These cables are more expensive as compared to UTP cable and 
they require more care as well.  For this reason, co-axial cables are not found 
frequently in computer networks; however, they can transmit data more reliably when 
compared to certain UTP cables. 
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Figure 1.5 Co-axial Cable  

Figure 1.6 Co-axial Cable with BNC Connector 
 
1.6.1.3 Fiber Optic Cable 
 
With the development in technology, a new type of cable has started taking up the 
markets.  These cables are known as Optical Fiber Cable (OFC).  Such cables are 
created from glass-like material that can transmit data with the help of light rays.  
(Imagine that we are sending message to some distant person with the help of a 
torch.) 
 
These cables are prepared by taking special care so that the data can be easily 
transmitted with the help of light rays.  It is ensured that the light gets reflected within 
the cable and does not get refracted (emerge out from the cable). 
 
When compared to other cables, OFCs can transmit data several times more and 
can also transmit it more reliably with minimum errors.  However, OFCs are 
expensive and difficult to manage as compared to other cables. Special type of 
connectors like SC and ST connectors are used with these cables. 
 

 

 
 

Figure 1.7 OFC Cable 

 
 

Figure 1.8 OFC Cable with Connector 
 

 
1.6.2 Wireless Medium 
We are all familiar with the term wireless. FM radio is a good example that uses 
wireless technology where we can listen to audio with the help of waves. Various 
utilities that we use at home like remote control, cordless phone, mobile phones, etc. 
use a wireless technology. These devices operate on different frequencies.  As such, 
there are different categories for wireless medium like radio waves, micro waves, x-
ray, light rays etc., but in computer networks radio waves and micro waves are being 
used 
 
We can connect our computer, laptop or let in a network without using wires. Such 
devices are connected to existing networks using wireless technologies like 3G or 
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Wi-Fi.  The data is transmitted in air with the help of radio waves.  Different types of 
technologies like Wi-Fi, GSM, WiMAX, Bluetooth, CDMA, etc. operate on different 
frequencies of radio waves, and that is the reason why their features keep on 
varying. 
 
As we have different channels (91.1 FM or 98.3 FM) in FM radio; similarly in wireless 
networks, different computers operate on different frequencies to transmit data.  As 
the devices operate on different wireless technologies, the range of connectivity and 
bandwidth vary with the frequencies on which they operate.  For example, wireless 
LAN or Wi-Fi technology can transmit data at the speed of 300 Mbps and within the 
periphery of 100 meter; whereas, Bluetooth technology can cover at the most 10 
meter periphery with the transmission speed of 700 Kbps. 
 
Note: The desktop computers that use wireless technology require special hardware 
equipment which are generally not present in consumer desktop computers.  
However, laptops and lets do have the in-built hardware to support the wireless 
medium. 
 

 
 

Figure 1.9 Wireless Media 
 

1.6.3 Satellite 
 

Data transmission can also take place with the help of satellites. With the help of 3 
satellites, data can be transmitted to any part of the globe. As we can receive various 
channels in television using DTH technology; similarly, our home computers can be 
connected to word-wide computers. As this technology is very expensive, it is being 
rarely used. The technology used to establish computer networks with the help of 
satellites is known as Very Small Aperture Technology (VSAT). 
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Figure 1.10 Communication with the help of Satellite 
  

 

1.7 DEVICES USED IN COMPUTER NETWORK 
 
Different types of devices are used in computer networks. Following points are 
usually considered before making the appropriate selection of a network device: 
 

 How many rooms or buildings are to be covered by a computer network? 
 Distance between these rooms and buildings? 
 What type of computers will be used (desktop/laptop)? 
 Type of network topology (we will discuss network topology in subsequent 

section) is used? 
 Will the organization be connected to any other organizations? 
 What kind of work is to be achieved through computer network? 
 Will the local network will be connected with internet or not? Let us take a 

brief overview of widely used devices in computer networks. 
 
1.7.1 Network Interface Card 
Network Interface Card (NIC) is an inveigle device for computer networking. NIC 
usually accompanies the motherboard of the computer. The main job of NIC is to 
convert data (bits form) into electrical signals for wired medium or electromagnetic 
waves for wireless medium and later transmit over those medium.  At the receiver‘s 
side, the NIC of that computer does the reverse process, i.e., it receives the signals 
and converts them back into bits form. 
 
Nowadays most of the computers and laptops have in-built NIC on the motherboard. 
However, NICs for wireless transmission are available in the form of external USB 
Dongles. 
1.7.2 Modem 
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Modems are required when a computer at home 
needs to be connected with Internet (global 
network). With the help of modem, a home 
computer can be connected to various other 
computers over the internet using telephone 
lines.  A modem is also required at the other end 
in case if they are using telephone lines.  
Different types of modems are available in 
market; they are generally known as dial-up 
modem like DSL, ADSL, and ASDL+ etc.  The 
main job of these models is to convert analog 
signals into digital signals and digital signals into 
analog signals (modulation & demodulation). 

 

 
Figure 1.11 Modem 

 
1.7.3 Hub 
Hub is a device used to connect different 
computers into a single network. The 
cables coming out of the computer NIC 
are connected with the hub. Whenever a 
message is sent by a computer, it is 
passed on to another computer via hub. 
 

 
Figure 1.12 Hub 

 
1.7.4 Switch 
The working of a switch is similar to that of a hub; however, it operates at a faster 
rate and is capable of attaching more computers into a single network.  A single 
switch can connect 64 computers into a single network.  In case one needs to 
connect more computers, these switches can be interconnected to accommodate 
hundreds of computers into a network.  Switches are more expensive than hub. 

 
Figure 1.13 Switch 

1.7.5 Access Point or Wireless Access Point 
The role of wireless access point is similar to that of a hub or a switch in the 
presence of wireless networks.  Recently, there has been a major increase in 
number of devices like lets and smartphones.  Such devices have the wireless 
networking capabilities (wireless card) and can easily connect to Wi-Fi networks with 
the help of access point.  An access point is connected with the switch so that it can 
connect various devices to the computer network of any organization. Using a single 
access point, at least 4-5 computers can get connected by a network without the use 
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of wires. 

 
Figure 1.14 Wireless Access Point 

 
1.7.6 Bridge 
Bridge is used whenever an interconnection of two or more LANs is required.  For 
example, suppose there are two different LANs in different buildings, these LANs can 
be connected with each other with the help of a bridge device. 
 
1.7.7 Router 
Routers are used whenever LANs need to be connected with WAN. Routers are also 
used to decide the path of flow of data (Route discovery and forwarding).  A device 
which is capable of performing the work of a router as well as a bridge is known as a 
Router. 

 
Figure 1.15 Router 

1.7.8 Gateway 
 

Gateways are widely used to interconnect two or more networks of diverse types.  
These networks might be running different applications.  For example, 
interconnecting telephone network and computer network or mobile network and 
computer network.  Modern routers and switches do possess limited capabilities of 
gateways. 
 
1.7.9 Amplifier & Repeater 
 
Whenever computers are connected with the help of wires, we must keep in mind 
the total length of the wire. In case of UTP cables, if the length of wire exceeds 100 
meters, gradually the electrical signals being transmitted get weakened.  Under such 
situations, devices like amplifiers or repeaters help to improve the signal strength so 
that they can propagate longer distances.  Few devices can help in reducing noise 
present in these signals.  Such devices are similar to pumping stations found in 
water pipelines. 
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Figure 1.16 Repeater 

 
1.7.10 Crimping Tool 
To attach connectors like RJ-45 to the UTP cables, crimping tools are required. With 
the help of such tools, connectors can be easily attached to UTP cables. 

 
Figure 1.17 Crimping Tool 

 

1.8 NETWORK TOPOLOGY 
 

Network Topology identifies the way in which different computers are connected in 
LAN. Few well known network topologies are bus, ring, mesh, star, tree and hybrid. 
Most of the LANs nowadays use star topology.  Let us explore each topology in brief: 
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Figure 1.18 Network Topology 

 
1.8.1 Bus Topology 
 
Bus topology was widely used earlier. In this topology, all the computers in a network 
are attached with a main cable (bus). It is similar to a water pipeline found in a 
society.  In early days, co-axial cables were being used.  A special device known as 
'Central Controller' is used in the bus topology.  The job of this device is to decide the 
path and the computers that will communicate at any given instance of time.  Due to 
such a provision, only two computers can communicate at a time.  There are other 
problems like scaling issues, i.e., as the number of computers attached to the bus 
increase, the network slows down.  Major issue is that in case the bus gets 
damaged, entire network will stop functioning. 
 
1.8.2 Ring Topology 
 
In the ring topology, all the computers are connected with each other in a circular 
fashion.  It is also known as a loop.  The transmission of data in ring topology is 
unidirectional.  At any instance, only two computers can communicate with the use of 
ring topology.  To avoid multiple computers transmitting data at the same time, a 
concept of 'token' is applied.  With the help of tokens, each computer can transmit 
data turn by turn.  The computer that possesses the token will be able to transmit 
data while the rest of the computers will listen.  After a fixed time interval, the token is 
passed on to the other computers.  Ring topology shows drawbacks like slow 
network speed when we try to add more computers into the network.  This network is 
not fault tolerant; in case if the loop gets damaged, it can bring down the entire 
network. 
 
1.8.3 Mesh Topology 
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In mesh topology, each computer is connected with rest of the computers with 
dedicated cables. Special kinds of network cards are required to implement this 
topology.  Such network cards can accommodate multiple cables.  Practical 
implementation of mesh topology is very difficult, apart from which, as the number of 
computers increases, more and more wires are required. 
 
1.8.4 Star Topology 
 
In star topology, each computer is connected with a special device called hub or 
switch.  This device works like a controller; it works like an intermediary while 
transmitting data from one computer to another. 
 
Nowadays, switches are used in most of the LAN networks.  Each computer is 
connected with the switch using UTP cables. Hubs and switches are low price 
products and are easily available in the market.  Modern switches allow fast 
transmission of data as compared to the rest of the topologies.  The main advantage 
of the switch is that in case of damage to the cable, only one computer will get 
disconnected while the rest of the computers can still be a part of the network. 
However, in case if a hub/switch fails, the entire network goes down. 
 
1.8.5 Tree Topology 
 
 
Whenever the computers are arranged and connected in a sequence of tree 
structure, a tree topology is formed. Tree topology can accommodate multiple 
topologies. Tree topology is best suited when multiple computers are to be 
interconnected. 
 
1.8.6 Hybrid Topology 
 
In certain cases, different topologies are required to construct a single network from 
different LANs. A hybrid topology is a combination of various topologies applied to a 
LAN. 

1.9 COMPUTER NETWORK MODELS 
 

Computer networks can be classified into two different categories according to their 
functions.  
1.9.1 Client-Server Models 
In the client-server model, various workstations or desktop computers are connected 
to the Server(s). Figure 6.18 illustrates a network that works according to client-
server model.  These servers can be file server, print server or network server.  
Servers are usually high-end computers that offer various services like hosting of a 
website whereas client computers are normal PCs or workstations from where the 
users can run their programs.  Client computers depend on servers for data 
processing, storage requirements and/or accessing shared devices. 
Servers can store a lot of information.  Usually, the client computer sends a request 
to the server to access the information and the server provides response for the 
same.  Client-server model works according to request-response mechanism. The 
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best example is when we read emails from gmail.com, our system works like a client 
that sends request to the server. 

 
Figure 1.19 Client-Server Model 

1.9.2 Peer-to-Peer Model 
 

In peer-to-peer model, each workstation can behave like a client as well as a server, 
i.e., each computer can send a request or give response to others request.  In this 
model, each computer has equal status.  In this model, there is no separate server 
with higher status.  Bit-torrent protocol is an example of peer-to-peer model using 
which we can upload or download files from any network. 

 

1.10 CHECK YOUR PROGRESS: POSSIBLE ANSWERS 
 
Q1. Select the appropriate choice 
 

 
Q2. Fill in the blanks with appropriate answers. 

 
1. Set of standardised rules and procedures are known as __________ in computer 

network. 
2. ____________Type of network has its span throughout the city. 
3. RJ-45 connector can be used with ____________ type of cable.  
4. Wi-Fi network uses __________ type of transmission medium. 
5. ____________Device is used in Star topology to connect different hosts. 
6. In wireless networks, _____________ device works similar to a Switch. 
 

1 Internet is a __________ type of network? 
(A) LAN        (B) MAN (C) WAN (D) PAN 

2 Data transmission rate in computer networks in known as _____________ . 
(A) Protocol (B) Bandwidth   (C) Waves   (D) Topology         

3 __________ Device increases the strength of signals. 
(A) Modem (B) Router (C)Hub (D)Amplifier 

4 _________ Topologyrequires hub or switch. 
(A) STAR  (B) BUS (C)RING (D)MESH 

5 ________ Type of cable uses light rays for data transmission. 
(A) UTP cable(B) Co-Axial cable (C)Fiber Optic cable (D)STP 

cable 
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Q3. State whether the followings are true or false. 
 
1. Brouter is the device that does the function of abridge as well as a router. 
2. Private network of any organization is known as BAN. 
3. Gateways are required to establish Wi-Fi network. 
4. Client-Server Model follows request-response mechanism. 
5. Crimping Tool is used to attach connectors to Fibre Optic Cables. 
 
Q4. Match the followings: 
 
1. RJ-45 connector a. Fiber Optic cable 
2. BNC connector b. Satellite Communication 
3. SC/ST connector c. Dial-up Connection 
4.VSAT d. UTP cable 
5. Modem e. Co-Axial cable 
 
Answers  
Q1.  1. C (WAN)    2. B (Bandwidth)    3. D (Amplifier)   4. A (STAR) 5. C (Fiber Optic 
Cable) 
Q2.  1. Protocol     2. MAN   3. UTP 4. Wireless  5. Hub or Switch  6. Wireless 
Access Point 
Q3.  1. True   2. False 3. False  4. True 5. False 
Q4.  1. RJ-45 connector- d (UTP cable)         2. BNC connector –e (Co-Axial cable) 
3. SC/ST connector- a (Fiber Optic cable)      4. VSAT–b (Satellite communications) 
      5. Modem – c (dial-up connection)  
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Unit 2:  Internet 
  

 
Unit Structure 
 
2.1. Learning Objectives 

 
2.2. Introduction 

 
2.3. Internet Services 

 
2.4. Internet Address 

 
2.4.1 IP Address 
2.4.2 Mac Address 
2.4.3 Port Address/ Port Number 
 

2.5. Top Level Domain 
2.5.1 Domain Name system 
2.5.2 Uniform Resource Locators- URLs 

 
2.6. Techniques to establish an Internet Connection 

 
2.7. Check Your Progress: Possible Answers 
  

2 
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2.1 LEARNING OBJECTIVES 
 
After studying this unit student should be able to understand: 

 To get an overview about Internet and its services 
 To learn various techniques of establishing Internet connection 

 

2.2 INTRODUCTION 
 
Internet is a network of networks. Internet word is derived from combination of two 
words, 'INTER Connection' and 'NET Work'.  Internet means a collection of huge 
number of computers or we can say it is network of various computer networks. The 
computers connected with Internet can easily exchange data. Today, most of the 
countries are well connected with the Internet. 
 
Internet is not restricted or controlled by any single organization; it is jointly governed 
by various organizations, industries and citizens. Few countries have formed their 
own policies and standards on Internet usage, some of them have also formed 
policies for penalizing in certain cases. Internet has evolved rapidly in short span, 
which is an achievement to human race. The penetration of Internet among people is 
more compared to the increase in human census, it won't be an exaggeration if all 
people world-wide will start using internet in near future. 
 
Origin of Internet:  
 
A brief summary of evolution of Internet is as under: 
 
1962: First computer network was invented 
1964: Packet Switching was invented 
1965: Hypertext was developed 
1969: ARPANET was formed 
1972: TCP/IP protocols were developed 
1984: Internet nomenclature was established 
1989: WWW was developed 
 
Initially, in 1969, the Advanced Research Project Agency (ARPA) of US Defense 
department developed ARPANET. In short period, ARPANET was extended to 
connect various Universities, 
Scientific Labs and was later extended to other countries. Initially ARPANET 
connected only few networks which later on scaled to world-wide network. 
 
During 1980s, networks like BITNET, CSNET were developed. In the same year 
National Science Foundation of USA developed NSFNET to interconnect various 
colleges, universities and scientific organization. Later, in 1993, International national 
information Centre (INTER NIC) was formed by NSF which worked with the 
collaboration of Network Solutions Incorporation (NSI) and AT&T. 
 
Protocol: Usually, TCP/IP protocol suite is used over Internet. Apart from TCP & IP,  
few well-known protocols like NETBEUI, Point-to-Point protocol (PPP), Serial Line 



 
 294 

Internet Protocol (SLIP) and application protocols like simple mail transfer protocol 
(SMTP), file transfer protocol (FTP), terminal emulation protocol (TELNET) etc. are 
also being used. 
 
Browser: Browsers are tools used to open any website running over Internet. By 
entering the website address and pressing the enter key will load the website in our 
browser. While browsing, we use 'WWW' that stands for World Wide Web. The 
information stored in web-pages is linked with each other and it is similar to the 
spider‘s web. Huge information is available over internet with the help of WWW, we 
can surf websites over internet and collect the information. To create such web-
pages, special tools and technologies are used. Hypertext mark-up language 
(HTML) and Dynamic HTML (DHTML) are the most familiar technologies used to 
create web-pages. Few well-known browsers like Netscape navigator and internet 
explorer were famous for browsing the websites. Internet explorer is a widely used 
browser till date. 
 
Using Internet Explorer: The icon of ‗Internet explorer‘ is usually present on the 
desktop. However, the option of internet explorer is also present on the Start Menu. 
By clicking on the icon/short-cut, the browser gets loaded as shown in figure 2.1 We 
type the website name in the address bar, later by pressing the enter key 
corresponding website gets loaded in the browser.  We can surf multiple websites 
with the help of tabs in Internet Explorer.  
 

 
Figure 2.1-a Internet Explorer (Browser) 

 
Although there are many advantages of Internet, but few disadvantages also exist. A 
big threat of hacking exists over Internet.  Hackers are those people who try to steal 
or modify important information from the servers. Rumors or un-authentic information 
can easily spread over internet.  Presence of pornographic content and objectionable 
content cannot be restricted over internet. Apart from it, various viruses try to spread 
over internet with the help of online free games, screen-savers, advertisements etc. 
Malicious software like viruses can easily spread through Internet. This leads to loss 
of revenue and our time. 
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2.3 INTERNET SERVICES 
 
Usually, internet is used for e-mailing, chatting, group discussion, video 
conferencing, online shopping and entertainment. Let us explore each one of them in 
brief. 
i) Store-house of Knowledge: Generally it is said that Internet means 

information hidden in vast ocean. Within seconds, we can get lot of information 
related to industries, education, people, and tribes, geographic areas, banking 
sector, travelling, defense or any subject. 

ii) E-mail: Electronic mail is a very important service of internet. With this service, 
one person can exchange messages, images, and audio/video with any other 
person or group of persons residing anywhere in the world. E-mail services are 
very cheap. However, to use e-mail services, proper user-id like 
baou@rediffmail.com must exist. Here, baou is Account Holder's id; 
rediffmail.com is the domain and @ is the separator. Few terminologies used 
with e-mail are: 

a. Outlook Express: It is an e-mail service where client can read email delivered 
from any person or organization, type and send emails, reply to any emails, 
sending or receiving important documents with messages 

b. Inbox: It is a folder that stores the incoming messages (emails) 
c. Outbox: It is a folder that stores the emails that are already typed and to be sent 
d. Sent Items: It is a folder that stores the emails that were sent earlier 
e. New Mail: It is a button used to type emails 
f. Send: It is a button to send the emails that have been typed 
g. Deleted items: It is a folder that stores the emails that were deleted previously 
h. Attachment: It is a button used to attach any file along with the message 
i. Addresses: This option is used to store the email contacts 

iii) Chatting: Chatting is very famous among youth. Usually chatting involves two 
or more people exchanging messages by typing it live. Chatting can be used 
to stay in touch with others, for example, Facebook, WhatsApp etc. provide 
such facilities. Chatting has found its wide use in students where at any time, 
one person can send messages to any other person or group of person sitting 
anywhere in the world within seconds and for any period. 

iv) Video Conferencing (Group Discussion): In video-conferencing, two or 
more people staying far away, can see and talk with each other live over 
internet. It is very important; websites like skype, webex provide such kind of 
services. We have seen in televisions that the news reader can communicate 
from studio with the correspondents who are at incident sites. Let us see 
another practical example, a director who is in USA can talk with the 
employees of his company in India using video-conferencing just by sitting in 
his office, there is no need for him to personally visit India. Video-conferencing 
can also be known as online group discussion. Gradually, the use of video-
conferencing is widening, now-a-days interviews are also being conducted 
with the help of video-conferencing. In near future, the education system will 
start using video-conferencing through which the students in India can attend 
live lectures from their home of any other universities of Germany, USA, and 
London etc. without traveling to such places. The main advantage of video-
conferencing is that we can see the expressions while interacting over 

mailto:baou@rediffmail.com
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internet. 
v) Online Shopping: Now-a-days, there is no need to visit any shop for the 

purchase, most of the purchases can be done online through websites with 
the help of Internet.  Most of the companies have their websites, just by 
visiting the website, we can select appropriate model and place an order. The 
product is delivered at our place with the help of agents/courier in very short 
span. The advantage of internet is that we can compare various products just 
by sitting at home with the help of websites. According to a survey, in 
America, nearly 40% of purchase is done online. A well-known website 
amazon.com is famous for online shopping. 

vi) Job Search: Whenever any organization requires employees, they can put 
the advertisement of their requirements over Internet; the needy people can 
search and apply to respective positions. Lot of jobs are being posted over 
Internet, there are few special websites that can be used for job search. We 
can upload our information over such websites, which becomes our bio-data, 
later various job related announcements and information is sent to our emails. 
A well-known website for job search is timesjobs.com 

vii) Entertainment: There are lots of websites for online entertainment and to 
remove boredom. Websites for online games, films, commercials are 
available over internet. 

viii) Railway and bus booking: We usually use railways, state transport and 
private buses for travelling. It consumes lot of time to book tickets physically 
as we have to stand in long queues. However, with the help of internet, these 
booking can be done online with confirmed tickets. A well-known website for 
railway ticket booking is irctc.co.in 

ix) Information about geographic location: We can get information about 
places, maps along with pictures over internet. e.g. Google maps 

x) News: We can use internet to know the latest news and events taking place 
world-wide. Websites like divyabhaskar.in (Gujarati), 
timesofindia.indiatimes.com - Times of India (English) are widely used for the 
same. 

xi) Admissions in School/Colleges: Websites running over internet are very 
helpful in choosing a particular school or college and securing admissions. 
For example baou.edu.in, gtu.ac.in, siksha.com 

xii) Travel Planning: Internet can be helpful to plan national or international visits 
and do online booking of tickets and hotels. For example yatraa.com 

 
The above listed are few uses of internet in our daily life. Apart from which, internet 
is also helpful in huge business, government, exchange of information for education 
etc. 

 

2.4 INTERNET ADDRESS 
 
As we have to remember different roads and paths to reach at a particular address 
or home, similarly each computer connected with Internet is identified by a unique 
address. These addresses are known as internet address. 
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Figure 2.1-b Internet Address 

Internet address of our computer can be viewed by opening control panel or My 
Computer icon. To view or modify the internet address, select Network Connection 
which shows the devices used to connect to the internet. In the above screen, the 
computer is connected using ―Local Area Connection‖, by double clicking on this 
icon, we can see the status, further navigate to Support->Details tab which opens a 
new dialog box. This dialog box shows Physical Address, IP Address, Subnet Mask, 
Default Gateway, DNS Server and Wins Server.  
 
2.4.1 IP Address 
 
Internet Protocol (IP) is a standard protocol for Internet. Each computer connected 
with internet is uniquely identified by a unique number known as ―internet number‖. 
This number has 32 bits and is divided into four parts. Each part has 8 bits ranging 
from 0 to 255. So, each part has different numbers from 0 to 255, for example 
203.52.42.36 is an IP address. These addresses are unique for each computer; 
however, if a computer has multiple internet connections, it may have multiple 
internet addresses. 
2.4.2 MAC Address 
 
MAC address is Medium Access Control Address. It is a unique address found on 
network hardware like NIC card. It is usually of 48 or 64 bits. MAC address is a 
permanent code found over internet adapter. It is given by the manufacturer of the 
NIC and adheres to Institute of Electrical and Electronics Engineers (IEEE) 
standards. 
 
2.4.3 Port Address / Port Number 
 
Computer network or Internet provides various services like file transfer, email, web 
services etc. Each of these services is offered on a pre-defined port. A port number 
or port address is an integer number that identifies each service uniquely. For 
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example file transfer protocol (FTP) uses port number 21, HTTP uses 80 and E-mail 
service of sending mails (SMTP) uses port number 25. 
We generally apply port numbers to enable or disable any service from firewall. 

 

2.5 TOP LEVEL DOMAIN 
It is difficult to remember IP addresses over internet. A service called Domain Name 
system (DNS) was established to easily remember names of computers/websites. It 
maps each IP address to some domain. Depending on the type of services being 
offered, there are various domain names available as shown in the following table: 
 

Domain Significance 
.gov Government 
.mil Military  
.edu Educational 
.com Commercial 
.org Organization 
.net Network 

 
Domain names are also assigned depending on the country name. The below table 
illustrates county level domains. 

Domain Country 
.in India 
.au Australia 
.us America 
.uk England 
.ca Canada 

 
As it is difficult to remember the IP address of different websites, an easy technique 
of domain name system was developed. Using which, we can remember websites 
easily like google.com, yahoo.com, baou.edu.in, gswan.gov.in, gujarat.gov.in etc. In 
fact for each of these websites, there are corresponding IP addresses with the help 
of which they function.  
To know the corresponding IP address for any domain name, we can use lookup 
command at command prompt as shown below: 
C:\>nslookup gswan.gov.in 
 
2.5.1 Domain Name System 
 
Whenever we open any website, our computer first contacts the domain name 
system (DNS) to fetch the IP address of that website. Later, using the IP address, 
our computer contacts the web-server and finally loads the webpage into our 
browser. This procedure is known as DNS resolution. Figure 2.2 explains the 
procedure in graphical form. In the figure, various message exchanges of DNS 
resolution are shown when our computer is trying to open hubpages.com website. 
As of now, there are thousands of DNS servers spread worldwide. 
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Figure 2.2 DNS Server 
 

2.5.2 Uniform Resource Locators –URLs 
 
Uniform resource locator (URL) is also known as web address. A website is a 
collection of web-pages. Each of the webpage can be uniquely identified over the 
internet and can be loaded in the browser. To identify each of the webpage, we use 
URLs. A URL is a combination of protocol, website (domain name), path of file and 
filename. For example, the library timings details of Santa Rosa College can be 
gained using the following URL 

 
 

Figure 2.3 Uniform Resource Locators (URLs) 
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2.6 TECHNIQUES TO ESTABLISH AN INTERNET 
CONNECTION 
 
With the recently developed technologies, the following are different ways to connect 
with Internet. 
 

i) Using Direct / Leased Line 
ii) Using Remote / Dial-up connection 
iii) Using SLIP / PPP 
iv) Using Commercial Online Services 

 
i) Direct / Leased Line: With the help of telephone line or dedicated line, internet 

connection can be established. The fee/tariff is charged depending on the 
bandwidth, usage and number of users. Usually, leased line connection is more 
expensive. 

ii) Remote Dial-up: Whenever a personal computer is required to establish 
connection with Internet through gateway computer or telephone line, under 
those circumstances the internet service provider (ISP) provides dial-up 
connection service through telephone lines. It is also known as remote dial-up. 

iii) SLIP/PPP: With the help of remote dial-up connection, the client computer can 
connect to other host computer with the help of point to point protocol (PPP) or 
serial line interface protocol (SLIP) 

Commercial Online Service: Various other commercial services that use phone line 
or cable lines cater online environment and internet service. They help connecting 
personal computer with other host computers over internet. 

2.7 CHECK YOUR PROGRESS: POSSIBLE ANSWERS 
 
Check Your Progress: 
 

1. Try to know the IP address of your computer if it is connected with the 
Internet. 

2. Try to know the IP address of google.com if your computer is connected with 
the Internet. 

3. Visit the following websites: 
a. www.baou.edu.in 
b. www.gujaratuniversity.org.in 
c. www.pmindia.nic.in 
d. www.hostindia.net 
e. www.ril.com 

 

  

http://www.baou.edu.in/
http://www.gujaratuniversity.org.in/
http://www.pmindia.nic.in/
http://www.hostindia.net/
http://www.ril.com/
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3.1 LEARNING OBJECTIVES 
 
After studying this unit student should be able to understand: 

 To understand the role of Browsers and its features 
 To understand the role of E-mail and MS-Outlook configurations 
 

3.2 INTRODUCTION 
In Previous lecture we have seen the origin of Internet, its services, Internet Address 
and different techniques to establish an Internet Connection. This chapter introduces 
E-Mail Client. Also explains how to add and configure E-mail. It also discusses 
facilities like Calendar, Contacts and Task and Note. Gives idea about general 
security concepts and Network Troubleshooting. 
 

3.3 BROWSER 
 
Once the internet connection is established, we must harness the benefits of it. 
Browsers were developed to use Internet and get the benefits of Internet. Browsers 
are also found in laptops and smart-phones. Browsers can be classified as follows: 

i) Line Browser: This type of browser uses command line interface. It only displays 
textual data. Here, the user can enter various commands to surf internet. At the 
bottom of browser screen, various commands and its usage are displayed. Lynx 
is a widely used command line browser. 

ii) Graphical Browser: Line browser cannot display multi-media data like images, 
audio, video etc. Graphical browsers are helpful in displaying such kind of data; 
mostly they rely on mouse instead of keyboard while surfing. These browsers can 
display hyperlinks in different colors; users can easily distinguish the web-pages 
they have already visited as such hyperlinks are shown in violet color, while the 
non-visited hyperlinks are shown in blue color. 

iii) Java Enabled Browser: These browser support java language. With the help of 
such browsers, java applets can be downloaded from the server and can execute 
within the browsers. With the help of such browsers, dynamic content can be 
accessed. 

 
Figure 2.1-a Different Browsers 

 
The above figure shows icons of four widely used browsers. 

i) Internet Explorer 
ii) Mozilla Firefox 
iii) Google Chrome 
iv) Safari 

 
These browsers are famous among computer users. Internet Explorer is pre-installed 
and available on all windows computer. Browsers come with various facilities, 
although there are different browsers, most of the features are available in all these 
browsers. Let us briefly study the features available in the browsers. 
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(a) Back and Forward Button: These buttons help us to easily navigate during 
internet surfing session. It helps to see the previous visited web-pages and 
subsequent web-pages during the session. 
(b) Refresh/Reload and Stop button: Refresh/Reload button can be used to load 
the web-page again in the browser so that it can provide updated details, if the web-
page is taking lot of time to load, the stop button can be used to stop loading of the 
page. 
(c) Zooming: The browser fonts and display can be enlarged. 
(d) Home Button: It helps in loading the Home page (default website); in few cases 
it opens a blank page in the browser. 
(e) Search bar: With the help of search bar, we can search for any specific keyword 
using a pre-configured search engine. 
(f) Address bar: The website is typed in address bar, after which the corresponding 
web-pages start getting loaded 
(g) Status bar: When a website is being loaded in the browser, its progress is 
displayed in status bar 
(h) Pinned Websites: Favorite websites can be pinned using this button, so that 
they can be easily launched from the task bar. 
(i) Bookmarks: Favorite websites can be bookmarked, so that the browser 
remembers such websites, it helps us to easily load websites in another browsing 
session (some other day) and reduces the burden of typing websites in address bar. 
(j) History: All the websites that have been visited are remembered by the browser 
as browsing history.  We can get the details of our browsing history of any previous 
day by using this option. 
(k)In private browsing: Each of our browsing session's data and history is stored by 
the browser. At times it is not preferable to store our data in the browser, for instance 
when we are using public computer from cyber cafe. In such cases, we can use 
'private browsing' option so that the browser does not store our history and data; this 
ensures that our browsing session is secure and protected. 
(l) Internet Options: To configure the behavior of browser during surfing, 'internet 
options' is used. Various aspects of browser like security, history, content etc. can be 
configured using it. 

 

 
Figure 3.1-b Internet Explorer Browser  
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Figure 3.1-c Internet Options in Internet Explorer 
 
Check Your Progress 

1. Set the website google.com as your default page 
2. Open and check the website www.baou.edu.in in different browsers. 

 
 
 

3.4 MS OUTLOOK 
 
Outlook is a product of Microsoft. It has facilities to create and store E-mails, 
Calendars, and Addresses etc. Outlook can be used to send or received emails 
when connected with the internet. The advantage of outlook is that we can view old 
emails without live internet connection. Today, outlook is being used in various 
organizations. Outlook is very simple to use, let us explore in more detail. 
The figure 3.2 is the initial screen when we open outlook. The screen is divided into 
four parts including a menu bar as seen in other programs. Part-1 displays the 
information about mails, on clicking an option in part-1; the details of those items will 
be shown in part-2. For instance, when you click on inbox in part-1, the details of 
inbox will be shown in part-2. After clicking on any mail in part-2, a small preview will 
be seen in part-3. Part-4 contains calendar, apart from viewing the dates, it can help 
to remind various events according to dates. It saves the information about work to 
be done on particular dates. 

http://www.baou.edu.in/
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Figure 3.2 Outlook Express 

3.5  ADDING AND CONFIGURING E-MAIL 

 
 

Figure 3.3 Adding an Email Account to MS Outlook 2010 
 

E-mail means electronic mail (electronic post). With the help of internet, any 
message can be sent or received instantly. To use e-mail, there must be a unique e-
mail address. We need to configure outlook to send or receive e-mails. Configuring a 
single email address is one time process. As soon as we start outlook, the first dialog 
box appears that displays configuring outlook. Subsequent dialog box will show 
'startup', after clicking on 'next', it asks to enter the e-mail account. If you already 
have an online e-mail account and want to proceed further, click 'yes' else click on 
'no'. 
Enter the details required by outlook, further click 'yes'. If all the details entered are 
configured successfully, you may click on 'finish' else it shows error message. To 
open a new account, click on the sign present in left hand side top corner. Later 

1 2 3 4 
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enter into 'Profile' and click on 'Add account'. Fill all the details in the screen, on 
confirming the details, your e-mail address will be added. 

3.6 ATTACHMENT AND SIGNATURE IN E-MAIL 
 

To send any file with e-mail, we use the 'Attach' button in 'Insert' menu. After 
selecting the file, it will be seen as an attachment in your email that can be sent to 
any person through email. 
 
Now, to send any file or attachment to any person, go to 'Files' menu and click on 
'New', this will open up the screen as shown in figure 3.4.  Then click on 'Attach 
Item‘, browse the file from your system to attach the file with the message.  
 
To attach a 'Signature' to your email, click on the 'Signature' button, this helps to add 
our signature (name & contact details) that we have already configured. 
 

 
Figure 3.4 Attachments in E-mail 

 
Check Your Progress 

1. Configure the outlook as per your email id. 
2. Send an email to your friend from outlook. 
3. Send an email with attachment and signature to your friend from outlook. 

 

3.7 CALENDAR 
 
By clicking on the calendar option, it pops up the calendar similar to that we use at 
home. Using this calendar, we can easily navigate between dates, months or years 
back and forward. We can prepare an organizer to identify the tasks to be done on 
particular date and time. 
 
The following steps are necessary to setup an organizer: 
 
 By clicking on 'New' button will open up a new window 
 Go to 'Action' menu and click on 'New Appointment' to open up another window. 
 Enter Subject, Location, time and other details. 
 
As shown in figure 3.5, a calendar for the month of April, 2014 is shown with dates. 
By clicking on a particular day, we can enter tasks to be performed on those days. 
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Figure 3.5 Calendar in Outlook 

3.8 CONTACTS 
 

After we send a new email to any person, there is a facility to add their contact 
details in outlook.  The 'Contacts' menu will display icons to manage contacts from 
outlook. From the 'Address Cards List', we can see the phone numbers and other 
details using the 'Current View' icon.  We have to add details of any person by 
selecting the emails sent to them. It is a onetime process to enter the detail of any 
person, later we have to save and close the window. 
 

 
 

Figure 3.6 Adding Contacts in Outlook 
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3.9 TASK AND NOTE 
 

Figure 3.7 Task in Outlook 
 
By clicking on 'Task' button, it displays all the tasks till date with the ending days of 
each task. To add a new task, a dialog box opens by clicking on 'new' button. We 
can add the task details like subject, start date and end date etc. and later save and 
close the window. The inserted details will be shown in a dialog box. 
 

 
 

Figure 3.8 Facility of Notes in Outlook 
 

Calendars can be used to insert daily tasks, however if we forget to visit the calendar 
on daily basis, the entire schedule may get disturbed. ‗Tasks‘ is another functionality 
of outlook which allows us to remember our schedule by sending alerts (reminders) 
on scheduled date and time. 
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In outlook, there are features to organize tasks and reminders by using notes. A user 
may enter notes for the task to be done on time to time basis. 
 

 
Figure 3.9 Reminder Note 

 
Check your progress 
 

1. Create your schedule for the current month in outlook. 
2. Create a reminder for the birth-days of your father and mother in outlook. 
3. Add the contact details of your friends in outlook. 

 

3.10 VIRTUAL  PRIVATE NETWORK – VPN 
 
Let us understand the concept of VPN through an example. Suppose a company has 
two branches, one in Jamnagar and the other in Mumbai. Now, if we want to 
establish a computer network between these two branches, it is known as private 
network. This network will be limited to the company. We have three ways to 
establish a private network for the above case: 
1. Use a dedicated wire to connect both the branches 
2. Use satellite communication to connect both the branches 
3. Use internet to connect both the branches. 
 
From the above alternatives, options (i) and (ii) are more expensive, in certain cases 
they might not be possible. For instance option (i) may face problems if there are 
sea/mountains in between the branches. 
In virtual private network (VPN) all the branches of any organization can be inter-
connected with the help of internet. Being a private network, no other person except 
the authorized people of the organization can use it. In VPN, the transmission of data 
takes place with the help of internet. In VPN, the security of data is a key concern, as 
private information is flowing through the public internet. In VPNs, the data is made 
secure using IPsec technology. Using IPsec, the data gets encrypted (cipher text) 
and is transmitted over internet. No one in the middle can understand the data. Once 
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the data reaches the destination, it gets decrypted (plain text) and can be used by 
the organization. To establish VPN, special types of routers are required.  

 
Figure 3.10 Virtual  Private Network – VPN 

 
Types of VPN Connectivity: Usually, VPNs are classified into three categories. Let 
us explore each one of them in brief: 
 
(a) Virtual Private Dial-up Network (VPDN) – Whenever an employee of any 

organization wants to access the company's private network being out of station, 
under those circumstances VPDN is used. An employee can connect his 
computer with the internet, through which he can login to his company‘s network. 
A special kind of software called VPN client is required to establish this type of 
connection. 

 
(b) Intranet based VPN – It is also known as site-to-site VPN. Whenever, two or 

more branches of an organization (sites) want to interconnect, they can connect 
their LANs with Internet. This helps to establish intranet based VPN.  

 
 
(c) Extranet based VPN – This type of connectivity is generally used when different 
organizations want to interconnect with each other. LANs of various organizations 
can be inter-connected with the help of internet. For example, a company (customer) 
can order goods from another company (supplier) through VPN. 

3.11 GENERAL SECURITY CONCEPTS 
Each and every computer is a store house of information. Lot of information can 
exists which may be personal information or belong to some organization. Most of 
the time, the information is confidential which has to be protected from public. 
Security is required to ensure that the data is protected, integral and safe. There are 
various aspects of security like: 
 
 Securing the Computer 
 Securing the Network – outsiders cannot access private network 
 Securing the data being transmitted 
 Securing the data residing on the Server 
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For the above aspects, different technologies exist to ensure security. For example, 
username and password are used for authentication purpose while encryption and 
decryption are used to maintain confidentiality of data being transmitted. Now, let us 
understand various principles and techniques in security in detail. 
 

 
 

Figure 3.11 General Security Concepts 
 
Importance of Password: Whenever we use the Gmail or Yahoo mail services, we 
provide username and password which plays an important role. They are used for 
authentication purpose so that no other person can access our emails. Depending 
on the situation, username and passwords can be different. For example, the 
username and password used for home PC is different from those of e-mails.  
 
In some cases, only passwords are used to secure a file. Whereas in other cases, 
apart from username and password, one time passwords (OTP) are sent to mobile 
via SMS for security purpose. 
 
In case if our username and password are known to other people, our data becomes 
unsecure. Although username can be known by others but password must always be 
kept secret. Passwords are similar to keys that must be kept in private to secure the 
data. 
 

 
 
Points to consider while selecting a password: 
 
 Password must not be too small. 
 Ideally a Password must be between 6-20 characters. 

Note:   Most of the websites uses captcha which asks to type few characters and digits that are distorted and 
difficult to identify. Captcha is different from passwords, it is used to ensure that the data being entered 
comes from a living person and is not being entered automatically through some program. 
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 A Password must be a combination of digits (0-9), alphabets (a-z or A-Z) and 
special characters ($, @, #). 

 Password must not be a dictionary word. 
 Password must not be a mobile number, car no., date of birth etc. 
 
Examples of Passwords: 
 

Username Password Particulars 
Mahesh Mahesh Insecure 
Mahesh Mahesh123 Insecure 
Mahesh M123 Insecure 
Mahesh 9879100000 Insecure 
Mahesh 29feb Insecure 
Mahesh GJ-6 Insecure 
Mahesh Vanilla Insecure 
Mahesh Iw@nt2fly Secure 
Mahesh Lx2$a33pqr Secure 
Mahesh TobeOrNotzb Secure 
Mahesh Trouble$hoot!ng Secure 

 
Things to take care while using passwords: 
 
 Passwords must be changed at regular intervals. 
 If possible, different passwords must be used for different accounts. 
 Password must not be kept in written along with you. 
 Password must not be told to anyone. 

 
 

3.12 FIREWALL 
Network Firewall helps to secure the data in our computer and networks. Firewall is 
like a fort that provides safety to our computer. It secures the information flowing out 
from our computer and the information entering into our computer. As the 'Great Wall 
of China' used to provide safety to China, similarly a firewall provides safety to any 
computer or a network.  
 
Basic Firewall Configurations: With the help of administrator login, we can either 
enable (on) or disable (off) a firewall. There are two ways to configure a firewall: 

 
a) By clicking on Windows Firewall Icon from Start button -> Control Panel -> 

Windows firewall 
b) By clicking on Left Pane and selecting 'Turn Windows Firewall On or Off' 
c) In a computer, when the data arrives from outside (enters our PC) through 

network, it is known as inbound connection, while the data leaving our computer 
(output of PC) to some network is known as outbound connection. 

 
With the help of firewall configuration, we can ensure what type of data must be 
allowed to enter our system or leave our system. For example, allowing data that 
enters our system using HTTP or HTTPS protocol but denies the data of FTP 
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connection. Firewall allows us to set rules and configure it according to different type 
of network services like HTTP, FTP, and SMTP etc.  

 
 

Figure 3.12 Basic Configurations of Firewall 
 

 
 

Figure 3.13 Customized Settings of Firewall 
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Advanced Settings of Firewall Configuration: We can provide different inbound 
rules or outbound rules to configure a firewall. If similar rules are required for 
different computers over the network, we can configure a single system and copy 
those rules to rest of the computers. For this, the option of ‗Import policy' and 'Export 
policy' are used from the advanced settings of firewall. 
 
With the help of firewalls, we can configure only inbound or only outbound 
connections. We can generate log files with the help of firewall, these log file records 
all the incidences. It can record the malicious activities (incidences) taking place in 
the network that violates the rules. The configurations are shown in figure 7.18. 
 

 
Figure 3.14 Advanced Configurations of Firewall 
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Figure 3.15 Dialog box showing Inbound/Outbound and Log File Configurations in Firewall 
 
Check Your Progress 
 
1. Identify whether the firewall of your computer is enabled or disabled. If it is 
disabled, put on the firewall of your system. 
 

3.13 INFRASTRUCTURE SECURITY 
Now-a-days, most of the organizations possess their own computer networks. Their 
computer network and various devices work like an infrastructure. Security is very 
essential for any infrastructure. Security concerns can be classified into two parts: 
 
a) Physical Security 
b) Logical Security 
 
Physical Security: Computers and various devices of an organization must be 
made secure from natural calamities like earthquakes, hurricanes, heavy-rains etc. It 
must be secured from fire accidents, terrorist attacks, riots etc. Apart from this, it 
must be ensured that the infrastructure is protected from the employees of the 
organization. Any employee must not be able to steal the devices or do not start 
using without the notice of managers or supervisory staff. 
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Figure 3.16Infrastrucutre Security  

 
Logical Security: As it is necessary to secure the computer hardware, similarly the 
concern for security of data is required. Confidential data of any organization must 
not be available to the outsiders or must not get corrupted by viruses. Lot of research 
has been done to ensure the security of the data. Techniques like authentication, 
authorization are applied to ensure the security of data and information. These 
techniques are based on the mechanism known as cryptography. 
 
Authentication: It is used to check the identity of the user. It allows identifying only 
the allowed users can access the system. 
Authorization: It is used to identify that the users can access the resources they are 
allowed to on the basis of certain permissions (having proper rights to read/modify a 
file).  
Cryptography: It is the art and science to convert plain text (understandable data) 
into cipher text (non-understandable form of data). The process of converting plain 
text into cipher text is known as encryption while the reverse is known as decryption. 
The encryption-decryption process requires keys and certain algorithms. However, 
with the help of crypto-analysis, if the keys or algorithms are not good enough, hack 
attacks are possible. 
 
Operations Security: It is necessary to ensure that the daily operations of any 
organization are carried out safely without any disturbance. The following points are 
necessary to maintain operational security: 
a) Development of Policies for computer usage and its implementation 
b) To identify and design the Standards for the usage of data by various employees. 
c) Necessary procedures to be developed and followed for each task. 
d) Necessary guidelines to be prepared for the usage of systems and devices. 
 

Organizational Security: New threats are being recognized daily, it is essential to 
maintain security for the organization's network and systems. Few widely used 
software to maintain security in an organization are: 
a) Firewalls 
b) Intrusion Detection systems (IDS) – it detects unauthentic users or programs 

entering into the system or network. 
c) Intrusion Prevention Systems (IPS) – it prevents unauthentic users or programs 

entering into the system or the network. 
d) Anti-Viruses, Anti-Malwares 
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To enforce hardware based security, devices like bio-metrics authentication system, 
smart cards, RFID cards etc. are used. 
 
Communication Security: Whenever the transmission of data is taking place, the 
following concerns are necessary to enforce communication security: 
a) Confidentiality – to keep data confidential 
b) Integrity – to ensure that the data does not change while transmission 
 
During transmission of data, the following criteria must be satisfied: 
a) Availability – data must always be available 
b) Accuracy – data must be accurate and integral (without any change) 
c) Authentication – data must arrive from authentic source 
 
Note: https protocol provides confidentiality compared to http protocol. It is advisable 
to use https protocol when sending passwords or confidential information. 
 

3.14 NETWORK TROUBLESHOOTING 
The following are few issues and solutions that arise in computer networks: 
 
Question: A message occurs saying “Cable Unplugged” 
Solution: Usually there are two reasons for the above message: 
(a) The cable attached with the network card is not properly connected, or maybe the 
cable is damaged. For this remove the cable, check it and again insert it. 
(b) Hub or Switch is switched off, ensure that it is working properly. 
 
Question: Computer is not connecting with the network. 
Solution: Usually, when the IP address is not properly configured, the computer is 
not identified over the network. The following things are to be done: 
(a) Configure proper IP address, Sub-net mask. 
(b) If the organization uses DHCP server, ensure that ―Obtain an IP address 
Automatically‖ is selected and check that the DHCP server is functioning and 
reachable. 
 
Question: Computer is getting connected to network but internet is not 
working. 
Solution: Although there can be many reasons, the following are few alternatives 
that can be tried 
(a) IP address is assigned but the Gateway or DNS is not configured properly. 
(b) Internet is blocked from firewall.  
(c) Computer is infected by virus or malware. 
(d) Modem or USB dongle is not configured properly or not working.  
(e) Services from ISP has been stopped (Internet account might have expired) 
 

3.15 CHECK YOUR PROGRESS: POSSIBLE ANSWERS 
 
Q1. Select the appropriate choice from the followings  
 

1 Which of the following is requred to surf Internet ? 
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 a) A) Browser   B) Microsoft OfficeC) Outlook   D) Wi-Fi 
2 URL stands for ________. 
 a. A) Unified Research Location  b. B) Uniform Resource Locator 
 c. C) Uniform Resource Link d. D) Unified Research Link 
3 In the E-mail address: abc@baou.edu ,  ___________ is the domain name. 
 a. A) abc     B) .org      C) baou.org     D) None of above 
4 Which of the following is a valid website address ? 
 a. A) www.baou.edu.in b. B) www.baou@india.baou 
 c. C) wwww.baou.india.uni d. D) wwwbaou.university.com 
5 __________ is the owner of Internet. 
 a. A) USAB) UK C) India   D) None  
 
Q2. Fill in the blanks 
 

1 _____ is not a Search engine. (Bing, Outlook, Google)  
2 Outlook is a product of __________ . (Google, Apple, Microsoft) 
3 Wireless Internet cannot be established using _______  (Wi-Fi, Hotspot, Hub) 
4 __________ cannot be accessed with Internet.  (PDA, Mobile, Stand-Alone 

Computer) 
5 Software Applications running on Internet are known as __________ applications. 

(desktop, web, mobile)   
 
Q3. State whether the followings are true or false:  
 

1 Every mobile phone has internet connection. 
2 Previous emails (old emails) can be viewed in Outlook. 
3 Netscape is a browser.  
4 For any business application, Internet is mandatory. 
5 The length of IP address must be 12 digits. 
 
Q4. Match the pair 
 A  B 

1 

 

 a. Firefox Mozilla 

2 

 

 b. Internet explorer 

3 

 

 c. Safari 
 

4 

 

 d. Chrome 

 
Answers 
 
Q1. 1. A (Browser)  
2. B (Uniform Resource Locator) 
3. D (None of above)    
4. A (www.baou.edu.in) 

mailto:abc@baou.edu
http://www.baou.edu.in/
http://www.baou@india.baou/
http://www.baou.edu.in/
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5. D (None)  
 
Q2. 1. Outlook     2. Microsoft     3. Hub 4. Stand-Alone Computer   5. Web 
 
Q3. 1. False   2. True  ૩. True   4. False   5. True 

 
Q4.  1-b, 2-a, 3-d, 4-c. 
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Unit 1:  Practical Exercise 
  

 
Unit Structure 
 
1.1  Learning Objectives 
1.2  Introduction 
1.3  Windows-7 Practicals 
1.4  Word-2010 Practicals 
1.5  Excel-2010 Practicals 
1.6  Powerpoint-2010 Practicals 
1.7  Outlook Practicals 
 
  

1 
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1.1 LEARNING OBJECTIVES 
 
After studying this unit students will able to: 
 

 Apply Theorical knowledge learned in previous chapters 
 Enhance their Practical knowledge 

1.2 INTRODUCTION 
 
This chapter is for the practice of students. Whatever discussions the students are 
having in previous chapters their practical exercises are given here so that they can 
apply the concepts learned. This will also help them to enhance their knowledge by 
applying theory concepts. So now let us move further to see the exercises. 

1.3 WINDOWS-7 PRACTICALS 
 
Q1. Change Background and screen saver in Windows 7. 
Q2. Draw Natural Scene in MS-Paint. 
Q3. Write your computer hard disk drives and their storage capacity. 
Q4. Change date and time of your computer. 
Q5. Write IP address of your computer.  
Q6. Use any gadgets of your choice in your Windows 7. 
Q7. Type any paragraph in notepad and copy it in WordPad and format the 
paragraph in WordPad. 
Q8. Prepare your important task list in sticky note. 
Q9. Pin calculator program in taskbar. 
Create short cut of Word, Excel and PowerPoint on your desktop. 

 

1.4 WORD-2010 PRACTICALS 
 
Q-1 Type the following text in Word-2010. 

The Panchatantra  
 
The Panchatantra stories are written by many years ago. Each stories of 
Panchatantra has some lesson at the end of the story. The stories like ―The thirsty 
crow‖ has lesson ―Necessity is the mother of invention‖.  
 
These stories use generally animals as characters of the story. This story makes 
children interesting in reading the story.  
 
Some of the popular stories are: 
 
 The talkative tortoise 
 Who will bell the cat? 
 The clever jackal  
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Do as directed.  
 
(1) Save your file with name ―Panchatantra‖ 
(2) Check your document for spelling mistakes  
(3) Bold and underline the text ―The thirsty crow‖ 
(4) Make line spacing of paragraph as 1.5  
(5) Give hanging indentation to the paragraph starts with ―These stories use…‖ 
(6) Replace word Lesson with Message using find and replace option. 
(7) Insert header in your document and write your name in header. 
(8) Change bulleted list to number list  
Q-2. Type following paragraph in Word-2010 : 

Curriculum Vitae of Sachin Tendulkar 
 
OBJECTIVE  
 
To seek career challenges keeping in view my past achievements and future goals. 
And to set new industry benchmarks in everything I endeavor.  
 
PROFESSIONAL EXPERIENCE  
 
 International Cricketer: Indian National Cricket Team [1989 -2013 onwards]  
 First Class Cricketer: Mumbai, West Zone, Yorkshire [1988 - 2013 onwards]  
 Junior Cricketer: Shardashram School, Bombay U-15, West Zone U-15 [1985-

1988].  
 
KEY OPERATIONS & MISSIONS UNDERTAKEN  
 
1. 155* — Operation Deflate Warne [Chennai, 1998]  
2. 143 & 134 — Operation Desert Storm [Sharjah, 1998]  
4. 98 — Operation Tame Vile Green Warriors [Centurion, 2003]  
 
CRISIS MANAGEMENT EXPERTISE  
 
1. 119* — Operation Bat Till Bedtime [Manchester, 1990]  
2. 82 — Mission Find New Opener [Christchurch, 1993]  
3. 1-0-3-0 — Operation Hold South Africa [Kolkata, 1993]  
 
OTHER BUSINESS INTERESTS  
 
I have interests in the food and beverages industry. I partly own two restaurants in 
Mumbai:  
 Tendulkar‘s (Colaba, 2002).  
 Sachin‘s (Mulund, 2004).  

 
[Reference: xa.yimg.com/kq/groups/18137660/.../cv+of+sachin+tendulkar.pdf] 
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Do as directed.  
 
(1) Save your file with name ―Sachin‖ in My Documents. 
(2) On left side of first line, insert image of sachin Tendulkar. 
(3) Insert border in word document. 
(4) Insert ―Confidential‖ as watermark text. 
Take print out of your file. 

Q-3Create following table in Word-2010 

 
Surname Name Computer Guajarati English 
Mehta Anjali 75 65 70 
Kotari Zarna 60 68 55 
Gandhi Vandna 90 55 86 

 
(1) Add row between Zarna and Vandna 

 
Patel Rachana 85 80 90 

 
(2) Give Right alignement in second row  
(3) Add column ―Total‖ as a last column 
(4) Using formula Find total of marks in ―Total‖ column. 
(5) Arrange data in table surname wise in ascending order.  
 

Q-4 Mail Merge 

Write letter using mail merge feature of Word 2010 for inviting your friends at party. 
Invite at least your five friends. 
 
 

1.5 EXCEL-2010 PRACTICALS 
 
Q1 Type the following data in excel and calculate values as per following 
instructions. 

Pay Slip 

Employee Name   Bharat Patel   

Designation  Assistant Professor   

Month-Year  Oct-13   

      

Allowances Amount Deductions Amount 

Pay 15600 IT  ? 

GP 6000 GPF  ? 

DA ? PROF. TAX  ? 

HRA ? GIS  ? 

COMP LO ALLOW ? FOODGRAIN DAVANCE  ? 

MA ? FESTIVAL ADVANCE  ? 
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TA ? HOUSE RENT  ? 

OTHER ALLOW ? EPF  ? 

OTHER ? OTHER  ? 

TOTAL EARN ? TOTAL DED.  ? 

Net Pay : ? 

(1) DA is 90% of Pay+GP 
(2) HRA is 20% of Pay+GP 
(3) MA is 1% of Pay+GP 
(4) TA is 10% of Pay 
(5) IT is 10% of Pay 
(6) GPF is 12% of Pay+GP 
(7) Prof. Tax is to be calculated as follows 

a. Prof. Tax is 100 if total earn is between 0-6000 
b. Prof. Tax is 150 if total earn is between 6001-12000 
c. Prof. Tax is 200 if total earn is > 12000 

(8) Enter all other information manually  
(9) Calculate Total Earn, Total Deduction and Net Pay 
(10) Format the pay slip 
(11) Create same sheet for Nov-2013 and Dec-2013 and Group all three sheets. 

 
Q. 2 Create worksheet as shown below in Excel and calculate as per below 
instructions 

 A B C D E F G H I 
1 Student ID Student 

Name 
CCC-1 

35 
CCC-2 

70 
CCC-3 

35 
CCC-4 

100 
Total 
240 

Percentage Result 

2 1 Kiran 28 56 20 80 ? ? ? 
3 2 Sanjay 25 45 25 75 ? ? ? 
4 3 Hardik 20 52 29 69 ? ? ? 
5 4 Jatan 15 47 30 72 ? ? ? 
6 5 Komal 18 18 30 55 ? ? ? 
7 6 Sparkline 

Chart 
       

8 7 Average ? ? ? ? ? ? ? 
9 8 Minimum ? ? ? ? ? ? ? 
10 9 Maximum ? ? ? ? ? ? ? 
11 10 No of Pass ? ? ? ? ? ? ? 
12 11 No of Fail ? ? ? ? ? ? ? 
(1) Calculate total marks using formula 
(2) Calculate percentage using formula and give percentage format up to two 

decimal points. 
(3) Generate students result. To pass in exam student must have at least 40% 

marks in each subjects. Write SC in result if student is pass and NC if student 
fails. 

(4) Sort student data in ascending order of percentage 
(5) Show fail students row with red background using conditional formatting.  
(6) Using filter feature separate student with more than 70% marks and copy all 

rows and paste at J1 cell. 
(7) Prepare column chart showing student name and Marks obtained in CCC-1 
(8) Prepare pie chart showing pass and fail student‘s percentage.    
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(9) Calculate Average, Minimum and Maximum marks in each subjects using 
function. 

(10) Count number of pass and number of fail students in each subject using 
function. 

(11) Create Sparkline chart for CCC-1, CCC-2, CCC-3 and CCC-4 in cell C7, D7, E7 
and F7 respectively. 

(12) Convert information in table format and apply style of your choice. 
 

Q3.  Create Excel worksheet for following information and calculate values as per 
instructions  . 

 A B C D E F 
1 Transaction ID Date Description  Debit Credit Balance 
2 1 01/07/2013 Initial Balance  50000 50000 
3 2 13/07/2013 Purchase Row material 8000  42000 
4 3 24/07/2013 Food 4000  38000 
5 4 10/08/2013 Cheque Received #25632  7500 45500 
6 5 12/08/2013 Furniture  5000  40500 
7 6 15/09/2013 Bank Interest  2500 43000 
8 7 01/10/2013 Salary 7000  36000 
9 8 20/10/2013 Cheque Received #45263  10000 46000 
10 9 30/10/2103 Fuel 1000  45000 
11 10 03/11/2013 Sales Income  8000 53000 
12   Total    
   Minimum    
   Maximum    
   Average    

(1) Find Balance using formula. 
(2) Find total income and total expense. 
(3) Calculate maximum, minimum and average income, expense and balance 

using function. 
(4) Sort in descending order of date. 
(5) Format income with greater than 10000 and expense greater than 5000. 
(6) Create date wise bar chart for income and expense. 
(7) Prepare Sparkline chart for balance   
(8) Convert information in table format. 
(9) Calculate no of days on which balance is greater than 50000. 
(10) Prepare pie chart for showing income and expense percentage 
(11) Find month wise subtotal of income and expense  
(12) Copy October month information and paste at some other place in your 

worksheet. 
 

Q4 Enter following information in excel worksheet and do necessary calculations as 
per instructions. 

 A B C D E F G 

1 Research Survey       
2        
3 Question-1    Question-2   
4        
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5 Gender Frequency Percentage  Marital Status Frequency Percentage 

6 Male 650   Married 750  
7 Female 750   Widowed 160  
8 Total    Divorced 78  
9     Separated 50  
10     Un-Married 250  
11     Total   

(1) Find percentage and total using formula. 
(2) Draw column chart for gender in separate sheet and give proper name to chart 

sheet. 
(3) Draw pie chart for marital status in separate sheet and give proper name to chart 

sheet. 
(4) Give tab color to work sheet and protect file with password. 
(5) Save file as pdf file. 

 

1.6 POWERPOINT-2010 PRACTICALS 
Q1 
Open PowerPoint 2010 and Prepare different slides for providing information 
regarding Dr. Babasaheb Ambedkar Open University. You can include information 
such as university establishment, vision, mission, objectives, various courses run by 
university, staff information, year wise student information and university program 
photos. You can collect these information from university prospectus and from 
university website http://www.baou.edu.in available on internet. Arrange proper 
information in slides.    
 
Change slide as per following instructions 
1) Prepare bulleted list for university objectives. 
2) Show current date and slide number in slide footer. 
3) Use different  slide transitions effects sounds such as braze, click, push, 

applause etc. for slide transition.  
4) Check Spelling mistakes in slides prepared by you using Spelling command of 

review tools. 
5) Print all slides such that two slides print in one page. 
6) Insert University event photos in slides at proper place using clipart command 

from Insert tab. 
7) Prepare custom slide shows for selected slides.   
8) User predefined time for each slide to automatic change slide when slide show 

presented. 
 
Q 2 . Prepare PowerPoint slides as per following instruction and slide given below. 
(1) Prepare title slide as shown in slide-1 
(2) Prepare table as shown in slide-2 
(3) Prepare chart as shown in slide-3. You can use necessary data from chart itself  
(4) Prepare slide as shown in slide-4 and obtain necessary picture from clipart. 
(5) Give slide design 
(6) Setup slide show to automatically show each slide for 5 Seconds. 
(7) Give animation effects to text in slide 4 and slide 7. 
(8) Give slide transition effect to each slide. 

http://www.baou.edu.in/
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(9) Add slide-9. Insert any table already prepared in excel in slide-9.    
(10) Add Slide-10. Insert any video in slide-10, video should be played when mouse 

pointer is place over video. 
(11) 1) 

(12)  

2)

 
3)

 

4) 

 
 

 
5) 

 

6) 

 

7) 8) 
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1.7 OUTLOOK PRACTICALS 

Q1. Add your email ID and other information in outlook. 
Q2. Prepare your email signature. 
Q3. Add information on calendar for email. 
Q4. Prepare task and note for email in outlook. 
Q5. Send email to your five friends using CC. 
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Unit 2:  
Utility, Troubleshooting, Installati

on and Best Practices   
  

 
Unit Structure 
 

2.1   Learning Objectives 
2.2   Introduction 
2.3      Microsoft Office Indic  
2.4      TBIL Data Converter  
2.5      The use of different storage devices (CD, DVD, Pen Drive)  
2.6      Copy and paste the file from LAN  
2.7      Upload and download file from the Internet using FTP  
2.8      Scanner 
2.9      Installation 
2.10 Best Practices 
2.11 Troubleshooting  
2.12 Portable Document Format (PDF) 
 
 

  

2 
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2.1 LEARNING OBJECTIVE 
 
After studying this unit you will get an understanding of the following issues.  
 
 Download, Install and do various settings in Microsoft Office Indic to type in 

Gujarati. Also be well informed about the different types of keyboards. 
 Downloading, Installation and use of TBIL software to convert text written in one 

Indian language into other Indian languages and in the language of one format 
into another format. 

 To copy and paste data in CD, DVD & pen drive in Windows 7. 
 Copy files from your computer and paste on another computer attached in the 

LAN in Windows 7.  
 How to utilize FTP protocol to copy and paste file on internet in Windows 7. 
 Scan the Picture, document or other information through the scanner attached to 

the computer.  
 How to install and Uninstall Microsoft Office 2010, fonts, printers or any hardware 

or software in Windows 7. 
 How to get information about software patch, upgrade and new version to 

install, viruses and anti-virus, backup and scandisk. 
 

2.2 INTRODUCTION 
 
It is necessary to learn downloading, uploading as well as several other important 
features like installation when you are using software for documentation purpose. 
This chapter gives students detailing about this points as well as other facilities like 
conversion of one language into other language. Utilization of FTP protocol as well 
as how to install and uninstall any software.  

2.3 MICROSOFT OFFICE INDIC 
www.bhashaindia.com has specially created font for people to easily write in Gujarati 
language. It is required to install the Gujarati IME (Input Method Editor) Indic. After 
installation, some settings in computer need to be done to work in Gujarati. 
 
Indic IME is an open source project. So it does not require a license. Currently, it is 
available in multiple languages. First you have to go the website 
http:\\www.bhashaindia.com    and download the software.  

http://www.bhashaindia.com/
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Figure 2.1 

 
Now, let us see how to install Indic IME software. After the ZIP (.zip) Indic Input 2 file 
has been downloaded from the website, it will have to be un-zipped. By 
double clicking on the ZIP file, it is extracted (un-zipped) and extracted files will be 
available in a new directory. 
 

 
Figure 2.2 

 
Here, we have to double-click on the Setup.exe file. When we Double-click on .exe 
file, a screen appears as shown in Figure 2.2.  
Here, click on the Next button and the new dialog box appears as shown in Figure 
2.3.  
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Figure 2.3 

 
Here, click on the Next button and the dialog box opens, as shown in Figure 2.4 

. 
Figure 2.4 

Then, click on Close and Indic IME application will be installed. 
 
2.1.1 Setup for the Gujarati language 
 
To write in Gujarati Language, we have to go to control panel and then go to a 
Region and Language option as we can see in Figure 2.5.  
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Figure 2.5 

 
Here, we have to select Keyboard and language tab. Then click on Change 
keyboards.  On doing so, a dialog box will appear as shown in Figure 2.7. 

 
Figure 2.6 
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Figure 2.7 

 
Here, click on Add button, so the dialog box appears as in Figure 2.8.Select the 
Gujarati (India) Gujarati Indic IME option from the list of languages and 
select OK. We can see a Language bar on the desktop, as shown in 2.9. We can 
write text in English as well as Gujarati by selecting a language in Language bar.  

 
Figure 2.8 

 
2.1.2 Changing  language: from English to Gujarati 
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Figure 2.9 

 
English or Gujarati language can be selected from the toolbar. You can see that 
Gujarati Language is chosen in the diagram shown above. 
 
2.1.3 Introduction of the Gujarati Keyboard 
 
As shown in the figure, Gujarati Indic IME keyboard provides a facility like 
following keyboards. By selecting the last option ‗Shoe Keyboard‘, the selected 
keyboard layout will appear on the desktop as shown in in Figure 2.11. If the 
first option is selected, keyboard layout will not appear.  

 
Figure 2.10 

Gujarati Transliteration: This keyboard is phonetic. When we type in English here, 
English words are automatically typed in relevant words in Gujarati. This is very 
useful when you know the English spellings of the Gujarati words and want to type in 
Gujarati. While typing, you get On Fly Help as shown in Figure 9.11-a. If you want to 
type ‗computer‘ in Gujarati, you have to type k + m + p + yoo + Ta + r. More 
examples given below are from Software Help Manual. 

Input Output 
auShadhee ઔષધ  



 
 337 

Rtu ઋત   
Ofar ઑફ  

Anukulan   ક લ ૂ 

sangeet       

atH   ઃ 
shuddha શ દ્ધ  

vidhya વ દ્ય   
satyam  ત્   

 

 
 Figure 2.11-a 

 
Gujarati Typewriter and Gujarati Typewriter (G): The layout of this keyboard is similar 
to the Gujarati type writer keyboard.  

 

 
Figure 2.11-b 

 
The keyboard shown below operates as per the key indicated on it.  



 
 338 

 

 

 

 
Figure 2.11-c 

 
The keyboard shown in Figure 2.11-d is used for special characters in Gujarati. 
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Figure 2.11-d 

 
 

2.4 TBIL (TRNASLITERATOR BETWEEN INDIAN 
LANGUAGES) DATA CONVERTER 
 
TBIL is a software to convert information from one Indian language to other Indian 
languages. Data in Word, Text or Access file in ROMAN or UNICODE format can be 
transliterated in other Indian languages through this software.  Currently it 
supports seven languages. The software is an open source, which can 
be downloaded for free. The free of cost software can be downloaded from 
www.bhashaindia.com.  
 
It is necessary to have Windows XP or higher operating system for TBIL and MS 
Office version should be Microsoft Office 2000 or higher. Installation of TBIL starts as 
soon as we double click on the setup.exe file.  At the end, click on Finish and its 
icon appears on the desktop. 

 
Figure 2.12 

 

http://www.bhashaindia.com/
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Figure 2.13 

 
Let‘s understand with an example. We have created one file which we want to 
convert its text in any other language. To do so, first we click on TBIL icon and the 
screen appears as shown in Figure 2.14.  

 
Figure 2.14 

 
We have to select the file type by clicking on the radio button from the given options- 
Text, Word, Access and Excel. After selecting, click on Go button and the dialog box 
as shown in 2.15 appears. We can see the Source Font Selection Wizard. 
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Figure 2.15 

 
Options Use 
Source 
Language 

We have to select the language in which we have written the 
information such as Hindi, Gujarati, Tamil or any other language. 

Source 
Format 

Here, ASCII, UTF, UNICODE options are given. It is usually 
recommended to click on ASCII or UNICODE.  

Source 
Font 

We have to select the fonts of the language that we have used.  

Target 
Language 

We have to select name of the language in which the data is to be 
transliterated.   

Target 
Format 

We are given ASCII, UTF and UNICODE options here, out of which it 
is usually recommended to select ASCII of UNICODE.  

Target 
Font 

We have to select the font in which we want to covert the font. E.g. 
Here, we want to select fonts for Hindi language, so we should select 
Mangal font. 

 
After this selection, we should click on the Next button to go to the new dialog box 
which appears in Figure 2.16.  

 
Figure 9.16 
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By clicking on the Browse option here, we have to select Word, Excel or Access file. 
As soon as we click on ‗Convert‘ and completion of the process, the converted file 
can be seen at the location of the given path.  

 
Figure 9.17 

 

2.5  USE OF DIFFERENT STORAGE DEVICES 
 
CD-ROM / DVD data writing (Burning Data Disc) 
 
Windows Explorer is used to write data in Windows 7 so that it can 
be viewed or copied in another computer. Windows allows you to write data 
in two formats. 
 
1. Live File System format: This format is useful to use data on a 

computer with Windows XP or later operating system. 
2. Master Format: This format is useful to view the data or play data 

on any computer or on a CD, DVD or Blue-Ray player. To writing the data in this 
format to the hard disk which has space should be twice the size of disc.  

 
Write data into the live file system format 
 
1. Put writable CD or DVD in your computer's CD, or DVD Writer. 
2. As CD or DVD is placed in Writer, the Auto play dialog box appears. Click on 

Burn files to disc using Windows Explorer. 
3. Type the name of a disk in Disc title box in Burn a Disc dialog box. Click on like a 

USB Flash Drive and click next. The disk formatted in Live File System format 
and shows disk empty folder.  

4. To make a copy in blank disc, drag one by one or all at the same time in blank 
folder. As you drag the file, it will be automatically copied to disk 

5. In Windows Explorer, click on CD or DVD drive then click on the toolbar and then 
click on the Close Session. After following these steps, you can use the disk on 
another computer. 

  
Master writing data format  
 
1. Put Writable CD or DVD, in your computer's CD, or DVD Writer. 
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2. As CD or DVD is placed in Writer, the Auto play dialog box appears. Now click on 
Burn files to disc using Windows Explorer. 

3. Type the name of a disk in Disc title box in Burn a Disc dialog box. Click with a 
CD / DVD player and click next.  

4. To make a copy in blank disc, drag one by one or all at the same time in blank 
folder. 

5. Now click on Burn to Disc in the toolbar and follow the steps in the wizard. Files 
will be copied to the disk after above steps are followed. When the data are 
written to the disk, the disk tray opens and user can take it back from the trey and 
use it in another computer  or DVD player. 

 

Pen Drive 

Files can be copied from Hard disk to Pen Drive in the following way.  
 
1. In windows explorer, select the file from Hard Disk. Click right button of mouse 

and then   select Copy option from shortcut menu or press Ctrl + C. Select a 
path on Pen Drive and click the right button of mouse. Select Paste option from 
shortcut menu or press Ctrl + V and the selected file will be copied in Pen Drive. 

2. In windows explorer, select the file from hard disk and click right button of mouse 
and then select Send to option from shortcut menu and within that select pen 
drive option to copy the file in the Pen Drive.  

 
Files can be copied from Pen Drive to Hard disk in the following way. 
1. In windows explorer, select the file from Pen Drive. Click right button of mouse. 

Then select Copy option from shortcut menu or press Ctrl + C. Select a path on 
Hard Disk and click the right button of mouse. Select Paste option from shortcut 
menu or press Ctrl + V and the file will be copied in the Hard Disk. 

 

2.6 TO COPY AND PASTE FILE FROM LAN 
 
Follow the following steps to copy files from the network computer to your computer 
in Windows 7. 
 
1) Press Windows Key + E or click on Start →Computer to open File Explorer.  
2) Click on the Network icon in the left side, which shows the list of connected 

computers to your computer.  
3) Select the computer from the list, from where you want to copy the file and 

double-click on it. 
4) If the computer is protected, than a dialog box will appear. You have to enter 

correct user name and password. When you press OK, shared folder / file will be 
shown on the computer that you need to copy. 

5) Copy and Paste the file wherever you want in your computer. 
 

Follow the following steps to copy files from your computer to the network computer 
in Windows 7. 
 
1) Press Windows Key + E or click on Start→ Computer to open File Explorer.  
2) Select the file which you have to copy from the File Explorer.  
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3) Click on the Network icon in the left side. It shows the list of connected computer 
to your computer.  

4) Select the computer where you want to copy the file, from the list and double click 
on it. 

5) If the computer is protected, than a dialog box will appear. You have to enter 
correct user name and password. When you press OK, shared folder/ file will be 
shown on the computer that you need to copy. 

As mentioned earlier, paste the file you have copied in the computer. However, 
the computer on which the files are to be pasted should have Write permission. 
 

2.7 UOLOAD AND DOWNLOAD FILE ON INTERNET USING 
FTP 
FTP (File Transfer Protocol) is used to download or upload a file from 
one computer to another computer using Internet. Address of any ftp site start with 
ftp: //  
 
To download File: Type the site address from where you want to download a file in 
the address bar of Internet Explorer. E.g. ‗ftp://ftp.microsoft.com‘ as 
shown in Figure 2.18. In doing so, it shows a list of available folders and files on the 
site, which can be viewed by clicking on the file or folder. For saving the file, right 
click the mouse on the file or folder to be saved and select Save Target as an option 
to download the file. 
 

 
Figure 2.18 

 
To Upload File: It is necessary to have specific permission granted to the ftp site on 
which we want to upload a file or files. In addition, the user 
name and password are required to login. 
 
1) Type the name of a site from where you want to download data in the address 

bar of Internet Explorer. As shown in Figure 2.19, type 
ftp://ftp.microsoft.com and press Enter to open the site.  
 

ftp://ftp.microsoft.com/


 
 345 

 
Figure 2.19 

 
2) Press Alt+F to open file menu. Login dialog box appears when you press Login as 

from the file menu. Type correct username and password to login. 
Now you can upload a file in folder on ftp site.  

 

 
Figure 2.20 

 

2.8 SCANNER 
Usually we use scanner to store any photograph in digital format in computer. 
However, scanner is also used for many other data like text, certificate etc to store 
them in digital format. Currently many scanners like hand-held scanner and Flat Bed 
scanner are available in different sizes. We have to first install the scanner, which 
ever is best suited to our needs, in our computer. When we purchase a scanner, it is 
accompanied with a CD to install scanner. The scanner can be installed by running 
the CD and installing the software in our computer.  
 
After successfully installing the scanner if we want to save a photograph in digital 
form, we have to put the photograph in the scanner. Then, click on the scanner icon. 
When Scan Picture option appears, click on that button and then the photograph 
image will be scanned and will appear on the screen. Now select the image and 
store at the location we wish to. We can usually store the scanned object in different 
formats like.jpg, .pdf, .bmp, .png etc. 
 

2.9 INSTALLATION 
 
2.9.1 Microsoft Office Installation 
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Following steps are there to install Microsoft Office. You must have a licensed copy 
of the Office.  
 
1) When we run the Setup programme of Office 2010, following dialog box appears. 

(Figure 2.21) 

 
 

Figure 2.21 
 

2) Click on checkbox and click on the Continue button. A Dialog box shown below 
appears.  
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Figure 2.22 
 

3) As you press Install Now button, installation will start and the dialog box shown 
below will appear to show the progress of the installation.  
 

 
 

Figure 2.23 
 

4. Following screen appears as soon as the installation is over.  
 

 
 

Figure 2.24 
 

5. Once the installation is over, start Microsoft Word 2010 as shown in the diagram 
to activate office.  
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Figure 2.25 
 

6) Go to File tab, click on Help available in the right-hand side of the screen. 
Activation process begins as you click on Change Product Key. Internet 
connection is required during the entire process.  
 

 
Figure 2.26 

 
7.  You have to enter the product key in the dialog box that opens after you follow the 

above mentioned procedure.  
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Figure 2.27 

 
 

8. After entering the product key, click on the Continue button to begin the process 
of Configuration in which the following dialog box appears.  
 

 
 

Figure 2.28 
1) When the activation process is completed, the following dialog box appears and 

installation process gets completed. If you have opened any Office program, turn 
it off and start it again as we have to close and begin Word 2010 
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Figure 2.29 
2.9.2 Printer Installation 
It is necessary to have information about which printer do we have or we wish to 
have. Currently Dot Matrix, Inkjet and Laser printers are more common. Among 
these, laser printers are faster and give better quality results. First, the printer is 
connected to the computer. The printer is installed in two ways.  
 
1) We have to run the CD that is provided along with the printer and follow the steps 

by clicking on Yes or Next. After the last step, the printer will be installed.  
2) After the printer CD is inserted into the computer, we have to move to printer 

option in control panel and click on Add Printer. First, it asks the company name 
and model number. Insallation process automatically begins after entering the 
correct company name and model number.While installation, the printer asks us 
whether we want to set up the printer in network or setup it as personal. Here we 
can select the option as required. Finally, click on the Finish button and the 
printer will be installed. 

2.9.3 Font Installation 
Font installation (addition) is quite simple in Windows 7. Many of the fonts in are 
provided by default in Windows 7, but we can also add new fonts. The following 
steps are there to install the font.  
 
1) Copy the font file to install it. 
2) Open the Font folder as per the shown path. Start  Control Panel 
Appearance and Personalization Font. The window as Figure 2.30 opens 
when we open the Fonts folder.  

3) Paste the copied font at the right-hand side where you can see a list or icons of 
fonts. In doing so, the dialog box appears and the font installation gets over.  
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Figure 2.30 
 

 
Figure 2.31 

2.9.4 Un-install the program from control panel 
To remove (un-install) programs from the control panel, first open control panel. To 
do so, go to start menu, click on Control Panel and the Control Panel window opens.  
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Figure 2.32 
 
New window as shown in Figure 2.33 opens when you click on Uninstall a 
programme.  
 

 
 

Figure 2.33 
 

Now selects that program from the list to uninstall and press the Uninstall button. 
The selected programme will be uninstalled. 
 
2.9.5 Installation of a new hardware driver 
When we connect a new hardware with the computer, we have to add the driver 
software. Software for that is provided with it in a CD, a DVD or from the website of 
the company that manufactured that hardware. To update or add any new device, 
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click on Start  Control Panel Hardware and Sound  Add Device. Following 
window will appear.  
 

 
 

Figure 2.34 
 

A list of device and printer attached to your computer will be displayed. You have to 
select the device or printer and by pressing the Next button. The following window 
will appear and it will be installed. 
 

 
Figure 2.35 

 

2.10 BEST PRACTICES FOR PC 
 
2.10.1 Patch, Upgrade, and Version  
Patch is generally created to remove critical software bugs, problems or security 
problem in software, while the updates are available to provide additional facilities. 
Patch is needed when a fault is indicated by the user or found by any other way.  
The Company that has created the Software updates the software to improve the 
utility of software. Usually software patch or update can be installed via the Internet.  
 
The software version provides a unique number to each release of the software. 
There are two types of versions, major and minor. Usually version numbers aregiven 
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in ascending order and they suggest major or minor changes in the software. The 
following are various ways of providing version number.  
 
1. Change based streamlined version number (1.3.1, 1.3.2, 1.3.3, 1.3.4 ... 1.4.1,)  
2. Software Development based version number (0-alpha, 1-beta, 2-release 

candidate, and 3-Final)  
3. Date based version number (e.g. Ubuntu 11.10 was released on October, 2011,). 
4. Year based version number (Office 2010, Office 2013) 
 
2.10.2 Disk Cleanup 
 
Windows 7 allows disk cleanup utility 
to remove unnecessary files running 
on your computer so you have more 
storage space on your hard disk and 
your computer can work faster.  Disk 
cleanup removes additional files 
such as temporary file, deleted file in 
recycle bin and unnecessary files.  
 
To remove the file using Disk 
Cleanup, type Disk in search box 
and the disk cleanup appears in 
program as shown in Figure 9.36. As 
you click on it the dialog box opens 
up as shown in Figure 2.37. 

 
 

Figure 2.36 
 

 
 

Figure 2.37 
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Figure 2.38 
 
You can see in Figure 2.38 a list of file which can be deleted. Out of these files, 
check the unrequired file and press the OK button as shown in the diagram. Tt ask 
you for your consent. When you give your concent by pressing Delete Files button, 
the selected file will be deleted. By pressing Clean up system files button we can 
delete unnecessary system files.  
 

 
Figure 2.39 

 
2.10.3 Virus and Antivirus Awareness 
Virus: In Modern era, Computer and Internet are widely used in every sector. 
Important information, business details, confidential data and software are stored in 
computer. We wish to make it safe and secure. 
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Virus:  
 Virus is a dangerous program created by computer experts, which causes 

destruction to computer data.  
 Just like biological virus, which spreads from a person to person, the computer 

virus also moves from one computer to another through floppy disk, hard disk or 
pen drive.  In addition, if Internet is available; virus may enter through the Internet 
too.  

 Generally, some computer experts prepare the virus programs in a way that they 
are activated on a particular date and time; so many computers are found 
affected by virus at some specific time.   

 Computer virus attacks on the computer software.  
 Some virus is placed automatically or intentionally with common and widely used 

software such as Games or Word Processor. When a user of computer 
downloads or copy of such a program, the virus program immediately becomes 
active automatically. Then the virus loads itself into memory and finds other 
programs in the memory and damages them.  

 When virus finds such type of program, it immediately spreads in it and also 
spoils a good program. Some of the dangerous viruses are Morris Worm, 
Melissa, Rontoubro etc. Types of virus: There are mainly three types of virus in 
computer. 

1. Boot Sector Virus  
2. Macro Virus  
3. E-mail  

 
Boot Sector Virus:  
 This type of virus damages the boot sector of hard disk, floppy disk that is used to 

turn on the computer or any secondary storage.  
 It comes into effect as soon as the computer starts.  
 It may happen that the computer does not start due to loss of the Boot Disk. 
 
Macro Virus:  
 This virus is a Macro or Script that attaches them with Template or file. Hence, 

when the file is loaded into memory, the immediately connected Macro or Script 
is activated.  

 Macro viruses more often damage Microsoft Word application and add 
unnecessary words in it.  
 

E-Mail Virus:  
 This Virus moves around E-Mail messages. It automatically collects the E-mail 

addresses from E-mail Address Book and sends e-mail by itself. They spread 
themselves from one computer to other computers.  

 
Virus and file:  
 Some viruses get connected with .com or .exe program file.  
 Some viruses damage the programs that ask for permission for the execution in 

addition to .sys, .ovl, .prg and .mnu.  
 
Harmful software:  
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 Some programs, which are not actually considered as virus, but are harmful to 
computer. Such programs spread while downloading from the internet. Such 
viruses are hidden in software. Such harmful Softwares are introduced below.  

 
Malware:  
 

 Malware is a program, file or a set of instructions (Code) that damages the 
computer without a permission of the user.  

 
Spyware:  

 Spyware are different from the virus. Some are similar to the behavior of 
the virus.  

 This is a program that enters into our computer to collect information on 
our computer and forward it to the advertising company or other interested 
persons. 

 Spyware enters into our computer without our permission and without 
informing us.  

 Spyware enters during the process of downloading information from the 
internet or clicking the pop-up window option.  

 
Worm:  

 It is theoretically similar to virus. It is improved version to the virus 
program.  

 Worm does not change the program, but it frequently causes duplication of 
data and multiple copies. The numbers of these unnecessary programs 
are increasing to the extent that eventually the computer on the network is 
slowed down and at the end computer shuts down. 

 Thus, the intension of the Worm attack is different from that of Virus. 
Worm attack victimizes a computer or network resources to destroy it and 
make it unusable.  

 
 
Trojan horse:  

 Just like virus, it is a hidden part of instructions.  
 The main objective of Trojan horse attack is to deliver confidential 

information of the computer to attacker. Trojan horse hides itself quietly in 
instructions and waits for the login screen. When the user of the system 
enters the user-id and password, it immediately activates and gets user-id 
and password unknowingly to the user and sends it to attackers.  

 
Browser Hijackers:  

 Browser hijacker is a program to change our computer browser‘s settings 
so that it will automatically open some of the websites.  

 Most of the browser hijackers change the default Home Page and Search 
Page. 

 
Spam:  

 Spamming is used to send the unwanted messages through the email.  
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 E-mail spam is also known as undesirable email or unwanted commercial 
e-mail.  

 It repeatedly sends unwanted e-mails and business detail e-mail 
operations to the recipient group. To prevent spam, we have to configure 
Spam Guard in Email account. Such unwanted e-mail goes to spam folder 
that we can delete later.  

 
Rescue virus: 
 A virus generally spreads through various media such as floppy, hard disk, pen 

drive, CD, or Internet. Many antivirus programs are available in the market to 
prevent virus. But it is essential to regularly update antivirus software.  

Kaspersky, Netware, Quick Heal etc. are known antivirus. Antivirus keeps constant 
watch on computer and prevents it from virus entering through floppy, Internet, CD or 
pen drive and it scans the data before allowing further action. 
 
2.10.4 Scandisk Utility 
Sometimes the hard disk runs slow because of the bad sectors. One reason to occur 
bad sector may be a sudden power failure. If the number of bad sectors is increased, 
it will create difficulties to store data. To solve this problem, we have to format the 
hard disk, floppy disk etc so that the life of hard disk can be extended and search 
can be made faster.  
 
We can use Scandisk utility of windows (The term utility referes to the need of the 
application for the user). Followings are steps for using scandisk utility.  
 

1. Click to open Computer. 
2. Right-click the drive that you want to check, and then click Properties. 
3. Click the Tools tab, and then, under Error-checking, click Check now.  
4. To automatically repair problems with files and folders that the scan detects, 

select automatically fix file system errors. Otherwise, the disk check will report 
problems but not fix them. 

5. To perform a thorough check, select Scan for and attempt recovery of bad 
sectors. This scan attempts to find and repair physical errors on the drive 
itself, and it can take much longer to complete.  

6. To check for both file errors and physical errors, select both Automatically fix 
file system errors and Scan for and attempt recovery of bad sectors. 

7. Click Start. 
 
Depending on the size of your drive, this might take several minutes. For best 
results, don't use your computer for any other tasks while it is checking for errors. 
 
2.10.5 Backup Utility 
Though all the data in the computer are safe, generally we copy all the files and 
store them at some other safe location for more safety. This is known as backup. 
Backup helps us restore or retrieve the data even though our computer faces some 
major problem or the data gets damages or deleted occasionally.  
 
Usually backups are taken into external drive, pen drive, DVD or CD. It is even 
possible to take a backup with an application. Its best example is the database 
management system. Here, whatever the information is stored is known as the data. 
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The database management software has a separate backup facility. The application 
may be given the same option. Click on the backup and all data are stored into 
another drive or folder. It is a simple and small utility through which we can safely 
back up the files and rescue out computer from data loss. 
 

2.11 Troubleshootings 
 
Some common problems may arise in our computer many a times. We should have 
the information to overcome these problems. Solving such problems is known as 
troubleshooting. Let us know some of the simple and basic troubleshooting that may 
be applied when we are or somebody is struggling to turn on the computer.  
 
(1) It is required to check that all cables of computer are properly fixed or not. 
(2) It is necessary to check the power cable (cord) of the computer to verify that 

whether it is connected to electricity supply or not.  
(3) It is required to check whether the UPS (Uninterruptable Power Supply), 

responsible for proper electricity supply, is properly connected.  It is also 
needed to check whether its electric supply is appropriate or not.  We must also 
check that UPS/Voltage Stabilizer has no error. 

(4) There are possibilities of occurrence of fault if there is some error in RAM or if 
the RAM is not fixed properly into the motherboard. 

(5) There may be a fault in the Microprocessor (CPU). 
(6) There may be a fault in CPU fan or it may not be working properly. 
(7) There may be fault in the motherboard or its circuit.  
(8) Problem or fault may occur in SMPS (Switched-mode power supply), which 

supplies the electricity to different parts of a computer.  
(9) If computer is connected to LAN, it is required to check whether the LAN card 

has been fixed correctly on the motherboard or not. 
(10) It is also required to check that sound cards, graphic cards, key-board, monitor 

cable, mouse cable, printer cable, scanner cable or other cables are connected 
at appropriate place.  

(11) If possible, clean the input and output devices daily since dust may damage the 
device and cause early breakdown in the device.   

(12) Cool environment enhances the life span of computer hardware. So turn on AC 
or fan while using the computer. 

(13) Improper installation of the new hardware may also create fault in the computer.   
(14) If the operating system is corrupted, the computer can not be startted. In such a 

scenario, we have backup of operating system or a bootable operating system 
disk then we can immediately re-install the operating system and resolve the 
problem.  

(15) Virus can cause severe damage to the computer hardware and software. The 
computer may slow down, files may be damaged, and applications can be 
corrupted or entirely removed due to virus. We should have anti-virus software 
in our computer to protect our computer against virus attack and keep it secure 
and safe. 

It is required to remove garbage files from a computer at a regular time interval. 
Unnecessary files may waste disk space. There are some good utilities available to 
do this.  The disk cleanup utility removes unnecessary files from your computer. 
Another utility is Scandisk, which is used to find or correct the bad sectors in the 
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storage device like hard disk. Hard disk data are stored at scattered locations. 
Defragment Drive utility is to be used at regular intervals to systematically arrange 
data on hard disk for faster access of the information. 
 

2.12 PORTABLE DOCUMENT FORMAT PDF 
 
Portable Document Format (PDF) is the open standard file format developed by 
Adobe Systems. It is used for representing two dimensional documents. PDF file can 
be viewed on any device. PDF format allows you to make a document with different 
resolution, fonts, graphics, colors and images.  
 
As shown in the preceding chapters, file created in Word, Excel or PowerPoint 2010 
can be saved as a PDF file. PDF file format consists of the following characteristics:  
 Multi-platform: It can be seen and printed on any operating systems like 

Macintosh, Windows, and Unix etc.  
 Data integrity: A PDF file crated in one device or computer can be seen on any 

other computer or device without any changes.  
 Information Search: It allows the user to easily find any word, bookmarks and 

data field from text data.  
Information accessibility: PDF document makes the information accessible for 
people with disabilities with the help of assistive technology. 
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